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C H A P T E R 1
Introduction to Oracle Service Bus
Oracle Service Bus (Oracle Service Bus) is a configuration-based, policy-driven Enterprise 
Service Bus (ESB). It provides highly scalable and reliable service-oriented integration, service 
management, and traditional message brokering across heterogeneous IT environments. It 
combines intelligent message brokering with routing and transformation of messages, along with 
service monitoring and administration in a unified software product. Oracle Service Bus Console 
enables you to control the service and policy configurations, and monitor system and operations 
tasks. Oracle Service Bus relies on WebLogic Server run-time facilities. For more information, 
see Oracle Service Bus Concepts and Architecture.

Starting Oracle Service Bus Console
1. Start Oracle Service Bus using one of the following methods:

– From the Windows Start menu, select:

Start > All Programs > Oracle WebLogic > User Projects > domain_name  > Start 
Server for Oracle Service Bus Domain.

Where domain_name represents the name you assigned your Oracle Service Bus 
domain when you created it. User Projects is the default location in which your 
domain is created by default.

– Invoke the startWebLogic command from the root of Oracle Service Bus domain: 
startWebLogic.cmd or startWebLogic.sh

A command window is displayed showing status information about WebLogic Server.
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If you started the server in production mode, you are required to enter a valid user 
name and password to start the server. For more information, see the Oracle Service 
Bus Installation Guide. 

2. When the server starts, enter the following URL in your browser:
http://hostname:port/sbconsole

where host represents the name of the machine on which WebLogic Server is running and 
port represents the port number.

For example, if WebLogic Server is running on your local machine using the default port 
configuration, enter the following URL in your browser:
http://localhost:7001/sbconsole

The Oracle Service Bus Console login page is displayed.

3. Enter the user name and the password you specified during the installation process.

4. Click Login.

To log out, click Logout on the banner near the top of the right panel of the Oracle Service Bus 
Console.

Customizing Table Views
Use the table customizer to display table information according on your specified settings. 

Note that the default sort order for any table is determined by the first column in the table.

1. Click the  Table Customizer icon. Additional fields are displayed.

You can click Cancel at any time to close this table and retain the original settings.

2. In the Columns field, select the columns you want to display:

a. Select a column name from the Available Columns field.

b. Click the arrow to move this column name to the Selected Columns field.

An asterisk denotes a required column.

c. Repeat until you have listed all the column names you want to display in the Selected 
Columns field.

In the Selected Columns field, you can use the Up and Down arrows to reorder the 
column names as required.
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3. To remove columns from being displayed, move the column names from the Selected 
Columns field to the Available Columns field.

4. From the Rows drop-down list, select the number of rows you want to display on a single 
page. 

5. Do one of the following:

– To save these settings and close the table customizer, click Apply.

– To discard your changes and retain the original settings, click Reset.
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C H A P T E R 2
Change Center
The Change Center allows for team collaboration when services and metadata are being 
configured in Oracle Service Bus. Each user works in a sandbox session until the user is ready to 
check in the working configuration to the core configuration of the bus. The change center 
provides multiple levels of undo, and visibility into conflicts, as multiple users work on the 
configuration.

Most of the Change Center pages display different information based on whether you are in a 
session (that is, you have clicked Create or Edit in the Change Center) or outside a session. For 
example, in a session, the View Configuration Changes page lists all the changes you have 
made in that session; outside a session, the page lists all session activations. 

Table 2-1 displays Change Center tasks and related session information.
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Using the Change Center
The Change Center module is the starting point for using the Oracle Service Bus Console to 
make changes to your configuration. To make configuration changes using the console, you must 
use the Change Center to start a session.

1. Click Create to begin a session. The name of the session is displayed under Change Center.

2. Make the appropriate changes on the relevant page of the console.

3. Click Save on each page where you make a change. All the changes you have made in the 
current session are saved.

Table 2-1  Change Center Tasks and Session Information 

Tasks Session Information

View conflicts Inside session only: This link displays the number of conflicts occurring in a session. 
View and resolve all conflicts between changes in the current session and those made by 
all other sessions within the Oracle Service Bus Console. A conflict occurs if a resource 
modified in the current session has already been modified and activated by another 
session. Two changes to the same resource by two sessions do not cause a conflict until 
one of the sessions is activated.

This page also displays semantic errors for resources in the session.

View changes Inside session: View the configuration changes you have made during the current 
session.

Outside session: View configuration changes that are caused by previous session 
activations.

Undo changes Inside session: Undo a change you have made during the current session.

Outside session: Undo an activation of a session.

View all sessions Inside and outside session: View all existing sessions within the Oracle Service 
Bus Console.

Activate sessions Inside session only: Activate the session.

View task details Inside session: View details of a specific change you made in the current session.

Outside session: View details of specific changes made by a previous session activation.
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Click Discard under Change Center, at any time during the session, to discard the 
changes you have made so far in the current session. 

4. When you have finished making changes, click Activate under Change Center. Continue in 
“Activating Sessions” on page 2-3.

Activating Sessions
1. Click Activate in the Change Center. The Activate Session page shows the session name, 

user name, and a description field. 

Creating a session and discarding a session proceed regardless of other activity in the 
system. However, if another session is in the process of being activated, the Activate 
Session page displays an error indicating the user that has the pending WebLogic Server 
changes. For information on resolving conflicts between changes made in your session and 
other activated sessions, see “Viewing and Resolving Conflicts” on page 2-11.

2. If there are validation errors, an error message is displayed, indicating that your session has 
validation errors. View and fix configuration conflicts before you proceed. For information 
on fixing conflicts, see “Viewing and Resolving Conflicts” on page 2-11. 

You will not be able to activate the session until you have viewed all conflicts. If new 
conflicts arise while you view the existing conflicts, before you activate, a message pops 
up informing you of the new conflicts.

3. Enter a description in the Description field. This description is displayed in the Description 
column when you click View Changes under Change Center to display configuration 
changes caused by session activations.

4. To activate the session, click Submit. If no new conflicts have arisen in the interim, the 
session ends and the configuration is deployed to the run time.

Note: When you attempt to activate a session with a JMS endpoint URI on another server (a 
single server other than the one on which you are working, or a Managed Server in a 
cluster), ensure that the destination server is available.

Oracle Service Bus does not allow registration of proxy services with JMS transport if 
the JMS endpoint URL specifies a destination that is unreachable. In other words, for 
JMS services, Oracle Service Bus checks if the specified connection factory exists; if it 
does not, a session activation error occurs.
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Exiting Sessions
Click Exit under Change Center at any time to exit the session. However, the session does not 
end. 

You can click Edit under Change Center to return to the session and continue making changes. 
This behavior also applies if you click Logout to log out of the console or close your browser. 
The session and all changes that you have made in the session persist even if you log out of the 
console or the server is restarted. 

The session ends only after it has been activated. See “Activating Sessions” on page 2-3.

Viewing Configuration Changes
This page displays different information based on whether you are in a session (that is, you have 
clicked Create or Edit in the Change Center) or outside a session. 

When you are in a session, the View Configuration Changes page displays a list of 
configuration changes that you have made during the current session. See “Viewing 
Configuration Changes in a Session” on page 2-4. 

When you are outside a session, the View Configuration Changes page displays a list of 
configuration changes that were caused by previous session activations. See “Viewing 
Configuration Changes Caused by Session Activations” on page 2-5.

Viewing Configuration Changes in a Session

1. If you have not already done so, click Create to create a new session for making changes to 
the current configuration. See “Using the Change Center” on page 2-2.

2. Make at least one change to the configuration.

3. Click View Changes under Change Center. For each change you have made to the 
configuration during the current session, the View Configuration Changes page displays the 
information shown in Table 2-2.

Table 2-2  In-Session Configuration Changes 

Property Description

Task A description of the task that was implemented. The task is a link to the Task 
Details page. See “Viewing Task Details” on page 2-8.
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Viewing Configuration Changes Caused by Session Activations

1. Make sure you are not in a session. See “Exiting Sessions” on page 2-4.

2. Click View Changes under Change Center. For each session you have previously activated, 
the View Configuration Changes page displays the information shown in Table 2-3.

Execution Time The date and time that the task was executed.

User The name of the user who implemented the change.

Task Status The status of the task:

Completed—the task was completed.

Undone—the task was undone.

Undo Completed—the undo was completed.

Undone By The name of the user who undid the task. This field will contain None if the task 
has not been undone.

Options Click the  Undo icon to reverse the execution of the task.

When you are working in a session, you can undo tasks in any order. 

As a result of undoing a task, the object of the task reverts to the state it was in 
before the task in question was performed. Note, however, that any tasks that were 
performed on the same object after the task that you undo are also undone. See 
“Undoing Tasks” on page 2-7.

Table 2-2  In-Session Configuration Changes (Continued)

Property Description

Table 2-3  Activated Configuration Changes 

Property Description

Task A description of the session that was activated. The task is a link to the Task 
Details page, which displays the operations that were performed in the session. 
See “Viewing Task Details” on page 2-8.

Description An additional description of the session that was activated, if a description was 
entered when the session was activated using the Activate Session page.

Execution Time The date and time that the session was activated.

User The name of the user who activated the session.
Using the Oracle Service Bus Console 2-5



Change  Cente r
Purging Session Activation History
You can purge sessions activated over a specific period, delimited by start and end dates. This 
action can only be performed outside a session. 

WARNING: Purging session activation history involves deleting data that enables multiple 
levels of undo. In other words, if you purge session activation history for a 
specific period, you will not be able to undo sessions activated during that period.

1. Ensure that you are not in an active session, and click View Changes. 

2. On the View Configuration Changes page, click Purge By Date. The Purge Session 
Activation History by Date page is displayed.

Task Status The status of the session:

Activated—the session was activated.

Partially Activated—displayed during session activation if one or more servers 
in a cluster are inaccessible, thus preventing activation of the session on those 
servers. When the servers become accessible, any unactivated changes will then 
be activated on them.

Undone—the previously activated session was undone and all the operations 
performed in the session were discarded.

Undo Activated—the undo was activated.

In Progress—displayed if a session activation is in progress, as session 
activations can take a long time. 

Failed—displayed if a session activation fails. Oracle Service Bus tracks session 
activation failures but not failures due to individual updates inside a session.

Undone By The name of the user who undid this task. This field will contain None if the 
session activation has not been undone.

Options Click the  Undo icon to reverse the session activation and the operations 
performed in that session. You can undo session activations in any order. 

Click the  Undo into Session icon to create a new session pre-populated 
with the tasks needed to undo the changes activated in the session. See “Undoing 
Into a Session” on page 2-8.

Table 2-3  Activated Configuration Changes (Continued)

Property Description
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3. Enter the Start and End dates, in their respective fields, in the format: MM/DD/YYYY.

The session activation history for all sessions between the dates specified will be deleted 
from Oracle Service Bus. 

Undoing Tasks
Use the View Configuration Changes page to undo tasks that you have performed in your 
Oracle Service Bus configuration during your current session, and to undo session activations 
outside a session. Oracle Service Bus lets you undo multiple levels of session activation, 
constrained only by your system resources. For more information, see “Order of Undoing Tasks” 
on page 2-8.

Note: If you upgrade from Oracle Service Bus version 2.1 to version 2.5, you will not be able 
to undo sessions activated before the upgrade. Sessions activated after the upgrade will 
be available in the session activation history, for undo.

Undoing a Task in a Session

1. Make sure you are in a session.

2. Click View Changes under Change Center. 

3. In the Options column for a specific task, click the  Undo icon. 

The task is undone.

You can undo any change in the current session. However after that, if you change your 
mind, you can undo the undo, or if you again change your mind, you can undo the undo 
that undid a previous undo, and so on.

Undoing a Session That Was Activated Earlier

1. Make sure you are outside a session.

2. Click View Changes under Change Center. 

3. Do one of the following:

– In the Options column for a specific task, click the  Undo icon. The session 
activation is undone.

– In the Options column for a specific task, select the  Undo into Session icon. A 
new session is created pre-populated with the tasks needed to undo the changes 
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activated in the session. For more information, see “Undoing Into a Session” on 
page 2-8.

Order of Undoing Tasks
You can undo tasks in any order (provided that individual undo actions result in valid data). The 
undo operation sets the value of a resource to the value it had before the change to that resource. 

In the case that the task that is being undone was one that created an object, there is no previous 
state to which an object can be returned—in other words, no object existed before this task was 
performed. Effectively, the undo operation deletes the new object from the session. In this case, 
errors occur for the objects that reference the one being deleted. You can view such errors on the 
View Conflicts page in the Change Center. 

When you are not working in a session, you can access the View Configuration Changes page 
to see the sessions that were previously activated. You can undo these sessions. The system does 
not allow you to undo a session that was previously activated if an error in the run time 
configuration would result from the undo action. For example, if you attempt to undo a session 
activation that results in the removal of an object that is being referenced by another object, that 
undo action is disallowed.

It is possible to undo an undo action. In the Options column of the Undo of [task], click the  
Undo icon. Oracle Service Bus supports unlimited undo. This means you can undo the undo that 
undid a previous undo, and so on.

Undoing Into a Session
If semantic errors result from undoing a session activation, you are prevented from doing the 
undo. However there is an alternative in this case. You can undo the session activation and have 
the changes put into a new session. You can then fix the semantic errors and activate the session. 
You can also use this capability of undoing into a session to explore the ramifications of a session 
activation undo. You can examine all the changes that result, and decide if you really want to do 
the undo. If you decide that you really want to, you can activate the session. 

Viewing Task Details
Use this page to view details of a specific change you made in the current session if you are in 
the session, and view details of specific changes you made in sessions that have been activated if 
you are outside a session.
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1. Select View Configuration Changes under Change Center.

2. On the View Configuration Changes page, click the name of the task in the Task column. 
The Task Details page displays the information shown in Table 2-4.

Table 2-4  Task Details

Property Description

Task The type of task you performed:
• Create
• Update
• Delete
• Rename
• Move

Resource Type Any of these resource types:
• Business Service
• Proxy Service
• WSDL
• XML Schema
• WS-Policies
• XQuery
• XSLT
• MFL file
• Service Account
• Alert Rule
• JNDI Provider
• SMTP Server
• Proxy Server
• Alert Destination
• JAR
• POJO
• Service Key Provider
• UDDI Registry
• MQ Connection
• Split-Join
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3. Click Back to return to the View Configuration Changes page.

Viewing All Sessions
Use this page to view all existing sessions within the Oracle Service Bus Console. You can view 
these sessions if you are currently in a session or outside a session.

You can view all sessions only if you are using the Administrator role. For more information, 
see Configuring Administrative Security in the Oracle Service Bus Security Guide.

1. Click View All Sessions under Change Center. For each existing session, the View All 
Sessions page displays the information shown in Table 2-5.

2. To switch to another session, click the link in the Session Name column for that session. 

Note: The same user logged in with multiple browsers is not supported. It causes unpredictable 
behavior in the console.

Resource The name and path of the resource. The path is the name of the project and folder 
in which the resource resides.

Table 2-4  Task Details

Property Description

Table 2-5  Session Details

Property Description

Session Name The name of the session. The name is a link to the session.

User The name of the user who created the session.

Creation Time The date and time the session was created.

Last Modified The date and time a change was last made during the session.

# of Objects Modified The number of objects that have been changed during the session.
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Viewing and Resolving Conflicts
Use this page to view diagnostic messages about errors in your configuration, and to view and 
resolve conflicts between changes made in your session and other activated sessions. The view 
conflicts link also displays the number of live conflicts in the session. 

Viewing Conflicts

1. Click View Conflicts under Change Center. The View Conflicts page can display any or all 
of the following sets of information depending on the nature of the conflicts:

– Errors (an  Error icon denotes non-committable, critical conflicts)—inform you of 
critical conflicts within your configuration. You cannot commit your changes without 
resolving the conflicts. See Table 2-6 and “Resolving Conflicts” on page 2-12.

– Concurrent Updates (a  Warning icon denotes committable, non-critical conflicts)—
warn you about incompatible changes with other activated sessions. See Table 2-7.

– Informational Messages (a  Warning icon denotes committable, non-critical 
conflicts)—inform you of any non-critical conflicts within your configuration. 

2. To display details of a specific conflict, click the link in the Name column for that conflict.

If the object to which you make changes in a session has changed in the run time since you 
began the edit of the current session, the View Conflicts page displays the information 
shown in Table 2-7.

Table 2-6  Errors 

Property Description

Name The resource to which the error message refers. The name is a link to that 
resource.

Path The project and folder in which the resource resides.

Resource Type The resource type.

Messages A description of the conflict. To resolve the conflict, see “Resolving 
Conflicts” on page 2-12.
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Resolving Conflicts
To resolve a conflict, use the information provided in the Messages column (as described in 
Table 2-6) to understand the problem, and then edit the object that is causing the conflict to fix 
the problem.

For the scenario in which you have a concurrent update conflict—that is, a conflict that occurs if 
a resource is modified in the current session that has already been modified and activated by 
another session (as described in Table 2-7), you can resolve the conflict in one of two ways:

Click Activate under Change Center. This saves your changes to the run time, which 
means you override changes that are deployed to core data by a previous session 
activation. In other words, the changes saved by the other user in another session are 
overwritten by your changes in this session.

Click the  Synchronize icon in the Synchronize column of the table (as described in 
Table 2-7). This action restores this object, in this session, to the state in which it was 
saved in the run time.

Table 2-7  Concurrent Updates 

Property Description

Name The resource in conflict. The name is a link to that resource.

Your Changes A description of the changes you made to this object in your session.

Other’s Changes A description of the changes another user made to this object in their 
session.

Synchronize Click the  Synchronize icon to return this object to the state in which it 
is saved in the run time.
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Working with Projects, Folders, and 
Resources
The Project Explorer organizes configurations and resources into projects and folders. In the 
Project Explorer, you can display the Projects View page, which lists all projects in the domain, 
and Project/Folder View pages, which list folders and resources in each project.

Projects are non-hierarchical, non-overlapping, top-level grouping constructs. 

All Oracle Service Bus resources (for example, services, WS-Policies, WSDLs, XQuery 
transformations, and so on) reside in exactly one project. Projects do not overlap. Resources can 
be created directly under a project, or they can be further organized into folders. However, you 
can reference any resource regardless of the project in which it resides.

When you create a domain in Oracle Service Bus, a default project is created.

Naming Projects and Folders 
Project names and folder names are limited to 64 characters, and must not contain the following 
characters: 

 \, <, >, |, {, }, %, (, ), :, `, /, commas

The names, length, and levels of nesting of projects and folders are ultimately affected by the 
limits of your operating system. Creating folders or projects with very long names or deeply 
nesting folders can fail due to the limitations of the operating system.
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Qualifying Resource Names Using Projects and Folders
Projects and folders qualify the names of Oracle Service Bus resources. A reference to a resource 
is constructed as follows:
  project-name/root-folder/. . ./parent-folder/resource-name

If a resource is located directly under a project, the reference is constructed as follows:
  project-name/resource-name

Projects View page
The Projects View page lists the projects defined in the current domain. Table 3-1 describes the 
options and controls on the page.

Table 3-1  Projects View Page - Options and Controls 

Option or Control Description

Enter New Project Name To create a new project, enter a name in the text field and click Add 
Project. See “Adding Projects” on page 3-6.
See also “Naming Projects and Folders” on page 3-1.

Name Click a project name to display the Project/Folder View page for that 
project. 
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Project/Folder View page
The Project/Folder View page displays details of a single project. Table 3-2 describe the options 
and controls on the page.

Options For any project listed, you can do any of the following:

• Click the  Rename Project icon to rename the project. See 
“Renaming Projects” on page 3-6.

• Click the  Move Project icon to move the project. See “Moving 
Projects (Converting to a Folder)” on page 3-7.

• Click the  Clone Project icon to clone the project. See “Cloning 
Projects” on page 3-7.

• Click the  Delete Project icon to delete the project. A  
Deletion Warning icon is displayed when other resources reference 
this resource. You can delete this resource with a warning 
confirmation. This might result in conflicts due to unresolved 
references to the deleted resource. See “Deleting Projects” on 
page 3-9. 

When you perform any of these actions, the result is saved in the current 
session. To end the session and deploy the configuration to the run time, 
click Activate under Change Center. 

Table 3-1  Projects View Page - Options and Controls (Continued)

Option or Control Description

Table 3-2  Project/Folder View Page - Options and Controls 

Option or Control Description

Project Name

References Click the number in this field (if greater than 0) to display a list of the 
resources outside of this project on which resources inside this project 
depend.
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Referenced By Click the number in this field (if greater than 0) to display a list of the 
resources outside of this project that are dependent on resources inside 
this project. 

Description Click Edit Description to add or edit a description of this project, then 
click Submit Description to update it.

Folders

Enter a New Folder Name To create a new folder in this project, enter a name in the text field and 
click Add Folder. See “Adding Folders” on page 3-10.
See also “Naming Projects and Folders” on page 3-1.

Name Click a folder name to display the Project/Folder View page for that 
folder.

Options For any folder listed, you can do any of the following:

• Click the  Rename Folder icon to rename the folder. See 
“Renaming Folders” on page 3-10.

• Click the  Upgrade to Project or Move Folder icon to move the 
folder or to upgrade it to a project. See “Moving or Upgrading 
Folders” on page 3-10.

• Click the  Clone Folder icon to clone the folder. See “Cloning 
Folders” on page 3-11.

• Click the  Delete Folder icon to delete the folder. A  Deletion 
Warning icon is displayed when other resources reference this 
resource. You can delete the resource with a warning confirmation. 
This might result in conflicts due to unresolved references to the 
deleted resource. See “Deleting Folders” on page 3-12. 

When you perform any of these actions, the result is saved in the current 
session. To end the session and deploy the configuration to the run time, 
click Activate under Change Center. 

Delete To delete folders, select the check boxes next to the names of the folders 
to delete, then click Delete.

Resources

Table 3-2  Project/Folder View Page - Options and Controls (Continued)

Option or Control Description
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Create Resource To create a new resource for this project, select a resource type from the 
Create Resource list. See “Creating Resources” on page 3-12.

Name Click a resource name to display details about the resource. 

Resource Type The type of this resource.

Actions The actions available for a resource depend on the type of resource:

• The  Edit Message Flow icon is displayed for proxy services. 
Click this icon to edit the message of a proxy service. See “Creating, 
Editing, and Viewing Message Flows” on page 18-1.

• The  Launch Test Console icon is displayed for business 
services, proxy services, XQuery transformations, XSL 
transformations, and MFL files. Click this icon to invoke the Test 
Console, which you use to validate and test the design of services and 
transformations. For services, you can only use the Test Console at 
run time; that is, when the session is activated. For transformations, 
you can use the Test Console whether you are inside or outside a 
session. See “Testing Services” on page 30-1 and “Testing 
Transformations” on page 30-17.

• The  Export WSDL icon is displayed for WSDL-based proxy 
services. Click this icon to export a WSDL, which you can then view 
or modify in an external tools such as an IDE. Note that this is 
different than the Export Resources functionality in the System 
Administration module, which you use to move and stage resources 
between two domains. See “Exporting a WSDL” on page 3-24.

• The  Generate WSDL icon is displayed for transport-typed 
business services, such as EJB and Flow. Click this icon to generate a 
WSDL, which you can then view or modify. See “Generating a 
WSDL” on page 3-25.

Table 3-2  Project/Folder View Page - Options and Controls (Continued)

Option or Control Description
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Adding Projects
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer > Projects to display the Projects View page.

3. In the Enter New Project Name field, enter a unique name for the project, then click Add 
Project. See “Naming Projects and Folders” on page 3-1. The new project is saved in the 
current session.

4. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Renaming Projects
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

Options The Options column displays the following icons:

• Click the  Rename Resource icon to rename the resource. See 
“Renaming Resources” on page 3-23

• Click the  Move Resource icon to move the resource. See 
“Moving Resources” on page 3-23.

• Click the  Clone Resource icon to clone the resource. See 
“Cloning Resources” on page 3-24

• Click the  Delete icon to delete the resource. A  Deletion 
Warning icon is displayed when other resources reference this 
resource. You can delete this resource with a warning confirmation. 
This might result in conflicts due to unresolved references to the 
deleted resource. 

When you perform any of these actions, the result is saved in the current 
session. To end the session and deploy the configuration to the run time, 
click Activate under Change Center. 

Table 3-2  Project/Folder View Page - Options and Controls (Continued)

Option or Control Description
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2. Select Project Explorer > Projects to display the Projects View page.

3. Click the  Rename Project icon in the row of the project you want to rename. The 
Rename Project page is displayed.

4. In the New Project Name field enter the new name for the project. See “Naming Projects and 
Folders” on page 3-1.

If you use the name of an existing project, the resources of both projects are merged under 
that name. For example, consider project MyProject with resources A and B, and project 
ThisProject with resources C and D. If you rename MyProject as ThisProject, the 
new ThisProject will have resources A, B, C, and D. 

5. Click Rename. The project is renamed in the current session.

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Moving Projects (Converting to a Folder)
When you “move” a project, the project is converted to a folder in the new location. 

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer > Projects to display the Projects View page. 

3. Click the  Move Project icon in the row of the project you want to move. The Move 
Project page is displayed with the current location of the project highlighted.

4. Under Location, select a project or folder to “move” the project into. The project is converted 
to a folder in the new location and is saved in the current session.

If you move a project to a new location and a folder with the same name already exists in 
that location, the contents of the project are merged with the contents of the existing folder.

5. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Cloning Projects 
There are three ways to clone (copy) a project:
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Clone the project with a new name at the root level. In this case, the original project and its 
clone exist as peer projects. The cloned project contains the same folders and resources as 
the original (at least until you modify the source or the clone). For instructions, see 
“Cloning a Project at the Root Level” on page 3-8.

Clone the project using the name of an existing project (other than the source project). In 
this case, the folders and resources from the source project are merged with the folders and 
resources of the project whose the name was assigned to the clone. The original project 
remains unchanged. For instructions, see “Cloning a Project at the Root Level” on 
page 3-8.

Clone the project in a new location, in an existing project or project folder. In this case, the 
cloned project is demoted to a folder in the new location. It contains the same folders and 
resources as the original project. 

If you clone a project with the same name and in the same location as an existing folder, 
the contents (subfolders and resources) of the project are merged with the contents of the 
target folder. 

In either case, the original project remains unchanged. 

For instructions, see “Cloning a Project and Demoting the Clone to a Folder” on page 3-9.

Cloning a Project at the Root Level

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer > Projects to display the Projects View page.

3. Click the  Clone Project icon in the row of the project you want to clone. The Clone 
Project page is displayed with the current location of the project highlighted.

4. In the New Name field, enter a name for the clone. See “Naming Projects and Folders” on 
page 3-1.

Use a unique name to create the clone as a new project, or use the name of an existing 
project to merge the clone with that project. 

5. In the Location panel, keep the default Root location when cloning a project at the root level.

6. Click Clone Project. The project is cloned in the current session. 

7. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.
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Cloning a Project and Demoting the Clone to a Folder

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer > Projects to display the Projects View page.

3. Click the   Clone Project icon in the row of the project you want to clone. The Clone 
Project page is displayed with the current location of the project highlighted.

4. In the New Name field, optionally enter a new name for the folder. See “Naming Projects and 
Folders” on page 3-1.

Use a unique name to create a new folder, or use the name of an existing folder to merge 
the clone with the existing folder (in the location you will select in the next step). 

5. In the Location panel, select a project or folder, then click Clone Project. The cloned project 
is converted to a folder in the new location and is saved in the current session. 

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Deleting Projects
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer > Projects to display the Projects View page.

3. Click the  Delete Project icon in the row of the project you want to delete. The project is 
deleted in the current session.

When you delete a project, all resources under the project are deleted. If any resources 
under this project are referenced by resources under a different project, you can delete the 
project but with a warning confirmation. This might result in conflicts due to unresolved 
references to the deleted resource. 

Instead of the  Delete icon, a  Deletion Warning icon is displayed for these resources.

4. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.
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Adding Folders
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, then select a project or folder in which to add the new folder. 

3. In the Enter New Folder Name field of the Project/Folder View page, enter a unique name 
for the folder. See “Naming Projects and Folders” on page 3-1.

4. Click Add Folder. The new folder is saved in the current session.

5. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Renaming Folders
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, then select the project or folder containing the folder whose name 
you want to change. The Project/Folder View page is displayed.

3. Click the  Rename Folder icon in the row of the folder you want to rename. The Rename 
Folder page is displayed.

4. In the New Folder Name field, enter a new name for the folder. See “Naming Projects and 
Folders” on page 3-1.

5. Click Rename. The renamed folder is saved in the current session.

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Moving or Upgrading Folders
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, then select the project or folder that contains the folder that you 
want to move or upgrade. The Project/Folder View page is displayed.
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3. Click the  Move Folder icon in the row of the folder you want to move or upgrade. The 
Move Folder page is displayed with the current location of the folder highlighted.

4. Determine whether you will move the folder to a new location under a different project or 
upgrade the folder to a project:

– To move it to a new location, in the Location panel, select a project or folder to move 
the folder into. 

– To upgrade the folder to a project, select the Root location.

5. Click Submit. The folder (or project, if it was upgraded from a folder) is saved in its new 
location in the current session. 

When you move or upgrade a folder, if another folder already exists in that location with 
the same name, the contents of the moved or upgraded folder are merged with the contents 
of the existing folder or project.

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Cloning Folders
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, navigate to the parent project or folder that contains the folder that 
you want to clone. The Project/Folder View page is displayed.

3. Click the   Clone Folder icon in the row of the folder you want to clone. The Clone Folder 
page is displayed with the current location of the folder highlighted.

4. Clone the folder in the same location or a different location, or upgrade the folder to a project:, 
as follows:

– To clone the folder in the same location, enter a new name in the New Name field. See 
“Naming Projects and Folders” on page 3-1.

When cloning in the same location, either do not select any location at all in the 
Location panel (which is equivalent to selecting the current location), or explicitly 
select the current project and folder. 
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– To clone the folder in a different location, optionally enter a new name in the New 
Name field, and select a project and/or folder from the Location area. See “Naming 
Projects and Folders” on page 3-1.

If you use the same name as an existing folder, the contents of the original folder are 
merged with the contents of the target folder. 

– To upgrade the folder to a project, select the Root location.

5. Click Clone Folder. The folder is cloned in the current session. 

When you clone a folder, all folder and resources under the folder are cloned recursively

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Deleting Folders
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, then select the project or folder that contains the folder that you 
want to delete. 

3. On the Project/Folder View page, Click the  Delete Folder icon in the row of the folder 
you want to delete. The folder is deleted in the current session.

When you delete a folder, all resources under the folder are deleted. If any resources under 
this folder are referenced by resources under a different folder, you can delete the folder 
but with a warning confirmation. This might result in conflicts due to unresolved references to 
the deleted resource. 

Instead of the  Delete icon, a  Deletion Warning icon is displayed for these resources.

4. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Creating Resources
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, then select the project or folder in which you want to create the 
resource. 
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3. From the Create Resource drop-down list on the Project/Folder View page, select the type 
of resource you want to create. Different pages are displayed, depending on the type of 
resource you select.

4. Follow the prompts to add information to each page to create the resource. For more 
information about creating each kind of resource, see the appropriate topic, as listed in 
Table 3-3.

Table 3-3  Creating Resources 

To Create this Type of Resource... See this Topic...

Service

Proxy Service Creating and Configuring Proxy Services

Business Service Creating and Configuring Business 
Services

Split-Join Adding Split-Joins

Interface

WSDL Adding WSDLs

XML Schema Adding XML Schemas

WS-Policy Adding Custom WS-Policies

Transformation

XQuery Transformation Adding XQuery Transformations

XSL Transformation Adding an XSL Transformation

MFL File Adding MFLs

Security

Service Account Adding Service Accounts

Service Key Provider Adding Service Key Providers

Utility

JAR Adding JARs
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5. When you create the resource, it is created in the current session.

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Loading Resources from a Zip File
You can select a Zip or JAR file that contains the resources you want to load; Oracle Service Bus 
locates and imports the resources from this Zip file.

Resources like WSDLs or XML Schemas can define full trees of dependent resources. The bulk 
load feature allows you to upload a set of resources at once; you need not resolve the 
dependencies manually.

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, then select the project or folder to which you want to add resources. 
The Project/Folder View page is displayed.

3. From the Create Resource drop-down list, select Zipped Resources. The Load Resources 
page is displayed.

4. In the Select Zip File field, specify a Zip file to import. Enter the name of the file (qualified 
by its path); or, click Browse, locate the file, then click Open.

5. Review the mapping of resource types to file extensions. Change or add extensions, according 
to your needs. Separate multiple extensions with commas.

Alert Destination Adding Alert Destinations

MQ Connection Adding MQ Connections

Bulk

Resources from URL Loading Resources from a URL

Zipped Resources Loading Resources from a Zip File

Table 3-3  Creating Resources (Continued)

To Create this Type of Resource... See this Topic...
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Each file in the Zip file is a possible resource, and the file extension is the commonly used 
way to identify the file type. Oracle Service Bus defines a default extension for each 
resource, but if you have additional extensions to describe those resources, this map 
enables you to declare those extensions to the loader. 

After you define the Zip file and extension map, the Oracle Service Bus loader scans the 
contents of the Zip file and tries to associate a resource type with each file. A file without 
an extension or one that does not have an extension defined in the map is considered 
unknown and is automatically excluded from the load. 

For known files, the name of the resource is the name of the file without its extension. The 
folder structure of the Zip file is recreated in the target Oracle Service Bus Console folder.

An extension can only be associated with one file type.

6. Click Next. 

7. On the Load Resources - Review Loaded Resources page, review the resources you are 
importing. You can clear the check boxes next to any resources you do not want to include in 
this import.

8. To import the selected resources, click Import. 

9. The Load Resources - Import Result page displays the imported resources. Click Load 
Another to import resources from another file, or proceed with other tasks by selecting a 
different page from the left navigation pane.

10. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Load Resources - Select Zip File and Review Type 
Extensions page

Use the Load Resources - Select Zip File and Review Type Extensions page to import 
resources from a Zip file, as documented in “Loading Resources from a Zip File” on page 3-14. 

Table 3-4 describes the options and controls on the page.
Using the Oracle Service Bus Console 3-15



Work ing  wi th  P ro j ec ts ,  Fo lde rs ,  and  Resources
Loading Resources from a URL
You can perform a bulk import of resources available at a URL or on the file system. Bulk import 
lets you import a root resource, such as a WSDL, along with its dependents, such as other WSDLs 
and schemas. The dependency map is resolved automatically.

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, then select the project or folder to which you want to add resources. 
The Project/Folder View page is displayed.

3. From the Create Resource drop-down list, select Resources from URL. The Load 
Resources - Load Resources from URL page is displayed.

4. In the URL/Path field, enter the URL or path of the resource. 

To specify a local resource, you can use the file protocol with a file name fully qualified 
by its path, for example, file:///c:/osbresources/ForeachAction.jar

5. In the Resource Name field, enter the resource’s name.

Table 3-4  Load Resources: Select Zip File and Review Type Extensions page - Options and Controls 

Options and Controls Description

Select Zip File Enter the fully qualified name of a Zip file to import, or click Browse to 
select it.

Resource Type and File 
Extension

Each file in the Zip file is a possible resource, and the file extension is 
the commonly used way to identify the file type. Oracle Service Bus 
defines a default extension for each resource, but if you have additional 
extensions to describe those resources, this map enables you to declare 
those extensions to the loader. 

After you define the Zip file and extension map, the Oracle Service Bus 
loader scans the contents of the Zip file and tries to associate a resource 
type with each file. A file without an extension or one that does not have 
an extension defined in the map is considered unknown and is 
automatically excluded from the load. 

For known files, the name of the resource is the name of the file without 
its extension. The folder structure of the Zip file is recreated in the target 
Oracle Service Bus Console folder.
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6. From the Resource Type drop-down list, select the type of the resource.

7. Click Next to display the Load Resources - Review Loaded Resources page. Clear the check 
boxes next to any resources you do not want to include in this import.

8. To import the selected resources, click Import. 

9. The Load Resources - Import Result page displays the imported resources. Click Load 
Another to import resources from another file, or proceed with other tasks by selecting a 
different page from the left navigation pane.

10. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Load Resources - Load Resources from URL page
Use the Load Resources - Load Resources from URL page to import resources from a file 
available on the Web, as documented in “Loading Resources from a URL” on page 3-16. 

Table 3-5 describes the options and controls on the page.

Load Resources - Review Loaded Resources page
The Load Resources - Review Loaded Resources page displays details about resources being 
imported from a Zip or other file, as documented in “Loading Resources from a Zip File” on 
page 3-14 or “Loading Resources from a URL” on page 3-16. 

Table 3-6 describes the options and controls on the page.

Table 3-5  Load Resources: Load Resources from URL page - Options and Controls 

Options and Controls Description

URL/Path Enter the URL where the file is located.

To specify a local resource, you can use the file protocol with a file 
name fully qualified by its path, for example, 
file:///c:/osbresources/ForeachAction.jar

Resource Name Enter a name for the resource.

Resource Type Select the type of resource from the list.
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A  Warning icon next to file name indicates that the resource type is unknown. (A file without 
an extension or one that does not have an extension defined in the map is considered unknown.) 
Files of unknown file types cannot be imported.

Load Resources - Import Result page
The Load Resources - Import Result page displays the results of loading resources from an 
imported Zip file or from a URL.

Depending on whether you have loaded resources from a Zip file or a URL, make sure you have 
completed the steps in either “Loading Resources from a Zip File” on page 3-14 or “Loading 
Resources from a URL” on page 3-16, and make sure you have completed the steps in “Load 
Resources - Review Loaded Resources page” on page 3-17.

The Import Result page is displayed, which displays the following information.

Table 3-6  Load Resources: Review Loaded Resources page - Options and Controls 

Options and Controls Description

File Name The file name of the resource, including the file extension.

Name The name of the resource.

Path The path of the resource, which is the project and folder where the 
resource resides.

Resource Type One of the resource types:
• WSDL
• XML Schema
• WS-Policy
• XQuery
• XSLT
• MFL
• JAR
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View References page
Depending on whether you clicked References or Referenced By on a Project/Folder View page, 
the View References page displays a list of:

Resources outside of the current project or folder that are referenced by resources inside 
the project or folder.

Resources outside of the current project or folder that reference resources inside the project 
or folder.

Table 3-8 describes the options and controls on the page.

Table 3-7  Project/Folder View Page - Options and Controls 

Option or Control Description

Status The status of the resource; for example, whether or not it has been 
imported successfully.

A WSDL may be temporarily marked as invalid until all of its 
dependencies are imported. When the import action is completed, 
however, the configuration service re-validates the files marked invalid. 

Name The name of the resource.

Path The path of the resource, which is the project and folder where the 
resource resides.

Resource Type One of these resource types:
• WSDL
• XML Schema
• WS-Policy
• XQuery
• XSLT
• MFL
• JAR
• Split-Join

Error Message Displays the details of the error message if the resource has not been 
imported successfully.
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Viewing References to Resources
You can view references to resources whether or not you are in a session. See “Using the Change 
Center” on page 2-2.

1. Click References or Referenced By on a project, folder or resource details page in the 
Project Explorer or Resource Browser modules. 

– Click References to display resources outside of a project or folder that are referenced 
by resources inside the project or folder.

– Click Referenced By to display resources outside of a project or folder that reference 
resources inside the project or folder.

Table 3-8  Project References Page - Options and Controls 

Option or Control Description

Name Click the name of the resource to display details of the resource.

Resource Type Displays Project, Folder, or any of the following resource types:
• Proxy Service
• Business Service
• WSDL
• XML Schema
• WS-Policy
• XQuery
• XSLT
• MFL
• Service Account
• Service Key Provider
• JAR
• Alert Destination
• JNDI Provider
• SMTP Server
• Proxy Server
• MQ Connection
• Split-Join
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The View References page is displayed. 

2. Click a name of a resource to display details about it, or click Back to return to the previous 
page.

View Change History page
The View Change History page displays the ten most recent changes to a resource, across all 
session activations.

Table 3-9 describes the options and controls on the page.

Using the Resource Browser
The Resource Browser provides tools for locating resources and for performing simple actions 
on them, such as Display, Edit, Export, and Delete. 

1. To display the Resource Browser, select Resource Browser from the left navigation pane.

2. On the left side of the page, click the name of the type of resource you want to locate. 
Table 3-10 shows the items you can select and the tasks associated with the page displayed 
for each one.

Table 3-9  Change History Page - Options and Controls 

Option or Control Description

Task The type of task performed:
• Create
• Update
• Clone
• Rename
• Move

User The user who created or edited this resource.

Execution Time The date and time that the user created or edited this resource.
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Table 3-10  Resource Types Available from the Resource Browser 

Resource Type Associated Task

Service

Proxy Services “Locating Proxy Services” on page 17-46

Business Services “Locating Business Services” on page 16-44

Split-Joins “Locating Split-Joins” on page 9-1

Interface

WSDLs “Locating WSDLs” on page 6-1

XML Schemas “Locating XML Schemas” on page 4-1

WS-Policies “Locating Custom WS-Policies” on page 11-2

Transformation

XQueries “Locating XQuery Transformations” on page 10-1

XSLTs “Locating XSL Transformations” on page 12-1

MFLs “Locating MFLs” on page 13-1

Security

Service Accounts “Locating Service Accounts” on page 14-3

Service Key Providers “Locating Service Key Providers” on page 15-2

Utility

JARs “Locating JARs” on page 7-1

Alert Destinations “Locating Alert Destinations” on page 5-1

MQ Connection “Locating MQ Connections” on page 8-1
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Renaming Resources
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, then select the project or folder containing the resource you want to 
rename. The Project/Folder View page is displayed.

3. Click the  Rename icon in the row of the resource you want to rename. The Rename page 
is displayed. 

4. In the New Resource Name field, enter a new name for the resource. Comma (,) and slash (/) 
characters are not allowed. 

5. Click Rename. 

Note: If you rename a business service imported from the UDDI registry, the service will 
become detached from the registry

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Moving Resources
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, then select the project or folder containing the resource you want to 
move. The Project/Folder View page is displayed.

3. Click the  Move icon in the row of the resource you want to move. The Move page is 
displayed with the current location of the resource highlighted. 

4. In the Location field, select the project and folder to which you want to move the file.

5. Click Move File. The resource is moved to the new location in the current session.

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.
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Cloning Resources
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, then select the project or folder containing the resource you want to 
clone. The Project/Folder View page is displayed.

3. Click the  Clone Resource icon in the row of the resource you want to clone. The Clone 
Resource page is displayed with the current location of the resource highlighted.

4. You can clone the resource in the same location or a different location:

– To clone the resource in the same location, enter a new name in the New Resource 
Name field. Comma (,) or slash (/) characters are not allowed. 

To clone in the same location, either do not select any location at all in the Location 
panel (which is equivalent to selecting the current location), or explicitly select the 
current project and folder. 

– To clone the resource in a different location, optionally enter a new name in the New 
Resource Name field, and select a project and/or folder from the Location area.

5. Click Clone Resource. The resource is cloned in the current session.

If you clone a business service imported from the UDDI registry, the cloned service will be 
detached from the registry

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Exporting a WSDL
Use the Project/Folder View page to export a WSDL associated with a proxy service or a 
business. The WSDL is exported as a JAR file. You can export a WSDL only when you are 
outside a session. See “Using the Change Center” on page 2-2.

Use the Export WSDL feature to make a WSDL available for consumption by external tools such 
as IDEs. Note that this is different than the Export Resources feature in the System 
Administration module, which you use to move and stage resources between two domains.

1. From the left navigation pane, click a project or folder from under Project Explorer. The 
Project/Folder View page is displayed.
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2. Click the  Export WSDL icon in the row of the proxy service whose WSDL you want to 
export. The File Download dialog box is displayed.

3. In the File Download dialog box, click Open to open the JAR file or click Save to save the 
JAR file to your desktop. 

Generating a WSDL
A generated WSDL is a WSDL resource that Oracle Service Bus generates for a service that did 
not start with a WSDL resource but which can be described using a WSDL. For example, a 
WSDL created from an EJB-based service is a generated WSDL. For more information, see How 
WSDL is Used in Oracle Service Bus in the Oracle Service Bus User Guide.

Use the Project/Folder View page to generate a WSDL associated with an EJB or Flow 
transport-typed business service. 

1. From the left navigation pane, click a project or folder from under Project Explorer. The 
Project/Folder View page is displayed.

2. Click the  Generate WSDL icon in the row of the business service whose WSDL you 
want to generate. The Generate WSDL Resource dialog box is displayed with the current 
location (project name and the name of the folder in which the business service resides) highlighted.

3. In the Generate WSDL Resource dialog box, specify a New WSDL Resource Name and 
location for the WSDL, and click Generate WSDL.

After you finish

Continue in “Editing WSDLs” on page 6-3 to view or modify the generated WSDL.

Viewing Resources in a Web Browser
View Oracle Service Bus resources in a standard Web browser, using the following URLs

– Path for WSDL resources:  
http://host:port/sbresource?WSDL/project/...wsdlname

– Path for WSS resources: 
http://host:port/sbresource?POLICY/project/...policyname

– Path for MFL resources: 
http://host:port/sbresource?MFL/project/...mflname
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– Path for SCHEMA resources: 
http://host:port/sbresource?SCHEMA/project/...schemaname

– Path for Proxy Service resources: 
http://host:port/sbresource?PROXY/project/...proxyname

Deleting Resources
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, then select the project or folder containing the resources you want 
to delete. 

3. Click the  Delete icon in the row of the resource you want to delete. The resource is deleted 

in the current session. A  Deletion Warning icon is displayed when other resources reference this 
resource. You can delete the resource with a warning confirmation. This might result in conflicts due to 
unresolved references to the deleted resource. 

4. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.
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XML Schemas
Schemas describe types for primitive or structured data. XML schemas are an XML vocabulary 
that describe the rules that XML business data must follow. XML schemas specify the structure 
of documents, and the data type of each element and attribute contained in the document.

You use XML schemas as references for WSDL resources. You can also use XML schemas in 
the Message Flow of proxy services to validate an element specified with an XPath expression. See 
“Adding Validate Actions” on page 19-32. 

Locating XML Schemas
1. Do either of the following:

– Select Project Explorer to display the Projects View page or the Project/Folder View 
page. Then navigate through projects and folders to find the XML schema.

– Select Resource Browser > XML Schemas. The Summary of XML Schemas page 
displays the information shown in Table 4-1. For a more detailed description of the 
properties, see “Editing XML Schemas” on page 4-3.

2. To locate a specific XML schema:

– Click the  Open icon to display additional search filters. If you specify multiple 
search criteria, only results that match all the criteria will be returned.

– To restrict the number of items in the list, you can filter by name, path, and namespace. 
In the Name, Path, and Namespace fields, enter the name, path and namespace of the 
search target(s), then click Search. 
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The path is the project name and the name of the folder in which the XML schema 
resides. 

– Click View All to remove the search filters and display all XML schemas.

Adding XML Schemas
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, then select a project or folder in which to add the new XML schema. 
The Project/Folder View page is displayed.

3. From the Create Resource drop-down list, select XML Schema to display the Create a New 
XML Schema Resource page.

4. In the Resource Name field, enter a unique name for this XML schema. This is a required 
field.

5. In the Resource Description field, enter a description for the XML schema.

6. In the XML Schema field, do one of the following:

– Enter text for the new XML schema.

– Click Browse to locate and import an existing XML schema.

– Copy and paste text from an existing XML schema into this field.

Table 4-1  XML Schema Information 

Property Description

XML Schema Name The unique name assigned to the XML schema. The name is a link to the XML 
Schema Details page. See “Editing XML Schemas” on page 4-3.

Path The path is the project name and the name of the folder in which the XML schema 
resides. It is a link to the project or folder that contains this resource. See 
“Qualifying Resource Names Using Projects and Folders” on page 3-2.

XML Schema Namespace The namespace used to qualify any of the definitions included in the XML 
schema.

Options Click the  Delete icon to delete a specific XML schema. See “Deleting XML 
Schemas” on page 4-5.
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This is a required field.

7. Click Save. The new XML schema is saved in the current session.

When you click Save, if there are any unresolved references for the new XML schema, the 
system displays them. See “Viewing Unresolved XML Schema References” on page 4-5.

8. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Editing XML Schemas
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Locate the XML schema, as described in “Locating XML Schemas” on page 4-1.

3. Click the XML schema name. The View XML Schema Details page displays the information 
shown in Table 4-2, Table 4-3, and Table 4-4.

The structural view of the XML schema is displayed by default, which includes the 
information shown in Table 4-3.

Table 4-2  XML Schema Details 

Property Description

Last Modified By The user who created this XML schema or imported it into the configuration.

Last Modified On The date and time that the user created this XML schema or imported it into the 
configuration. Click the date and time link to view the change history of this 
resource. See “View Change History page” on page 3-21.

References The number of objects that this XML schema references. If such references exist, 
click the numeric link to view a list of the objects. See “Viewing References to 
Resources” on page 3-20.

Referenced by The number of objects that reference this XML schema. If such references exist, 
click the numeric link to view a list of the objects. For example, if this XML 
schema is referenced by a specific WSDL, the WSDL is listed as a reference when 
you click the link. See “Viewing References to Resources” on page 3-20.

Description A description of this XML schema, if one exists.
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4. Click Text View to display a text view of the XML schema details. The text view includes the 
information shown in Table 4-4.

5. To make changes to the fields, click Edit. See “Adding XML Schemas” on page 4-2 for 
descriptions of the fields.

Table 4-3  XML Structure Details 

Property Description

Target Namespace The namespace used to qualify any of the definitions included in the XML 
schema.

XML Schema Definitions The attributes and groups associated with the XML schema:
• XML Schema Types
• XML Schema Elements
• XML Schema Imports
• XML Schema Includes/Redefines

Schema State Status of the XML schema:
• Valid 

An XML schema is shown as valid when all of the locations for XML 
schemas included by the current XML schema are specified. Furthermore, all 
of the locations for nested XML schemas (XML schemas subsequently 
included by the included XML schemas) are specified.

• Invalid 
An XML schema is shown as invalid when one or more of the locations for 
the XML schema is not specified. Additionally, the location for one or more 
nested XML schemas (XML schemas subsequently included by the included 
XML schemas) may not be specified. To resolve an invalid XML schema, 
click Edit References. See “Resolving Unresolved XML Schema 
References” on page 4-6.

Table 4-4  XML Schema Text Details

Property Description

Target Namespace The namespace used to qualify any of the definitions included in the XML 
schema.

XML Schema The text for this XML schema.
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6. Make the appropriate edits.

7. Click Save to commit the updates in the current session.

8. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Deleting XML Schemas
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Resource Browser > XML Schemas. 

3. Click the  Delete icon in the Options field of the XML schema you want to delete. The 

XML schema is deleted in the current session. A  Deletion Warning icon is displayed when 
other resources reference this resource. You can delete the resource with a warning confirmation. This 
might result in conflicts due to unresolved references to the deleted resource.

4. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Viewing Unresolved XML Schema References
For each unresolved XML schema reference, this page displays the information shown in 
Table 4-5. 

To locate a specific reference:

Resort the list. Click on an underlined column name. Ascending and descending arrows 
indicate the sort order. Click the column name to change the sort order.

Table 4-5  Unresolved XML Schema Details 

Property Description

Schema Name The unique name assigned to the XML schema. Click the name of a specific XML 
schema to view details for that XML schema. See “Editing XML Schemas” on 
page 4-3.

Namespace The namespace used to qualify any of the definitions included in the XML schema.
Using the Oracle Service Bus Console 4-5



XML Schemas
Scroll through the pages. Use the page controls above or below the table. Go to a page by 
selecting the page number or by using the arrow buttons to go to the next, previous, first, 
or last page.

Resolving Unresolved XML Schema References
Use the Edit the References of an XML Schema Resource page to resolve unresolved XML 
schema references by configuring the mapping for XML schema references such as XML schema 
imports. 

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. On the Summary of XML Schemas page, in the XML Schema Name column, click the 
appropriate XML schema name to view details of the unresolved reference. The View XML 
Schema Details page is displayed.

3. Click Edit References to display the Edit the References of an XML Schema Resource 
page.

4. In the Resource Type field, select XML Schema.

5. Click Browse. The XML Schema Browser is displayed.

6. In the XML Schema Browser, select an XML schema, then select a definition from the 
Definitions pane.

7. Click Submit. The XML schema you selected is displayed in the Resource Name field.

8. Click Save to resolve the reference. 

9. On the XML Schema Details page, click OK. The state of the XML schema is displayed as 
Valid.
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Alert Destinations
An alert destination resource captures a list of recipients that can receive alert notifications from 
the Oracle Service Bus. In typical system monitoring contexts, alerts generated by Oracle Service 
Bus bear significance to a finite set of users.

In Oracle Service Bus, you can configure each alert destination resource to include a set of 
recipients according to a given context. Alert destinations are used by Alert actions configured in 
the message flow, and also by SLA alert rules. An alert destination can include one or more of 
the following types of destinations: console (default), Reporting Data stream, SNMP trap, e-mail, 
JMS queue, or JMS topic. 

In the case of e-mail and JMS destinations, a destination resource can include a list of e-mail 
addresses or JMS URIs, respectively.

You can re-use alert destinations across alert configurations for services. See “Adding Alert 
Actions” on page 19-33.

Locating Alert Destinations
You can view a list of alert destinations in the Summary of Alert Destinations page. If you have 
not yet created an alert destination, and want to do so, create a new alert Destination resource 
from the Project Explorer. To learn how, see “Adding Alert Destinations” on page 5-2. 

1. Do either of the following:

– Select Project Explorer to display the Projects View page or the Project/Folder View 
page. Then navigate through projects and folders to find the alert destination.
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– Select Resource Browser > Alert Destinations. The Summary of Alert Destinations 
page displays the information shown in Table 5-1. 

2. To restrict the number of items in the list, you can filter by name, path, or both. In the Name 
and Path fields, enter the name and path of the search target(s), then click Search. 

The path is the project name and the name of the folder in which the alert destination 
resides. 

Click View All to remove the search filters and display all alert destinations.

Adding Alert Destinations
An alert destination is a destination address for alert notifications in Oracle Service Bus. You can 
create alert destination resources in the Create Alert Destination page. 

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, then select a project or folder in which to add the alert destination. 
The Project/Folder View page is displayed.

3. From the Create Resource drop-down list, select Alert Destination to display the Create 
Alert Destination page.

4. In the Resource Name field, enter a unique name for this alert destination. This is a required 
field.

5. In the Resource Description field, enter a description for the alert destination.

6. Select any or all of the following destinations to be included in this alert destination resource.

Table 5-1  Alert Destination Details 

Property Description

 Name The name of the alert destination resource. The name is a link to the View an Alert 
Destination - Configuration page. See “Editing Alert Destinations” on page 5-5.

Path The path is the project name and the name of the folder in which the alert 
destination resides. It is a link to the project or folder that contains this resource. 
See “Qualifying Resource Names Using Projects and Folders” on page 3-2.

Options Click the  Delete icon to delete a specific Alert Destination. See “Deleting 
Alert Destinations” on page 5-6.
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Note: By default, all alerts are sent to the Oracle Service Bus console at run time. These 
alerts can be viewed under Operations > Dashboard.

– SNMP Trap: If you specify SNMP Trap, alerts are sent as SNMP traps, and can be 
processed by any third-party enterprise monitoring systems (ESM). 

– Reporting: If you specify Reporting, alerts are sent to the Oracle Service Bus 
Reporting module and can be captured using a custom Reporting Provider that can 
developed using the Reporting APIs provider by Oracle Service Bus. This allows 
third-parties to receive and process alerts in custom Java code.

7. Add an e-mail recipient to the alert destination resource definition. See “Adding E-Mail 
Recipients” on page 5-3.

8. Add a JMS Destination to the alert destination resource definition. See “Adding JMS 
Destinations” on page 5-4.

9. Click Save. The new alert destination is saved in the current session.

10. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Adding E-Mail and JMS Recipients
You can add multiple e-mail and JMS recipients to an alert destination. 

This section includes the following tasks:

“Adding E-Mail Recipients” on page 5-3

“Adding JMS Destinations” on page 5-4

Adding E-Mail Recipients
Before you add an e-mail destination, you must configure an SMTP Server (see “Adding SMTP 
Servers” on page 28-6), or a JavaMail session in WebLogic Server (see Configure access to 
JavaMail in Administration Console Online Help). If there are no SMTP Server resources or 
JavaMail sessions available, configured, you cannot configure an e-mail recipient.

1. Select Send an alert via e-mail from the drop-down list and click Add to display the Add 
E-mail Recipient page.

2. In the Mail Recipients field, enter an e-mail recipient in the format: 
mailto:username@hostname
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This is a required field. 

You can specify multiple e-mail recipients by entering the user names and hostnames in a 
comma-separated list. For example, mailto:username@hostname 
[,username_1@hostname_1]...[,username_n@hostname_n]

Only the first mail recipient needs to be prefixed with the text “mailto:”.

3. In the SMTP Server field, select the name of the SMTP Server for the outgoing e-mail. This 
field is not required if a mail session is selected in the next step.

4. In the Mail Session field, select an available mail session. This field is not required if an 
SMTP Server is selected in the previous step.

5. In the From Name field, provide a sender’s name for the alert notification. This field is 
optional.

6. In the From Address field, provide a valid e-mail address. This field is required if a value for 
“From Name” field is specified.

7. In the Reply To Name field, provide a name to which a reply may be addressed. This field is 
optional.

8. In the Reply To Address field, provide an e-mail address to which a reply may be sent. This 
field is required if a value for “Reply To Name” field is specified.

9. In the Connection Timeout field, enter the number of seconds a connection must wait for a 
response from the server before timing out. The default value is 0.

10. In the Request Encoding field, enter a character set encoding value. The default encoding 
value is iso-8859-1.

11. Click Save. The e-mail recipient is added to the list of e-mail recipients for this alert 
destination and saved in the current session.

Adding JMS Destinations
1. Select Send an alert to a JMS Destination from the drop-down list and click Add to display 

the Add JMS Destination page. 

2. In the destination URI field, enter a JMS destination URI in the format: 
jms://host:port/factoryJndiName/destJndiName

This is a required field. 

3. In the Destination Type field, select Queue or Topic.
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4. In the Message Type field, select Bytes or Text.

5. In the Request Encoding field, enter a character set encoding value. The default encoding 
value is UTF-8.

6. Click Save. The JMS destination is added to the list of JMS destinations to be included for 
this alert destination and saved in the current session.

Editing Alert Destinations
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Locate the alert destination, as described in “Locating Alert Destinations” on page 5-1 or 
“Finding Alert Destinations” on page 24-10.

3. Click the alert destination name. The View Alert Destination - Configuration page displays 
the information shown in Table 5-2.

Table 5-2  Alert Destination Configuration Details 

Property Description

Last Modified By The user who created or edited this alert destination.

Last Modified On The date and time that the user created or edited this alert destination. Click the 
date and time link to view the change history of this resource. See “View Change 
History page” on page 3-21.

References The number of objects that this alert destination references. If such references 
exist, click the numeric link to view a list of the objects. See “Viewing References 
to Resources” on page 3-20.

Referenced by The number of objects that reference this alert destination. If such references exist, 
click the numeric link to view a list of the objects. See “Viewing References to 
Resources” on page 3-20.

Description A description of this alert destination, if one exists.
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4. You can change your selection of the SNMP Trap or Reporting setting.

5. To edit or delete an e-mail recipient or JMS destination, click Edit at the bottom of the page.

a. To edit the e-mail recipient, in E-mail click the  Edit icon under Options, for the 
e-mail recipient you want to edit. Use the Edit E-mail Recipient page to make changes 
to the e-mail recipient information. See “Adding E-Mail Recipients” on page 5-3. 

b. To edit the JMS destination, in JMS click the  Edit icon under Options, for the JMS 
destination you want to edit. Use the Edit JMS Destination page to make changes to the 
JMS destination information. See “Adding JMS Destinations” on page 5-4. 

c. To delete one or all e-mail recipients or JMS destinations, click the  Delete icon under 
Options, for the e-mail recipients or JMS destinations you want to delete.

6. Click Save to commit the updates in the current session. 

7. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Deleting Alert Destinations
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Resource Browser > Alert Destinations to display the Summary of Alert 
Destinations page.

General Configuration SNMP Trap: Yes or No, to indicate whether the SNMP Trap option was specified 
as a destination for this alert when it was configured.

Reporting: Yes or No, to indicate whether the Reporting option was specified as 
a destination for this alert when it was configured.

E-mail & JMS: Displays a list of e-mail recipients or JMS destinations, or both, 
if they were configured.

Table 5-2  Alert Destination Configuration Details (Continued)

Property Description
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3. Click the  Delete icon in the Options field of the alert destination you want to delete. The 

alert destination is deleted in the current session. A  Deletion Warning icon is displayed when 
other resources reference this resource. You can delete the resource with a warning confirmation. This 
might result in conflicts due to unresolved references to the deleted resource.

To delete particular e-mail recipients or JMS destinations configured within an alert 
destination, see “Editing Alert Destinations” on page 5-5.

4. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 
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WSDLs
A WSDL (Web Service Definition Language) is the formal description of a Web Service; in 
Oracle Service Bus, it describes a proxy service or a business service. A WSDL is used to 
describe what a Web Service can do, where it resides, and how to invoke it. 

You can base SOAP and XML services on an existing WSDL resource. A WSDL document is 
available for proxy and business services for any transport. See Create/Edit a Proxy Service - 
“General Configuration page” on page 17-3 and “Creating and Configuring Business Services” 
on page 16-1.

For more information, see How WSDL is Used in Oracle Service Bus in the Oracle Service Bus 
User Guide.

Locating WSDLs
1. Do either of the following:

– Select Project Explorer to display the Projects View page or the Project/Folder View 
page. Then navigate through projects and folders to find the WSDL.

– Select Resource Browser > WSDLs. The Summary of WSDLs page displays the 
information shown in Table 6-1. For a more detailed description of the properties, see 
“Editing WSDLs” on page 6-3.

2. To locate a specific WSDL:

– Click the  Open icon to display additional search filters. If you specify multiple 
search criteria, only results that match all the criteria will be returned.
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– To restrict the number of items in the list, you can filter by name, path, and namespace. 
In the Name, Path, and Namespace fields, enter the name, path, and namespace of the 
search target(s), then click Search. 

The path is the project name and the name of the folder in which the WSDL resides. 

– Click View All to remove the search filters and display all WSDLs.

Adding WSDLs
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, then select a project or folder in which to add the WSDL. The 
Project/Folder View page is displayed.

3. From the Create Resource drop-down list, select WSDL from under Interface to display the 
Create a New WSDL Resource page.

4. In the Resource Name field, enter a unique name for this WSDL. This is a required field.

5. In the Resource Description field, enter a description for the WSDL.

6. In the WSDL field, do one of the following:

– Enter text for the new WSDL.

– Click Browse to locate and import an existing WSDL.

Table 6-1  WSDL Details 

Property Description

WSDL Name The unique name assigned to the WSDL. The name is a link to the View WSDL 
Details page. See “Editing WSDLs” on page 6-3.

Path The path is the project name and the name of the folder in which the WSDL 
resides. It is a link to the project or folder that contains this resource. See 
“Qualifying Resource Names Using Projects and Folders” on page 3-2.

WSDL Namespace The address of the WSDL. It is displayed in the format:
http://example.com/example/example

Options Click the  Delete icon to delete a specific WSDL. See “Deleting WSDLs” 
on page 6-5.
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– Copy and paste text from an existing WSDL into this field.

This is a required field.

7. Click Save. The new WSDL is saved in the current session.

When you click Save, if there any unresolved references for the new WSDL, the system 
displays them. See “Viewing Unresolved WSDL References” on page 6-5.

8. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Editing WSDLs
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Locate the WSDL, as described in “Locating WSDLs” on page 6-1.

3. Click the WSDL name. The View WSDL Details page displays the information shown in 
Table 6-2, Table 6-3, and Table 6-4.

Table 6-2  WSDL Details 

Property Description

Last Modified By The user who created this WSDL or imported it into the configuration.

Last Modified On The date and time that the user created this WSDL or imported it into the 
configuration. Click the date and time link to view the change history of this 
resource. See “View Change History page” on page 3-21.

References The number of objects that this WSDL references. If such references exist, click 
the numeric link to view a list of the objects. See “Viewing References to 
Resources” on page 3-20.

Referenced by The number of objects that reference this WSDL. If such references exist, click 
the numeric link to view a list of the objects. For example, if you select this 
WSDLs port or binding as the service type for a specific business service or proxy 
service, the business service or proxy service is listed as a reference when you 
click the link. See “Viewing References to Resources” on page 3-20.

Description A description of this WSDL, if one exists.
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The structural view of the WSDL is displayed by default, which includes the information 
shown in Table 6-3.

4. Click Text view to display a text view of the WSDL details. The text view includes the 
information shown in Table 6-4.

Table 6-3  WSDL Structure Details 

Property Description

Target Namespace The namespace used to qualify any of the definitions included in the WSDL.

WSDL Definitions The attributes and groups associated with the WSDL:
• WSDL Port Types
• WSDL Bindings
• WSDL Ports
• XML Schema Types
• XML Schema Elements
• WSDL Imports
• XML Schema Imports
• WS-Policy References
• Implicit WS-Policy References

WSDL State The status of the WSDL:
• Valid

All of the locations for XML schemas or WSDLs included by the current 
WSDL are specified and are valid. Furthermore, all of the locations for nested 
XML schemas or WSDLs (XML schemas or WSDLs subsequently included 
by the included WSDLs or XML schemas) are specified and are valid.

• Invalid
One or more of the locations for XML schemas or WSDLs included by the 
current WSDL is not specified or is not valid. Additionally, the location for 
one or more of the nested XML schemas or WSDLs (XML schemas or 
WSDLs subsequently included by the included WSDLs or XML schemas) 
may not be specified or may not be valid.To resolve an invalid XML schema 
or WSDL, click Edit References. See “Resolving Unresolved WSDL 
References” on page 6-6.
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5. To make a change to the fields, click Edit. See “Adding WSDLs” on page 6-2 for descriptions 
of the fields.

6. Make the appropriate edits.

7. Click Save to commit the updates in the current session.

8. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Note: The View WSDL Details page may also include a Separate Callbacks button. This 
button is only displayed if the WSDL has port types with callback operations that can be 
rewritten. If you click this button, the WSDL is rewritten.

Deleting WSDLs
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Resource Browser > WSDLs. 

3. Click the  Delete icon in the Options field of the WSDL you want to delete. The WSDL 

is deleted in the current session. A  Deletion Warning icon is displayed when other resources 
reference this resource. You can delete the resource with a warning confirmation. This might result in 
conflicts due to unresolved references to the deleted resource.

4. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Viewing Unresolved WSDL References
The View Unresolved WSDL References page displays the information shown in Table 6-5. 

Table 6-4  WSDL Text Details 

Property Description

Target Namespace The namespace used to qualify any of the definitions included in the WSDL.

Text The text for this WSDL.
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To locate a specific reference:

Resort the list. Click on an underlined column name. Ascending and descending arrows 
indicate the sort order. Click the column name to change the sort order. 

Scroll through the pages. Use the page controls above or below the table. Go to a page by 
selecting the page number or by using the arrow buttons to go to the next, previous, first, 
or last page.

Resolving Unresolved WSDL References
Use the Edit the References of a WSDL Resource page to resolve unresolved WSDL references 
by configuring the mapping for WSDL references such as WSDL imports and XML schema 
imports. A WSDL may also have an unresolved reference to a WS-Policy.

Resolving an Unresolved WSDL or XML Schema Reference

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select Resource Browser > WSDLs. 

3. On the Summary of WSDLs page, in the WSDL Name column, click the appropriate WSDL 
name to view details of the unresolved reference. The View WSDL Details page is displayed.

4. Click Edit References to display the Edit the References of a WSDL Resource page.

5. In the Resource Type field, select WSDL or select XML Schema.

6. Click Browse. Depending on the resource type, the WSDL Browser or the XML Schema 
Browser is displayed.

Table 6-5  Unresolved WSDL Reference Details 

Property Description

WSDL Name The name assigned to the WSDL. Click the name of a specific WSDL to view 
details for that WSDL.

Namespace The address of the WSDL. It is displayed in the format:
http://example.com/example/example
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7. In the WSDL Browser or XML Schema Browser, select a WSDL or XML Schema, then 
select a definition from the Definitions pane.

8. Click Submit. The WSDL or XML Schema you selected is displayed in the Resource Name 
field.

9. Click Save to resolve the reference. 

10. On the View WSDL Details page, click OK. The state of the WSDL is displayed as Valid.

Resolving an Unresolved WS-Policy Reference

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select Resource Browser > WSDLs. 

3. On the Summary of WSDLs page, in the WSDL Name column, click the appropriate WSDL 
name to view details of the unresolved reference. The View WSDL Details page is displayed.

4. Click Edit References to display the Edit the References of a WSDL Resource page.

5. In the WS-Policy Name field, click Browse. The Policy Browser is displayed.

6. In the Policy Browser, select a WS-Policy.

7. Click Submit. The WS-Policy you selected is displayed in the WS-Policy Name field.

8. Click Save to resolve the reference. 

9. On the View WSDL Details page, click OK. The state of the WSDL is displayed as Valid.
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JARs
A JAR (Java ARchive) is a zipped file that contains a set of Java classes. It is used to store 
compiled Java classes and associated metadata that can constitute a program. A JAR acts like a 
callable program library for Java code elements (so that a single compilation link provides access 
to multiple elements, rather than requiring bindings for each element individually). To learn more 
about JARs, see http://java.sun.com/docs/books/tutorial/deployment/jar/

JAR resources in Oracle Service Bus are used in: 

Java callout actions

EJB-based business services

Tuxedo-based proxy and business services

Locating JARs
1. Do either of the following:

– Select Project Explorer to display the Projects View page or the Project/Folder View 
page. Then navigate through projects and folders to find the JAR.

– Select Resource Browser > JARs. The Summary of JARs page displays the 
information shown in Table 7-1. For a more detailed description of the properties, see 
“Editing JARs” on page 7-3.

2. To restrict the number of items in the list or locate a specific JAR, search for a JAR using name 
and path filters. In the Name and Path fields, enter the name and path of the search target(s), 
then click Search. 
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The path is the project name and the name of the folder in which the JAR resides.

This search supports wildcard characters. For example, you can enter “j*” in the Name 
field to get a list of JARs that start with “j”.

Click View All to remove the search filters and display all JARs.

Adding JARs
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, then select a project or folder in which to add the JAR. The 
Project/Folder View page is displayed.

3. From the Create Resource drop-down list, select JAR from under Utility to display the 
Create a New JAR Resource page.

4. In the Resource Name field, enter a unique name for this JAR. This is a required field.

5. In the Resource Description field, enter a description for the JAR.

6. In the JAR Source File field, do one of the following:

– Enter the path to the location of the JAR.

– Click Browse to locate and import an existing JAR.

Table 7-1  JAR Details

Property Description

JAR Name The unique name assigned to the JAR. The name is a link to the View a JAR 
Resource - JAR Configuration page. See “Editing JARs” on page 7-3.

Path The path is the project name and the name of the folder in which the JAR 
resides. It is a link to the project or folder that contains this resource. See 
“Qualifying Resource Names Using Projects and Folders” on page 3-2.

No. of Classes The number of classes the JAR contains. 

Size The size of the JAR in bytes.

Options Click the  Delete icon to delete a specific JAR. See “Deleting JARs” on 
page 7-6.
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This is a required field.

7. Click Save. The JAR resource is created and saved in the current session.

If the JAR loads without problems, the contents of the JAR will be available for viewing. 
To learn how to view JAR details, see “Editing JARs” on page 7-3.

8. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Editing JARs
Use the View a JAR Resource - Configuration page to update JAR files. Updating a JAR file 
essentially involves pointing the resource to a new version of the JAR, as you cannot edit a JAR 
using Oracle Service Bus.

1. If you have not already done so, click Create to create a new session, or click Edit to enter 
an existing session. See “Using the Change Center” on page 2-2.

2. Locate the JAR, as described in “Locating JARs” on page 7-1.

3. Click the JAR name. The View a JAR Resource - JAR Configuration page displays the 
information shown in Table 7-2.

Table 7-2  JAR Information 

Property Description

Last Modified By The user who imported this JAR into the configuration.

Last Modified On The date and time that the user imported this JAR into the configuration. Click 
the date and time link to view the change history of this resource. See “View 
Change History page” on page 3-21.

References The number of JARs that this JAR references. If such references exist, click the 
numeric link to view a list of the JARs. See “Viewing References to Resources” 
on page 3-20.

Referenced by The number of objects that reference this JAR. If such references exist, click the 
numeric link to view a list of the objects. See “Viewing References to 
Resources” on page 3-20.

Description A description of this JAR, if one exists.
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The JAR configuration is displayed by default, which includes the information shown in 
Table 7-3.

4. To make a change to the fields, click Update. 

The only field you can edit is Description. You cannot edit a JAR in Oracle Service Bus. 
To update the JAR, you must select a new JAR to use. To learn how, see “Adding JARs” 
on page 7-2.

5. Click Save to commit the updates in the current session.

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Note: If you change the JAR used by an EJB Business Service (point the JAR resource to a new 
version of the JAR), you need to redeploy the EJB. You will then have to edit any EJB 
service that uses this JAR, and reselect the JAR resource, save, and activate. That will 
repackage the EJB business service to use the new JAR. 

Java callout actions and Tuxedo-based services, however, will automatically pick up the 
new JAR.

Editing JAR Dependencies
In Oracle Service Bus, JAR resources can contain classes that depend on other classes in different 
JARs. Use the Edit JAR Dependencies page to add or remove referenced JAR resources.

1. If you have not already done so, click Create to create a new session, or click Edit to enter 
an existing session. See “Using the Change Center” on page 2-2.

2. Locate the JAR, as described in “Locating JARs” on page 7-1.

3. Click the JAR name. 

Table 7-3  JAR Configuration Details

Property Description

JAR Configuration The list of classes and interfaces in this JAR.

Click (+) beside the name of a Java class to display a list of methods 
included in the class. 
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On the View a JAR Resource - JAR Configuration page, a numeric indicator on the 
Dependencies tab displays the number of referenced JARs configured for this JAR 
resource, or a zero if there are none.

4. Select the Dependencies tab to display referenced JARs or to add them. 

The JAR dependencies page includes the information shown in Table 7-4.

5. To add or remove referenced JARs, click Edit. 

The Edit JAR dependencies page includes the information shown in Table 7-5.

6. Click Add JARS.

7. In the JARs Browser, locate or select referenced JAR resources and click Submit.

For example, if you are editing JAR A and adding JARs B and C, JAR A references 
(depends on) JAR B and JAR A references (depends on) JAR C.

Table 7-4  JAR Dependencies Information 

Property Description

Name The name of the referenced JAR. The name is a link to the View a JAR 
Resource - JAR Configuration page. See “Editing JARs” on 
page 7-3.

Path The path is the project name and the name of the folder in which the JAR 
resides.

Table 7-5  JAR Dependencies Details

Property Description

Manifest Class Path Class-Path entries in the JAR manifest file.

Name The name and path of the referenced JAR resource.

Options • Use the Up and Down arrows to change the referenced JARs 
order of precedence. 

• Click the  Delete icon to remove a referenced JAR.
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Use the arrows in the Options column to reorder the hierarchy of referenced JARs or the 
Delete icon to remove them.

8. Click Save to commit the updates in the current session.

9. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Deleting JARs
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Resource Browser > JARs. 

3. Click the  Delete icon in the Options field of the JAR you want to delete. The JAR is 

deleted in the current session. A  Deletion Warning icon is displayed when other resources 
reference this resource. You can delete the resource with a warning confirmation. This might result in 
conflicts due to unresolved references to the deleted resource.

4. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 
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MQ Connections
Note: See Product Support Information for the supported versions of WebSphere MQ on 
Oracle Service Bus. The WebSphere MQ client library is not bundled with the Oracle 
Service Bus installer. Get the WebSphere MQ client library from your WebSphere MQ 
installation.

MQ Connections are sharable resources that can be reused across multiple MQ proxy and 
business services. MQ proxy and business services must connect to an MQ queue manager before 
accessing an MQ queue. MQ Connection resources provide the connection parameters required 
for connecting to a MQ queue manager. 

Each MQ Connection resource has a connection pool. Every business or proxy service using a 
given MQ Connection resource to get a connection to a given queue manager uses the same 
connection pool that was created for that resource. Thus, multiple business services and proxy 
services using the same queue manager share a connection pool. 

To learn more about Oracle Service Bus MQ Connection resources and native MQ transports, see 
the MQ Transport User Guide.

To learn more about WebSphere MQ Fundamentals, see 
http://www.redbooks.ibm.com/redbooks/SG247128/wwhelp/wwhimpl/java/html/wwhelp.htm.

Locating MQ Connections
1. Do either of the following:

– Select Project Explorer to display the Projects View page or the Project/Folder View 
page. Then navigate through projects and folders to find the MQ Connection resource.
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– Select Resource Browser > MQ Connections. The Summary of MQ Connections 
page displays the information shown in Table 8-1. For a more detailed description of 
the properties, see “Editing MQ Connections” on page 8-5.

2. To restrict the number of items in the list, you can filter by name, path, or both. In the Name 
and Path fields, enter the name and path of the search target(s), then click Search. 

3. Click the  Open icon to display additional search filters. If you specify multiple search 
criteria, only results that match all the criteria will be returned.

– Filter by Queue Manager Name. Enter any string, including wildcard characters, then 
click Search.

– Filter by Queue Manager Channel Name. Enter any string, including wildcard 
characters, then click Search.

– Click View All to remove the search filters and display all MQ Connection resources.

Adding MQ Connections
Before you begin

See Product Support Information for the supported versions of WebSphere MQ on Oracle Service 
Bus. The WebSphere MQ client library is not bundled with the Oracle Service Bus installer. Get 
the WebSphere MQ client library from your WebSphere MQ installation.

To configure and use MQ Connection resources and the MQ transport in Oracle Service Bus, you 
must add the MQ client library to the classpath. One option is to copy the com.ibm.mq.jar library 

Table 8-1  MQ Connection Details 

Property Description

MQ Connection Name The name assigned to the MQ Connection resource. The name is a link to the 
MQ Connection Configuration page. See “Editing MQ Connections” on 
page 8-5.

Path The path is the project name and the name of the folder in which the MQ 
Connection resource resides. It is a link to the project or folder that contains 
this resource. See “Qualifying Resource Names Using Projects and Folders” 
on page 3-2.

Options Click the  Delete icon to delete a specific MQ Connection resource. See 
“Deleting MQ Connections” on page 8-6.
8-2 Using the Oracle Service Bus Console

http://download.oracle.com/docs/cd/E13159_01/osb/docs10gr3/interopmatrix/matrix.html


Adding  MQ Connect ions
to your DOMAIN_NAME/lib directory, where DOMAIN_NAME is the name of the directory in which 
you located the domain, typically BEA_HOME\user_projects\domains\DOMAIN_NAME.

To add a MQ Connection resource

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, then select a project or folder in which to add the MQ Connection 
resource. The Project/Folder View page is displayed.

3. From the Create Resource drop-down list, select MQ Connection from under Utility to 
display the Create a New MQ Connection Resource page.

Specify the connection parameters shown in Table 8-2. 

Table 8-2  MQ Connection Parameters 

Property To create or edit...

Resource Name Enter a unique name for this MQ Connection resource.

Note: Do not include spaces in the name.

Resource Description Enter a description for the MQ Connection resource.

Connection Type Select one of the following modes for connecting to the MQ queue 
manager:
• tcp mode—Use TCP/IP to connect to a queue manager that 

does not reside on the same machine as Oracle Service Bus.
• binding mode—Use the bindings mode to connect to a queue 

manager that is located on the same machine as Oracle Service 
Bus.

MQ Host Name For tcp mode connections only:

Enter the host name of the MQ queue manager.

MQ Port Number For tcp mode connections only:

Enter the port number of the MQ queue manager listener.

MQ Queue Manager Name Enter the name of the MQ queue manager to which to connect.
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Queue Manager CCSID For tcp mode connections only:

The coded character set identifier (CCSID) to be used when establishing a 
connection. The CCSID is used mainly for internationalization support.

To learn more, see WebSphere MQ Fundamentals at 
http://www.redbooks.ibm.com/redbooks/SG247128/wwhelp/wwhimpl/ja
va/html/wwhelp.htm.

MQ Queue Manager 
Channel Name

For tcp mode connections only:

Enter the queue manager server connection channel name.

SSL Required For tcp mode connections:

Select the check box to use SSL for sending messages. Only server-side 
SSL will be enabled when the 2-way SSL Required option is not selected.

Cipher Suite This option is available only when the SSL Required check box is 
selected.

Select the Cipher Suite algorithm to be used by SSL. 

The Cipher Suite algorithm is used to encrypt and decrypt message 
communications between the WebSphere MQ server and the WebSphere 
MQ client. Thus a Cipher Suite algorithm must be specified when using 
SSL to communicate with a WebSphere MQ server.

2-way SSL Required This option is available only when the SSL Required check box is 
selected.

Select the check box to enable both client-side and server-side SSL 
authentication. 

Reference to the Service 
Key Provider

If you selected 2-way SSL Required, you must provide a reference to the 
service key provider for obtaining the appropriate key store and trust store 
information.

Enter the path (project/folder) and name of a service key provider, 
or click Browse to select one from the Select Service Key Provider page.

Reference to the Static 
Service Account

For tcp mode connections only:

Required for user name and password authentication. Enter the path 
(project/folder) and name of a static service account, or click 
Browse to select service accounts from a browser. 

Table 8-2  MQ Connection Parameters (Continued)

Property To create or edit...
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4. Click Save. The MQ Connection resource is created and saved in the current session.

5. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Editing MQ Connections
This section describes how to edit existing MQ Connection resources.

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Locate the MQ Connection resource, as described in “Locating MQ Connections” on 
page 8-1.

3. Click the MQ Connection resource name. 

The View MQ Connection - Configuration page displays the information shown in 
Table 8-3.

WebSphere MQ Version Select the WebSphere MQ version:
• 5.3
• 6.0

MQ Connection Pool Size Enter the size of the MQ connection pool.

MQ Connection Timeout Enter the time interval in seconds after which unused connections 
are destroyed. The default is 1800 seconds.

MQ Connection Max Wait Enter the Max Wait in seconds for the amount of time to wait for a 
connection to become available. If a connection is not made within 
that time interval, Oracle Service Bus throws an exception. The 
default is 3 seconds.

Table 8-2  MQ Connection Parameters (Continued)

Property To create or edit...
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4. To make a change to the fields, click Edit. For descriptions of the fields, see “Adding MQ 
Connections” on page 8-2.

You cannot change the Resource Name field.

5. Click Save to commit the updates in the current session.

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Deleting MQ Connections
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Resource Browser > MQ Connections to display the Summary of MQ Connections 
page.

3. Click the  Delete icon in the Options field of the MQ Connection resource you want to 

delete. The MQ Connection resource is deleted in the current session. A  Deletion Warning 
icon is displayed when other resources reference this resource. You can delete the resource with a 

Table 8-3  MQ Connection Details 

Property Description

Last Modified By The user who created this MQ Connection resource or imported it into the 
configuration.

Last Modified On The date and time that the user created this MQ Connection resource or 
imported it into the configuration. Click the date and time link to view the 
change history of this resource. See “View Change History page” on page 3-21.

References The number of objects that this MQ Connection resource references. If such 
references exist, click the numeric link to view a list of the objects. See 
“Viewing References to Resources” on page 3-20.

Referenced by The number of objects that reference this MQ Connection resource. If such 
references exist, click the numeric link to view a list of the objects. See 
“Viewing References to Resources” on page 3-20.

Description A description of this MQ Connection resource, if one exists.
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warning confirmation. This might result in conflicts due to unresolved references to the deleted 
resource.

4. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 
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Split-Joins
Split-Joins let you send message invocations in parallel (in addition to sequentially) and to 
aggregate the responses. To learn more about Split-Joins, see Improving Service Performance 
with Split-Join in the Oracle Service Bus User Guide. See also, Working with Split-Join and the 
Split-Join User Interface Reference in Using the Oracle Service Bus Plug-in for Workshop for 
WebLogic.

You access Split-Joins through Flow transport-typed business services. For more information, 
see the “Flow Transport Configuration page” on page 16-18.

Locating Split-Joins
1. Do either of the following:

– Select Project Explorer to display the Projects View page or the Project/Folder View 
page. Then navigate through projects and folders to find the Split-Join.

– Select Resource Browser > Split-Joins. The Summary of Split-Joins page displays 
the information shown in Table 9-1. For a more detailed description of the properties, 
see “Editing Split-Joins” on page 9-3.

2. To restrict the number of items in the list, you can filter by name, path, or both. In the Name 
and Path fields, enter the name and path of the search target(s), then click Search. 

3. Click View All to remove the search filters and display all Split-Joins.
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Adding Split-Joins
Before you begin

Split-Joins require a .flow file which is created when you create a Split-Join using the Oracle 
Service Bus Plug-in for Workshop for WebLogic or when you import a Split-Join configuration 
JAR into the plug-in. The .flow file might have references to proxy services, business services, 
or to external WSDL resources. Resources on which the Split-Join depends must be present on 
the server before activating the Split-Join.

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, then select a project or folder in which to add the Split-Join. The 
Project/Folder View page is displayed.

3. From the Create Resource drop-down list, select Split-Join to display the Create a New 
Split-Join Resource page.

Specify the parameters shown in Table 9-2. 

Table 9-1  Split-Join Details 

Property Description

Split-Join Name The name assigned to the Split-Join. The name is a link to the Split-Join 
Configuration page. See “Editing Split-Joins” on page 9-3.

Path The path is the project name and the name of the folder in which the Split-Join 
resides. It is a link to the project or folder that contains this resource. See 
“Qualifying Resource Names Using Projects and Folders” on page 3-2.

Options Click the  Delete icon to delete a specific Split-Join. See “Deleting 
Split-Joins” on page 9-4.

Table 9-2  Split-Join Parameters 

Property To create or edit...

Resource Name Enter a unique name for this Split-Join.

Resource Description Enter a description for the Split-Join.
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4. Click Save. The Split-Join is created and saved in the current session.

Note: Resources on which the Split-Join depends must be present before activating the 
Split-Join.

5. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Editing Split-Joins
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Locate the Split-Join, as described in “Locating Split-Joins” on page 9-1.

3. Click the Split-Join name.

The View a Split-Join - Configuration page displays the information shown in Table 9-3.

Split-Join Click Browse to locate a .flow file on your system, typically located under 
BEA_HOME\user_projects\workspaces\your_workspace, 
where BEA_HOME represents the directory in which you installed Oracle 
Service Bus.

Dispatch Policy Select the instance of WebLogic Server Work Manager used to create 
threads (parallel branches) to execute the Split-Join. The default Work 
Manager is used if no other Work Manager exists.

Table 9-2  Split-Join Parameters (Continued)

Property To create or edit...

Table 9-3  Split-Join Details 

Property Description

Last Modified By The user who created this Split-Join or imported it into the configuration.

Last Modified On The date and time that the user created this Split-Join or imported it into the 
configuration. Click the date and time link to view the change history of this 
resource. See “View Change History page” on page 3-21.
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4. You can make the following operational settings to a Split-Join:

5. Click Update to commit the updates in the current session.

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Deleting Split-Joins
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Resource Browser > Split-Joins to display the Summary of Split-Joins page.

3. Click the  Delete icon in the Options field of the Split-Join you want to delete. The Split-Join 

is deleted in the current session. A  Deletion Warning icon is displayed when other resources 
reference this resource. You can delete the resource with a warning confirmation. This might result in 
conflicts due to unresolved references to the deleted resource.

4. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

References The number of objects that this Split-Join references. If such references exist, 
click the numeric link to view a list of the objects. See “Viewing References to 
Resources” on page 3-20.

Referenced by The number of objects that reference this Split-Join. If such references exist, 
click the numeric link to view a list of the objects. See “Viewing References to 
Resources” on page 3-20.

Description A description of this Split-Join, if one exists.

Table 9-3  Split-Join Details (Continued)

Property Description

Table 9-4  Split-Join Operational Settings

Property Description

Logs If you want to capture log information in a Split-Join, select Enable Logging 
and select the logging level you want to capture.

Execution Tracing If you want to enable run-time tracing, select Enabled.
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XQuery Transformations
XQuery transformation maps can describe XML-to-XML, XML to non-XML, and non-XML to 
XML mappings.

Locating XQuery Transformations
1. Do either of the following:

– Select Project Explorer to display the Projects View page or the Project/Folder View 
page. Then navigate through projects and folders to find the XQuery.

– Select Resource Browser > XQueries. The Summary of XQueries page displays the 
information shown in Table 10-1.

2. To restrict the number of items in the list, you can filter by name, path, or both. In the Name 
and Path fields, under Search, enter the name and/or path of the target(s), then click the 
Search button. 

The path is the project name and the name of the folder in which the XQuery resides.

Wildcard characters * and ? are allowed. Search is case-sensitive.

Click View All to display all XQueries in the domain. This clears the search parameters 
from the previous search.
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Adding XQuery Transformations
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer to display the Projects View page or Project/Folder View page.

3. Navigate to the project or a folder to which you want to add the XQuery transformation.

4. From the Create Resource list, select XQuery. The Create a New XQuery page is 
displayed.

5. In the Resource Name field, enter a unique name for this XQuery transformation. 

Table 10-1  XQuery Transformation Details 

Property Description

XQuery Name The name assigned to the XQuery transformation. Click the name to display 
the View XQuery Transformation Details page.

See “Editing XQuery Transformations” on page 10-3.

Path The path is the project name and the name of the folder in which the XQuery 
resides, for example, MyProject/MyFolder/MyResource.

Click the path of an XQuery to display the Project/Folder View page that 
contains it. 

Actions
Click the  Launch Test Console icon to invoke the Test Console, which 
you use to validate and test the design of your services and transformations. 
For XQuery transformations, you can use the Test Console whether you are 
inside or outside a session. To learn more, see “Testing Transformations” on 
page 30-17.

Options If you have not already done so, click Create to create a new session or click 
Edit to enter an existing session. See “Using the Change Center” on 
page 2-2.

Click the  Delete icon to delete the XQuery. A  Deletion Warning 
icon is displayed when other resources reference this resource. You can 
delete the resource with a warning confirmation. This might result in 
conflicts due to unresolved references to the deleted resource. For more 
information, see “Deleting an XQuery Transformation” on page 10-4.
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6. In the Resource Description field, enter a description for the XQuery transformation.

7. In the XQuery field, do one of the following:

– Enter text for the new XQuery transformation.

– Click Browse to locate and import an existing XQuery transformation.

– Copy and paste text from an existing XQuery transformation into this field.

8. Click Save to commit the updates in the current session. 

9. To end the session and deploy the configuration to the run time, select Activate under Change 
Center.

Editing XQuery Transformations
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Locate the XQuery transformation, as described in “Locating XQuery Transformations” on 
page 10-1.

3. Click the XQuery transformation name. The View XQuery Transformation Details page 
displays the information shown in Table 10-2.

Table 10-2  XQuery Transformation Resource Details 

Property Description

Last Modified By The user who created this XQuery transformation or imported it into the 
configuration.

Last Modified On The date and time that the user created this XQuery transformation or 
imported it into the configuration. Click the date and time link to view the 
change history of this resource. See “View Change History page” on 
page 3-21.

References The number of objects that this XQuery transformation references. If such 
references exist, click the numeric link to view a list of the objects. To learn 
more, see “Viewing References to Resources” on page 3-20.
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4. To make a change to the fields, click Edit. See “Adding XQuery Transformations” on 
page 10-2 for a description of the fields.

You cannot change the Resource Name field.

5. Click Save to commit the updates in the current session. 

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Deleting an XQuery Transformation
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Resource Browser > XQueries. The Summary of XQueries page is displayed.

3. Click the  Delete icon in the row of the XQuery transformation you want to delete. The 

XQuery transformation is deleted in the current session. A  Deletion Warning icon is 
displayed when other resources reference this resource. You can delete the resource with a warning 
confirmation. This might result in conflicts due to unresolved references to the deleted resource. 

4. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Referenced by The number of objects that reference this XQuery transformation. If such 
references exist, click the numeric link to view a list of the objects. For 
example, if you assigned this XQuery transformation to a variable in the 
Message Flow of a specific proxy service, the proxy service is listed as a 
reference when you click the link.To learn more, see “Viewing References 
to Resources” on page 3-20.

Description A description of this XQuery transformation, if one exists.

XQuery The full text of the XQuery transformation.

XQuery Variables The XQuery variables selected for this XQuery transformation.

Table 10-2  XQuery Transformation Resource Details (Continued)

Property Description
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Custom WS-Policies
Web Services Policy Framework (WS-Policy) is an extensible XML-based framework that 
extends the configuration of a Web Service with domain specific security assertions and specifies 
the security requirements, expectations, and capabilities of the Web Service. In Oracle Service 
Bus, one of the primary uses of WS-Policy is configuring message-level security in proxy 
services and business services. 

Using Oracle Service Bus WS-Policies
Oracle Service Bus includes three simple WS-Policy files that you can use to require clients to 
authorize, digitally encrypt, or digitally sign SOAP messages: Auth.xml, Encrypt.xml, and 
Sign.xml. Oracle recommends that unless you have specific security needs, you use these 
pre-packaged files as often as possible.

For more information about using these policies, see Oracle Service Bus Policy Statements in 
Oracle Service Bus Security Guide.

Using Custom WS-Policies
If the Oracle Service Bus WS-Policy statements do not meet your security needs, you can write 
your own WS-Policies (custom WS-Policies), import them to Oracle Service Bus, and refer to 
them from the WSDL. (The Oracle Service Bus WS-Policy statements are read-only.)

For information about creating and referring to custom WS-Policies, see Using Web Service 
Policy to Specify Inbound Message-Level Security in Oracle Service Bus Security Guide.
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Locating Custom WS-Policies
The Summary of WS-Policies page lists the custom Web Service Policies (WS-Policies) that 
you have added to the current Oracle Service Bus domain. The Oracle Service Bus Console does 
not display the Oracle Service Bus WS-Policies, which are pre-packaged and available to all 
Oracle Service Bus domains. 

1. Do either of the following:

– Select Project Explorer to display the Projects View page or the Project/Folder View 
page. Then navigate through projects and folders to find the WS-Policy.

– Select Resource Browser > WS-Policies. The Summary of WS-Policies page 
displays the information shown in Table 11-1. For a more detailed description of the 
properties, see “Locating Custom WS-Policies” on page 11-2.

2. To search for a custom WS-Policy, enter part or all of the WS-Policy name in the Name field. 
You can also enter part or all of the WS-Policy project name and folder in the Path fields. 
Click Search. 

Click View All to remove the search filters and display all WS-Policies.

Adding Custom WS-Policies
You can either import an XML file that contains your WS-Policy or write the WS-Policy directly 
in the Oracle Service Bus Console.

Table 11-1  WS-Policy Information 

Property Description

WS-Policy Name The unique name assigned to the WS-Policy. Click the name to see the View 
WS-Policy Details page. See Editing Custom WS-Policies.

Path The project name and the name of the folder in which the WS-Policy resides. 
Click on the name to see the project or folder that contains this resource. See 
“Qualifying Resource Names Using Projects and Folders” on page 3-2.

Options Contains a  Delete icon. If a business service or proxy service has been 

configured to use a WS-Policy, a  Deletion Warning icon indicates that you 
can delete the WS-Policy with a warning confirmation. This might result in 
conflicts due to unresolved references from the service to the deleted 
WS-Policy. See Deleting Custom WS-Policies
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1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, then select a project or folder in which to add the WS-Policy. The 
Project/Folder View page is displayed.

3. From the Create Resource drop-down list, select WS-Policy from under Interface to display 
the Create a New WS-Policy page.

4. In the Resource Name field, enter a unique name for this WS-Policy. 

5. In the Resource Description field, enter a description of this WS-Policy.

6. In the Policy field, do one of the following:

– Click Browse to locate and import an XML file that contains your custom WS-Policy.

– Enter text for the new WS-Policy.

– Copy and paste text from an existing WS-Policy into this field.

7. Click Save. The WS-Policy is saved in the current session.

8. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Editing Custom WS-Policies
Use the View WS-Policy Details page to view and change details of a specific custom Web 
Service Policy (WS-Policy). The Oracle Service Bus Console does not display the Oracle Service 
Bus WS-Policies, which are read-only. 

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Locate the WS-Policy, as described in “Locating Custom WS-Policies” on page 11-2.

3. Click the WS-Policy name. The View WS-Policy Details page displays the information 
shown in Table 11-2.
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4. To make a change to the fields, click Edit. See “Adding Custom WS-Policies” on page 11-2 
for descriptions of the fields.

You cannot change the Resource Name field.

5. Click Save to commit the updates in the current session.

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Deleting Custom WS-Policies
If any business service or proxy service is configured to use the WS-Policy, remove the 
WS-Policy from the business service or proxy service. 

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select Resource Browser > WS-Policies. 

3. Click the  Delete icon in the Options field of the WS-Policy you want to delete. 

Table 11-2  WS-Policy Details 

Property Description

Last Modified By The user who created this WS-Policy or imported it into the configuration.

Last Modified On The date and time that the user created this WS-Policy or imported it into the 
configuration. Click the date and time link to view the change history of this 
resource. See “View Change History page” on page 3-21.

References The number of objects that this WS-Policy references. If such references 
exist, click the numeric link to view a list of the objects. See “Viewing 
References to Resources” on page 3-20.

Referenced by The number of objects that reference this WS-Policy. If such references exist, 
click the numeric link to view a list of the objects. See “Viewing References 
to Resources” on page 3-20.

Description A description of this WS-Policy, if one exists.

Policy The text for this WS-Policy.
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The WS-Policy is deleted in the current session. If a business service or proxy service has been 

configured to use a WS-Policy, a  Deletion Warning icon indicates that you can delete the 
WS-Policy with a warning confirmation. This might result in conflicts due to unresolved references 
from the service to the deleted WS-Policy.

4. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 
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XSL Transformations
Transformation maps describe the mapping between two data types. eXtensible Stylesheet 
Language Transformation (XSLT) maps describe XML-to-XML mappings.

Locating XSL Transformations
1. Do either of the following:

– Select Project Explorer to display the Projects View page or the Project/Folder View 
page. Then navigate through projects and folders to find the XSL transformation.

– Select Resource Browser > XSLTs. The Summary of XSLTs page displays the 
information shown in Table 12-1.

2. To restrict the number of items in the list, you can filter by name, path, or both. In the Name 
and Path fields, under Search, enter the name and/or path of the target(s), then click the 
Search button. 

The path is the project name and the name of the folder in which the XSLT resides.

Wildcard characters * and ? are allowed. Search is case-sensitive.

Click View All to display all XSLTs in the domain. This clears the search parameters from 
the previous search.
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Adding an XSL Transformation
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer to display the Projects View page or Project/Folder View page.

3. Navigate to the project or a folder to which you want to add the XSL transformation.

4. From the Create Resource list, select XSLT to display the Create a New XSLT page.

5. In the Resource Name field, enter a unique name for this XSL transformation. 

Table 12-1  XSL Transformation Details 

Property Description

XSLT Name The name assigned to the XSL transformation. Click the name to display the 
View XSL Transformation Details page.

See “Editing XSL Transformations” on page 12-3.

Path The path is the project name and the name of the folder in which the XSL 
transformation resides, for example, 
MyProject/MyFolder/MyResource.

Click the path of an XSLT to display the Project/Folder View page that 
contains it. 

Actions
Click the  Launch Test Console icon to invoke the Test Console, which 
you use to validate and test the design of your services and transformations. 
For XSL transformations, you can use the Test Console whether you are 
inside or outside a session. To learn more, see “Testing Transformations” on 
page 30-17.

Options If you have not already done so, click Create to create a new session or click 
Edit to enter an existing session. See “Using the Change Center” on 
page 2-2.

Click the  Delete icon to delete the XSLT. A  Deletion Warning icon 
is displayed when other resources reference this resource. You can delete the 
resource with a warning confirmation. This might result in conflicts due to 
unresolved references to the deleted resource. For more information, see 
“Deleting an XSL Transformation” on page 12-5.
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6. In the Resource Description field, enter a description for the XSL transformation.

7. In the XSLT field, do one of the following:

– Enter text for the new XSL transformation.

– Click Browse to locate and import an existing XSL transformation.

– Copy and paste text from an existing XSL transformation into this field.

8. Click Save to commit the updates in the current session. 

9. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Editing XSL Transformations
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Locate the XSL transformation, as described in “Locating XSL Transformations” on 
page 12-1.

3. Click the XSL transformation name. The View XSL Transformation Details page displays 
the structural view of the XSLT by default, which includes the information shown in 
Table 12-2.

Table 12-2  XSL Transformation Resource Details 

Property Description

Last Modified By The user who created this XSL transformation or imported it into the 
configuration.

Last Modified On The date and time that the user created this XSL transformation or imported it 
into the configuration. Click the date and time link to view the change history 
of this resource. See “View Change History page” on page 3-21.

References The number of objects that this XSL transformation references. If such 
references exist, click the numeric link to view a list of the objects. To learn 
more, see “Viewing References to Resources” on page 3-20.
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4. Click Text view to display a text view of the XSL transformation details. The text view includes 
the information shown in Table 12-3.

Referenced by The number of objects that reference this XSL transformation. If such 
references exist, click the numeric link to view a list of the objects. For 
example, if you assigned this XSL transformation to a variable in the Message 
Flow of a specific proxy service, the proxy service is listed as a reference 
when you click the link. To learn more, see “Viewing References to 
Resources” on page 3-20.

Description A description of this XSL transformation.

Target Namespace The namespace used to qualify any of the definitions included in the XSL 
transformation.

XSLT Dependencies The attributes and groups associated with the XSLT:
• The XSLT location

State The status of the XSL transformation:
• Valid

All of the XSL transformation locations included by the current XSL 
transformation are specified and are valid. Furthermore, all of the 
locations for nested XSL transformations (XSL transformations 
subsequently included by the included XSL transformations) are specified 
and are valid.

• Invalid
One or more of the locations for XSL transformations included by the 
current XSL transformation is not specified or is not valid. Additionally, 
one or more of the nested XSL transformations (XSL transformations 
subsequently included by the included XSL transformations) may not be 
specified or may not be valid.To resolve an invalid XSL transformation, 
click Edit References.To learn more, see “Resolving Unresolved XSL 
Transformation References” on page 12-5.

Table 12-2  XSL Transformation Resource Details (Continued)

Property Description
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5. To make a change to the fields, click Edit. See “Adding an XSL Transformation” on 
page 12-2 for a description of the fields.

You cannot change the Resource Name field.

6. Click Save to commit the updates in the current session. 

Deleting an XSL Transformation
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Resource Browser > XSLTs to display the Summary of XSLTs page.

3. Click the  Delete icon in the row of the XSL transformation you want to delete. The XSL 

transformation is deleted in the current session. A  Deletion Warning icon is displayed when 
other resources reference this resource. You can delete the resource with a warning confirmation. This 
might result in conflicts due to unresolved references to the deleted resource. 

4. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Resolving Unresolved XSL Transformation References
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Resource Browser > XSLTs to display the Summary of XSLTs page.

3. In the XSLT Name column, click the appropriate XSLT name to view details of the 
unresolved reference. The View XSL Transformation Details page is displayed.

Table 12-3  XSL Transformation Text Details 

Property Description

Target Namespace The namespace used to qualify any of the dependencies included in the XSL 
transformation.

XSLT The full text of the XSL transformation.
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4. Click Edit References to display the Edit the References of an XSL Transformation 
Resource page.

5. In the Resource Type field, select XSLT.

6. Click Browse. The XSLT Browser is displayed.

7. In the XSLT Browser, select an XSLT, then select a dependency from the Dependencies 
pane.

8. Click Submit. The XSLT you selected is displayed in the Resource Name field.

9. Click Save. The View XSLT Details page is displayed.

10. Click OK. The state of the XSL transformation is displayed as Valid.

11. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 
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MFLs
A Message Format Language (MFL) document is a specialized XML document used to describe 
the layout of binary data. It is an Oracle proprietary language used to define rules to transform 
formatted binary data into XML data. An MFL document conforms to the mfl.dtd, which 
includes elements and attributes used to describe each field of data, as well as groupings of fields 
(groups), repetition, and aggregation.

When you create a business services or proxy services of Messaging Service type, you can select 
MFL types as the request message type or the response message type of the service.

You use Oracle Format Builder to create MFLs. When you define the hierarchy of a binary 
record, the layout of fields, and the grouping of fields and groups, the information is saved as an 
MFL document that can then be used to perform run-time translations. An MFL document can 
also be used in Format Builder to generate the corresponding DTD that describes its content 
model. To learn how to use the Format Builder, see the Format Builder Online Help. 

Locating MFLs
1. Do either of the following:

– Select Project Explorer to display the Projects View page or the Project/Folder View 
page. Then navigate through projects and folders to find the MFL.

– Select Resource Browser > MFLs. The Summary of MFL Files page displays the 
information shown in Table 13-1. For a more detailed description of the properties, see 
“Editing MFLs” on page 13-3.
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2. To restrict the number of items in the list, you can filter by name, path, or both. In the Name 
and Path fields, enter the name and path of the search target(s), then click Search. 

The path is the project name and the name of the folder in which the MFL file resides. 

Click View All to remove the search filters and display all MFL files.

Adding MFLs
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, then select a project or folder in which to add the MFL file. The 
Project/Folder View page is displayed.

3. From the Create Resource drop-down list, select MFL File from under Transformation to 
display the Create a New MFL File Resource page.

4. In the Resource Name field, enter a unique name for this MFL. This is a required field.

5. In the Resource Description field, enter a description for the MFL.

6. In the MFL Text field, do one of the following:

– Enter text for the new MFL.

Table 13-1  MFL Details 

Property Description

MFL File Name The unique name assigned to the MFL. The name is a link to the View MFL 
Resource Details page. See “Editing MFLs” on page 13-3.

Path The path is the project name and the name of the folder in which the MFL file 
resides. It is a link to the project or folder that contains this resource. See 
“Qualifying Resource Names Using Projects and Folders” on page 3-2.

Actions Click the  Launch Test Console icon to invoke the Test Console, which 
you use to validate and test the design of your services and transformations. 
For MFLs, you can use the Test Console whether you are inside or outside a 
session. See “Testing Transformations” on page 30-17.

Options Click the  Delete icon to delete a specific MFL. See “Deleting MFLs” on 
page 13-4.
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– Click Browse to locate and import an existing MFL.

– Copy and paste text from an existing MFL into this field.

This is a required field.

7. Click Save. The MFL file resource is created and saved in the current session.

8. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Editing MFLs
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Locate the MFL file, as described in “Locating MFLs” on page 13-1.

3. Click the MFL file name. The View MFL Resource Details page displays the information 
shown in Table 13-2.

Table 13-2  MFL Resource Details 

Property Description

Last Modified By The user who created this MFL file or imported it into the configuration.

Last Modified On The date and time that the user created this MFL file or imported it into the 
configuration. Click the date and time link to view the change history of this 
resource. See “View Change History page” on page 3-21.

References The number of objects that this MFL file references. If such references exist, 
click the numeric link to view a list of the objects. See “Viewing References to 
Resources” on page 3-20.

Referenced by The number of objects that reference this MFL file. If such references exist, 
click the numeric link to view a list of the objects. For example, if you selected 
this MFL file as the request or response message type for a messaging business 
service or proxy service, the business service or proxy service is listed as a 
reference when you click the link.See “Viewing References to Resources” on 
page 3-20.

Description A description of this MFL file, if one exists.

MFL Text The text for this MFL.
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4. To make a change to the fields, click Edit. For descriptions of the fields, see “Adding MFLs” 
on page 13-2.

You cannot change the Resource Name field.

5. Click Save to commit the updates in the current session.

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Deleting MFLs
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Resource Browser > MFLs to display the Summary of MFL Files page.

3. Click the  Delete icon in the Options field of the MFL you want to delete. The MFL file 

is deleted in the current session. A  Deletion Warning icon is displayed when other resources 
reference this resource. You can delete the resource with a warning confirmation. This might result in 
conflicts due to unresolved references to the deleted resource.

4. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 
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Service Accounts
A service account provides a user name and password that proxy services and business services 
use for outbound authentication or authentication to a local or remote resource, such as an FTP 
server or a JMS server. For example, if a business service is required to supply a user name and 
password for transport-level authentication with a Web Service, you create a service account that 
specifies the user name and password, then you configure the business service to include the 
service-account credentials in its outbound requests.

The user names and passwords that you enter in service accounts are used for outbound 
authentication or for providing credentials to local or remote resources. The user names and 
passwords that you enter in the Security Configuration module of the Oracle Service Bus Console 
are used for inbound authentication and for authenticating administrative requests. See 
“Specifying Service Accounts” on page 14-1.

Specifying Service Accounts
You can use the same service account for multiple business services and proxy services. To 
specify the user name and password that a service account provides, you can use any of the 
following techniques:

Static

Requires you to save a user name and password with the service account configuration. 
The service account encodes this user name and password in the outbound request.

User name and password pass-through
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Causes the service account to provide the user name and password that it receives from an 
incoming client request. For example, if an inbound HTTP BASIC request contains “pat” 
and “patspassword” as the user name and password, the service account encodes “pat” and 
“patspassword” in the outbound request. 

Because this technique requires that client requests include clear-text user names and 
passwords, it is applicable only for client requests that use either the HTTP BASIC 
protocol, a Web Services Security Username Token authentication with a clear-text 
password, or a custom user name and password token.

Oracle recommends that you use this technique only when Oracle Service Bus and the 
endpoint belong to the same authentication domain. For example, use this technique when 
you are routing messages within a single organization and both Oracle Service Bus and the 
message consumer authenticate against a common LDAP server.

The following restrictions apply to this technique:

– It cannot be used in outbound requests that authenticate Oracle Service Bus to a local 
or remote server or system resource, such as an FTP server or a JMS server.

– It cannot be used with the fn-bea:lookupBasicCredentials XQuery function. For 
more information, see XQuery Implementation in Oracle Service Bus User Guide.

Note: If your proxy is an active WSS intermediary, you can use WS-Security to encrypt a 
WS-Security Username Token or custom user name/password. In this instance, user 
name/password pass-through works because the proxy will first decrypt the request 
and will then have access to the clear-text user name/password.

User mapping

Requires you to correlate (map) the user name that is the result of authenticating an 
inbound request from a client (the local user name) to a user name and password that you 
specify (the remote user name and password). When the service account receives a request 
from an authenticated client that has been mapped, it provides the appropriate remote user 
name and password for the business service or proxy service outbound request.

If the client authenticates at both transport level and message level, the service account 
maps the message level user name to the remote user name and password. 

You can also map an anonymous user name to a remote user name and password.

The following restrictions apply to this technique:

– It cannot be used in outbound requests that authenticate Oracle Service Bus to a local 
or remote server or system resource, such as an FTP server or a JMS server.
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– It cannot be used with the fn-bea:lookupBasicCredentials XQuery function. For 
more information, see XQuery Implementation in Oracle Service Bus User Guide.

Related Topics
“Creating and Configuring Business Services” on page 16-1

Create/Edit a Proxy Service - “E-Mail Transport Configuration page” on page 17-12

Using Service Accounts Data and Sessions
Service accounts and their data participate fully in Oracle Service Bus sessions: you must be in a 
session to create or modify a service account, and if you discard the session, the service account 
and its data is also discarded. When you activate a session, Oracle Service Bus saves the user 
name, password, and other service account data in the user name/password credential mapping 
provider that is configured for the domain.

Locating Service Accounts
1. Do either of the following:

– Select Project Explorer to display the Projects View page or the Project/Folder View 
page. Then navigate through projects and folders to find the service account.

– Select Resource Browser > Service Accounts. The Summary of Service Accounts 
displays the information shown in Table 14-1.

2. To search for a service account, enter part or all of the account name in the Name field. You 
can also enter part or all of the account project name and folder in the Path fields. Click 
Search. 

Click View All to remove the search filters and display all service accounts.
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Adding Service Accounts
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, then select a project or folder in which to add the service account. 
The Project/Folder View page is displayed.

3. From the Create Resource drop-down list, select Service Account to display the Create a 
New Service Account page.

4. In the Resource Name field, enter a unique name for this service account.

5. In the Resource Description field, enter a description for the service account.

6. Under Resource Type, do one of the following:

– To create a service account that provides the user names and passwords that it receives 
from incoming client requests, select Pass Through.

– To create a service account that provides a user name and password that you save with 
the service account configuration, select Static.

Table 14-1  Service Account Information 

Property Description

Service Account Name A unique name for the service account. Click on the name to see the View 
Service Account Details page. See “Editing Service Accounts” on 
page 14-8.

Path The project name and the name of the folder in which the service account 
resides. Click on the name to see the project or folder that contains this 
resource. See “Qualifying Resource Names Using Projects and Folders” on 
page 3-2.

Options Contains a  Delete icon. If a business service or proxy service has been 

configured to use a service account, a  Deletion Warning icon indicates 
that you can delete the service account with a warning confirmation. This 
might result in conflicts due to unresolved references from the service to 
the deleted service account. See “Deleting Service Accounts” on 
page 14-9.
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– To create a service account that maps the user name from one or more authenticated 
clients to user names and passwords that you specify, select Mapping. 

7. Depending on the resource type you selected in step 6, do one of the following steps described 
in Table 14-2.

Table 14-2  Resource Type Options 

Selected Resource Type Complete These Steps

Pass Through Click Last.
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Static 1. Click Next.
2. Enter the user name and password in the User Name field, Password, and 

Confirm Password fields.
3. Click Last.

Table 14-2  Resource Type Options (Continued)

Selected Resource Type Complete These Steps
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Mapping To create a service account that maps the user name from one or more clients to 
user names and passwords that you specify, do the following:
1. Click Next. 
2. In the Enter Authorized Remote User table, do the following:

a. In the Remote User Name, Password, and Confirm Password 
fields, enter the user name and password that you want to send in 
outbound requests.

b. Click Add.

The user mapping is added to the Remote Users table.

c. (Optional) Add additional remote users in the Enter Authorized Remote 
User table.

3. Click Next.
4. To map authorized clients to remote user names and passwords, do the 

following in the Enter Authorized Local User table:

a. In the Local User Name field, enter the name that identifies a 
client that has been authenticated on its inbound request. 

If you have not already added this user in the Security 
Configuration module of the Oracle Service Bus Console, do so 
before you use this mapping in a runtime environment. See 
Adding Users. Oracle Service Bus lets you create a mapping for 
a non-existent local user, but the mapping will never match an 
authenticated user and will never be used.

b. From the Remote User Name list, select the user name that you 
want to send in outbound requests for the authenticated user you 
specified in the Local User Name field.

c. Click Add.
5. To map anonymous clients to remote user names, do the following:

a. Select the Map Anonymous Requests check box. 

b. From the Select Remote User list, select the user name that you 
want to send in outbound requests for all anonymous users.

6. Click Last.

Table 14-2  Resource Type Options (Continued)

Selected Resource Type Complete These Steps
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8. Click Save. The service account is created and saved in the current session.

9. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Editing Service Accounts
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Locate the service account, as described in “Locating Service Accounts” on page 14-3.

3. Click the service account name. The View Service Account Details page displays the 
information shown in Table 14-3.

4. To make a change to the fields, click Edit. See “Adding Service Accounts” on page 14-4 for 
descriptions of the fields.

You cannot change the Resource Name field.

5. Click Save to commit the updates in the current session.

Table 14-3  Service Account Details  

Property Description

Last Modified By The user who created this service account or imported it into the configuration.

Last Modified On The date and time that the user created this service account or imported it into the 
configuration. Click the date and time link to view the change history of this 
resource. See “View Change History page” on page 3-21.

References The number of objects that this service account references. If such references 
exist, click the numeric link to view a list of the objects. See “Viewing References 
to Resources” on page 3-20.

Referenced by The number of objects that reference this service account. If such references exist, 
click the numeric link to view a list of the objects. For example, if you selected 
this service account as the JMS service account in a proxy service with a JMS 
transport protocol, the proxy service is listed as a reference when you click the 
link. See “Viewing References to Resources” on page 3-20.

Description A description of this service account, if one exists.
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6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Note: If the service account that you modified is used to authenticate with a WebLogic JMS 
server, the JMS server might not recognize your modification for up to 60 seconds. By 
default, WebLogic Server JMS checks permissions for each destination every 60 
seconds. To change this behavior, modify the WebLogic Server startup command so that 
it sets the following system property to the frequency (in seconds) that you want 
WebLogic Server JMS to check permissions: 
weblogic.jms.securityCheckInterval  
A value of 0 (zero) for this property ensures that a permissions check is performed for 
every send, receive, and getEnumeration action on a JMS resource.

Related Topics
See Ensuring the Security of Your Production Environment in Securing a Production 
Environment, which is available at the following URL: 
http://download.oracle.com/docs/cd/E12840_01/wls/docs103/lockdown/practices.html

Deleting Service Accounts
When you delete a service account, the user name, password, or local-user to remote-user 
mapping data that the service account contains is also deleted.

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. If any business service or proxy service is configured to use the service account, remove the 
service account from the business service or proxy service. 

See “Editing Business Service Configurations” on page 16-46 or “Editing Proxy Service 
Configurations” on page 17-47.

3. Select Resource Browser > Service Accounts to display the Summary of Service Accounts 
page.

4. Click the  Delete icon in the Options field of the service account you want to delete. 

The service account is deleted in the current session. If a business service or proxy service has 

been configured to use a service account, a  Deletion Warning icon indicates that you can delete 
the service account with a warning confirmation. This might result in conflicts due to unresolved 
references from the service to the deleted service account.
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5. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 
14-10 Using the Oracle Service Bus Console



C H A P T E R 15
Service Key Providers
A service key provider contains Public Key Infrastructure (PKI) credentials that proxy services 
use for decrypting inbound SOAP messages and for outbound authentication and digital 
signatures. A PKI credential is a private key paired with a certificate that can be used for digital 
signatures and encryption (for Web Service Security) and for outbound SSL authentication. The 
certificate contains the public key that corresponds to the private key.

Note: To use a service key provider, you must configure a PKI credential mapping provider. 
See “Configuring the WebLogic Security Framework: Main Steps” under Understanding 
Oracle Service Bus Security in Oracle Service Bus Security Guide.

A single service key provider can contain all of the following PKI credentials:

A key-pair for digital encryption

Proxy services use this key-pair to decrypt inbound SOAP messages that have been 
encrypted to conform with a Web Services Policy statement. If you want the service key 
provider to support digital encryption, the key store that is associated with the PKI 
credential mapper must contain at least one X.509 certificate that supports encryption. 

A key-pair for digital signatures

Proxy services use this key-pair when its endpoint is a Web Service and the Web Service 
requires clients to sign one or more parts of a SOAP envelope. 

A key-pair for SSL client authentication (two-way SSL)

Proxy services use this key-pair to authenticate when acting as a client during an outbound 
TLS/SSL (Secure Sockets Layer) connection; that is, when routing a message to an HTTPS 
business service or proxy service that requires client-certificate authentication.
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You can use the same service key provider for multiple proxy services.

Locating Service Key Providers
1. Do either of the following:

– Select Project Explorer to display the Projects View page or the Project/Folder View 
page. Then navigate through projects and folders to find the service key provider.

– Select Resource Browser > Service Key Providers. The Summary of Service Key 
Providers displays the information shown in Table 15-1.

2. To search for a service key provider, enter part or all of the provider name in the Name field. 
You can also enter part or all of the provider project name and folder in the Path fields. Click 
Search. 

Click View All to remove the search filters and display all service key providers.

Adding Service Key Providers
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, then select a project or folder in which to add the service key 
provider. The Project/Folder View page is displayed.

3. From the Create Resource drop-down list, select Service Key Provider to display the 
Create a New Service Key Provider page.

4. In the Service Key Provider Name field, enter a unique name for this service key provider. 

Table 15-1  Service Key Provider Information 

Property Description

Name A unique name for the service key provider. Click on the name to see the 
View Service Key Provider Details page. See “Editing Service Key 
Providers” on page 15-4.

Path The project name and the name of the folder in which the service key 
provider resides. Click on the name to see the project or folder that contains 
this resource. See “Qualifying Resource Names Using Projects and 
Folders” on page 3-2.
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5. In the Description field, enter a description for the service key provider.

6. Do any of the following steps, shown in Table 15-2.

Table 15-2  Authentication Options 

To Add a Key-Pair for... Complete These Steps...

Digital encryption 1. Next to Encryption Key, click Browse.
The Select an alias for Encryption Key window displays the key 
aliases from the key store that your realm’s PKI credential mapper is 
using.

2. In the Select an alias for Encryption Key window, enter the password 
that you use to secure access to the key store. (You set the password 
when you create the keystore.)

3. Select a key alias that maps to an X.509 certificate and that supports 
encryption.

4. Click Submit.

When you associate this service key provider with a proxy service, Oracle 
Service Bus embeds the X.509 certificate into the proxy service’s WSDL. 
The proxy service then uses this certificate to encrypt the messages that it 
sends to its endpoint. The proxy service uses the private key in the PKI 
credential to decrypt the messages that the endpoint returns.
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7. Click Save. The service key provider is saved in the current session.

8. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Editing Service Key Providers
Use the View Service Key Provider Details page to view and change details of a specific service 
key provider. 

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Locate the service key provider, as described in “Locating Service Key Providers” on 
page 15-2.

Digital signatures 1. Next to Digital Signature Key, click Browse.
The Select an alias for Digital Signature Key window displays the 
key aliases from the key store that your realm’s PKI credential mapper 
is using.

2. In the Select an alias for Digital Signature Key window, enter the 
password that you use to secure access to the key store. (You set the 
password when you create the keystore.)

3. Select a key alias.
4. Click Submit.

SSL client authentication 
(two-way SSL)

1. Next to SSL Client Authentication Key, click Browse.
The Select an alias for SSL Client Authentication Key window 
displays the key aliases from the key store that your realm’s PKI 
credential mapper is using.

2. In the Select an alias for SSL Client Authentication Key window, 
enter the password that you use to secure access to the key store. (You 
set the password when you create the keystore.)

3. Select a key alias.
4. Click Submit.

Table 15-2  Authentication Options (Continued)

To Add a Key-Pair for... Complete These Steps...
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3. Click the service key provider name. The View Service Key Provider Details page displays 
the information shown in Table 15-3.

4. To make a change to the fields, click Edit. See “Adding Service Key Providers” on page 15-2 
for descriptions of the fields.

5. Click Save to commit the updates in the current session.

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Deleting Service Key Providers
When you delete a service key provider, Oracle Service Bus also deletes the associated alias to 
key-pair bindings from PKI credential mapping provider. Oracle Service Bus does not delete the 
associated key-certificate pair from the key store.

Table 15-3  Service Key Provider Details 

Property Description

Service Key Provider 
Name

The name of this service key provider.

Last Modified By The user who created this service key provider or imported it into the 
configuration.

Last Modified On The date and time that the user created this service key provider or 
imported it into the configuration. Click the date and time link to view the 
change history of this resource. See “View Change History page” on 
page 3-21.

References The number of objects that this service key provider references. If such 
references exist, click the numeric link to view a list of the objects. See 
“Viewing References to Resources” on page 3-20.

Referenced by The number of objects that reference this service key provider. If such 
references exist, click the numeric link to view a list of the objects. For 
example, if you selected this service key provider as the service provider 
for a specific proxy service, the proxy service is listed as a reference when 
you click the link. See “Viewing References to Resources” on page 3-20.

Description A description of this service key provider, if one exists.
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1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. If any proxy service is configured to use the service key provider, remove the service key 
provider from the proxy service. See “Editing Proxy Service Configurations” on page 17-47.

3. Select Resource Browser > Service Key Providers to display the Summary of Service Key 
Providers page.

4. Click the  Delete icon in the Options field of the service key provider you want to delete. 
The service key provider is deleted in the current session. If a business service or proxy service 

has been configured to use a service account, a  Deletion Warning icon indicates that you can delete 
the service key provider with a warning confirmation. This might result in conflicts due to unresolved 
references from the service to the deleted service key provider.

5. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.
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Business Services: Creating and 
Managing
Business services are Oracle Service Bus definitions of the enterprise services with which you 
want to exchange messages. You define business services using WSDLs (Web Services 
Definition Language) just as you would define a proxy service. However, the configuration of 
business services differs from that of proxy services in that a business service does not have a 
pipeline. Therefore, a business service is any service not implemented by the Oracle Service Bus 
pipelines.

For more information, see Proxy Service and Business Service Configuration in Oracle Service 
Bus User Guide.

Creating and Configuring Business Services
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, then select the project or folder to which you want to add the 
business service. 

3. On the Project/Folder View page, select Business Service from the Create Resource 
drop-down list. 

4. On the Create/Edit a Business Service - General Configuration page, provide a name for the 
service and select the type of service to create.

5. Click Next. The pages that follow depend on the choices you made on the first page. Enter 
the appropriate information on each of the subsequent pages, until you reach the summary 
page, then click Save to save the service in the current session.
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For detailed instructions on completing each page, see the following:

– “General Configuration page” on page 16-3

– “Message Type Configuration page” on page 16-5

– “Transport Configuration page” on page 16-7

– “Protocol-Specific Transport Configuration page” on page 16-10

– “SOAP Binding Configuration page” on page 16-41

– “Message Content Handling Configuration page” on page 16-41

– “Summary page” on page 16-43

If a business service is created from a WSDL that includes WS-Policy attachments, the policies 
(read-only) are displayed on the Protocol-Specific Transport Configuration page. If any of the 
service's WS-Policies specifies authentication, then you must select a service account. A proxy 
service that routes to this business service will use this service account to authenticate to the 
business service.

Create/Edit a Business Service - Page Reference
Create a business service by selecting Business Service from the Create Resource drop-down 
list on the Project/Folder View page. When you select that option, it displays the first in a series 
of pages for configuring and adding business services. The pages displayed vary, depending on 
the options you choose along the way. The pages are:

“General Configuration page” on page 16-3

“Message Type Configuration page” on page 16-5

“Transport Configuration page” on page 16-7

“Protocol-Specific Transport Configuration page” on page 16-10

“SOAP Binding Configuration page” on page 16-41

“Message Content Handling Configuration page” on page 16-41

“Summary page” on page 16-43
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General Configuration page
The Create/Edit a Business Service - General Configuration page is one in a series of pages 
for creating and editing business services, as described in “Creating and Configuring Business 
Services” on page 16-1 and “Editing Business Service Configurations” on page 16-46.

Use this page to modify general configuration settings for a business service. 

When you create a business service, this is the first page displayed in a series of pages for 
configuring the service. The pages displayed after this one differ depending on the choices you 
make on this page.

Table 16-1 describes how to use the page.

Table 16-1  Create/Edit a Business Service - General Configuration Page 

Option To create or edit...

Service Name Enter a unique name for the business service.

Description Enter a description.
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Service Type A service type defines the types and packaging of the messages exchanged by the 
service. Select the type of business service to create:
• WSDL Web Service - Select this option to create a business service based on a 

WSDL. Then, enter the WSDL name, qualified by its path (for example, 
myProject/myFolder/myWSDL). Alternatively, click Browse to select a 
WSDL from the Select a WSDL page.
(port or binding) - Enter the name of a port (defined in the WSDL) to describe 
an actual transport address, or enter the name of a binding (defined in the WSDL) 
to map to a transport address. If you use Browse to select a WSDL, as described 
above, the Select a WSDL Definition page lists any ports and bindings defined 
in the WSDL. When you choose a port or a binding on that page, the (port or 
binding) field is filled with the selected name.

• Transport Typed Service - Select this option to create a service that uses the EJB 
or Flow transport. 

• Messaging Service - Select this option to create a service that exchanges 
messages of very different content-type. These exchanges can be either 
request/response or one-way. It can also just have a response with no request 
when used with the HTTP ‘GET’ option for the HTTP transport. Unlike Web 
Services, the content-type of the request and response need not be the same.

• Any SOAP Service - Select this option to create a SOAP service that does not 
have an explicitly defined, concrete interface.
Keep the default SOAP 1.1, or select SOAP 1.2 from the drop-down list.

• Any XML Service - Select this option to create an XML service that does not 
have an explicitly defined, concrete interface.
HTTP GET is only supported for messaging services and this service type.

• Business Service - Select this option to clone an existing business service. 
Enter the path (project/folder) and the name of the business service; or click 
Browse to select the business service from the Summary of Business Services 
page.
Since Oracle Service Bus does not accept the same URI for multiple services, you 
must change the URI for the cloned service. 

• Proxy Service - Select this option to create a business service based on an existing 
proxy service.

Table 16-1  Create/Edit a Business Service - General Configuration Page 

Option To create or edit...
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Business Service - Summary page.

Message Type Configuration page
The Create/Edit a Business Service - Message Type Configuration page is one in a series of 
pages for creating and editing business services, as described in “Creating and Configuring 
Business Services” on page 16-1 and “Editing Business Service Configurations” on page 16-46.

Use this page to configure message types for a business service whose type is Messaging Service.

The binding definition for messaging services consists of configuring the content-type of the 
messages that are exchanged. The content-type for the response does not need to be the same as 
for the request; therefore, the response is configured separately (for example, the service could 
accept an MFL message and return an XML acknowledgment receipt).

Note: E-mail, File, FTP, or SFTP transport business services whose type is Messaging Service 
support one-way messaging only; the Response Message Type should be none. If you 
select an option other than none, the file, ftp, or sftp protocol will not be available on the 
Transport Configuration page.

Table 16-2 describes how to use Create/Edit a Business Service - Message Type 
Configuration page.

Service Type 
(continued)

Note: When a service is created from another service, alert rules are maintained in 
the following way:

– When a proxy service is created from a business service or a 
business service is created from a proxy service, the alert rules, if 
any, are removed.

– When a proxy service is created from another proxy service or a 
business service is created from another business service, the alert 
rules, if any, are retained.

Table 16-1  Create/Edit a Business Service - General Configuration Page 

Option To create or edit...
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Business Service - Summary page.

Table 16-2  Create/Edit a Business Service - Message Type Configuration Page 

Option To create or edit...

Request Message Type Select a message type for the request message:
• None - Select this option if there is no request message (HTTP GET 

example)
• Binary - Select this option if the content-type of the message is 

unknown or not important.
• Text - Select this option if the message can be restricted to text.
• MFL - Select this option if the message is a binary document 

conforming to an MFL definition. You can configure only one MFL 
file.
For MFLs, you can click Browse to select an MFL from the MFL 
Browser, then click Submit.

• XML - Select this option if the message is an XML document. To 
provide some type information, you can choose to declare the XML 
schema type of the XML document exchanged.

Response Message Type Select a message type for the response message:
• None - Select this option if there is no response message.
• Binary - Select this option if the content-type of the message is 

unknown or not important.
• Text - Select this option if the message can be restricted to text.
• MFL - Select this option if the message is a binary document 

conforming to an MFL definition. You can configure only one MFL 
file.
For MFLs, you can click Browse to select an MFL from the MFL 
Browser, then click Submit.

• XML - Select this option if the message is an XML document. To 
provide some type information, you can choose to declare the XML 
schema type of the XML document exchanged.
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Transport Configuration page
The Create/Edit a Business Service - Transport Configuration page is one in a series of pages 
for creating and editing business services, as described in “Creating and Configuring Business 
Services” on page 16-1 and “Editing Business Service Configurations” on page 16-46.

Use this page to select a transport protocol for the business service and to set other general 
transport configuration settings.

Outbound transport-level security applies to the connections between Oracle Service Bus proxy 
services and business services. For more information about transport-level security, see 
Configuring Transport-Level Security in the Oracle Service Bus Security Guide.

Table 16-3 describes how to use this page.

Table 16-3  Create/Edit a Business Service - Transport Configuration Page 

Option To create or edit...

Protocol Select a transport protocol from the list. The protocols available differ, depending on the 
service type you are creating:
• WSDL Web Service: bpel-10g, dsp, http, jca, jms, jpd, sb, ws
• Transport-Typed Service: ejb, flow
• Messaging Service: email, file, ftp, http, jms, mq (if available), sftp, tuxedo
• Any SOAP Service: dsp, http, jms, jpd, sb
• Any XML Service: dsp, email, file, ftp, http, jms, jpd, mq (if available), sb, sftp, tuxedo

Load 
Balancing 
Algorithm

Select one of these load-balancing algorithms:
• Round-robin - This algorithm dynamically orders the URLs that you enter in the 

Endpoint URI field for this business service. If the first one fails, it tries the next one, and 
so on until the retry count is exhausted.
For every new message, there is a new order of URLs.

• Random - This algorithm randomly orders the list of URLs that you enter in the Endpoint 
URI field for this business service. If the first one fails, it tries the next one, and so on until 
the retry count is exhausted.

• Random-weighted - This algorithm randomly orders the list of URLs that you enter in the 
Endpoint URI field for this business service, but some are retried more than others based 
on the value you enter in the Weight field.

• None - This algorithm orders the list of URLs that you enter in the Endpoint URI field for 
this business service from top to bottom.
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Endpoint URI Enter an endpoint URL in the format based on the transport protocol you selected in the 
Protocol field, above: The formats are:
• bpel-10g – protocol:// host [:port] 

[/protocol-path]/domain/process[/version[/partnerlink/role]]

Optional URI elements are shown in square brackets. For more information, see the Oracle 
BPEL Process Manager User Guide.

• dsp - t3://dsp-ip-address:port/dsp-app-name
• ejb - ejb:provider:jndiname

In the URI, provider is the name of the JNDI provider resource, and JNDIname is the 
JNDI name in the JNDI server for the EJB.
If the JNDI provider is located on the same server, the JNDI provider need not be specified. 
The URI then would be ejb::jndiname

• email - mailto:java-net@java.sun.com
• file - file:///drivename:/somename
• flow - flow:<reference path to split-join resource>

reference path to split-join resource is the path (project/folder) and 
name of the Split-Join; for example, batchorderProcessing/batchorder.

• ftp - ftp://host:port/directory
• http - http://host:port/someService

The HTTP transport supports both HTTP and HTTPS endpoints.
• jca - jca://<resource_adapter_jndi>
• jms - jms://host:port/factoryJndiName/destJndiName

To target a JMS destination to multiple servers, use the following URI format: 
jms://host1:port,host2:port/QueueConnectionFactory/DestName

In a cluster: The host names in the JMS URI must exactly match the host names 
of the cluster servers as they are configured in WebLogic Server.

• jpd - jpd:[<jndi_provider_name>]:<jpd_uri>
jndi_provider_name (optional) is the name of the JNDI provider which corresponds 
to the WLI JNDI Provider resource. When omitted, the JNDI provider on the local server 
is used.
<jpd uri> is the relative URL of the JPD on the WLI server. For example, if 
processes.Process.jpd is in the SampleApp Web project, then the relative URL of 
the JPD is /SampleApp/processes/Process.jpd.

Table 16-3  Create/Edit a Business Service - Transport Configuration Page 

Option To create or edit...
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Endpoint URI 
(continued)

• mq - mq://<local-queue-name>?conn=<mq-connection-resource-ref>
local-queue-name is the name of the MQ queue from which the business service reads 
messages.
mq-connection-resource-ref is the path (project/folder) and name of the MQ 
connection resource; for example, default/my_MQconnection.

Note: The Endpoint URI cannot contain spaces, so do not create MQ 
Connection resources or projects/folders with spaces in the names.

To make the MQ transport available in Oracle Service Bus, see “MQ Connections” on 
page 8-1.

• sb - sb://[<jndi_provider_name/>]service_name
jndi_provider_name (optional) is the name of the Oracle Service Bus JNDI Provider 
resource. When omitted, the default context is used.
service_name is a target service and corresponds to the remote proxy service URI.

• sftp - sftp://hostname:port/directory
• tuxedo - tuxedo:resourcename[/remotename]

In the URI, resourcename corresponds to a WTC Import name and remotename 
corresponds to the service name exported by the remote Tuxedo domain. The URI 
resourcename is required, and the remotename is optional.
If more than one URI is specified, you must have unique resource names for the endpoints. 
If no remote name is specified, its value is the value of the resource name. If no remote 
name is entered or if remote and resource name are the same, only one URI is allowed. In 
this case resource name and remote name have the same value. This allows already defined 
WTC Imports to make use of WTC load-balancing and failover. For more information, see 
Oracle Service Bus Interoperability Solution for Tuxedo.

• ws - http://host:port/somename or https://host:port/somename

Click Add to add one or more additional URIs. At run time, the URLs are selected based on the 
load balancing algorithm you selected in the Load Balancing Algorithm field.

If you selected Random-weighted in the Load Balancing Algorithm field, you can also enter 
a weight in the Endpoint URI field. The default is 1.

If you have multiple endpoint defined, and you selected None in the Load Balancing 
Algorithm field, the order of endpoints is significant. You can reorder the endpoints using the 
Up and Down arrows in the Options column.

Oracle Service Bus does not support duplicate endpoint URIs within the same business service.

Table 16-3  Create/Edit a Business Service - Transport Configuration Page 

Option To create or edit...
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Business Service - Summary page.

Protocol-Specific Transport Configuration page
The Create/Edit a Business Service - Protocol-Specific Transport Configuration page is one 
in a series of pages for creating and editing business services, as described in “Creating and 
Configuring Business Services” on page 16-1 and “Editing Business Service Configurations” on 
page 16-46.

“BPEL-10g Transport Configuration Page” on page 16-11

“DSP Transport Configuration page” on page 16-14

“EJB Transport Configuration page” on page 16-15

Retry Count In case of delivery failure when sending outbound requests, specify the number of times to retry 
individual URL endpoints; in other words, the number of failover attempts.

For example, a business service has one configured URI (U1) and the number of retries is set 
to 3. If U1 fails on the first attempt, the system retries the U1 endpoint 3 more times.

If a business service has 2 configured URIs (U1 and U2) and a retry count of 3, if the first 
attempt (for example, to U1) fails, the system tries (fails over to) the next URI (U2). If that also 
fails, the system makes two more attempts, once to U1 and once to U2.

Retry Iteration 
Interval

Specify the number of seconds the system pauses before iterating over all the endpoint 
URIs in the list again.

For example, a business service has two configured URIs (U1 and U2) and a retry count of 2 
with a retry iteration interval of 5 seconds. If the first attempt (to U1) fails, the system tries U2 
right away. But if U2 also fails, the system waits for 5 seconds and retries U1 once more.

Retry 
Application 
Errors

Select Yes or No.

In case of delivery failure when sending outbound requests, specify whether or not to retry 
endpoint URIs based on application errors (for example, a SOAP fault).
This field is available only for these transports, HTTP, EJB, JMS, DSP, JPD, Tuxedo, SB, and 
WS. For more information, see How to Suppress Retries in Case of Application Errors in 
Oracle Service Bus Operations Guide.

Table 16-3  Create/Edit a Business Service - Transport Configuration Page 

Option To create or edit...
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“E-Mail Transport Configuration page” on page 16-17

“File Transport Configuration page” on page 16-18

“Flow Transport Configuration page” on page 16-18

“FTP Transport Configuration page” on page 16-19

“HTTP Transport Configuration Page” on page 16-20

“JCA Transport Configuration Page” on page 16-23

“JMS Transport Configuration page” on page 16-26

“JPD Transport Configuration page” on page 16-30

“MQ Transport Configuration page” on page 16-31

“SB Transport Configuration page” on page 16-35

“SFTP Transport Configuration page” on page 16-36

“Tuxedo Transport Configuration page” on page 16-37

“WS Transport Configuration page” on page 16-39

BPEL-10g Transport Configuration Page
Use this page to configure transport settings for a business service using the BPEL-10g (Oracle 
BPEL Process Manager) transport protocol. For more information on using Oracle Service Bus 
with Oracle BPEL Process Manager, see the Oracle BPEL Process Manager Transport User 
Guide.
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Property Description

Role The BPEL transport is used to send request messages from Oracle Service Bus to 
Oracle BPEL Process Manager. The business service can serve one of the following 
roles:
• Synchronous Client 

For synchronous communication with an Oracle Service Bus client, the only 
location information that is required is the BPEL address. This address is 
captured statically as the endpoint URI and/or dynamically through URI 
rewriting.

• Asynchronous Client 
For asynchronous communication with an Oracle Service Bus client, a callback 
from Oracle BPEL Process Manager to Oracle Service Bus is sent on a different 
connection than the request, and you must configure Oracle Service Bus to 
provide the correct callback address. For more information, see “Creating a 
Callback Proxy for Asynchronous Communication” in the Oracle BPEL 
Process Manager Transport User Guide.

• Service Callback 
If the business service is designed to be a service callback to Oracle BPEL 
Process Manager (where Oracle BPEL Process Manager is calling an external 
service through Oracle Service Bus), the callback address is known only at run 
time. Use an Endpoint URI of bpel://callback.
If you configure the business service with the marker URI, configure your 
pipeline logic to dynamically set the URI on $outbound; for example, using the 
TransportHeader action.

Note: A Service Callback business service does not support load 
balancing or failover.

Callback Proxy This optional field is available only for the Asynchronous Client role. This field lets 
you select the proxy service (must be either an SB or HTTP proxy of type Any 
SOAP) that will be used to route callbacks to the Oracle Service Bus client that 
made the request. For more information, see “Creating a Callback Proxy for 
Asynchronous Communication” in the Oracle BPEL Process Manager Transport 
User Guide.
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Service Account For JNDI context security, used to access the Oracle BPEL Process Manager 
delivery service. Click Browse and select a service account. If no service account is 
specified, an anonymous subject is used.

There is no restriction on the type of service account that can be configured, such 
as static or pass-through, but the run time must be able to access a user name and 
password.

Suspend Transaction Selecting Suspend Transaction makes the business service non-transactional even 
if the business service is invoked by a transaction.

If you do not select Suspend Transaction:
• If the protocol indicates a WebLogic Server-supported protocol (t3, iiop, http), 

the transaction is propagated.
• If the protocol indicates an OC4J server (ormi, opmn), the BPEL transport 

throws an exception, since OC4J does not support transaction propagation.

The BPEL transport ignores the Suspend Transaction option in the following 
situations:
• The business service is called with quality of service (QoS) “best-effort.” The 

BPEL transport automatically suspends any transaction that does not support 
QoS.

• The business service is called with QoS set to “exactly-once” and there is no 
transaction.

For a description of transaction propagation, see “Transaction Propagation” in the 
Oracle BPEL Process Manager Transport User Guide.

Dispatch Policy Select the instance of WebLogic Server Work Manager that you want to use for the 
dispatch policy for this endpoint. The default Work Manager is used if no other 
Work Manager exists.

For information about Work Managers, see the following WebLogic Server 
Administration Console Online Help topics:
• “Using Work Managers to Optimize Scheduled Work” at 

http://download.oracle.com/docs/cd/E12840_01/wls/docs103/config_wls/self_
tuned.html

• “Create Global Work Managers” at 
http://download.oracle.com/docs/cd/E12840_01/wls/docs103/ConsoleHelp/tas
khelp/work/CreateGlobalWorkManager.html

Property Description
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DSP Transport Configuration page
The Create/Edit a Business Service - DSP Transport Configuration page is one in a series of 
pages for creating and editing business services, as described in “Creating and Configuring 
Business Services” on page 16-1 and “Editing Business Service Configurations” on page 16-46.

For more information, see Accessing Data Services Through Oracle Service Bus.

Use this page to configure transport settings for a business service using the DSP (Oracle Data 
Service Integrator) transport protocol. Table 16-4 describes how to use this page.

For more information on accessing Oracle Data Service Integrator from Oracle Service Bus, see 
Accessing Data Services Through Oracle Service Bus. 

After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Business Service - Summary page.

Table 16-4  Create/Edit a Business Service - DSP Transport Configuration Page 

Option To create or edit...

Debug Level Specify one of the following
• 0 - for no debug information
• 1 - to output information on the request message
• 3 - to output information on the request and the response message

Service Account Click Browse and select a service account from the list displayed. If no service 
account is specified, an anonymous subject is used.

For more information:
• “Service Accounts” on page 14-1
• “Adding Service Accounts” on page 14-4

Dispatch Policy Select the instance of WebLogic Server Work Manager that you want to use for the 
dispatch policy for this endpoint. The default Work Manager is used if no other 
Work Manager exists. 

The Work Manager is used to post the reply message for response processing. For 
information about Work Managers, see Using Work Managers to 
Optimize Scheduled Work and Create Global Work Managers in the 
WebLogic Server Administration Console Online Help.
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EJB Transport Configuration page
The Create/Edit a Business Service - EJB Transport Configuration page is one in a series of 
pages for creating and editing business services, as described in “Creating and Configuring 
Business Services” on page 16-1 and “Editing Business Service Configurations” on page 16-46.

Use this page to configure transport settings for a business service using the EJB transport 
protocol. Table 16-5 describes how to use the page.

Table 16-5  Create/Edit a Business Service - EJB Transport Configuration Page 

Option To create or edit...

Pass Caller’s 
Subject

Select this check box to have Oracle Service Bus pass the authenticated subject 
from the proxy service when invoking the EJB and no service accounts are 
configured. Note that the Service Account field is disabled when this option is 
selected.

Service Account Click Browse and select a service account from the list displayed. If no service 
account is specified, an anonymous subject is used.

For more information:
• “Service Accounts” on page 14-1
• “Adding Service Accounts” on page 14-4

Supports 
Transaction

Select this check box to specify transaction support.

Client Jar Click Browse and select an EJB client JAR resource from the list displayed. To 
learn about creating JAR resources, see “JARs” on page 7-1. This is a required 
field.

Converter Jar Click Browse and select an EJB converter class JAR resource from the list 
displayed. To learn more about EJB client JAR resources and converter classes, 
see EJB Transport in the Oracle Service Bus User Guide.

Home Interface Select the required EJBHome interface from the options populated by the JAR. 
The JNDI name in this URI sample must be associated with the EJBHome 
interface you select here. If the EJB is not of the required type or an EJBHome 
interface is not specified in the client-jar, a warning will be displayed.

Remote Interface This field is automatically populated depending on the configuration of the Home 
Interface.
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Business Service - Summary page.

Target 
Namespace

This field is populated by information picked up from the JAR.

Style Select Document Wrapped or RPC according to your requirements. If two or 
more methods of your stateless session EJB have the same number and data type 
of parameters, and you want the operations to be document-oriented, you must 
specify that they be document-wrapped.

The style is important because when routing or publishing to the EJB, $body must 
have content that matches the style. Also when calling out to an EJB, the style 
affects the parameter contents, especially for document wrapped. Secondly one 
usage pattern is to define an EJB business service and then create a proxy service 
with the same WSDL that routes to the EJB. In this case care must be taken on the 
style of the WSDL because the client tool used to invoke the proxy might have 
limitations on the style of the WSDL. 

Encoding Select Encoded or Literal.

Methods Select the required methods (you can select multiple methods). Click + to expand 
the method and: edit the default parameter values and select a converter if provided 
(or required).

Exceptions This field appears if a method throws a business exception. If an EJB method 
throws an exception that has data types not supported by Java Web Services 
(JWS), such as an ArrayList, use the Exceptions field to select a converter class 
that converts the exception to a type supported by JWS.

Your converter class must implement 
com.bea.wli.sb.transports.ejb.ITypeConverter. Converter classes can only be 
configured for checked exceptions and not for run-time exceptions.

Package the converter class and the converted exception class in the client or 
converter JAR.

For more information, see the Interoperability with EJB Transport guide.

Table 16-5  Create/Edit a Business Service - EJB Transport Configuration Page 

Option To create or edit...
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E-Mail Transport Configuration page
The Create/Edit a Business Service - E-Mail Transport Configuration page is one in a series 
of pages for creating and editing business services, as described in “Creating and Configuring 
Business Services” on page 16-1 and “Editing Business Service Configurations” on page 16-46.

Use this page to configure transport settings for a business service using the e-mail transport 
protocol. Table 16-6 describes how to use the page.

After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Business Service - Summary page.

Table 16-6  Create/Edit a Business Service - E-Mail Transport Configuration Page 

Option To create or edit...

SMTP Server Select an SMTP server.

This is a required field if you do not select a JNDI name in the Mail Session field.

Mail Session Select the JNDI name of a configured session.

This is a required field if you do not enter an SMTP server name in the Mail Server 
address field.

From Name Enter a display name for the originating e-mail account for this service.

From Address Enter the originating e-mail account for this service.

Reply To Name Enter a display name for the reply to e-mail account.

Reply To Address Enter an e-mail address to reply to.

Connection 
Timeout 

Enter the timeout interval, in seconds, before the connection is dropped. If you 
enter 0, there is no timeout.

Request Encoding Accept the default ISO-8859-1 as the character set encoding for requests in 
e-mail transports, or enter a different character set encoding.
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File Transport Configuration page
The Create/Edit a Business Service - File Transport Configuration page is one in a series of 
pages for creating and editing business services, as described in “Creating and Configuring 
Business Services” on page 16-1 and “Editing Business Service Configurations” on page 16-46.

Use this page to configure transport settings for a business service using the file transport 
protocol. Table 16-7 describes how to use this page.

After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Business Service - Summary page.

Flow Transport Configuration page
The Create/Edit a Business Service - Flow Transport Configuration page is one in a series of 
pages for creating and editing business services, as described in “Creating and Configuring 
Business Services” on page 16-1 and “Editing Business Service Configurations” on page 16-46.

You use Flow transport-typed business services to access Split-Joins. To learn more about 
Split-Joins, see Improving Service Performance with Split-Join in the Oracle Service Bus User 
Guide.

Use this page to configure transport settings for a business service using the Flow transport 
protocol. Table 16-8 describes how to use this page.

Table 16-7  Create/Edit a Business Service - File Transport Configuration Page 

Option To create or edit...

Prefix Enter a prefix to be prepended to the file name. 

Do not enter * in this field. This character causes a run-time exception.

Suffix Enter a suffix to be appended to the file name. This is a required field.

Do not enter * in this field. This character causes a run-time exception.

Request Encoding Accept the default utf-8 as the character set encoding for requests in File 
transports, or enter a different character set encoding.
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Business Service - Summary page.

FTP Transport Configuration page
The Create/Edit a Business Service - FTP Transport Configuration page is one in a series of 
pages for creating and editing business services, as described in “Creating and Configuring 
Business Services” on page 16-1 and “Editing Business Service Configurations” on page 16-46.

Use this page to configure transport settings for a business service using the ftp transport protocol. 
Table 16-9 describes how to use this page.

Table 16-8  Create/Edit a Business Service - Flow Transport Configuration Page 

Option To create or edit...

Timeout Enter the number of seconds to wait for a response. This value is ignored for a 
request-only (one-way) operation.

Table 16-9  Create/Edit a Business Service - FTP Transport Configuration Page 

Option To create or edit...

User 
Authentication

Select anonymous if the user of the FTP server is anonymous, or select external 
user if the user of the FTP server is an externally configured account.

Identity (E-mail 
id)

This field is available only if the User Authentication option is set to anonymous.

Enter the mail ID for the anonymous user.

Service Account This field is available only if the User Authentication option is set to external 
user.

Enter the service account for the external user.

For more information:
• “Service Accounts” on page 14-1
• “Adding Service Accounts” on page 14-4.

Timeout Enter the socket timeout interval, in seconds, before the connection is dropped. 
The default is 60 seconds.
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Business Service - Summary page.

HTTP Transport Configuration Page
The HTTP transport supports both HTTP and HTTPS endpoints.

The Create/Edit a Business Service - HTTP Transport Configuration page is one in a series 
of pages for creating and editing business services, as described in “Creating and Configuring 
Business Services” on page 16-1 and “Editing Business Service Configurations” on page 16-46.

Use this page to configure transport settings for a business service using the HTTP transport 
protocol. Table 16-10 describes how to use the page.

Prefix for 
destination File 
Name

Enter a prefix for the file name under which the file is stored on the remote server. 

Do not enter * in this field. This character causes a run-time exception.

Suffix for 
destination File 
Name

Enter a suffix for the file name under which the file is stored on the remote server.

Do not enter * in this field. This character causes a run-time exception.

Transfer Mode Select ASCII or binary as the transfer mode.

Request Encoding Accept the default UTF-8 as the character set encoding for requests in ftp 
transports, or enter a different character set encoding.

Table 16-10  Create/Edit a Business Service - HTTP Transport Configuration Page (Continued)

Option To create or edit...

Timeout Enter the response timeout interval in seconds. If you enter 0, there is no timeout.

Table 16-9  Create/Edit a Business Service - FTP Transport Configuration Page 

Option To create or edit...
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HTTP Request 
Method 

This parameter lets you to use one of the following HTTP methods in a request:
• POST – Passes all its data, of unlimited length, directly over the socket 

connection as part of its HTTP request body. The exchange is invisible to the 
client, and the URL does not change. For REST-based requests, POST tells the 
transport to perform a create/replace operation or perform an action with the 
request.

• GET – You can include as part of the request some of its own information that 
better describes what to get. This information is passed as a sequence of 
characters appended to the request URL in a query string. You can use GET in 
a business service with a Service Type of “Any XML Service,” or with a 
Service Type of “Messaging Service” when the Request Message Type is set 
to “None.” For REST-based requests, GET retrieves a representation of a 
remote resource.

• PUT – You can use PUT in a business service with a Service Type of “Any 
XML Service” or “Messaging Service.” PUT tells the transport to perform a 
create/replace operation with a REST-based request, such as uploading a file 
to a known location.

• HEAD – You can use HEAD in a business service with a Service Type of 
“Any XML Service,” or with a Service Type of “Messaging Service” when the 
Response Message Type is set to “None.” HEAD tells the transport to get 
header information for a remote resource rather than getting a full 
representation of the resource in a REST-based request.

• DELETE – You can use PUT in a business service with a Service Type of 
“Any XML Service” or “Messaging Service.” DELETE tells the transport to 
perform a delete operation with a REST-based request.

Note: If a method is already set in the 
$outbound/transport/request/http:http-method variable, that value takes 
precedence over any method you select for HTTP Request Method.

Table 16-10  Create/Edit a Business Service - HTTP Transport Configuration Page (Continued)

Option To create or edit...
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Authentication Select one of the following:
• None - Specifies that authentication is not required to access this service.
• Basic - Specifies that basic authentication is required to access this service.

Basic authentication instructs WebLogic Server to authenticate the client using 
a user name and password against the authentication providers configured in 
the security realm, such as a Lightweight Directory Access Protocol (LDAP) 
directory service and Windows Active Directory. The client must send its user 
name and password on the HTTP request header.
Basic authentication is strongly discouraged over HTTP because the password 
is sent in clear text. However, it is safe to send passwords over HTTPS because 
HTTPS provides an encrypted channel.
Warning: By default, all users (authorized and anonymous) can access a 
business service. To limit the users who can access a business service, create 
a transport-level authorization policy. See “Editing Transport-Level Access 
Policies” on page 22-16.

• Client Certificate - Specifies encrypted communication and strong client 
authentication (two-way SSL). To learn more, see Configuring 
Transport-Level Security in the Oracle Service Bus Security Guide.

Service Account Enter a service account. A service account is an alias resource for a user name and 
password. This is a required field if you selected the Basic Authentication 
Required field. 

For more information:
• “Service Accounts” on page 14-1
• “Adding Service Accounts” on page 14-4.

Follow HTTP 
redirects

Select this check box to specify that HTTP redirects (which are requests with a 
response code 3xx) should be automatically followed. A re-direct occurs when 
you send an outbound request to the URL of a business service, and that service 
returns a response code (for example, 302) that says the URL is no longer valid 
and this request needs to be sent to another URL. 

If the Follow HTTP Redirects check box is selected, Oracle Service Bus 
automatically re-sends the request to the new URL without any action on your part. 
Deselect this check box if you do not want the HTTP redirects to be automatically 
followed.

Table 16-10  Create/Edit a Business Service - HTTP Transport Configuration Page (Continued)

Option To create or edit...
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Business Service - Summary page.

JCA Transport Configuration Page
Use this page to configure transport settings using the JCA transport protocol. For more 
information on using the JCA transport, see the JCA Transport User Guide.

Dispatch Policy Select the instance of WebLogic Server Work Manager that you want to use for the 
dispatch policy for this endpoint. The default Work Manager is used if no other 
Work Manager exists. For information about Work Managers, see Using 
Work Managers to Optimize Scheduled Work and Create Global Work 
Managers in the WebLogic Server Administration Console Online Help.

Request Encoding Accept the default iso-8859-1 as the character set encoding for requests in 
HTTP transports, or enter a different character set encoding.

Response 
Encoding

Accept the default iso-8859-1 as the character set encoding for responses in 
HTTP transports, or enter a different character set encoding.

Proxy Server Enter a proxy server resource or click Browse to choose an entry from the list of 
configured proxy server resources.

Table 16-11  JCA transport configuration 

Option Description

Adapter Name A read-only value showing the name of the adapter that the JCA service will use.

Adapter Type A read-only value showing the adapter type.

Table 16-10  Create/Edit a Business Service - HTTP Transport Configuration Page (Continued)

Option To create or edit...
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Dispatch Policy Select the instance of WebLogic Server Work Manager that you want to use for 
the dispatch policy for this endpoint. The default Work Manager is used if no 
other Work Manager exists.

For information about Work Managers, see the following WebLogic Server 
Administration Console Online Help topics:
• Using Work Managers to Optimize Scheduled Work
• Create Global Work Managers

JNDI Service 
Account

JNDI Service Account is for JNDI context security, used to access the EIS 
adapter managed connection factory. Click Browse and select a service account. 
If no service account is specified, an anonymous subject is used.

For JCA business services, there is no restriction on the type of JNDI service 
account that can be configured, such as static or pass-through, but the run time 
must be able to access a user name and password. JCA proxy services can use 
only static JNDI service accounts.

For more information on JNDI service accounts, see “Security” in the JCA 
Transport User Guide.

Always use 
configuration from 
JCA WSDL

This option determines whether or not connection factory properties, activation 
spec properties (proxy services), and interaction spec properties (business 
services) are always used from the WSDL.

If this option is selected (default), the JCA transport interacts with the JCA 
framework in the following ways, depending on whether you are using managed 
or non-managed mode:
• Managed mode – The activation/interaction spec defined in the JCA WSDL. 

The Activation/Interaction Spec Properties field is read-only; and if 
Connection Mode is set to Managed, the Connection Factory Properties field 
is read-only.

• Non-managed mode – Connection factory properties defined in the JCA 
WSDL. The Activation/Interaction Spec Properties field is read-only.

If this option is deselected, you can override the Activation/Interaction Spec 
Properties of the WSDL; and in non-managed mode you can override the 
Connection Factory Properties of the WSDL. At run time the JCA transport 
interacts with the JCA framework using the JCA WSDL and any 
activation/interaction spec or connection factory overrides you have provided.

For more information on using this option, see “Endpoint Redeployment” in the 
JCA Transport User Guide.

Table 16-11  JCA transport configuration (Continued)

Option Description
16-24  Using the Oracle Service Bus Console

http://download.oracle.com/docs/cd/E12840_01/wls/docs103/config_wls/self_tuned.html
http://download.oracle.com/docs/cd/E12840_01/wls/docs103/ConsoleHelp/taskhelp/work/CreateGlobalWorkManager.html
http://download.oracle.com/docs/cd/E13159_01/osb/docs10gr3/jcatransport/index.html
http://download.oracle.com/docs/cd/E13159_01/osb/docs10gr3/jcatransport/index.html
http://download.oracle.com/docs/cd/E13159_01/osb/docs10gr3/jcatransport/index.html


Create /Ed i t  a  Bus iness  Serv ice  -  Page  Refe rence
Connection Mode This option determines how the service connects to the associated JCA adapter 
for the EIS system.

Managed – Recommended for production. The JCA transport connects to the 
JCA adapter through the JCA adapter-managed connection factory configured in 
WebLogic Server. For authentication, specify a JNDI service account. If no 
JNDI service account is specified, an anonymous subject is used. In managed 
mode, Connection Factory Authentication Properties are read-only.

Non-Managed – The JCA transport connects to the JCA adapter through the 
JCA adapter framework, which acts as a container for the JCA adapter. For 
authentication, specify a JNDI service account. If no JNDI service account is 
specified, an anonymous subject is used. In non- managed mode, Connection 
Factory Authentication Properties are editable for overrides.

Note: If you want to change from Non-Managed mode to Managed mode, be 
sure to deselect the Overwrite Connection Authentication Properties 
option before changing modes.

Overwrite 
Connection 
Authentication 
Properties

This option indicates whether or not the user name/password in the adapter 
connection factory is overwritten by the Connection Authentication Service 
Account credentials. If no JNDI Service Account is specified, an anonymous 
subject is used.

This option, which is displayed only if the connection factory properties 
contain user name/password properties, is available in non-managed mode 
with “Always use configuration from JCA WSDL” deselected.

Connection 
Authentication 
Service Account

This field is enabled if “Overwrite Connection Authentication Properties” is 
enabled and selected. This service account browser displays available service 
accounts. If the “Overwrite Connection Authentication Properties” option is 
selected, you must select a service account. For proxy services, only static 
service accounts are available.

This field if displayed only if the connection factory properties contain user name 
password properties.

Connection Factory 
Authentication 
Properties

This field is displayed only if the Connection Factory Properties contain a user 
name and password. This field is always read-only.

Table 16-11  JCA transport configuration (Continued)

Option Description
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JMS Transport Configuration page
The Create/Edit a Business Service - JMS Transport Configuration page is one in a series of 
pages for creating and editing business services, as described in “Creating and Configuring 
Business Services” on page 16-1 and “Editing Business Service Configurations” on page 16-46.

For more information, see the Oracle Service Bus Interoperability Solutions for JMS.

Connection Factory 
Properties

This field shows the connection factory properties from the WSDL’s 
<jca:address> element.

Development and Testing: You can override this value if you deselect “Always 
use configuration from JCA WSDL” and make the Connection Mode 
Non-Managed. In production environments, use managed mode, which makes 
the JCA transport connect to the adapter connection factory configured in 
WebLogic Server.

Operation Name Displays a read-only name of the selected WSDL operation. An operation can 
have its own activation/interaction spec properties, shown in the 
Activation/Interaction Spec Properties field.

Activation/Interactio
n Spec Properties

“Activation Spec Properties” is the field name for proxy services; “Interaction 
Spec Properties” is the field name for business services.

If this service is an inbound service invoked by an EIS application, this field 
displays the activation spec properties for the JCA inbound operation shown in 
Operation Name field.

You can override the activation/interaction spec properties if you deselect 
“Always use configuration from JCA WSDL.”

Note: For Oracle Adapter Suite adapters, activation/interaction spec 
properties are displayed as read-only. The Oracle Adapter Suite 
adapters store their own configurations, which you must change in the 
Oracle Adapter Suite management tools.

TopLink File Browser For Oracle Database or Oracle Applications adapters that depend on a database, 
use this field to select a TopLink mapping file from the file system. The content 
of the TopLink mapping file is displayed in an editable text box.

Generate a TopLink mapping file in Oracle JDeveloper and import it into Oracle 
Service Bus.

Table 16-11  JCA transport configuration (Continued)

Option Description
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Use this page to configure transport settings for a business service using the JMS transport 
protocol. Table 16-12 describes how to use the page.

Table 16-12  Create/Edit a Business Service - JMS Transport Configuration Page (Continued)

Option To create or edit...

Destination Type Select a type for the JMS bridge destination:
• Queue (for point-to-point)
• Topic (for publish/subscribe)

Message Type Select one of the following:
• Bytes (for a stream of uninterpreted bytes)
• Text (for text messages)

Is Response Required This option is available only when Queue is selected for the Destination 
Type.

Select this option to specify that a response is expected after an outbound 
message is sent. 

Response Correlation 
Pattern

This option is available only when the Is Response Required check box 
is selected.

Select one of the following: 
• Select JMSMessageID for JAX-RPC services running on 

WebLogic Server 9.2.
• Select JMSCorrelationID for all other services. When you select 

this option, you must also enter a Response URI, below.

Response URI This option is available only when JMSCorrelationID is selected for the 
Response Correlation Pattern.

Enter a response URI in the format:

  jms://host:port/factoryJndiName/destJndiName

To target multiple servers, use the following format:
  jms://host1:port,host2:port/QueueConnectionFacto
ry/DestName
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Response Connection 
Factory

This option is available only when JMSMessageID is selected for the 
Response Correlation Pattern.

Enter a response connection factory URI.

If a connection factory is not specified, the connection factory for the 
request is used for the response.

Response JNDI Names This option is available only when JMSMessageID is selected for the 
Response Correlation Pattern.

Enter a list of JNDI destination names 

Response Timeout Enter the amount of time to wait for the response, in seconds. This field 
is required if you selected Is Response Required.

Request Encoding Accept the default UTF-8 as the character set encoding for requests in 
JMS transports, or enter a different character set encoding.

Response Encoding This option is available only when the Is Response Required check box 
is selected.

Accept the default UTF-8 as the character set encoding for responses in 
JMS transports, or enter a different character set encoding.

Dispatch Policy Select the instance of WebLogic Server Work Manager that you want to 
use for the dispatch policy for this endpoint. The default Work Manager 
is used if no other Work Manager exists. 

For example, if the business service has a JMS transport protocol, the 
business service endpoint is an MDB (message-driven bean) JAR file 
that you can associate with the specific dispatch policy. 

Advanced Settings

Table 16-12  Create/Edit a Business Service - JMS Transport Configuration Page (Continued)

Option To create or edit...
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Business Service - Summary page.

Use SSL Select only if the requests are made over a TLS/SSL connection. 

TLS/SSL (Secure Sockets Layer) provides secure connections by 
allowing two applications connecting over a network to authenticate the 
other's identity and by encrypting the data exchanged between the 
applications. Authentication allows a server, and optionally a client, to 
verify the identity of the application on the other end of a network 
connection. Additionally, if the administrator has restricted access to 
individual JMS destinations (queues or topics) by setting access control 
on the JNDI entry for the destination, the Business Service must 
authenticate when looking up the entry in the JNDI tree with a user name 
and password.

Expiration The time interval in milliseconds after which the message will expire. 
Default value is 0, which means that the message never expires.

Unit of Order Enter a message unit-of-order. Message unit-of-order enables message 
producers to group messages into a single unit with respect to the 
processing order. This single unit-of-order requires that all messages in 
that unit be processed sequentially in the order they were created.

Pass Caller’s Subject Select this check box to have Oracle Service Bus pass the authenticated 
subject when sending a message.

When you enable this field and the business service targets JMS 
resources in a different domain, enable global trust on both domains. See 
Configuring Security for a WebLogic Domain in Securing WebLogic 
Server.

JMS Service Account Select a service account to use for the JMS resource managed by the JMS 
server. A service account is an alias resource for a User ID and its 
associated password. The same service account is used for both JNDI and 
JMS purposes.

For more information:
• “Service Accounts” on page 14-1
• “Adding Service Accounts” on page 14-4

Table 16-12  Create/Edit a Business Service - JMS Transport Configuration Page (Continued)

Option To create or edit...
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JPD Transport Configuration page
The Create/Edit a Business Service - JPD Transport Configuration page is one in a series of 
pages for creating and editing business services, as described in “Creating and Configuring 
Business Services” on page 16-1 and “Editing Business Service Configurations” on page 16-46.

For more information, see the JPD Transport User Guide.

Use this page to configure transport settings for a business service using the JPD transport 
protocol. Table 16-13 describes how to use the page.

Table 16-13  Create/Edit a Business Service - JPD Transport Configuration Page (Continued)

Option To create or edit...

System Service Account Enter the service account for the user, or click Browse to select one from 
the list displayed.

The system service account specifies the user credentials for the invocation 
of the WLI stateless session bean that the JPD transport uses to send 
incoming messages. 

If no service account is specified, the inbound request subject is used. If 
there is no inbound request subject, an anonymous subject is used.

Process Service Account Enter the service account for the user, or click Browse to select one from 
the list displayed.

The process service account specifies the user credentials for the 
invocation of the JPD. 

If no service account is specified, the inbound request subject is used. If 
there is no inbound request subject, an anonymous subject is used
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Business Service - Summary page.

MQ Transport Configuration page
The Create/Edit a Business Service - MQ Transport Configuration page is one in a series of 
pages for creating and editing business services, as described in “Creating and Configuring 
Business Services” on page 16-1 and “Editing Business Service Configurations” on page 16-46.

For more information, see the MQ Transport User Guide.

Callback Proxy Location Enter the location of the proxy service for receiving callbacks from the 
JPD, specified in the following format:
jms://[host:port[,host:port]*]/MyFactory/MyQueue

Where:
• host: (optional) Host name of the Oracle Service Bus server where the 

callback proxy service is configured
• port: (optional) Port number on which Oracle Service Bus is listening 

for incoming requests
• MyFactory: JNDI name of the Queue connection factory
• MyQueue: JNDI name of the Queue where the Oracle Service Bus 

proxy service is waiting for callback requests

In a clustered environment, specify the host name and port numbers of the 
Managed Servers, separated by a comma (,). 

The Callback Proxy Location will be ignored if the JPD being invoked is a 
synchronous JPD or an asynchronous JPD without callbacks.

Dispatch Policy Select the default dispatch policy or a configured Work Manager instance 
for the outbound response. For information about Work Managers, see 
Using Work Managers to Optimize Scheduled Work and Create 
Global Work Managers in the WebLogic Server Administration 
Console Online Help.

Propagate Transaction Select the check box to propagate the existing transaction within Oracle 
Service Bus to the JPD.

Table 16-13  Create/Edit a Business Service - JPD Transport Configuration Page (Continued)

Option To create or edit...
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Before you begin

Configure a MQ Connection resource. See “MQ Connections” on page 8-1.

To configure the MQ transport

Use this page to configure transport settings for a business service using the native MQ transport 
protocol. Table 16-14 describes how to use the page.

Table 16-14  Create/Edit a Business Service - MQ Transport Configuration Page 

Option To create or edit...

Message Type This option is available only when the Is Response Required check box is 
selected.

Select one of the following:
• Bytes (for a stream of uninterpreted bytes)
• Text (for text messages)

Is Response Required Select this option to specify that a response is expected after an outbound 
message is sent. 

Polling Interval This option is available only when the Is Response Required check box is 
selected.

Enter a polling interval, in milliseconds. The default is 1000.

Response Correlation 
Pattern

This option is available only when the Is Response Required check box is 
selected.

Specify whether the response correlation pattern should be based on 
MessageID or CorrelationID.

Auto-generate Correlation 
Value

Select this check box to automatically generate a CorrelationID or 
MessageID.

MQ Response URI This option is available only when the Is Response Required check box is 
selected.

The destination to which the response should be published. Enter a response 
URI in the same format as the endpoint URI: 
mq://<local-queue-name>?conn=<mq-connection-resourc
e-ref>

For more detailed information, see the MQ Transport User Guide.
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Response Timeout This option is available only when the Is Response Required check box is 
selected.

Enter the number of seconds to wait for a response before dropping the 
connection. 

Dispatch Policy This option is available only when the Is Response Required check box is 
selected.

Select a dispatch policy for this endpoint. 

Dispatch policy refers to the instance of WLS Work Manager that you want 
to use for the service endpoint. For information about work managers, see 
Using Work Managers to Optimize Scheduled Work and Create Work 
Manager in the WebLogic Server Administration Console Online Help.

Table 16-14  Create/Edit a Business Service - MQ Transport Configuration Page (Continued)

Option To create or edit...
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Endpoint URI ‘PUT’ 
options

Enter the MQ PUT message options from among the following:
• MQC.MQPMO_ALTERNATE_USER_AUTHORITY
• MQC.MQPMO_DEFAULT_CONTEXT
• MQC.MQPMO_FAIL_IF_QUIESCING
• MQC.MQPMO_LOGICAL_ORDER
• MQC.MQPMO_NEW_CORREL_ID
• MQC.MQPMO_NEW_MSG_ID
• MQC.MQPMO_NO_CONTEXT
• MQC.MQPMO_NO_SYNCPOINT
• MQC.MQPMO_NONE
• MQC.MQPMO_PASS_ALL_CONTEXT
• MQC.MQPMO_PASS_IDENTITY_CONTEXT
• MQC.MQPMO_RESOLVE_LOCAL_Q
• MQC.MQPMO_SET_ALL_CONTEXT
• MQC.MQPMO_SET_IDENTITY_CONTEXT
• MQC.MQPMO_SYNCPOINT
• MQC.MQPMO_VERSION_1
• MQC.MQPMO_VERSION_2

You can use either “|” or “+” to separate multiple options. For example, you 
can specify the following:

MQC.MQPMO_LOGICAL_ORDER | MQC.MQPMO_NEW_MSG_ID

The MQ PUT message options are applied when the message is placed in 
the outbound queue.

MQ Unrecognized 
Response URI

Enter the URI representing the queue to which unrecognized response 
messages should be sent. Note that this setting is enabled only when the 
Auto-generate Correlation Value check box is selected.

If you do not specify a value for this field, unrecognized response messages 
are deleted.

Process RFH2 Headers Select this option to parse WebSphere MQ RFH2 headers from a message 
payload and automatically generate an RFH2Headers transport header 
containing the RFH2 data.

If you do not select this option, the payload is passed through as received.

Table 16-14  Create/Edit a Business Service - MQ Transport Configuration Page (Continued)

Option To create or edit...
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Business Service - Summary page.

SB Transport Configuration page
The Create/Edit a Business Service - SB Transport Configuration page is one in a series of 
pages for creating and editing business services, as described in “Creating and Configuring 
Business Services” on page 16-1 and “Editing Business Service Configurations” on page 16-46.

For more information, see the SB Transport User Guide.

Use this page to configure transport settings for a business service using the SB (Service Bus) 
transport protocol. Table 16-15 describes how to use the page.

After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Business Service - Summary page.

Table 16-15  Create/Edit a Business Service - SB Configuration Page 

Option To create or edit...

Dispatch policy Select the instance of WebLogic Server Work Manager that you want to use for the 
dispatch policy for this endpoint. The default Work Manager is used if no other 
Work Manager exists. For information about Work Managers, see Using 
Work Managers to Optimize Scheduled Work and Create Global Work 
Managers in the WebLogic Server Administration Console Online Help.

Timeout The amount of time in seconds it takes the service to time out.

Note: The timeout will be ignored when the quality of service is Exactly-Once.

Service Account Click Browse and select a service account from the list displayed. If no service 
account is specified, an anonymous subject is used.

For more information:
• “Service Accounts” on page 14-1
• “Adding Service Accounts” on page 14-4
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SFTP Transport Configuration page
The Create/Edit a Business Service - SFTP Transport Configuration page is one in a series 
of pages for creating and editing business services, as described in “Creating and Configuring 
Business Services” on page 16-1 and “Editing Business Service Configurations” on page 16-46.

For more information, see the HTTP and Poller Transports User Guide.

Use this page to configure transport settings for a business service using the sftp transport 
protocol. Table 16-16 describes how to use this page.

Table 16-16  Create/Edit a Business Service - SFTP Transport Configuration Page 

Option To create or edit...

User Authentication Select one of the following:
• Username Password Authentication - Specifies that a static service account is 

associated with this authentication method and the client is authenticated using 
the provided credentials.

• Host Based Authentication - Specifies that a user name and service key provider 
is required to use this authentication method. Any user connecting from a known 
host is authenticated using the private key of the host. 

• Public Key Authentication - Specifies that a user name and service key provider 
is required to use this authentication method. Every user has their own private 
key. 

Service Account Enter the service account for the user, or click Browse to select service accounts from 
a browser.

Service Key Provider This option is available only when Host Based or Public Key Authentication is 
selected.

Enter a service key provider in the Service Key Provider field. You can click 
Browse to select service key providers from a browser. This is a required field.

Username This option is available only when Host Based or Public Key Authentication is 
selected.

Enter the user name.

Timeout Enter the socket timeout interval, in seconds, before the connection is dropped. If you 
enter 0, there is no timeout. The default value is 60.

Prefix for destination 
File Name

Enter the prefix for the file name under which the file is stored on the remote server.
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Business Service - Summary page.

Tuxedo Transport Configuration page
The Create/Edit a Business Service - Tuxedo Transport Configuration page is one in a series 
of pages for creating and editing business services, as described in “Creating and Configuring 
Business Services” on page 16-1 and “Editing Business Service Configurations” on page 16-46.

For more information, see Oracle Service Bus Interoperability Solution for Tuxedo.

Use this page to configure transport settings for a business service using the Tuxedo transport 
protocol. Table 16-17 describes how to use the page.

Suffix for destination 
File Name

Enter the suffix for the file name under which the file is stored on the remote server.

Request Encoding Accept the default UTF-8 as the character set encoding for requests in SFTP 
transports.

Table 16-16  Create/Edit a Business Service - SFTP Transport Configuration Page 

Option To create or edit...

Table 16-17  Create/Edit a Business Service - Tuxedo Transport Configuration Page (Continued)

Option To create or edit...

Field Table 
Classes

Enter the name of the class or classes describing the FML/FML32 buffer received. 
These are used for the FML/FML32-to-XML conversion routines to map field 
names to element names. This is a space separated list of fully qualified class 
names.

View Classes Enter the name of the class or classes describing the VIEW/VIEW32 buffer 
received or sent. These are used for the VIEW-to-XML or VIEW32-to-XML 
conversion routines to map field names to element names. This is a space separated 
list of fully qualified class names.

Classes Jar Select a JAR Resource that contains a JAR file with the FML/FML32 or 
VIEW/VIEW32 classes necessary for this endpoint operation.
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Remote Access 
Point(s)

Select a remote access point from the drop down list that is associated with the 
Import. The list contains remote access points configured in WTC. A business 
service cannot be created if there is no associated remote access point.

If no remote access points exist or to create a new one, select New. Enter 
the corresponding Access Point Name and Network Address in the 
adjacent fields. Upon validation of the endpoint, the access point is added 
to the WTC configuration for each WTC server. If no WTC server exists, 
one is created.
If more than one URI has been specified, there will be one remote access point 
field per URI and the URI displays for informative purposes. If more than one URI 
exists, each requires a different remote access point. If the URI specified already 
corresponds to an existing WTC resource, the corresponding remote access point 
displays, but cannot be modified. 

Local Access 
Point(s)

This field appears only when you select New in the Remote Access Point field. 

From the drop-down list, select a local access point to be associated with the newly 
created remote access point. If none exist or to create a new one, select New. Enter 
the corresponding Local Access Point Name and Local Network Address in the 
adjacent fields.

Request Buffer 
Type

Select the type of buffer that the remote Tuxedo service will receive.

Request Buffer 
Subtype

This option is enabled if the previous Request Buffer Type value is VIEW or 
VIEW32. Enter the buffer subtype with which to associate the request buffer.

Response 
Required?

Select this check box to indicate a bidirectional call. If not checked, the underlying 
tpcall is invoked with TPNOREPLY flag, and a null response is posted 
asynchronously.

Suspend 
Transaction?

Select this check box to suspend the transaction, if it exists. This is useful when the 
remote service does not support transactions.

Table 16-17  Create/Edit a Business Service - Tuxedo Transport Configuration Page (Continued)

Option To create or edit...
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Business Service - Summary page.

WS Transport Configuration page
The Create/Edit a Business Service - WS Transport Configuration page is one in a series of 
pages for creating and editing business services, as described in “Creating and Configuring 
Business Services” on page 16-1 and “Editing Business Service Configurations” on page 16-46.

For more information, see the WS Transport User Guide.

Dispatch Policy Select the instance of WebLogic Server Work Manager that you want to use for the 
dispatch policy for this endpoint. The default Work Manager is used if no other 
Work Manager exists. 

This Work Manager is used to asynchronously post a null reply in the case of a 
one-way invocation. For information about Work Managers, see Using 
Work Managers to Optimize Scheduled Work and Create Global Work 
Managers in the WebLogic Server Administration Console Online Help.

Request Encoding Specify a character set encoding for requests in Tuxedo transports.

Response 
Encoding

Specify a character set encoding for responses in Tuxedo transports.

Timeout Specify the maximum amount of time (in seconds) that the transport run time waits 
for replies; an integer value that is greater than or equal to 0. If not specified or set 
to zero (default), replies will time out at BLOCKTIME, the maximum number of 
seconds that the local WTC access point allows for a blocking call.

Transformation 
Style

Select one of the following:
• None - (default) The order of fields may not be respected.
• Ordered - The fields are presented with all their occurrences in the correct 

order.
• Ordered and Grouped - If the fields are logically structured as records, the 

fields are ordered by occurrence and grouped by record.

Table 16-17  Create/Edit a Business Service - Tuxedo Transport Configuration Page (Continued)

Option To create or edit...
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Use this page to configure transport settings for a business service using the WS transport 
protocol. Table 16-18 describes how to use the page.

After you finish

Table 16-18  Create/Edit a Business Service - WS Transport Configuration Page 

Option To create or edit...

Response Timeout Enter the number of seconds to wait for a response.

Leaving this field blank indicates that there is no response timeout. The business 
service will wait for the duration of the sequence timeout configured in the RM 
policy. 

If you enter a zero (0) value, there is no timeout; as such, it will never time out.

Service Account Enter a service account or click Browse to select one from the list displayed. 

The service account specifies the credentials to use when there is an HTTP basic 
authentication policy on this service.

Advanced Settings

Queue Error Messages Select the check box to enable sending error messages to the configured error 
queue.

Error Queue URI This option is available only when the Queue Error Messages check box is 
selected.

Enter the URI of the JMS queue for storing error messages, in the following 
format:
jms://host:port/connFactoryJndiName/queueJndiName

JMS Error Queue Service 
Account

This option is available only when the Queue Error Messages check box is 
selected.

Enter a service account or click Browse to select one from the list displayed.

The service account specifies the credentials to use for JNDI lookups and sending 
error messages to the error queue.

Use SSL for Error Queue This option is available only when the Queue Error Messages check box is 
selected.

Select the check box to use SSL for connecting to the error queue.
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Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Business Service - Summary page.

SOAP Binding Configuration page
The Create/Edit a Business Service - SOAP Binding Configuration page is one in a series of 
pages for creating and editing business services, as described in “Creating and Configuring 
Business Services” on page 16-1 and “Editing Business Service Configurations” on page 16-46.

Use this page to configure the SOAP Binding for a business service based on a WSDL. 

Select Enforce WS-I Compliance to specify whether or not the service is to conform to the Basic 
Profile defined by the Web Services Interoperability Organization. This option is available for or 
SOAP 1.1 services only

When a service is marked WS-I compliant, checks are performed against the messages sent to and from that 
service. 

After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Business Service - Summary page.

Message Content Handling Configuration page
The Create/Edit a Business Service - Message Content Handling Configuration page is one 
in a series of pages for creating and editing business services, as described in “Creating and 
Configuring Business Services” on page 16-1 and “Editing Business Service Configurations” on 
page 16-46.

Use this page to specify how Oracle Service Bus is to encode outbound messages sent by business 
services and whether Oracle Service Bus should stream attachments in outbound response 
messages instead of buffering the attachment contents in memory.

Using this page, you can enable the business service to encode outbound messages in 
MTOM/XOP format. SOAP Message Transmission Optimization Mechanism (MTOM) is a 
method of sending binary data to and from Web services. MTOM uses XML-binary Optimized 
Packaging (XOP) to transfer the binary data.

Using this page, you can also enable the business service to store attachments in outbound 
response messages to a disk file and then process the data in a streaming fashion without 
buffering the attachment contents in memory. This enables the business service to process large 
attachments robustly and efficiently.
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After you finish

Table 16-19  Create/Edit a Business Service - Message Content Handling Configuration Page 

Option To create or edit...

XOP/MTOM Support Oracle Service Bus supports XOP/MTOM using the following transports:
• HTTP/S
• Local
• SB

Select the Enabled check box to enable the business service to encode outbound 
messages in MTOM/XOP format. Note that this option is disabled for imported 
business services that are based on previous release configurations.

If XOP/MTOM Support is enabled, select how to handle binary data in the $header 
and $body message context variables from among the following options:
• Include Binary Data by Reference: (Default) In an outbound response message, 

replace xop:Include elements with ctx:binary-content elements when setting up 
the $body message context variable.

• Include Binary Data by Value: In an outbound response message, replace 
xop:Include elements with Base64-encoded text versions of corresponding binary 
data when setting up the $body message context variable.

Note that if XOP/MTOM Support is enabled for a business service, it is not required 
that every outbound message be in the MTOM format. Instead, this setting specifies 
that the business service is capable of handling an MTOM payload. 

Since Oracle Service Bus does not support a combination of MTOM and SwA, the 
system issues a runtime error when Oracle Service Bus attempts to dispatch an 
outbound request to a business service and the business service is both 
MTOM/XOP-enabled and the $attachments message context variable is not null.

Attachments Oracle Service Bus supports streaming MIME attachments using the HTTP/S 
transport.

Select the Page Attachments to Disk check box to enable the business service to 
stream attachments in outbound response messages.

Note that if you enable XOP/MTOM Support, the Attachments option is only 
available if you choose the Include Binary Data by Reference option under 
XOP/MTOM Support. Note also that payloads that contain attachments must 
conform to RFC 822. Specifically, lines containing Internet headers need to be 
terminated with CRLF (carriage return line feed).
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Click Next to review and save this configuration on the Create/Edit a Business Service - 
Summary page.

Summary page
The Create/Edit a Business Service - Summary page is one in a series of pages for creating and 
editing business services, as described in “Creating and Configuring Business Services” on 
page 16-1 and “Editing Business Service Configurations” on page 16-46.

Use this page to view or modify the configuration settings for a business service before saving it. 

To view or modify settings, click Edit in the row of the appropriate category (for example, 
General Configuration, Transport Configuration, etc.). The pages you can edit depend on 
what pages you configured when creating the business service. The following list shows all 
pages:

“General Configuration page” on page 16-3

“Message Type Configuration page” on page 16-5

“Transport Configuration page” on page 16-7

“Protocol-Specific Transport Configuration page” on page 16-10

“BPEL-10g Transport Configuration Page” on page 16-11

“DSP Transport Configuration page” on page 16-14

“EJB Transport Configuration page” on page 16-15

“E-Mail Transport Configuration page” on page 16-17

“File Transport Configuration page” on page 16-18

“Flow Transport Configuration page” on page 16-18

“FTP Transport Configuration page” on page 16-19

“HTTP Transport Configuration Page” on page 16-20

“JCA Transport Configuration Page” on page 16-23

“JMS Transport Configuration page” on page 16-26

“JPD Transport Configuration page” on page 16-30
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“MQ Transport Configuration page” on page 16-31

“SB Transport Configuration page” on page 16-35

“SFTP Transport Configuration page” on page 16-36

“Tuxedo Transport Configuration page” on page 16-37

“WS Transport Configuration page” on page 16-39

Exporting a WSDL Associated with a Business Service
You can export the WSDL of a WSDL-based business service, so you can view or modify the 
WSDL in an external tool such as an IDE. The WSDL is exported as a JAR file.

Note that this is different than the Export Resources functionality in the System Administration 
module, which you use to move and stage resources between two domains. See “Exporting 
Resources” on page 26-7.

Before you begin

You can only export a WSDL when you are outside a session. See “Using the Change Center” on 
page 2-2.

To export a WSDL

1. Do either of the following:

– Select Resource Browser > Business Services to display the Summary of Business 
Services page.

– Select Project Explorer, then select the project or folder containing the business 
service you want to export as a WSDL. The Project/Folder View page is displayed.

2. Click the  Export WSDL icon in the row of the business service whose WSDL you want 
to export. A dialog box prompts you to open or save the exported JAR file.

3. In the dialog box, click Open to open the file, or click Save to save it. 

Locating Business Services
1. Do either of the following:

– Select Project Explorer to display the Projects View page or the Project/Folder View 
page. Then navigate through projects and folders to find the business service.
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– Select Resource Browser > Business Services. The Summary of Business Services 
page displays the information shown in Table 16-20. For a more detailed description of 
the properties, see “Editing Business Service Configurations” on page 16-46.

2. To restrict the number of items in the list, you can filter by name, path, or both. In the Name 
and Path fields, under Search, enter the name and/or path of the target(s), then click the 
Search button. 

The path is the project name and the name of the folder in which the business service 
resides. 

Wildcard characters * and ? are allowed. Search is case-sensitive.

Click View All to display all business services in the domain. This clears the search 
parameters from the previous search.

Table 16-20  Summary of Business Services Page 

Property Description

Name A unique name for the business service. Click the name to display the View a 
Business Service - Configuration Details page. 

See “Editing Business Service Configurations” on page 16-46.

Path The path is the project name and the name of the folder in which the business 
service resides, for example, UDDI/BusServices/OSB_services.

Click the path of a business service to display the Project/Folder View page that 
contains it.
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Editing Business Service Configurations
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

You don’t have to enter a session if you only want to view details.

2. Locate the business service you want to view or edit, as explained in “Locating Business 
Services” on page 16-44.

3. Click the business service name. The View a Business Service - Configuration Details page 
displays configuration information for the selected business service.

Actions Do any of the following:

• Click the  Launch Test Console icon to invoke the Test Console, which 
you use to validate and test the design of your services and transformations. 
For business services, you can only use the Test Console at run time; that is, 
when the session is activated. For transformations, you can use the Test 
Console whether you are inside or outside a session. See “Testing Services” 
on page 30-1 and “Testing Transformations” on page 30-17.

• The  Export WSDL icon is displayed for WSDL-based business 
services. Click this icon to export a WSDL, which you can then view or 
modify in an external tools such as an IDE. See 
Note that this is different than the Export Resources functionality in the 
System Administration module, which you use to move and stage resources 
between two domains. See “Exporting a WSDL” on page 3-24.

• The  Generate WSDL icon is displayed for transport-typed business 
services, such as EJB and Flow. Click this icon to generate a WSDL, which 
you can then view or modify. See “Generating a WSDL” on page 3-25

Options
• Click the  Delete icon to delete the service. A  Deletion Warning 

icon is displayed when other resources reference this resource. You can 
delete the resource with a warning confirmation. This might result in 
conflicts due to unresolved references to the deleted resource. For more 
information, see “Deleting Business Services” on page 16-57.

Table 16-20  Summary of Business Services Page 

Property Description
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4. To view or modify settings, do either of the following:

– Click the  Edit icon next to the name of the category whose properties you want to 
view or edit (for example, General Configuration, Transport Configuration, etc.). 
The pages you can edit depend on what pages you configured when creating the 
business service. 

For a list of all those pages, see “View a Business Service - Configuration Details 
page” on page 16-47.

– Click Edit at the bottom of the page to display the Create/Edit a Business Service - 
General Configuration page, which is the first page in the sequence of pages for 
configuring this business service. 

5. Continue to view or edit, as described in “Creating and Configuring Business Services” on 
page 16-1.

6. On the Edit a Business Service - Summary page, click Save to commit the updates in the 
current session. 

7. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

View a Business Service - Configuration Details page
The View Business Service - Configuration Details page displays the configuration details of a 
business service. Table 16-21 describes all the properties that can appear on this page. (Properties 
vary depending on the details of the business service.)

The categories listed on this page correspond to the Create/Edit a Business Service pages used 
for creating and editing business service configurations, as described in “Create/Edit a Business 
Service - Page Reference” on page 16-2. 

Click the Edit link next to any category name to display the associated configuration page.
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Table 16-21  View a Business Service: Configuration Details Page 

Properties Description

Last Modified By The user who created this business service or imported it into the 
configuration.

Last Modified On The date and time that the user created this business service or imported 
it into the configuration. Click the date and time link to view the change 
history of this resource. See “View Change History page” on page 3-21.

References The number of objects that this business service references. If such 
references exist, click the numeric link to view a list of the objects. To 
learn more, see “Viewing References to Resources” on page 3-20.

Referenced by The number of objects that reference this business service. If such 
references exist, click the numeric link to view a list of the objects. To 
learn more, see “Viewing References to Resources” on page 3-20.

Description A description of this business service, if one exists.

General Configuration - Shows properties configured on the General Configuration page.

Service Type The service type

Message Type Configuration- Shows properties configured on the Message Type Configuration page.

Request Message Type A message type for the request message: None, Binary, Text, MFL, or 
XML.

Response Message Type A message type for the response message: None, Binary, Text, MFL, or 
XML.

Transport Configuration - Shows properties configured on the Transport Configuration page.

Protocol The transport protocol

Load Balancing Algorithm The load balancing algorithm

Endpoint URI The endpoint URI

Retry Count The retry count

Retry Interval The retry interval
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BPEL-10g Transport Configuration - Shows properties configured on the BPEL-10g Transport 
Configuration Page.

DSP Transport Configuration - Shows properties configured on the DSP Transport Configuration 
page.

Debug Level Specifies the output of debug information.

Service Account If you selected one, a service account for this transport.

Dispatch Policy Refers to the instance of WLS Work Manager that you want to use for the 
service endpoint.

EJB Transport Configuration - Shows properties configured on the EJB Transport Configuration page.

Pass Caller’s Subject Whether Oracle Service Bus is to pass the authenticated subject from the 
proxy service when invoking the EJB and no service accounts are 
configured.

Service Account The service account selected for this business service.

Supports Transaction Selecting the check box indicates Yes. Transactions will be supported.

Client Jar* The name of the client JAR that this EJB transport service invokes.

Converter Jar The name of the converter class JAR that this EJB transport service 
requires.

Home Interface* The Home interface URI selected for this service.

Remote Interface* The Remote Interface URI for the service.

Target Namespace* The target namespace picked from the JAR information.

Style Whether the service uses Document Wrapped or RPC Style.

Encoding Whether the coding for the outbound message should be encoded or 
literal.

Methods A list of methods to be invoked by this service. 

E-Mail Transport Configuration - Shows properties configured on the E-Mail Transport Configuration 
page.

Table 16-21  View a Business Service: Configuration Details Page 

Properties Description
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Mail Server Address The SMTP server for this service

Service Account The service account for this mail server

Mail Session The mail session for this service

From Name The originating display name for this service

From Address The originating address for this service

Reply to Name The reply to display name for this service

Reply to Address The reply to address for this service

Request Encoding The character set encoding for requests in E-mail transports.

File Transport Configuration - Shows properties configured on the File Transport Configuration page.

Prefix A prefix that is prepended to the file name.

Suffix A suffix that is appended to the file.

Request Encoding The character set encoding for requests in File transports.

Flow Transport Configuration - Shows properties configured on the Flow Transport Configuration 
page.

Timeout The number of seconds to wait for a response before timing out.

FTP Transport Configuration - Shows properties configured on the FTP Transport Configuration 
page.

User Authentication The user authentication method: anonymous or externally configured 
account.

Identity (E-mail id) or 
Service Account

The mail ID for an anonymous user or service account for an externally 
configured account.

Timeout The socket timeout, in seconds.

Prefix for destination File 
Name

The prefix for the file name under which the file is stored on the remote 
server.

Table 16-21  View a Business Service: Configuration Details Page 

Properties Description
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Suffix for destination File 
Name

The suffix for the file name under which the file is stored on the remote 
server.

Transfer Mode The transfer mode: Binary or ASCII.

Request Encoding The character set encoding for requests in FTP transports.

HTTP Transport Configuration - Shows properties configured on the HTTP Transport Configuration 
Page.

Timeout The amount of time in seconds it takes the service to time out.

HTTP Request Method The HTTP request method.

Basic Authentication 
Required

Whether or not basic authentication is required: displays Enabled if it is 
required.

Follow HTTP Redirects Whether or not a re-direct occurs when you send an outbound request to 
the URL of a business service, and that service returns a response code 
(for example, 302) that says the URL is no longer valid and this request 
needs to be sent to another URL. Displays Enabled if Oracle Service Bus 
automatically re-sends the request to the new URL without any action on 
your part.

Service Account If you selected one, a service account for this transport.

Request Encoding The character set encoding for requests in HTTP transports.

Response Encoding The character set encoding for responses in HTTP transports.

Proxy Server The proxy server resource configured for the business service.

JCA Transport Configuration - Shows properties configured on the JCA Transport Configuration 
Page.

JMS Transport Configuration - Shows properties configured on the JMS Transport Configuration 
page.

Destination Type The destination type: Queue or Topic.

Use SSL Displays Enabled if the requests are made over a TLS/SSL connection.

Message Type The message type: Text or Bytes.

Table 16-21  View a Business Service: Configuration Details Page 

Properties Description
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Expiration The expiration or time-to-live value for a message, in seconds. If it is 0, 
the message never expires.

Is Response Required Whether or not a response is expected after an outbound message is sent.

Response URI A response URI in the format 
jms://host:port/factoryJndiName/destJndiName.

To target multiple servers, use the following URI format: 
jms://host1:port,host2:port/QueueConnectionFactory
/DestName

Response Timeout The amount of time to wait for the response, in seconds.

Unit of Order The Message Unit-of-Order that enables message producers to group 
messages into a single unit with respect to the processing order. This 
single unit requires that all messages from that unit be processed 
sequentially in the order they were created.

Pass Caller’s Subject Whether Oracle Service Bus is to pass the authenticated subject when 
sending a message.

Request Encoding The character set encoding for requests in JMS transports.

Response Encoding The character set encoding for responses in JMS transports.

JMS service account The service account to use for the JMS resource managed by the JMS 
server.

JPD Transport Configuration - Shows properties configured on the JPD Transport Configuration page.

System Service Account The service account to use for the invocation of the WLI stateless session 
bean.

Process Service Account The service account to use for the invocation of the JPD.

Callback Proxy Location The location of the proxy service for receiving callbacks from the JPD.

Dispatch Policy Refers to the instance of WLS Work Manager that you want to use for the 
outbound response.

Propagate Transaction Whether or not to propagate the existing transaction within Oracle 
Service Bus to the JPD.

Table 16-21  View a Business Service: Configuration Details Page 

Properties Description
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MQ Transport Configuration - Shows properties configured on the MQ Transport Configuration page.

SB Transport Configuration - Shows properties configured on the SB Transport Configuration page.

Dispatch Policy Refers to the instance of WLS Work Manager that you want to use for the 
service endpoint.

Service Account A service account for this transport.

Timeout The socket timeout, in seconds.

SFTP Transport Configuration - Shows properties configured on the SFTP Transport Configuration 
page.

Authentication Mode The authentication method: Username Password, Host-Based, or Public 
Key Authentication.

Service Account The service account for this sftp server.

Service Key Provider The service key provider for this sftp server.

Username The user name for this sftp server.

Timeout The socket timeout, in seconds.

Prefix for destination File 
Name

The prefix for the file name under which the file is stored on the remote 
server.

Suffix for destination File 
Name

The suffix for the file name under which the file is stored on the remote 
server.

Request Encoding Displays the character set encoding for requests in SFTP transports. The 
default is utf-8.

Tuxedo Transport Configuration - Shows properties configured on the Tuxedo Transport 
Configuration page.

Field Table Classes The space separated list of fully qualified FML Files class names for 
buffer mapping.

View Classes The space separated list of fully qualified View class names for buffer 
mapping.

Table 16-21  View a Business Service: Configuration Details Page 

Properties Description
Using the Oracle Service Bus Console 16-53



Business  Serv ices :  Crea t ing  and  Managing
Classes Jar A JAR Resource that contains a JAR file with the FML/FML32 or 
VIEW/VIEW32 classes necessary for the endpoint operation.

Remote Access Point for 
URI

The remote access point for the URI Endpoint associated with the WTC 
Import Service.

Request Buffer Type The buffer type: CARRAY, FML, FML32, MBSTRING, STRING, 
VIEW, VIEW32, X_COMMON, X_C_TYPE, XML, X_OCTET.

Request Buffer Subtype The buffer subtype with which to associate the reply buffer if the buffer 
type is VIEW or VIEW32.

Response Required Selecting the check box indicates Yes. A response is required. Otherwise, 
no response is required.

Suspend Transaction Selecting the check box indicates Yes. If a transaction exists, it will be 
suspended. Otherwise the transaction will run.

Dispatch Policy Refers to the instance of WLS Work Manager that you want to use for the 
service endpoint.

Request Encoding The character set encoding for requests in Tuxedo transports.

Response Encoding The character set encoding for responses in Tuxedo transports.

Timeout The maximum amount of time (in seconds) that the transport run time 
waits for replies.

Transformation Style The ordering or grouping of elements when FML or FML32 buffers are 
transformed into XML.

WS Transport Configuration - Shows properties configured on the WS Transport Configuration page.

Response Timeout The amount of time to wait for the response, in seconds.

Service Account The service account to use when there is an HTTP basic authentication 
policy on this service.

Queue Error Messages Whether or not to send error messages to the configured error queue.

Error Queue URI The error queue URI in the format:
jms://host:port/connFactoryJndiName/queueJndiName

Table 16-21  View a Business Service: Configuration Details Page 

Properties Description
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View a Business Service - Policies page
The View a Business Service - Policies Configuration page is one in a series of pages for editing 
business services, as described in “Creating and Configuring Business Services” on page 16-1 
and “View a Business Service - Configuration Details page” on page 16-47.

Use this page to configure policy settings for a business service that has a WSDL-based policy or 
that uses custom policy bindings (both WSDL-based and Any SOAP services). Table 16-22 
describes how to use the page.

Note that for WSDL-based services, all policies bound to the service are exposed (inlined) in the 
effective WSDL, regardless of which binding model is used. Abstract policies are pre-processed 
before they are inlined.

JMS Error Queue Service 
Account

The service account to use for JNDI lookups and sending error messages 
to the error queue.

Use SSL for Error Queue Displays Enabled if the requests are made over a TLS/SSL connection.

Message Content Handling Configuration - Shows properties configured on the Message Content 
Handling Configuration page.

XOP/MTOM Support Indicates whether the business service is Enabled or Disabled to encode 
outbound messages in MTOM/XOP format.

If the business service is enabled for XOP/MTOM Support, the field 
displays whether the binary data is included By Reference or By Value.

Attachments Indicates whether the business service is configured to Page 
Attachments to Disk to stream attachments in outbound response 
messages.

Table 16-21  View a Business Service: Configuration Details Page 

Properties Description
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After you finish

Click Update to save this configuration; or click Reset to undo your changes.

Table 16-22  View a Business Service - Policies Page 

Option To edit...

Service Policy 
Configuration

There are two options in the Service Policy Configuration field: 
• WSDL-Based Policy, in which one or more Web Services Policy 

(WS-Policy) statements in a WSDL document express the business 
service's message-level security requirements. 

• Custom Policy Bindings, in which you add service-level policies, 
operation-level policies (in which case the policy applies to both the 
request and response messages), request policies, and response policies 
from the console.

Note: The two policy binding models are mutually exclusive. If you bind 
policies directly to the service, all WSDL-based policies are 
ignored. 

Service Level Policies 
(Custom Policy Bindings 
Only)

To specify policies that apply to the entire service, expand the service name 
entry. Click Add to search for and select your policies.

You can select from your own existing WS-Policy resources, or from 
predefined policies.

You can bind multiple policies to the service. 

Update the policy binding. 

Operation Level Policies 
(WSDL-Based Policy 
Only)

Provides a read-only view of the request and response policies from the 
WSDL. 

Operation Level Policies 
(Custom Policy Bindings 
Only)

To specify policies that apply to an operation, the request/response of that 
operation, or any request or any response in the case of Any SOAP 
services, expand the operation name entry. Click Add to search for and 
select your policies.

You can select from your own existing WS-Policy resources, or from 
predefined policies.

You can bind multiple policies to the service. 

Update the policy binding.
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View a Business Service - Security page
The View a Business Service - Security Configuration page is one in a series of pages for 
editing business services, as described in “Creating and Configuring Business Services” on 
page 16-1 and “View a Business Service - Configuration Details page” on page 16-47.

All policies bound to the service are exposed (inlined) in the effective WSDL, regardless of which 
binding model is used. Abstract policies are pre-processed before they are inlined. 

Use this page to configure security settings for a business service that has a WSDL-based policy 
or that uses custom policy bindings. Table 16-23 describes how to use the page.

After you finish

Click Update to save this configuration; or click Reset to undo your changes.

Deleting Business Services
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Resource Browser > Business Services to display the Summary of Business 
Services page.

3. Click the  Delete icon in the row of the business service you want to delete. The business 

service is deleted in the current session. A  Deletion Warning icon is displayed when other 
resources reference this resource. You can delete the resource with a warning confirmation. This might 
result in conflicts due to unresolved references to the deleted resource.

Table 16-23  View a Business Service - Security Page 

Option To edit...

Service Account Click Browse and select a service account from the list displayed. If no 
service account is specified, an anonymous subject is used.

For more information:
• “Specifying Service Accounts” on page 14-1
• “Adding Service Accounts” on page 14-4
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4. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 
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Proxy Services: Creating and Managing
Proxy services are Oracle Service Bus definitions of services implemented locally on WebLogic 
Server. 

For more information, see Proxy Service and Business Service Configuration in Oracle Service 
Bus User Guide.

Creating and Configuring Proxy Services
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Project Explorer, then select the project or folder to which you want to add the proxy 
service. 

3. On the Project/Folder View page, select Proxy Service from the Create Resource drop-down 
list. 

4. On the General Configuration page, provide a name for the service and select the type of 
service to create.

5. Click Next. The pages that follow depend on the choices you made on the first page. Enter 
the appropriate information on each of the subsequent pages, until you reach the summary 
page, then click Save to save the service in the current session.

For detailed instructions on completing each page, see the following:

– “General Configuration page” on page 17-3
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– “Message Type Configuration page” on page 17-6

– “Transport Configuration page” on page 17-8

– “Protocol-Specific Transport Configuration Pages” on page 17-12

– “E-Mail Transport Configuration page” on page 17-12

– “File Transport Configuration page” on page 17-14

– “FTP Transport Configuration page” on page 17-16

– “HTTP Transport Configuration Page” on page 17-18

– “JCA Transport Configuration Page” on page 17-20

– “JMS Transport Configuration page” on page 17-24

– “MQ Transport Configuration page” on page 17-28

– “SB Transport Configuration page” on page 17-31

– “SFTP Transport Configuration page” on page 17-32

– “Tuxedo Transport Configuration page” on page 17-34

– “WS Transport Configuration page” on page 17-37

– “Operation Selection Configuration page” on page 17-38

– “Message Content Handling page” on page 17-41

– “Summary page” on page 17-44

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

7. After you create a proxy service, the next step is to configure its message flow. The message 
flow defines the implementation of a proxy service. To learn more, see “Creating, Editing, 
and Viewing Message Flows” on page 18-1.

Create/Edit a Proxy Service - Page Reference
Create a proxy service by selecting Proxy Service from the Create Resource drop-down list on 
the Project/Folder View page. When you select that option, it displays the first in a series of pages 
for configuring and adding proxy services. The pages displayed vary, depending on the options 
you choose along the way. The pages are:

“General Configuration page” on page 17-3
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“Message Type Configuration page” on page 17-6

“Transport Configuration page” on page 17-8

“Protocol-Specific Transport Configuration Pages” on page 17-12

“E-Mail Transport Configuration page” on page 17-12

“File Transport Configuration page” on page 17-14

“FTP Transport Configuration page” on page 17-16

“HTTP Transport Configuration Page” on page 17-18

“JCA Transport Configuration Page” on page 17-20

“JMS Transport Configuration page” on page 17-24

“MQ Transport Configuration page” on page 17-28

“SB Transport Configuration page” on page 17-31

“SFTP Transport Configuration page” on page 17-32

“Tuxedo Transport Configuration page” on page 17-34

“WS Transport Configuration page” on page 17-37

“Operation Selection Configuration page” on page 17-38

“Message Content Handling page” on page 17-41

“Summary page” on page 17-44

General Configuration page
The Create/Edit a Proxy Service - General Configuration page is one in a series of pages for 
creating and editing proxy services, as described in “Creating and Configuring Proxy Services” 
on page 17-1 and “Editing Proxy Service Configurations” on page 17-47.

Use this page to modify general configuration settings for a proxy service. 

When you create a proxy service, this is the first page displayed in a series of pages for 
configuring the service. The pages displayed after this one differ depending on the choices you 
make on this page.

Table 17-1 describes how to use the page.
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Table 17-1  Create/Edit a Proxy Service - General Configuration Page 

Option To create or edit...

Service Name Enter a unique name for the proxy service.

Description Enter a description.
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Service Type Select the type of proxy service to create:
• WSDL Web Service - Select this option to create a proxy service based on a 

WSDL. Then enter the WSDL name, qualified by its path (for example, 
myProject/myFolder/myWSDL). Alternatively, click Browse to select a 
WSDL from the Select a WSDL Definition page.
(port or binding) - Enter the name of a port (defined in the WSDL) to describe 
an actual transport address, or enter the name of a binding (defined in the WSDL) 
to map to a transport address. If you use Browse to select a WSDL, the Select a 
WSDL Definition page lists any defined ports and bindings. 

Note: If you are going to use the SOAP Body Type for operations, ensure that the 
WSDL does not have two operations with the same input message. The 
SOAP Body Type operation cannot be uniquely identified by inspecting the 
input message.

• Messaging Service - Select this option to create a service that can receive 
messages of one data type and respond with messages of a different data type. 
These exchanges can be either request/response or one-way. 
(HTTP GET is supported only in the Any XML Service and Messaging Service 
service types.)

• Any SOAP Service - Select this option to create a SOAP service that does not 
have an explicitly defined, concrete interface.
Select SOAP 1.1 or SOAP 1.2 from the drop-down list to specify the SOAP 
version to be used.

• Any XML Service - Select this option to create an XML service that does not 
have an explicitly defined, concrete interface.
(HTTP GET is supported only in the Any XML Service and Messaging Service 
service types.)

• Business Service - Select this option to create a proxy service with a route node 
that routes to the business service you select. You cannot create a proxy service 
from a transport typed business service. If you create a proxy service from a DSP 
transport business service, Oracle Service Bus switches the transport type of the 
proxy service to HTTP, because the DSP transport cannot be used for proxy 
services. You can change the transport type of the proxy service to any other 
available transport.
Enter the path (project/folder) and the name of the business service; or 
click Browse to select the business service from the Select Business Service 
page.

• Proxy Service - Select this option to clone an existing proxy service. Since 
Oracle Service Bus does not accept the same URI for multiple services, you must 

Table 17-1  Create/Edit a Proxy Service - General Configuration Page (Continued)

Option To create or edit...
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Proxy Service - Summary page.

Message Type Configuration page
The Create/Edit a Proxy Service - Message Type Configuration page is one in a series of 
pages for creating and editing proxy services, as described in “Creating and Configuring Proxy 
Services” on page 17-1 and “Editing Proxy Service Configurations” on page 17-47.

Use this page to configure message types for a proxy service whose type is Messaging Service. 

Service Type 
(continued)

Note: When a service is created from another service, alert rules are maintained in 
the following way:

– When a proxy service is created from a business service or a business 
service is created from a proxy service, the alert rules, if any, are removed.

– When a proxy service is created from another proxy service or a business 
service is created from another business service, the alert rules, if any, are 
retained.

Service Key 
Provider

If needed, enter the path (project/folder) and name of a service key provider, or 
click Browse to select one from the Select Service Key Provider page.

A service key provider is only required in certain cases: 
• Outbound two-way TLS/SSL, where the proxy service routes messages to 

HTTPS services that require client-certificate authentication.
• In some Web Service security scenarios, for example, if the proxy service 

requires messages to be encrypted. 

To add a Web service security-enabled proxy service, you must create the proxy 
service from a WSDL (port or binding) with WS-Policy attachments. 

For more information, see “Service Key Providers” on page 15-1. To learn how to 
create a service key provider, see “Adding Service Key Providers” on page 15-2. 

Publish to 
Registry

This option appears only when a default UDDI registry exists. 
Select this option to publish the proxy service to the default registry automatically. 
For more information, see “Using Auto-Publish” on page 27-10.

Table 17-1  Create/Edit a Proxy Service - General Configuration Page (Continued)

Option To create or edit...
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The binding definition for messaging services consists of configuring the content-type of the 
messages that are exchanged. The content-type for the response does not have to be the same 
as for the request; therefore, the response is configured separately (for example, the service could 
accept an MFL message and return an XML acknowledgment receipt).

Note: E-mail, File, FTP, or SFTP transport proxy services whose type is Messaging Service 
support one-way messaging only; the Response Message Type should be none. If you 
select an option other than none, the E-mail, File, FTP, or SFTP protocols will not be 
available on the Transport Configuration page.

Table 17-2 describes how to use Create/Edit a Proxy Service - Message Type Configuration 
page.

Table 17-2  Create/Edit a Proxy Service - Message Type Configuration Page 

Option To create or edit...

Request Message Type Select a message type for the request message:
• None - Select this option if there is no request message.
• Binary - Select this option if the content-type of the message is 

unknown or not important.
• Text - Select this option if the message can be restricted to text.
• MFL - Select this option if the message is a binary document 

conforming to an MFL definition. Enter the MFL file name 
(qualified by its path), or click Browse to select a file.
You can configure only one MFL file.
Note: To support multiple MFL files, define the content as binary or 
text and use the MFL action in the message flow to convert to XML.

• XML - Select this option if the message is an XML document. Enter 
the XML file name (qualified by its path), or click Browse to select 
a file. 
Optionally provide some type information by declaring (in the 
element or type field) the XML schema type of the XML document 
exchanged.
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Proxy Service - Summary page.

Transport Configuration page
The Create/Edit a Proxy Service - Transport Configuration page is one in a series of pages 
for creating and editing proxy services, as described in “Creating and Configuring Proxy 
Services” on page 17-1 and “Editing Proxy Service Configurations” on page 17-47.

Use this page to select a transport protocol for the proxy service and to set other general transport 
configuration settings. Table 17-3 describes how to use the page.

Note: Inbound transport-level security applies to the client applications and Oracle Service Bus 
proxy services. Outbound transport-level security applies to the connections between 
Oracle Service Bus proxy services and business services. To learn more about 
transport-level security, see Configuring Transport-Level Security in the Oracle Service 
Bus Security Guide. 

Response Message Type Select a message type for the response message:
• None - Select this option if there is no response message.
• Binary - Select this option if the content-type of the message is 

unknown or not important.
• Text - Select this option if the message can be restricted to text.
• MFL - Select this option if the message is a binary document 

conforming to an MFL definition. Enter the MFL file name 
(qualified by its path), or click Browse to select a file.
You can configure only one MFL file.
Note: To support multiple MFL files, define the content as binary or 
text and use the MFL action in the message flow to convert to XML.

• XML - Select this option if the message is an XML document. Enter 
the XML file name (qualified by its path), or click Browse to select 
a file. 
Optionally provide some type information by declaring (in the 
element or type field) the XML schema type of the XML document 
exchanged.

Table 17-2  Create/Edit a Proxy Service - Message Type Configuration Page (Continued)

Option To create or edit...
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Table 17-3  Create/Edit a Proxy Service - Transport Configuration Page 

Option To create or edit...

Protocol Select a transport protocol from the list. The protocols available differ, depending on the 
service type you are creating:
• WSDL Web Service: http, jca, jms, local, sb, ws
• Messaging Service: email, file, ftp, http, jms, local, mq (if available), sftp, tuxedo
• Any SOAP Service: http, jms, local, sb
• Any XML Service: email, file, ftp, http, jms, local, mq (if available), sb, sftp, tuxedo
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Endpoint URI Enter an endpoint URI in the format based on the transport protocol you selected in the 
Protocol field, above: The formats are:
• email - mailfrom:mail-server-hostname:mail-server-port 
• file - file:///drivename:/somename
• ftp - ftp://hostname:port/directory
• http - someName

The HTTP transport supports both HTTP and HTTPS endpoints.
• jca - jca://<resource_adapter_jndi>
• jms - jms://host:port/factoryJndiName/destJndiName

To target a target a JMS destination to multiple servers, use the following URI format:
jms://host1:port,host2:port/QueueConnectionFactory/DestName

Note that when you create a proxy service, you can configure a JMS endpoint URI 
even if the server at that endpoint if not available. However, in the case of JMS, when 
you activate the session, the endpoint must be available. To learn more, see 
“Activating Sessions” on page 2-3.
In a cluster: The host names in the JMS URI must exactly match the host 
names of the cluster servers as they are configured in WebLogic Server.

• local
This transport does not require an endpoint URI.

• mq - 
mq://<local-queue-name>?conn=<mq-connection-resource-ref>

local-queue-name is the name of the MQ queue from which the proxy service 
reads messages.
mq-connection-resource-ref is the path (project/folder) and name of the MQ 
connection resource; for example, default/my_MQconnection.

Note: The Endpoint URI cannot contain spaces, so do not create MQ 
Connection resources or projects/folders with spaces in the names.

To make the MQ transport available in Oracle Service Bus, see “MQ Connections” on 
page 8-1.

• sb - service_name
service_name is the unique identifier for the proxy service. By default, this name 
will be the proxy service name. 
service_name must only contain characters permitted in URIs (as described in 
RFC2396), except it cannot contain forward slash (/) or colon (:) characters.

• sftp - sftp://hostname:port/directory

Table 17-3  Create/Edit a Proxy Service - Transport Configuration Page (Continued)

Option To create or edit...
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After you finish

Endpoint URI 
(continued)

• tuxedo - exportname
The URI exportname corresponds to a WTC Export that the remote Tuxedo domain 
identifies as a Tuxedo service.
If more than one URI is specified, you must have unique resource names for the 
endpoints. If no remote name is specified, its value is the value of the resource name. 
If no remote name is entered or if remote and resource name are the same, only one 
URI is allowed. In this case resource name and remote name will have the same value. 
This allows users using already defined WTC Imports to make use of WTC 
load-balancing and failover.
Note: If you configure two identical URIs, an error indicates that the service name 
already exists.

• ws - /contextPath
contextPath must be unique for proxy services that use either HTTP or WS 
transport.

Get All Headers Select Yes to retrieve all the headers from the transport.

Select No to retrieve a defined set of headers. If you select No, enter a set of headers in the 
Header field, then click Add. (This step does not apply to Local transport.)

Note: Oracle Service Bus does not pass the HTTP Authorization header from the request 
to the pipeline because it opens a security vulnerability. You could inadvertently 
create a log action that writes the user name and unencrypted password to a log 
file. If your design pattern requires the HTTP Authorization header to be in the 
pipeline, do the following: 
 
a. In the startup command for Oracle Service Bus, set the following system 
property to true: 
com.bea.wli.sb.transports.http.GetHttpAuthorizationHeade
rAllowed  
 
b. In the Oracle Service Bus Console, on the Transport Configuration page, select 
Get All Headers or select User-specified Headers and specify Authorization.  
c. Restart Oracle Service Bus. 
 
Oracle Service Bus will pass the Authorization header to the pipeline.

Table 17-3  Create/Edit a Proxy Service - Transport Configuration Page (Continued)

Option To create or edit...
Using the Oracle Service Bus Console 17-11



Proxy  Serv ices :  Crea t ing  and Managing
Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Proxy Service - Summary page.

Protocol-Specific Transport Configuration Pages
The Create/Edit a Proxy Service - Transport-Type Configuration pages are each one in a 
series of pages for creating and editing proxy services, as described in “Creating and Configuring 
Proxy Services” on page 17-1 and “Editing Proxy Service Configurations” on page 17-47.

This page differs, depending on what kind of transport you chose to configure. It can be:

“E-Mail Transport Configuration page” on page 17-12

“File Transport Configuration page” on page 17-14

“FTP Transport Configuration page” on page 17-16

“HTTP Transport Configuration Page” on page 17-18

“JMS Transport Configuration page” on page 17-24

“MQ Transport Configuration page” on page 17-28

“SB Transport Configuration page” on page 17-31

“SFTP Transport Configuration page” on page 17-32

“Tuxedo Transport Configuration page” on page 17-34

“WS Transport Configuration page” on page 17-37

E-Mail Transport Configuration page
The Create/Edit a Proxy Service - E-Mail Transport Configuration page is one in a series of 
pages for creating and editing proxy services, as described in “Creating and Configuring Proxy 
Services” on page 17-1 and “Editing Proxy Service Configurations” on page 17-47.

Use this page to configure transport settings for a proxy service using the e-mail transport 
protocol. Table 17-4 describes how to use the page.
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Table 17-4  Create/Edit a Proxy Service - E-Mail Transport Configuration Page 

Option To create or edit...

Service Account Enter a service account name, or click Browse to select service accounts from a 
browser.

Managed Server This field is available only in a clustered domain.

Select the Managed Server to act as the polling server. All of the Managed Servers 
can process the message, but only one can poll for the message.

Polling Interval Enter a polling interval, in seconds.

E-Mail Protocol Select POP3 or IMAP as the server type for the e-mail account.

Read Limit Specify the maximum number of messages to read per polling sweep. Enter 0 to 
specify no limit.

Pass By Reference Select this check box to stage the file in the archive directory and pass it as a 
reference in the headers.

By default when you create a new service, the Pass By Reference option is selected 
and you must specify the archive directory location.

Pass Attachments 
by Reference

Select this check box to stage the attachments in the archive directory and pass them 
as a reference in the headers.

By default, when the Pass By Reference option is selected, the Pass Attachments 
By Reference option is implicitly true and you must specify the archive directory 
location.

Post Read Action Select what happens to a message after it has been read:
• Archive - The message is archived.
• Delete - The message is deleted.
• Move - The message is moved. Move is only available with the IMAP protocol. 

Attachments Select how attachments are handled:
• Archive - Attachments are saved to the archive directory.
• Ignore - Attachments are ignored. 

IMAP Move 
Folder

Enter the folder to which the message is moved if the Post Read Action field is set 
to Move.
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Proxy Service - Summary page.

File Transport Configuration page
The Create/Edit a Proxy Service - File Transport Configuration page is one in a series of 
pages for creating and editing proxy services, as described in “Creating and Configuring Proxy 
Services” on page 17-1 and “Editing Proxy Service Configurations” on page 17-47.

Use this page to configure transport settings for a proxy service using the file transport protocol. 
Table 17-5 describes how to use this page.

Download 
Directory

Enter a temporary location for downloading e-mails.

Archive Directory Specify the path to the archive location if the Post Read Action field is set to 
Archive. 

This field is required if the Pass By Reference or Pass Attachments By Reference 
option is selected.

Error Directory Enter the file system directory path to write the message and any attachments if 
there is a problem.

Request Encoding Accept the default ISO-8859-1 as the character set encoding for requests in 
E-mail transports, or enter a different character set encoding.

Table 17-5  Create/Edit a Proxy Service - File Transport Configuration Page 

Option To create or edit...

File Mask Enter the regular expression for the files to be picked. The default is *.*.

Managed Server This field is available only in a clustered domain.

Select the Managed Server to act as the polling server. All of the Managed Servers 
can process the message, but only one can poll for the message.

Polling Interval Enter a polling interval, in seconds. The default is 60. 

Table 17-4  Create/Edit a Proxy Service - E-Mail Transport Configuration Page (Continued)

Option To create or edit...
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Proxy Service - Summary page.

Read Limit Specify the maximum number of messages to read per polling sweep. Enter 0 to 
specify no limit. The default is 10.

Sort By Arrival Select this check box to specify that events are delivered in the order of arrival.

Note that when this option is selected for a proxy service that is executed in a 
clustered environment, messages are always sent to the same server. In other words, 
load balancing across servers is ignored when this option is selected.

Scan 
Subdirectories

Select this check box to recursively scan all the directories.

Pass By Reference Select this check box to stage the file in the archive directory and pass it as a 
reference in the headers.

Post Read Action Select what happens to a message after it has been read:
• Archive - The message is archived.
• Delete - The message is deleted. 

Stage Directory Enter an intermediate directory to temporarily stage the files while processing them.

Do not put the stage directory inside of the polling directory (the directory identified 
in the URL of the file transport proxy service; for example, file:///c:/dir1/dir2).

Archive Directory Specify the path to the archive location if the Post Read Action option is set to 
Archive. The Archive Directory field is also a required field if you have selected 
the Pass By Reference field.

Do not put the archive directory inside of the polling directory.

Error Directory Enter the location where messages and attachments are posted if there is a problem. 

Do not put the error directory inside of the polling directory.

Request Encoding Accept the default UTF-8 as the character set encoding for requests in file 
transports, or enter a different character set encoding.

Table 17-5  Create/Edit a Proxy Service - File Transport Configuration Page (Continued)

Option To create or edit...
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FTP Transport Configuration page
The Create/Edit a Proxy Service - FTP Transport Configuration page is one in a series of 
pages for creating and editing proxy services, as described in “Creating and Configuring Proxy 
Services” on page 17-1 and “Editing Proxy Service Configurations” on page 17-47.

Use this page to configure transport settings for a proxy service using the ftp transport protocol. 
Table 17-6 describes how to use this page.

Table 17-6  Create/Edit a Proxy Service - FTP Transport Configuration Page 

Option To create or edit...

User 
Authentication

Select anonymous if the user of the FTP server is anonymous, or select external 
user if the user of the FTP server is an externally configured account.

Identity (E-Mail 
ID)

This field is available only if the User Authentication option is set to anonymous.

Enter the mail ID for the anonymous user.

Service Account This field is available only if the User Authentication option is set to external 
user.

Enter the service account for the user. This is a required field when the User 
Authentication option is set to external user.

Pass By Reference Select this check box to stage the file in the archive directory and pass it as a 
reference in the headers.

Remote Streaming Select this check box to stream the FTP files directly from the remote server at the 
time of processing. When you select this option, the archive directory is the remote 
directory on the remote FTP server machine. Therefore, you should specify the 
archive directory as relative to the FTP user directory.

File Mask Enter the regular expression for the files to be picked. The default is *.*.

Managed Server This field is available only in a clustered domain.

Select the Managed Server to act as the polling server. All of the Managed Servers 
can process the message, but only one can poll for the message.

Polling Interval Enter a polling interval, in seconds. The default is 60. 

Read Limit Specify the maximum number of messages to read per polling sweep. Enter 0 to 
specify no limit. The default is 10. 
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After you finish

Post Read Action Select what happens to a message after it has been read. 
• Archive - The message is archived.
• Delete - The message is deleted. 

Transfer Mode Select ASCII or binary as the transfer mode.

Archive Directory Specify the path to the archive location if the Post Read Action option is set to 
Archive. This field is required if the Pass By Reference option is selected.

Note: The Archive, Download, and Error directories are absolute paths, and they 
are automatically created. If you specify a relative path, the files are 
created relative to the Java process that starts the WebLogic Server.

Download 
Directory

Enter the directory on your local machine where files are downloaded during the 
file transfer.

Note: The Archive, Download, and Error directories are absolute paths, and they 
are automatically created. If you specify a relative path, the files are 
created relative to the Java process that starts the WebLogic Server.

Error Directory Enter the location where messages are posted if there is a problem.

Note: The Archive, Download, and Error directories are absolute paths, and they 
are automatically created. If you specify a relative path, the files are 
created relative to the Java process that starts the WebLogic Server.

Request Encoding Accept the default UTF-8 as the character set encoding for requests in FTP 
transports.

Advanced Settings

Scan 
Subdirectories

Select this check box to recursively scan all directories

Sort By Arrival Select this check box to deliver events in the order of arrival.

Timeout Enter the socket timeout interval, in seconds, before the connection is dropped. If 
you enter 0, there is no timeout.

Retry Count Specify the number of retries for FTP connection failures.

Table 17-6  Create/Edit a Proxy Service - FTP Transport Configuration Page (Continued)

Option To create or edit...
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Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Proxy Service - Summary page.

HTTP Transport Configuration Page
The HTTP transport now supports both HTTP and HTTPS endpoints.

The Create/Edit a Proxy Service - HTTP Transport Configuration page is one in a series of 
pages for creating and editing proxy services, as described in “Creating and Configuring Proxy 
Services” on page 17-1 and “Editing Proxy Service Configurations” on page 17-47.

Use this page to configure transport settings for a proxy service using the HTTP transport 
protocol. Table 17-7 describes how to use the page.

Table 17-7  Create/Edit a Proxy Service - HTTP Transport Configuration Page 

Option To create or edit...

HTTPS required Select this check box for inbound HTTPS endpoints.

To learn more, see Configuring Transport-Level Security in the Oracle Service 
Bus Security Guide.
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Authentication Select one of the following:
• None - Specifies that authentication is not required.
• Basic - Specifies that basic authentication is required to access this service.

Basic authentication instructs WebLogic Server to authenticate the client using 
a user name and password against the authentication providers configured in 
the security realm, such as a Lightweight Directory Access Protocol (LDAP) 
directory service and Windows Active Directory. The client must send its user 
name and password on the HTTP request header.
Basic authentication is strongly discouraged over HTTP because the password 
is sent in clear text. However, it is safe to send passwords over HTTPS because 
HTTPS provides an encrypted channel.
Warning: By default, all users (authorized and anonymous) can access a 
proxy service. To limit the users who can access a proxy service, create a 
transport-level authorization policy. See “Editing Transport-Level Access 
Policies” on page 22-16.

• Client Certificate - Specifies encrypted communication and strong client 
authentication (two-way SSL). To learn more, see Configuring 
Transport-Level Security in the Oracle Service Bus Security Guide.

• Custom Authentication - Specifies that an authentication token is contained 
in an HTTP header. The client's identity is established through the use of this 
client-supplied token. You must configure an Identity Assertion provider that 
maps the token to an Oracle Service Bus user.
The custom authentication token can be of any active token type supported by 
a configured WebLogic Server Identity Assertion provider.

Dispatch Policy Select a dispatch policy for this endpoint. Leave blank to use the default dispatch 
policy.

Dispatch policy refers to the instance of WLS Work Manager that you want to use 
for the service endpoint. For information about Work Managers, see Using 
Work Managers to Optimize Scheduled Work and Create Work Manager 
in the WebLogic Server Administration Console Online Help.

Table 17-7  Create/Edit a Proxy Service - HTTP Transport Configuration Page (Continued)

Option To create or edit...
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Proxy Service - Summary page.

JCA Transport Configuration Page
Use this page to configure transport settings using the JCA transport protocol. For more 
information on using the JCA transport, see the JCA Transport User Guide.

Request Encoding • For HTTP inbound transports:
If the character set encoding parameter of the Content-Type header is not 
specified in Client Request, enter a character set encoding parameter. If you do 
not enter a value, the field defaults to ISO-8859-1.

• For HTTP outbound transports:
If you have not configured a request encoding, the Oracle Service Bus run time 
decides the most appropriate encoding while it makes a request to the business 
service. In the case of a non-passthrough scenario, the default character 
encoding is UTF-8 at run time. However if it is a passthrough scenario, the run 
time will pass through the encoding received with the outbound response. 

Response 
Encoding

Accept the default ISO-8859-1 as the character set encoding for responses in 
HTTP transports, or enter a different character set encoding.

Advanced Settings

Authentication 
Header

Enter the HTTP header (any except Authorization) from which Oracle 
Service Bus is to extract the token. This field is available only if you selected the 
Custom Authentication check box.

For example, client-xyz-token. 

Authentication 
Token Type

Select an authentication token type. Only the active token types configured for an 
Identity Assertion provider are available. (See Configuring Identity Assertion 
Providers for Custom Tokens for more information.) This field is available only if 
you selected the Custom Authentication check box.

Table 17-7  Create/Edit a Proxy Service - HTTP Transport Configuration Page (Continued)

Option To create or edit...
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Table 17-8  JCA transport configuration 

Option Description

Adapter Name A read-only value showing the name of the adapter that the JCA service will 
use.

Adapter Type A read-only value showing the adapter type.

Dispatch Policy Select the instance of WebLogic Server Work Manager that you want to use 
for the dispatch policy for this endpoint. The default Work Manager is used if 
no other Work Manager exists.

For information about Work Managers, see the following WebLogic Server 
Administration Console Online Help topics:
• Using Work Managers to Optimize Scheduled Work
• Create Global Work Managers

JNDI Service Account JNDI Service Account is for JNDI context security, used to access the EIS 
adapter managed connection factory. Click Browse and select a service 
account. If no service account is specified, an anonymous subject is used.

For JCA business services, there is no restriction on the type of JNDI service 
account that can be configured, such as static or pass-through, but the run time 
must be able to access a user name and password. JCA proxy services can use 
only static JNDI service accounts.

For more information on JNDI service accounts, see “Security” in the JCA 
Transport User Guide.
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Always use 
configuration from JCA 
WSDL

This option determines whether or not connection factory properties, 
activation spec properties (proxy services), and interaction spec properties 
(business services) are always used from the WSDL.

If this option is selected (default), the JCA transport interacts with the JCA 
framework in the following ways, depending on whether you are using 
managed or non-managed mode:
• Managed mode – The activation/interaction spec defined in the JCA 

WSDL. The Activation/Interaction Spec Properties field is read-only; and 
if Connection Mode is set to Managed, the Connection Factory Properties 
field is read-only.

• Non-managed mode – Connection factory properties defined in the JCA 
WSDL. The Activation/Interaction Spec Properties field is read-only.

If this option is deselected, you can override the Activation/Interaction Spec 
Properties of the WSDL; and in non-managed mode you can override the 
Connection Factory Properties of the WSDL. At run time the JCA transport 
interacts with the JCA framework using the JCA WSDL and any 
activation/interaction spec or connection factory overrides you have provided.

For more information on using this option, see “Endpoint Redeployment” in 
the JCA Transport User Guide.

Connection Mode This option determines how the service connects to the associated JCA 
adapter for the EIS system.

Managed – Recommended for production. The JCA transport connects to the 
JCA adapter through the JCA adapter-managed connection factory configured 
in WebLogic Server. For authentication, specify a JNDI service account. If no 
JNDI service account is specified, an anonymous subject is used. In managed 
mode, Connection Factory Authentication Properties are read-only.

Non-Managed – The JCA transport connects to the JCA adapter through the 
JCA adapter framework, which acts as a container for the JCA adapter. For 
authentication, specify a JNDI service account. If no JNDI service account is 
specified, an anonymous subject is used. In non- managed mode, Connection 
Factory Authentication Properties are editable for overrides.

Note: If you want to change from Non-Managed mode to Managed mode, 
be sure to deselect the Overwrite Connection Authentication 
Properties option before changing modes.

Table 17-8  JCA transport configuration (Continued)

Option Description
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Overwrite Connection 
Authentication 
Properties

This option indicates whether or not the user name/password in the adapter 
connection factory is overwritten by the Connection Authentication Service 
Account credentials. If no JNDI Service Account is specified, an anonymous 
subject is used.

This option, which is displayed only if the connection factory properties 
contain user name/password properties, is available in non-managed mode 
with “Always use configuration from JCA WSDL” deselected.

Connection 
Authentication Service 
Account

This field is enabled if “Overwrite Connection Authentication Properties” is 
enabled and selected. This service account browser displays available service 
accounts. If the “Overwrite Connection Authentication Properties” option is 
selected, you must select a service account. For proxy services, only static 
service accounts are available.

This field if displayed only if the connection factory properties contain user 
name password properties.

Connection Factory 
Authentication 
Properties

This field is displayed only if the Connection Factory Properties contain a user 
name and password. This field is always read-only.

Connection Factory 
Properties

This field shows the connection factory properties from the WSDL’s 
<jca:address> element.

Development and Testing: You can override this value if you deselect 
“Always use configuration from JCA WSDL” and make the Connection 
Mode Non-Managed. In production environments, use managed mode, which 
makes the JCA transport connect to the adapter connection factory configured 
in WebLogic Server.

Operation Name Displays a read-only name of the selected WSDL operation. An operation can 
have its own activation/interaction spec properties, shown in the 
Activation/Interaction Spec Properties field.

Table 17-8  JCA transport configuration (Continued)

Option Description
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JMS Transport Configuration page
The Create/Edit a Proxy Service - JMS Transport Configuration page is one in a series of 
pages for creating and editing proxy services, as described in “Creating and Configuring Proxy 
Services” on page 17-1 and “Editing Proxy Service Configurations” on page 17-47.

For more information, see the Oracle Service Bus Interoperability Solutions for JMS.

Use this page to configure transport settings for a proxy service using the JMS transport protocol. 
Table 17-9 describes how to use the page.

Activation/Interaction 
Spec Properties

“Activation Spec Properties” is the field name for proxy services; “Interaction 
Spec Properties” is the field name for business services.

If this service is an inbound service invoked by an EIS application, this field 
displays the activation spec properties for the JCA inbound operation shown 
in Operation Name field.

You can override the activation/interaction spec properties if you deselect 
“Always use configuration from JCA WSDL.”

Note: For Oracle Adapter Suite adapters, activation/interaction spec 
properties are displayed as read-only. The Oracle Adapter Suite 
adapters store their own configurations, which you must change in 
the Oracle Adapter Suite management tools.

TopLink File Browser For Oracle Database or Oracle Applications adapters that depend on a 
database, use this field to select a TopLink mapping file from the file system. 
The content of the TopLink mapping file is displayed in an editable text box.

Generate a TopLink mapping file in Oracle JDeveloper and import it into 
Oracle Service Bus.

Table 17-9  Create/Edit a Proxy Service - JMS Transport Configuration Page 

Option To create or edit...

Destination Type Select one of the following:
• Queue (for a point-to-point destination type)
• Topic (for a publish/subscribe destination)

Table 17-8  JCA transport configuration (Continued)

Option Description
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Is Response Required This option is available only when Queue is selected for the Destination 
Type.

Select this option to specify that a response is expected after an outbound 
message is sent. 

Response Correlation 
Pattern

This option is available only when the Is Response Required check box 
is selected.

Select one of the following: 
• Select JMSMessageID for JAX-RPC services running on 

WebLogic Server 9.2.
• Select JMSCorrelationID for all other services. When you select 

this option, you must also enter a Response URI, below.

Response URI This option is available only when JMSCorrelationID is selected for the 
Response Correlation Pattern.

Enter a response URI in the format:

  jms://host:port/factoryJndiName/destJndiName

To target multiple servers, use the following format:
  jms://host1:port,host2:port/QueueConnectionFacto
ry/DestName

Response Connection 
Factory

This option is available only when JMSMessageID is selected for the 
Response Correlation Pattern.

Enter a response connection factory URI.

If a connection factory is not specified, the connection factory for the 
request is used for the response.

Response Message Type This option is available only when the Is Response Required check box 
is selected.

Select one of the following:
• Bytes (for a stream of uninterpreted bytes)
• Text (for text messages)

Request Encoding Accept the default UTF-8 as the character set encoding for requests in 
JMS transports, or enter a different character set encoding.

Table 17-9  Create/Edit a Proxy Service - JMS Transport Configuration Page (Continued)

Option To create or edit...
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Response Encoding This option is available only when the Is Response Required check box 
is selected.

Accept the default UTF-8 as the character set encoding for responses in 
JMS transports, or enter a different character set encoding.

Client Response Timeout This option is available only when the Is Response Required check box 
is selected.

Enter the number of seconds to wait for a server response before 
dropping the connection. This only applies if the client is another proxy 
service in the same domain.

Dispatch Policy Select a dispatch policy for this endpoint. Default signifies the default 
dispatch policy.

Dispatch policy refers to the instance of WLS Work Manager that you 
want to use for the service endpoint to process the request. For example, 
if the proxy service has a JMS transport protocol, the proxy service 
endpoint is an MDB (message-driven bean) JAR file that you can 
associate with the specific dispatch policy. 

Advanced Settings

Use SSL Select only if the requests are made over a TLS/SSL connection. 

TLS/SSL (Secure Sockets Layer) provides secure connections by 
allowing two applications connecting over a network to authenticate the 
other's identity and by encrypting the data exchanged between the 
applications. Authentication allows a server, and optionally a client, to 
verify the identity of the application on the other end of a network 
connection. Additionally, if the administrator has restricted access to 
individual JMS destinations (queues or topics) by setting access control 
on the JNDI entry for the destination, the Business Service must 
authenticate when looking up the entry in the JNDI tree with a user name 
and password.

Message Selector Enter a message selector expression. 

Only messages with properties matching the expression are processed

Table 17-9  Create/Edit a Proxy Service - JMS Transport Configuration Page (Continued)

Option To create or edit...
17-26 Using the Oracle Service Bus Console



Create /Ed i t  a  Proxy  Se rv ice  -  Page  Refe rence
Durable Subscription  This option is available only if Topic is selected for the Destination 
Type.

Select this check box if the subscription is durable or leave it blank if the 
subscription is not durable

Retry Count Enter the number of delivery retries a message can have before it is 
moved to the error destination. This field only applies to WebLogic 
Server JMS destinations.

Retry Interval Enter the amount of time, in milliseconds, before rolled back or 
recovered messages are redelivered. This field only applies to WebLogic 
Server JMS destinations.

Error Destination Enter the name of the target destination for messages that have reached 
their redelivery limit. This field only applies to WebLogic Server JMS 
destinations.

Expiration Policy Select an Expiration Policy to use when an expired message is 
encountered on a destination. This field only applies to WebLogic Server 
JMS destinations.

Is XA Required Select this check box if your connection factory is XA.

This value is taken into account when the remote connection factory is 
unavailable. If your connection factory is available and this value is true, 
make sure that the connection factory is defined as transactional.

Synchronous Transactional Select this check box to have the response pipeline inherit the transaction 
from the request pipeline. This means that the transaction will not 
commit until both pipelines have completed.

This field is enabled only when the Is Response Required field is 
checked.

Synchronous Transactional consumes a request thread until the response 
thread is completed.

JMS Service Account Select a service account to use for the JMS resource managed by the JMS 
server. A service account is an alias resource for a User ID and its 
associated password. The same service account is used for both JNDI and 
JMS purposes. To learn more about service accounts, see “Service 
Accounts” on page 14-1.

Table 17-9  Create/Edit a Proxy Service - JMS Transport Configuration Page (Continued)

Option To create or edit...
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Proxy Service - Summary page.

MQ Transport Configuration page
The Create/Edit a Proxy Service - MQ Transport Configuration page is one in a series of 
pages for creating and editing proxy services, as described in “Creating and Configuring Proxy 
Services” on page 17-1 and “Editing Proxy Service Configurations” on page 17-47.

For more information, see the MQ Transport User Guide.

Before you begin

Configure a MQ Connection resource. See “MQ Connections” on page 8-1.

To configure the MQ transport

Use this page to configure transport settings for a proxy service using the native MQ transport 
protocol. Table 17-10 describes how to use the page.

Table 17-10  Create/Edit a Proxy Service - MQ Transport Configuration Page 

Option To create or edit...

Polling Interval Enter a polling interval, in milliseconds. The default is 1000.

Is Response Required Select this option to specify that a response is expected after an outbound 
message is sent. 

Response Correlation 
Pattern

This option is available only when the Is Response Required check box 
is selected.

Specify whether the response correlation pattern should be based on 
MessageID or CorrelationID.

MQ Response URI This option is available only when the Is Response Required check box 
is selected.

The destination to which the response should be published. Enter a 
response URI in the same format as the endpoint URI: 
mq://<local-queue-name>?conn=<mq-connection-resourc
e-ref>

For more detailed information, see the MQ Transport User Guide.
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Response Message Type This option is available only when the Is Response Required check box 
is selected.

Select one of the following:
• Bytes (for a stream of uninterpreted bytes)
• Text (for text messages)

Client Response Timeout This option is available only when the Is Response Required check box 
is selected.

Enter the number of seconds to wait for a response before dropping the 
connection. 

Dispatch Policy This option is available only when the Is Response Required check box 
is selected.

Select a dispatch policy for this endpoint. 

Dispatch policy refers to the instance of WLS Work Manager that you want 
to use for the service endpoint. For information about work managers, see 
Using Work Managers to Optimize Scheduled Work and Create Work 
Manager in the WebLogic Server Administration Console Online Help.

Backout Threshold Enter a value representing the number of times the pipeline should retry a 
message before redirecting the message to the queue specified in the Dead 
Letter URI field.

If you do not specify a value for this field, the message is redirected to the 
dead letter queue without attempting any retries.

MQ Dead Letter URI Enter the URI of the dead letter queue to which request messages should 
be redirected after attempting the number of retries specified in the 
Backout Threshold field.

If you do not specify a value for this field, the message is discarded after 
retrying the number of times specified in the Backout Threshold field. 
The Dead Letter URI uses the same format as the EndPoint URI.

Table 17-10  Create/Edit a Proxy Service - MQ Transport Configuration Page (Continued)

Option To create or edit...
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Endpoint URI ‘GET’ 
options

Enter the MQ GET message options from among the following:
• MQC.MQGMO_ACCEPT_TRUNCATED_MSG
• MQC.MQGMO_ALL_MSGS_AVAILABLE
• MQC.MQGMO_BROWSE_FIRST
• MQC.MQGMO_BROWSE_NEXT
• MQC.MQGMO_COMPLETE_MSG
• MQC.MQGMO_CONVERT
• MQC.MQGMO_FAIL_IF_QUIESCING
• MQC.MQGMO_LOCK
• MQC.MQGMO_LOGICAL_ORDER
• MQC.MQGMO_MARK_BROWSE_CO_OP
• MQC.MQGMO_MARK_SKIP_BACKOUT
• MQC.MQGMO_NO_SYNCPOINT
• MQC.MQGMO_NONE
• MQC.MQGMO_NO_WAIT
• MQC.MQGMO_SYNCPOINT
• MQC.MQGMO_SYNCPOINT_IF_PERSISTENT
• MQC.MQGMO_UNLOCK
• MQC.MQGMO_UNMARK_BROWSE_CO_OP
• MQC.MQGMO_UNMARK_BROWSE_HANDLE
• MQC.MQGMO_UNMARKED_BROWSE_MSG
• MQC.MQGMO_VERSION_1
• MQC.MQGMO_VERSION_2
• MQC.MQGMO_VERSION_3
• MQC.MQGMO_WAIT

You can use either “|” or “+” to separate multiple options. For example, 
you can specify the following:

MQC.MQGMO_ACCEPT_TRUNCATED_MSG | 
MQC.MQGMO_LOCK

The MQ GET message options are applied when reading a message from 
the inbound queue.

Table 17-10  Create/Edit a Proxy Service - MQ Transport Configuration Page (Continued)

Option To create or edit...
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Proxy Service - Summary page.

SB Transport Configuration page
The Create/Edit a Proxy Service - SB Transport Configuration page is one in a series of pages 
for creating and editing proxy services, as described in “Creating and Configuring Proxy 
Services” on page 17-1 and “Editing Proxy Service Configurations” on page 17-47.

For more information, see the SB Transport User Guide.

Use this page to configure transport settings for a proxy service using the SB (Service Bus) 
transport protocol. Table 17-11 describes how to use the page.

Process RFH2 Headers Select this option to parse WebSphere MQ RFH2 headers from a message 
payload and automatically generate an RFH2Headers transport header 
containing the RFH2 data.

If you do not select this option, the payload is passed through as received.

Table 17-11  Create/Edit a Proxy Service - SB Transport Configuration Page 

Option To create or edit...

Dispatch Policy Select a dispatch policy for this endpoint or use the default dispatch 
policy.

Dispatch policy refers to the instance of WLS Work Manager that you 
want to use for the service endpoint to process the request. For 
information about Work Managers, see Using Work Managers to 
Optimize Scheduled Work and Create Work Manager in the 
WebLogic Server Administration Console Online Help.

Use SSL When specified, requests must be sent over an SSL connection. 

However, unsecured connections are not forbidden. The administrator 
must close all unsecured protocols on the server (for example, t3 or http) 
to strictly enforce secured client connections. 

Table 17-10  Create/Edit a Proxy Service - MQ Transport Configuration Page (Continued)

Option To create or edit...
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Proxy Service - Summary page.

SFTP Transport Configuration page
The Create/Edit a Proxy Service - SFTP Transport Configuration page is one in a series of 
pages for creating and editing proxy services, as described in “Creating and Configuring Proxy 
Services” on page 17-1 and “Editing Proxy Service Configurations” on page 17-47.

For more information, see the HTTP and Poller Transports User Guide.

Use this page to configure transport settings for a proxy service using the sftp transport protocol. 
Table 17-12 describes how to use this page.

Table 17-12  Create/Edit a Proxy Service - SFTP Transport Configuration Page 

Option To create or edit...

User Authentication Select one of the following:
• Username Password Authentication - Specifies that a static service account is 

associated with this authentication method and the client is authenticated using 
the provided credentials.

• Host Based Authentication - Specifies that a user name and service key provider 
is required to use this authentication method. Any user connecting from a known 
host is authenticated using the private key of the host. 

• Public Key Authentication - Specifies that a user name and service key provider 
is required to use this authentication method. Every user has their own private 
key. 

Service Account Enter the service account for the user, or click Browse to select service accounts from 
a browser.

Service Key Provider This option is available only when Host Based or Public Key Authentication is 
selected.

Enter a service key provider in the Service Key Provider field. You can click 
Browse to select service key providers from a browser. This is a required field.

Username This option is available only when Host Based or Public Key Authentication is 
selected.

Enter the user name.
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Pass By Reference Select this check box to stage the file in the archive directory and pass it as a reference 
in the headers.

Remote Streaming Select this check box to stream the SFTP files directly from the remote server at the 
time of processing. When you select this option, the archive directory is the remote 
directory on the remote SFTP server machine. Therefore, you should specify the 
archive directory as relative to the SFTP user directory.

File Mask Enter the regular expression for the files to be picked. The default is *.*.

Managed Server This field is available only in a clustered domain.

Select the Managed Server to act as the polling server. All of the Managed Servers 
can process the message, but only one can poll for the message.

Polling Interval Enter the interval in seconds at which the file is polled from the specified location. 
The default is 60. 

Read Limit Specify the maximum number of messages to read per polling sweep. Enter 0 to 
specify no limit. The default is 10. 

Post Read Action Select what happens to a message after it has been read. 
• Archive - The message is archived.
• Delete - The message is deleted. 

Archive Directory Specify the path to the archive location if the Post Read Action option is set to 
Archive. This field is required if the Pass By Reference option is selected.

Note: The Archive, Download, and Error directories are absolute paths, and they 
are automatically created. If you specify a relative path, the files are created 
relative to the Java process that starts the WebLogic Server.

Download Directory Enter the directory on your local machine where files are downloaded during the file 
transfer.

Note: The Archive, Download, and Error directories are absolute paths, and they 
are automatically created. If you specify a relative path, the files are created 
relative to the Java process that starts the WebLogic Server.

Table 17-12  Create/Edit a Proxy Service - SFTP Transport Configuration Page (Continued)

Option To create or edit...
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Proxy Service - Summary page.

Tuxedo Transport Configuration page
The Create/Edit a Proxy Service - Tuxedo Transport Configuration page is one in a series of 
pages for creating and editing proxy services, as described in “Creating and Configuring Proxy 
Services” on page 17-1 and “Editing Proxy Service Configurations” on page 17-47. 
For more information, see Oracle Service Bus Interoperability Solution for Tuxedo.

Use this page to configure transport settings for a proxy service using the Tuxedo transport 
protocol. Table 17-13 describes how to use the page.

Error Directory Enter the location where messages are posted if there is a problem.

Note: The Archive, Download, and Error directories are absolute paths, and they 
are automatically created. If you specify a relative path, the files are created 
relative to the Java process that starts the WebLogic Server.

Request Encoding Accept the default UTF-8 as the character set encoding for requests in SFTP 
transports.

Advanced Settings

Scan Subdirectories Select this check box to recursively scan all directories

Sort By Arrival Select this check box to deliver events in the order of arrival.

Timeout Enter the socket timeout interval, in seconds, before the connection is dropped. If you 
enter 0, there is no timeout. The default value is 60.

Retry Count Specify the number of retries for SFTP connection failures.

Table 17-12  Create/Edit a Proxy Service - SFTP Transport Configuration Page (Continued)

Option To create or edit...
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Table 17-13  Create/Edit a Proxy Service - Tuxedo Transport Configuration Page 

Option To create or edit...

Field Table 
Classes

Enter the name of the class or classes describing the FML/FML32 buffer received. 
These are used for the FML/FML32-to-XML conversion routines to map field 
names to element names. This is a space separated list of fully qualified class 
names.

View Classes Enter the name of the class or classes describing the VIEW/VIEW32 buffer 
received or sent. These are used for the VIEW-to-XML or VIEW32-to-XML 
conversion routines to map field names to element names. This is a space separated 
list of fully qualified class names.

X_C_TYPE and X_COMMON Tuxedo buffer types are handled in the same manner 
as VIEW/VIEW32 buffers.

If an incoming request contains a VIEW, then the corresponding VIEW class should 
be specified in the Oracle Service Bus CLASSPATH. 

Classes Jar Select a JAR resource that contains a JAR file with the FML/FML32 or 
VIEW/VIEW32 classes necessary for this endpoint operation.

Local Access 
Point

Select a local access point from the drop-down list that is associated with the 
export. The drop-down list contains local access points configured in WTC. A 
proxy service cannot be created if there is not an associated local access point.

If no local access points exist or to create a new one, select New. Enter the 
corresponding Local Access Point Name and Local Network Address in the 
adjacent fields. Upon validation of the endpoint, the access point is added to the 
WTC configuration for each WTC server. If no WTC server exists, one is created.

You can enter an existing access point name after selecting the New option. This 
causes the existing information to be updated with the new parameters. You can 
change only the host name and port number.
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Remote Access 
Point

This field appears only when you select New in the Local Access Point field. 

From the drop-down list, select a remote access point to be associated with the 
newly created local access point. If none exist or to create a new one, select New. 
Enter the corresponding Access Point Name and Network Address in the 
adjacent fields.

You can enter an existing access point name after selecting the New option. This 
causes the existing information to be updated with the new parameters. You can 
change only the host name and port number.

The remote access point will also be the authentication principal for the WTC 
connection for inbound requests. Optionally, you can create a user with the same 
access point ID in the default security realm to allow incoming calls. To do so, 
select Yes from the Create User? drop-down list. The password will be randomly 
generated using a temporary variable to avoid security issues.

Reply Buffer Type This option is available only if the Response Required? field is selected.

Select the type of buffer that the remote Tuxedo client will receive. 

Reply Buffer 
Subtype

This option is available only when the Response Required? option is selected and 
the Reply Buffer Type value is VIEW or VIEW32. 

Enter the buffer subtype with which to associate the reply buffer. 

Response 
Required? 

Select this check box if this service is expected to send a response. 

The default status is that this option is selected. 

This option is cleared and the unavailable if the service type is Messaging Service 
and the response message type is None. 

Request Encoding Specify a character set encoding for requests in Tuxedo transports.

Response 
Encoding

Specify a character set encoding for responses in Tuxedo transports.

Transformation 
Style

Select one of the following:
• None - (default) The order of fields may not be respected.
• Ordered - The fields are presented with all their occurrences in the correct 

order.
• Ordered and Grouped - If the fields are logically structured as records, the 

fields are ordered by occurrence and grouped by record.

Table 17-13  Create/Edit a Proxy Service - Tuxedo Transport Configuration Page (Continued)

Option To create or edit...
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Proxy Service - Summary page.

WS Transport Configuration page
The Create/Edit a Proxy Service - WS Transport Configuration page is one in a series of 
pages for creating and editing proxy services, as described in “Creating and Configuring Proxy 
Services” on page 17-1 and “Editing Proxy Service Configurations” on page 17-47. 

For more information, see the WS Transport User Guide.

Use this page to configure transport settings for a proxy service using the WS transport protocol. 
Table 17-14 describes how to use the page.

Table 17-14  Create/Edit a Proxy Service - WS Transport Configuration Page 

Option To create or edit...

Dispatch Policy Select a dispatch policy for this endpoint or use the default dispatch policy.

Dispatch policy refers to the instance of WLS Work Manager that you want 
to use for the service endpoint. For information about Work Managers, 
see Using Work Managers to Optimize Scheduled Work and Create 
Work Manager in the WebLogic Server Administration Console Online 
Help.

Advanced Settings

Retry Count The number of times to retry delivery of a message to the pipeline.

If an unhandled exception occurs in the request pipeline of a proxy service, 
the incoming WS transport message will be redelivered to the pipeline up 
to the number of times specified by the retry count. This value is important 
for reliably processing WS transport messages.

Retry Delay The number of seconds the system pauses before retrying to send a 
message to the pipeline after an error.

Synchronous Select this check box to have the response pipeline inherit the transaction 
from the request pipeline. This means that the transaction will not commit 
until both pipelines have completed.

Synchronous consumes a request thread until the response thread is 
completed.
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Proxy Service - Summary page.

Operation Selection Configuration page
The Create/Edit a Proxy Service - Operation Selection Configuration page is one in a series 
of pages for creating and editing proxy services, as described in “Creating and Configuring Proxy 
Services” on page 17-1 and “Editing Proxy Service Configurations” on page 17-47. This page is 
displayed only if the service you are creating has operations.

Use this page to enforce WS-I compliance (for SOAP 1.1 services only) and select the selection 
algorithm to use to determine the operation called by this proxy service. This option is only 
available for SOAP or XML services defined from a WSDL. 

The WSDL specification defines a default algorithm to compute which operation is called based 
on the type of the SOAP message received. However, there are cases (for example, performance 
issues, signature/encryption issues, or the default algorithm is not applicable) when you may need 
to select the operation based on other means.

Oracle Service Bus provides additional algorithms. Each of them follows the same pattern and 
are based on the evaluation of an expression to get a value that is then used to lookup the 
corresponding operation in a static table.

Oracle Service Bus is generally very forgiving if an inbound message is either missing data such 
that the operation cannot be determined, or has data that does not correspond to a valid operation. 
Both of these conditions result in $operation being empty. Rather than reject all such messages, 
Oracle Service Bus does not initialize the operation variable in the context but otherwise 
continues to process the message.

However, security requirements are enforced if the proxy service is WSDL-based and at least one 
of the following conditions is true:

The WSDL has a WS-Security policy and the proxy is an active intermediary.

The proxy has message-level custom authentication (either custom token or 
username/password).

If these conditions are met, then there is a runtime check to make sure the operation selection 
algorithm returns a valid operation name. If the operation selection returns null or an operation 
that is not in the WSDL, then the message is rejected and an error is raised.
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Table 17-15 describes how to use the Create/Edit a Proxy Service - Operation Selection 
Configuration page.

Table 17-15  Create/Edit a Proxy Service - Operation Selection Configuration Page 

Option To create or edit...

Enforce WS-I 
Compliance

For SOAP 1.1 services only: 

Select this check box if you want to specify whether or not the service is to 
conform to the Basic Profile defined by the Web Services Interoperability 
Organization.

When a service is marked WS-I compliant, checks are performed against the 
messages sent to and from that service. For proxies, checks are performed 
against request messages received by the proxy. For invoked services (i.e. 
services invoked by a proxy via service callout action or route node), checks are 
performed against the response messages received from those services. Note 
that it is the WS-I compliance property of the invoked service and not the proxy 
that determines whether or not checks are performed against messages received 
from the invoked service. If you specify WS-I compliance testing for an invoked 
service, the message flow generates a fault for response errors. 
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Selection Algorithm Select one of the following and perform any required additional steps:
• Transport Header - Select this algorithm to define the transport header that 

contains the lookup value. Then:
– In the Header Name field, enter the transport header that extracts the 

value used as a key to select the operation being invoked.
– Under the Operation Mapping field, specify the value for each 

operation in the Value field. The value is used as the key of the 
operation. 

• SOAPAction Header - Select this algorithm to specify that operation 
mapping be done automatically from the WSDL associated with this proxy 
service.

• WS-Addressing - Select this algorithm to specify that the lookup value is 
contained by the WS-Addressing Action tag located in the SOAP headers 
of the SOAP message. Then, under the Operation Mapping field, specify 
the value for each operation in the Value field. The value is used as the key 
of the operation.

• SOAP Header - Select this algorithm to define an XPath expression to be 
evaluated against the SOAP headers. This allows you to get the lookup 
value. Then:
– In the XPath Expression field, specify the XPath expression that 

extracts the value used as a key to select the operation being invoked.
– Under the Operation Mapping field, specify the value for each 

operation in the Value field. The value is used as the key of the 
operation. 

• SOAP Body Type - This is the default algorithm defined by the WSDL 
specification to compute which operation is called based on the type of the 
SOAP message received.
If the proxy service is configured for a Web Service security pass-through 
scenario with an encrypted body, you cannot select this algorithm. A similar 
caveat applies to pass-through encrypted SOAP headers.
If you have a WSDL that has two operations with the same input message, 
do not select this algorithm for operations, because the operation cannot be 
uniquely identified by inspecting the input message.

• Payload Type - Available only for XML services based on a WSDL port or 
WSDL binding.

Table 17-15  Create/Edit a Proxy Service - Operation Selection Configuration Page (Continued)

Option To create or edit...
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After you finish

Click Next to continue configuring this service on the next page; or click Last to review and save 
this configuration on the Create/Edit a Proxy Service - Summary page.

Message Content Handling page
The Create/Edit a Proxy Service - Message Content Handling page is one in a series of pages 
for creating and editing proxy services, as described in “Creating and Configuring Proxy 
Services” on page 17-1 and “Editing Proxy Service Configurations” on page 17-47.

Use this page to specify whether the proxy service should stream message content, how the 
service is to decode request messages received and encode response messages sent, and whether 
the proxy service should stream MIME attachments instead of buffering the attachment contents 
in memory.

Using this page, you can enable the proxy service to stream message content rather than storing 
it in memory. You can also enable the proxy service to decode and parse inbound messages in 
MTOM/XOP format and to send responses using the MTOM/XOP format, when appropriate. 
SOAP Message Transmission Optimization Mechanism (MTOM) is a method of sending binary 
data to and from Web services. MTOM uses XML-binary Optimized Packaging (XOP) to 
transfer the binary data.

Header Name This option is available only when the Selection Algorithm option is set to 
Transport Header.

Enter the transport header that extracts the value used as a key to select the 
operation being invoked.

XPath Expression This option is available only when the Selection Algorithm option is set to 
SOAPHeader.

Specify the XPath expression that extracts the value used as a key to select the 
operation being invoked.

Operation Mapping This option is available only when the Selection Algorithm option is set to 
Transport Header, WS-Addressing, or SOAP Body Type.

Specify the value for each operation in the Value field. The value is used as the 
key of the operation.

Table 17-15  Create/Edit a Proxy Service - Operation Selection Configuration Page (Continued)

Option To create or edit...
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Using this page, you can also enable the proxy service to store MIME attachment content to a 
disk file and then process the data in a streaming fashion without buffering the attachment 
contents in memory. This enables the proxy service to process large attachments robustly and 
efficiently.

Table 17-16 describes how to use the Create/Edit a Proxy Service - Message Content 
Handling page.

Table 17-16  Create/Edit a Proxy Service - Message Content Handling Page 

Option To create or edit...

Content Streaming Select this option to stream message content rather than store it in memory.

Select the Enabled check box and choose the following:
• Whether to buffer the intermediate content in memory (Memory Buffer) or 

to a disk file (Disk Buffer)
• Whether to enable Compression

For more information, see Streaming body Content in the Oracle Service Bus 
User Guide.
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XOP/MTOM 
Support

Oracle Service Bus supports XOP/MTOM using the following transports:
• HTTP/S
• Local
• SB

Select the Enabled check box to enable the proxy service to decode and parse 
inbound messages in MTOM/XOP format and to send responses using the 
MTOM/XOP format, when appropriate. Note that this option is disabled for 
imported proxy services that are based on previous release configurations.

If XOP/MTOM Support is enabled, select how to handle binary data in the 
$header and $body message context variables from among the following 
options:
• Include Binary Data by Reference: (Default) In an inbound request 

message, replace xop:Include elements with ctx:binary-content elements 
when setting up the $header and $body message context variables.

• Include Binary Data by Value: In an inbound request message, replace 
xop:Include elements with Base64-encoded text versions of corresponding 
binary data when setting up the $header and $body message context 
variables.

Use Include Binary Data by Reference when you need direct access to binary 
data, for example to pass data to a Java callout or Message Format Language 
(MFL) transform.

Use Include Binary Data by Value in the following cases:
• To bridge between MTOM and non-MTOM services. For example, 

consider an MTOM-enabled proxy service that receives a request that is 
then routed to a non-MTOM-enabled service. You could use this option to 
comply with existing standards for sending binary data in XML in 
Base64-encoded form.

• To validate the contents of the message against an XML schema that 
requires a base64binary element to be used in place of binary data

Note that if XOP/MTOM Support is enabled for a proxy service, it is not 
required that every inbound message be in the MTOM format. Instead, this 
setting specifies that when an MTOM-formatted message arrives, the proxy 
service should handle it accordingly. Note also that when proxy services not 
enabled for XOP/MTOM Support receive an MTOM-formatted message, the 
service rejects the message and issues a runtime error.

Table 17-16  Create/Edit a Proxy Service - Message Content Handling Page (Continued)

Option To create or edit...
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After you finish

Click Next to review and save this configuration on the Create/Edit a Proxy Service - Summary 
page.

Summary page
The Create/Edit a Proxy Service - Summary page is one in a series of pages for creating and 
editing proxy services, as described in “Creating and Configuring Proxy Services” on page 17-1 
and “Editing Proxy Service Configurations” on page 17-47.

Use this page to view or modify the configuration settings for a proxy service before saving it. 

To view or modify settings, click Edit in the row of the appropriate category (for example, 
General Configuration, Transport Configuration, etc.). The pages you can edit depend on 
what pages you configured when creating the proxy service. The following list shows all pages:

“General Configuration page” on page 17-3

“Message Type Configuration page” on page 17-6

“Transport Configuration page” on page 17-8

“Protocol-Specific Transport Configuration Pages” on page 17-12

Attachments Oracle Service Bus supports streaming MIME attachments using the following 
transports:
• HTTP/S
• Local (when chained through an HTTP proxy with streaming attachments 

enabled)

Select the Page Attachments to Disk check box to enable the proxy service to 
stream MIME attachments. When enabled for HTTP proxy services, the option 
applies to proxy service inbound request messages.

Note that if you select XOP/MTOM Support, the Attachments option is only 
available if you choose the Include Binary Data by Reference option under 
XOP/MTOM Support. Note also that payloads that contain attachments must 
conform to RFC 822. Specifically, lines containing Internet headers need to be 
terminated with CRLF (carriage return line feed).

Table 17-16  Create/Edit a Proxy Service - Message Content Handling Page (Continued)

Option To create or edit...
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“E-Mail Transport Configuration page” on page 17-12

“File Transport Configuration page” on page 17-14

“FTP Transport Configuration page” on page 17-16

“HTTP Transport Configuration Page” on page 17-18

“JCA Transport Configuration Page” on page 17-20

“JMS Transport Configuration page” on page 17-24

“MQ Transport Configuration page” on page 17-28

“SB Transport Configuration page” on page 17-31

“SFTP Transport Configuration page” on page 17-32

“Tuxedo Transport Configuration page” on page 17-34

“WS Transport Configuration page” on page 17-37

“Operation Selection Configuration page” on page 17-38

“Message Content Handling page” on page 17-41

Exporting a WSDL Associated with a Proxy Service
You can export the WSDL of a WSDL-based proxy service, so you can view or modify the 
WSDL in an external tool such as an IDE. The WSDL is exported as a JAR file.

Note that this is different than the Export Resources functionality in the System Administration 
module, which you use to move and stage resources between two domains. See “Exporting 
Resources” on page 26-7.

Before you begin

You can only export a WSDL when you are outside a session. See “Using the Change Center” on 
page 2-2.

To export a WSDL

1. Do either of the following:

– Select Resource Browser > Proxy Services to display the Summary of Proxy 
Services page.
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– Select Project Explorer, then select the project or folder containing the proxy service 
you want to export as a WSDL. The Project/Folder View page is displayed.

2. Click the  Export WSDL icon in the row of the proxy service whose WSDL you want to 
export. A dialog box prompts you to open or save the exported JAR file.

3. In the dialog box, click Open to open the file, or click Save to save it. 

Locating Proxy Services
1. Do either of the following:

– Select Project Explorer to display the Projects View page or the Project/Folder View 
page. Then navigate through projects and folders to find the proxy service.

– Select Resource Browser > Proxy Services. The Summary of Proxy Services page 
displays the information shown in Table 17-17. For a more detailed description of the 
properties, see “Editing Proxy Service Configurations” on page 17-47.

2. To restrict the number of items in the list, you can filter by name, path, or both. In the Name 
and Path fields, under Search, enter the name and/or path of the target(s), then click the 
Search button. 

The path is the project name and the name of the folder in which the proxy service resides. 

Wildcard characters * and ? are allowed. Search is case-sensitive.

Click View All to display all proxy services in the domain. This clears the search 
parameters from the previous search.

Table 17-17  Summary of Proxy Services Page 

Property Description

Name A unique name for the proxy service. Click the name to display the View a Proxy 
Service - Configuration Details page. 

See “Editing Proxy Service Configurations” on page 17-47.

Path The path is the project name and the name of the folder in which the proxy 
service resides, for example, UDDI/Proxies/OSB_services.

Click the path of a proxy service to display the Project/Folder View page that 
contains it.
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Editing Proxy Service Configurations
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2. 

2. Locate the proxy service you want to view or edit. See “Locating Proxy Services” on 
page 17-46.

3. Click the proxy service name. The View a Proxy Service - Configuration Details page 
displays configuration information for the selected proxy service.

4. To view or modify settings, do either of the following:

Actions Do any of the following:

• Click the  Edit Message Flow icon to edit the message flow of the proxy 
service. See “Creating, Editing, and Viewing Message Flows” on page 18-1.

• Click the  Launch Test Console icon to invoke the Test Console, which 
you use to validate and test the design of your services and transformations. 
For business services, you can only use the Test Console at run time; that is, 
when the session is activated. For transformations, you can use the Test 
Console whether you are inside or outside a session. See “Testing Services” 
on page 30-1 and “Testing Transformations” on page 30-17.

• The  Export WSDL icon is displayed for WSDL-based business 
services. Click this icon to export a WSDL, which you can then view or 
modify in an external tools such as an IDE. See 
Note that this is different than the Export Resources functionality in the 
System Administration module, which you use to move and stage resources 
between two domains. See “Exporting a WSDL” on page 3-24.

Options
Click the  Delete icon to delete the service. A  Deletion Warning icon is 
displayed when other resources reference this resource. You can delete the 
resource with a warning confirmation. This might result in conflicts due to 
unresolved references to the deleted resource. For more information, see 
“Deleting Proxy Services” on page 17-63.

Table 17-17  Summary of Proxy Services Page (Continued)

Property Description
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– Click the  Edit icon next to the name of the category whose properties you want to 
view or edit (for example, General Configuration, Transport Configuration, etc.). 
The pages you can edit depend on what pages you configured when creating the proxy 
service. 

For a list of all those pages, see “View a Proxy Service - Configuration Details page” 
on page 17-48.

– Click Edit at the bottom of the page to display the Create/Edit a Proxy Service - 
General Configuration page, which is the first page in the sequence of pages for 
configuring this proxy service. 

5. Continue to view or edit, as described in “Creating and Configuring Proxy Services” on 
page 17-1.

6. On the Edit a Proxy Service - Summary page, click Save to commit the updates in the current 
session. 

7. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

View a Proxy Service - Configuration Details page
The View Proxy Service - Configuration Details page displays the configuration details of a 
proxy service. Table 17-18 describes all the properties that can appear on this page. (Properties 
vary depending on the details of the proxy service.)

The categories listed on this page correspond to the Create/Edit a Proxy Service pages used for 
creating and editing proxy service configurations, as described in “Create/Edit a Proxy Service - 
Page Reference” on page 17-2. 

Click the Edit link next to any category name to display the associated configuration page.

Table 17-18  View a Proxy Service: Configuration Details Page 

Properties Description

Last Modified By The user who created this proxy service or imported it into the 
configuration.

Last Modified On The date and time that the user created this proxy service or imported it 
into the configuration. Click the date and time link to view the change 
history of this resource. See “View Change History page” on page 3-21.
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References The number of objects that this proxy service references. If such 
references exist, click the numeric link to view a list of the objects. 

Referenced by The number of objects that reference this proxy service. If such references 
exist, click the numeric link to view a list of the objects.

Description A description of this proxy service, if one exists.

General Configuration - Shows properties configured on the General Configuration page.

Service Type The service type.

Service Key Provider The name of the service key provider.

Message Type Configuration- Shows properties configured on the Message Type Configuration page.

Request Message Type A message type for the request message: None, Binary, Text, MFL, or 
XML.

Response Message Type A message type for the response message: None, Binary, Text, MFL, or 
XML.

Transport Configuration - Shows properties configured on the Transport Configuration page.

Protocol The transport protocol.

Endpoint URI The endpoint URI.

Get All Headers Whether all the headers or a defined set of headers are retrieved from the 
transport.

E-Mail Transport Configuration - Shows properties configured on the E-Mail Transport Configuration 
page.

E-mail Protocol A server type for the E-mail account:
• pop3
• imap

Service Account The service account for this mail server.

Managed Server The Managed Server for polling in a clustered domain.

Polling Interval A polling interval, in seconds.

Table 17-18  View a Proxy Service: Configuration Details Page (Continued)

Properties Description
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Read Limit The maximum number of messages read per polling sweep. 0 signifies no 
limit.

Pass By Reference Whether or not the file is staged in the archive directory and passed as a 
reference in the headers.

Pass Attachments by 
Reference

Whether or not the attachments are staged in the archive directory and 
passed as a reference in the headers.

Post Read Action Whether or not a message is archived, deleted, or moved after it has been 
read:
• Archive - the message is archived.
• Delete - the message is deleted.
• Move - the message is moved.

Note: Move is only available with the IMAP protocol.

Attachments Whether or not attachments are archived or ignored:
• Archive - attachments are saved to the Archive Directory.
• Ignore - attachments are ignored.

IMAP Move Folder The folder to which the message is moved if the Post Read Action field 
is set to Move.

Download Directory The temporary location for downloading E-mails.

Archive Directory The path to the archive location if the Post Read Action field is set to 
Archive. 

The Archive Directory field is also a required field if you have selected 
the Pass By Reference or the Pass Attachments By Reference field.

Error Directory The file system directory path to write the message and any attachments 
if there is a problem.

Request Encoding Displays the character set encoding for requests in E-mail transports. The 
default is iso-8859-1.

File Transport Configuration - Shows properties configured on the File Transport Configuration page.

File Mask The regular expression applied for this file to be picked.

Table 17-18  View a Proxy Service: Configuration Details Page (Continued)

Properties Description
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Managed Server The Managed Server for polling in a clustered domain.

Polling Interval The polling interval, in seconds.

Read Limit The maximum number of messages to read per polling sweep. 0 signifies 
no limit.

Sort by Arrival Whether or not events are delivered in the order of arrival.

Scan Subdirectories Whether or not all the directories are recursively scanned.

Pass By Reference Whether or not the file is staged in the archive directory and passed as a 
reference in the headers.

Post Read Action Whether or not a message is archived or deleted after it has been read:
• Archive - the message is archived.
• Delete - the message is deleted.

Stage Directory The intermediate directory where files are temporarily staged while they 
are processed. 

Error Directory The file system directory path to write the message and any attachments 
if there is a problem.

Archive Directory  The path to the archive location if the Post Read Action field is set to 
Archive. The Archive Directory field is also a required field if you have 
selected the Pass By Reference field.

Request Encoding Displays the character set encoding for requests in File transports. The 
default is utf-8.

FTP Transport Configuration - Shows properties configured on the FTP Transport Configuration 
page.

Identity (E-mail id)/ Service 
Account

The mail ID for an anonymous user or service account for an externally 
configured user.

Timeout The socket timeout, in seconds.

File Mask The regular expression applied for this file to be picked.

Scan Subdirectories Whether or not all the directories are recursively scanned.

Table 17-18  View a Proxy Service: Configuration Details Page (Continued)

Properties Description
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Pass By Reference Whether or not the file is staged in the archive directory and passed as a 
reference in the headers.

Remote Streaming Whether or not the ftp files are directly streamed from the remote server 
at the time of processing.

Post Read Action Whether or not a message is archived or deleted after it has been read:
• Archive - the message is archived.
• Delete - the message is deleted.

Archive Directory The path to the archive location if the Post Read Action field is set to 
Archive. The Archive Directory field is also a required field if you have 
selected the Pass By Reference field.

Download Directory The temporary location for downloading FTP files.

Error Directory The file system directory path to write the message and any attachments 
if there is a problem.

Retry Count The number of retries for FTP connection failures.

Managed Server The Managed Server for polling in a clustered domain.

Polling Interval The polling interval, in seconds.

Read Limit The maximum number of messages to read per polling sweep. 0 signifies 
no limit.

Sort By Arrival Whether or not events are delivered in the order of arrival.

Transfer Mode The transfer mode: Binary or ASCII.

Request Encoding Displays the character set encoding for requests in FTP transports. The 
default is utf-8.

HTTP Transport Configuration - Shows properties configured on the HTTP Transport Configuration 
Page.

HTTPS required Whether or not there are inbound HTTPS endpoints

Authentication The client authentication method: None, Basic, or Custom 
Authentication.

Table 17-18  View a Proxy Service: Configuration Details Page (Continued)

Properties Description
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Request Encoding Displays the character set encoding for requests in HTTP transports. The 
default is iso-8859-1.

Response Encoding Displays the character set encoding for responses in HTTP transports. 
The default iso-8859-1.

JCA Transport Configuration - Shows properties configured on the JCA Transport Configuration 
Page.

JMS Transport Configuration - Shows properties configured on the JMS Transport Configuration 
page.

Destination Type The destination type: Queue or Topic.

Is Response Required Whether or not a response is expected after an outbound message is sent.

Response Correlation 
Pattern 

Correlation pattern options:
• JMSCorrelationID

•  JMSMessageID

Response URI The Response URI for the JMSCorrelationID.

Response Connection 
Factory

The Response Connection Factory URI for MessageID.

Response Message Type Format for response message.

Request Encoding The character set encoding for requests in JMS transports. The default is 
utf-8.

Response Encoding The character set encoding for responses in JMS transports. The default 
is utf-8.

Client Response Timeout The number of seconds to wait for a client response before timing 
out.

Dispatch Policy The dispatch policy for this endpoint.

Use SSL Whether or not the requests are made over a TLS/SSL connection.

Message Selector The Message selector pattern.

Durable Subscription Whether the subscription is durable or not.

Table 17-18  View a Proxy Service: Configuration Details Page (Continued)

Properties Description
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Retry Count The number of delivery retries configured before the message is sent to 
the error destination.

Retry Interval The retry interval in seconds.

Error Destination The name of the target destination for messages that have reached their 
delivery limit.

Expiration Policy The expiration policy used when an expired message is encountered on a 
destination.

Is XA Required Whether the Connection Factory is transactional or not.

Synchronous Transactional Whether the response pipeline inherits the transaction from the request 
pipeline. If set to true, the transaction does not commit until both 
pipelines have completed.

JMS service account The service account to use for the JMS resource managed by the JMS 
server.

MQ Transport Configuration - Shows properties configured on the MQ Transport Configuration page.

SB Transport Configuration - Shows properties configured on the SB Transport Configuration page.

Dispatch Policy The dispatch policy for this endpoint.

Use SSL Whether or not the requests are made over an SSL connection.

SFTP Transport Configuration - Shows properties configured on the SFTP Transport Configuration 
page.

Authentication Mode The authentication method: Username Password, Host-Based, or Public 
Key Authentication.

Service Account The service account for this sftp server.

Service Key Provider The service key provider for this sftp server.

Username The user name for this sftp server.

Timeout The socket timeout, in seconds.

File Mask The regular expression applied for this file to be picked.

Table 17-18  View a Proxy Service: Configuration Details Page (Continued)

Properties Description
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Scan Subdirectories Whether or not all the directories are recursively scanned.

Pass By Reference Whether or not the file is staged in the archive directory and passed as a 
reference in the headers.

Remote Streaming Whether or not the remote file is directly streamed at the time of 
processing.

Post Read Action Whether or not a message is archived or deleted after it has been read:
• Archive - the message is archived.
• Delete - the message is deleted.

Archive Directory The path to the archive location if the Post Read Action field is set to 
Archive. The Archive Directory field is also a required field if you have 
selected the Pass By Reference field.

Download Directory The temporary location for downloading SFTP files.

Error Directory The file system directory path to write the message and any attachments 
if there is a problem.

Retry Count The number of retries for SFTP connection failures.

Managed Server The Managed Server for polling in a clustered domain.

Polling Interval The polling interval, in seconds.

Read Limit The maximum number of messages to read per polling sweep. 0 signifies 
no limit.

Sort By Arrival Whether or not events are delivered in the order of arrival.

Request Encoding Displays the character set encoding for requests in SFTP transports. The 
default is utf-8.

Tuxedo Transport Configuration - Shows properties configured on the Tuxedo Transport 
Configuration page.

Field Table Classes The space separated list of fully qualified FML Files class names for 
buffer mapping.

View Classes The space separated list of fully qualified View class names for buffer 
mapping.

Table 17-18  View a Proxy Service: Configuration Details Page (Continued)

Properties Description
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Classes Jar A JAR Resource that contains a JAR file with the FML/FML32 or 
VIEW/VIEW32 classes necessary for the endpoint operation.

Local Access Point for URI The local access point for the URI Endpoint associated with the WTC 
Export Service.

Reply Buffer Type The buffer type buffer that the remote Tuxedo client will receive. This 
field is enabled if the Response Required field is selected. 

Valid types are: CARRAY, FML, FML32, MBSTRING, STRING, VIEW, 
VIEW32, X_COMMON, X_C_TYPE, XML, X_OCTET.

Reply Buffer Subtype The buffer subtype with which to associate the reply buffer if the buffer 
type is VIEW or VIEW32.

Response Required Selecting the check box indicates Yes. A response is required. Otherwise, 
no response is required.

The default status is selected, and deselected if the service type is 
Messaging Service and the response message type is None. In this case, 
the field is not enabled.

Request Encoding The character set encoding for requests in Tuxedo transports.

Response Encoding The character set encoding for responses in Tuxedo transports.

Transformation Style The ordering or grouping of elements when FML or FML32 buffers are 
transformed into XML.

WS Transport Configuration - Shows properties configured on the WS Transport Configuration page.

Dispatch Policy The dispatch policy for this endpoint.

Retry Count The number of retries for message delivery.

Retry Delay The retry interval in seconds.

Synchronous Whether the response pipeline inherits the transaction from the request 
pipeline. If set to true, the transaction does not commit until both 
pipelines have completed.

Message Level Security Configuration - Shows properties configured on the View a Proxy Service - 
Security page.

Table 17-18  View a Proxy Service: Configuration Details Page (Continued)

Properties Description
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Custom Authentication The client message-level authentication method: None, Custom 
Username and Password, or Custom Token.

Process WS-Security Indicates whether the proxy service behaves as an active intermediary.

Operation Selection Configuration - Shows properties configured on the Operation Selection 
Configuration page.

Enforce WS-I Compliance For SOAP 1.1 services only: Displays Yes if you selected this option to 
specify whether or not the service is WS-I compliant, and displays No if 
you did not want to specify this.

Selection Algorithm The selection algorithm that determines the operation called by this proxy 
service.

Header Name If you selected Transport Header in the Selection Algorithm field for 
this proxy service, this field displays the transport header that extracts the 
value used as a key to select the operation being invoked.

XPath Expression If you selected SOAP Headers in the Selection Algorithm field for this 
proxy service, this field displays the XPath expression that extracts the 
value used as a key to select the operation being invoked.

Operation Mapping If you selected Transport Headers, WS-Addressing or SOAP Headers 
in the Selection Algorithm field for this proxy service, this field displays 
the value for each operation. The value is used as the key of the operation.

Message Content Handling Configuration - Shows properties configured on the Message Content 
Handling page.

Content Streaming Indicates whether to stream message content, whether to buffer 
intermediate content in memory or to a disk file, and whether to apply 
compression.

XOP/MTOM Support Indicates whether the proxy service is Enabled or Disabled to decode 
and parse inbound messages in MTOM/XOP format and to send 
responses using the MTOM/XOP format, when appropriate.

If the proxy service is enabled for XOP/MTOM Support, the field 
displays whether the binary data is included By Reference or By Value.

Page Attachments to Disk Indicates whether the proxy service is configured to Page Attachments 
to Disk to stream MIME attachments.

Table 17-18  View a Proxy Service: Configuration Details Page (Continued)

Properties Description
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View a Proxy Service - Policies page
The View a Proxy Service - Policies page is one in a series of pages for editing proxy services, 
as described in “Creating and Configuring Proxy Services” on page 17-1 and “Editing Proxy 
Service Configurations” on page 17-47.

Use this page to configure policy settings for a proxy service that has a WSDL-based policy or 
that uses custom policy bindings (both WSDL-based and Any SOAP services). Table 17-19 
describes how to use the page.

Note that for WSDL-based services, all policies bound to the service are exposed (inlined) in the 
effective WSDL regardless of which binding model is used. Abstract policies are pre-processed 
before they are inlined.

Table 17-19  View a Proxy Service - Policy Page 

Option To edit...

Service Policy 
Configuration

There are two options in the Service Policy Configuration field: 
• WSDL-Based Policy, in which one or more Web Services Policy 

(WS-Policy) statements in a WSDL document express the proxy 
service's message-level security requirements. 

• Custom Policy Bindings, in which you add service-level policies, 
operation-level policies (in which case the policy applies to both the 
request and response messages), request policies, and response 
policies from the console. 

Note: The two policy binding models are mutually exclusive. If you bind 
policies directly to the service, all WSDL-based policies are 
ignored. 

Service Level Policies 
(Custom Policy Bindings 
Only)

To specify policies that apply to the entire service, expand the service 
name entry. Click Add to search for and select your policies. 

You can select from your own existing WS-Policy resources, or from 
predefined policies. 

You can bind multiple policies to the service. 

Update the policy binding. 
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After you finish

Click Update to save this configuration; or click Reset to undo your changes.

View a Proxy Service - Security page
The View a Proxy Service - Security page is one in a series of pages for editing proxy services, 
as described in “Creating and Configuring Proxy Services” on page 17-1 and “Editing Proxy 
Service Configurations” on page 17-47.

Use this page to configure security settings for a proxy service.

The fields available on this page depend on the configuration of the proxy service. For example, 
if the proxy service is WSDL-based and the WSDL has a security policy or if the proxy service 
is an Any SOAP service and has a security policy, the page displays the Process WS-Security 
Header control. Depending on how that control is set, the Message Access control may also be 
displayed.

The configuration for both custom user name/password and custom token is similar. In both 
cases, you specify XPath expressions that enable Oracle Service Bus to locate the necessary 
information. The root of these XPath expressions is as follows:

Use soap-env:Envelope/soap-env:Header if the service binding is AnySOAP or 
WSDL-SOAP.

Operation Level Policies 
(WSDL-Based Policy 
Only)

Provides a read-only view of the request and response policies from the 
WSDL. 

Operation Level Policies 
(Custom Policy Bindings 
Only)

To specify policies that apply to an operation, the request/response of that 
operation, or any request or any response in the case of Any SOAP 
services, expand the operation name entry. Click Add to search for and 
select your policies. 

You can select from your own existing WS-Policy resources, or from 
predefined policies. 

You can bind multiple policies to the service. 

Update the policy binding.

Table 17-19  View a Proxy Service - Policy Page (Continued)

Option To edit...
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Use soap-env:Body if the service binding is not SOAP based.

All XPath expressions must be in a valid XPath 2.0 format. The XPath expressions must use the 
XPath "declare namespace" syntax to declare any namespaces used, as follows:
  declare namespace 
  ns='http://webservices.mycompany.com/MyExampleService';)

Table 17-20 describes the View a Proxy Service - Security Configuration page for a 
WSDL-based proxy service, in which the WSDL has a security policy, the transport is HTTP, and 
HTTPS is required.

Table 17-20  View a Proxy Service - Security Configuration Page 

Option To edit...

General Configuration

Service Key Provider If needed, enter the path (project/folder) and name of a service key 
provider, or click Browse to select one from the Select Service Key 
Provider page.

For more information, see “Service Key Providers” on page 15-1. To learn 
how to create a service key provider, see “Adding Service Key Providers” 
on page 15-2. 

Web Services Security Configuration

Process WS-Security 
Header

If a client request includes a WS-Security security header, decide whether 
or not to process this header:
• Select Yes: In an active intermediary scenario, the client applies 

WS-Security to the request and/or response messages. The proxy 
service processes the security header and enforces the WS-Security 
policy.

• Select No: In a WS-Security pass-through scenario, the client applies 
WS-Security to the request and/or response messages. The proxy 
service does not process the security header. Instead, it passes the 
secured request message untouched to a business service.

Access Control

Transport Access Control For all proxy services, you can create a transport-level policy, which 
applies a security check when a client attempts to establish a connection 
with the proxy service. Only requests from users who are listed in the 
transport-level policy are allowed to proceed.
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Message Access Control A message-level access control policy applies a security check when a 
client attempts to invoke a proxy service with message-level security. You 
can create a message-level access control policy in the following cases: 
• For proxy services that are active Web Service security intermediaries; 

that is, you process the WS-Security header.
• For proxy services for which you set custom authentication on this 

page.

Only users who are listed in the message-level policy are allowed to invoke 
the operation.

Custom Authentication 
(Message-Level)

Authentication Type Select one of the following:
• Select None if the proxy service will not use custom authentication. 
• Custom User Name and Password

When you select this option, you must also enter values in the User 
Name XPath field and the User Password XPath field.

• Custom Token
When you select this option, you must also select a Token Type and 
enter values for the Token XPath field.

User Name XPath This option is available only when the Custom Authentication Settings 
option is set to Custom User Name and Password. When available, this 
option is required.

Enter the user name as an XPath expression. 

The XPath expression is evaluated against the message headers or payload, 
as appropriate, which allows Oracle Service Bus to obtain the user name 
and for custom authentication.

User Password XPath This option is available only when the Custom Authentication Settings 
option is set to Custom User Name and Password. When available, this 
option is required.

Enter the password as an XPath expression. 

The XPath expression is evaluated against the message headers or payload, 
as appropriate, which allows Oracle Service Bus to obtain the password 
values for custom authentication.

Table 17-20  View a Proxy Service - Security Configuration Page (Continued)

Option To edit...
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After you finish

Token Type This option is available only when the Custom Authentication Settings 
option is set to Custom Token. When available, this option is required.

Select the token type from the drop-down list. Only the active token types 
configured for a WebLogic Server Identity Assertion provider are 
available. See Configuring Identity Assertion Providers for Custom 
Tokens for more information.

Token XPath This option is available only when the Custom Authentication Settings 
option is set to Custom Token. When available, this option is required.

Enter an XPath expression to specify a path to the custom token. Oracle 
Service Bus evaluates the Token XPath expression against the message 
headers or payload, as appropriate, to obtain the token for custom 
authentication.

Context Properties Optionally, specify one or more context properties to pass additional 
context information to the Authentication (Custom User Name and 
Password) or Identity Assertion (Custom Token) security provider.

Context Properties provide a way (the ContextHandler interface) to 
pass additional information to the WebLogic Security Framework so that 
a security provider can obtain contextual information. See Context 
Properties Are Passed to Security Providers for possible values.

Enter the Property Name as a literal string, and the Value Selector as a 
valid XPath expression. (XPath expressions can also be literal strings.)

The XPath expressions are evaluated against the same message-part that is 
used for the custom token or custom user name/password. That is, the 
Value Selector XPath expressions for SOAP-based proxy services 
evaluate against the header and against the payload for non-SOAP-based 
proxy services.

The XPath expression is evaluated at runtime to produce the property's 
value. A ContextHandler is essentially a name/value list and, as such, it 
requires that a security provider know what names to look for. Therefore, 
the XPath expressions are evaluated only if a security provider asks for the 
value of one of these user-defined properties.

Click Add Property to add this context property. You can add multiple 
context properties. 

Table 17-20  View a Proxy Service - Security Configuration Page (Continued)

Option To edit...
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Click Update to save this configuration; or click Reset to undo your changes.

Deleting Proxy Services
Deleting a proxy service deletes all of the ACLs referenced by the proxy from the repository 
controlled by Oracle Service Bus, as well as from the appropriate authorization provider. 

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select Resource Browser > Proxy Services to display the Summary of Proxy Services 
page.

3. Click the  Delete icon in the row of the of the proxy service you want to delete. The proxy 

service is deleted in the current session. A  Deletion Warning icon is displayed when other 
resources reference this resource. You can delete the resource with a warning confirmation. This might 
result in conflicts due to unresolved references to the deleted resource. 

4. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 
Using the Oracle Service Bus Console 17-63



Proxy  Serv ices :  Crea t ing  and Managing
17-64 Using the Oracle Service Bus Console



C H A P T E R 18
Proxy Services: Message Flow
Message flows define the implementations of proxy services.

Creating, Editing, and Viewing Message Flows
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Locate the proxy service whose message flow you want to view or edit. Do either of the 
following:

– Select Project Explorer to display the Projects View page or the Project/Folder View 
page. Then navigate through projects and folders to find the proxy service. 

– Select Resource Browser > Proxy Services to display the Summary of Proxy 
Services page.

3. Click the  Edit Message Flow icon in the row of the proxy service whose message flow 
you want to view or edit. 

– If no message flow has yet been created for the selected proxy service, the Edit 

Message Flow page is displayed with a single icon on the page, the  Proxy Service 
icon. This is the starting node for the proxy service. Click this icon to begin 
constructing the message flow. 

– If the proxy service already has a message flow, the page contains a graphic 
representation of the flow. Click the icons to view or edit the parts of the message flow. 
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See “Edit Message Flow page” on page 18-2 for information about what you can do to 
construct a message flow on that page.

4. Click Save to commit the updates in the current session. 

5. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Edit Message Flow page
Use the Edit Message Flow page to construct a message flow for a proxy service.

The left navigation pane of the Edit Message Flow page shows a tree view of the nodes and 
objects in the message flow. When the details of an object are defined on a separate page, you can 
click the name of the object to display the associated page. 

The right pane provides a field upon which to construct the message flow. When a message flow 

has not yet been defined, the pane includes a single  Proxy Service icon that signifies the 
starting node for the service. Click the icon to add pipeline pair nodes, route nodes, conditional 
branches, operational branches, and error handling for the service.

When you add objects to the page, icons are displayed on the page to represent the objects. The 
relationships among the objects are shown with lines and bounding boxes. Click an icon on the 
Edit Message Flow page to display a menu of the actions you can perform on that object. The 
options available on the menu may differ, depending on context. See Table 18-1 for a complete 
list of icons and options.
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Table 18-1  Edit Message Flow Page Icons and Options 

Icon Description Menu Options

Proxy Service

The starting node for the message 
flow.

• Add Pipeline Pair - See “Adding Pipeline 
Pair Nodes to Message Flows” on page 18-6.

• Add Route - See “Adding Route Nodes to 
Message Flows” on page 18-11.

• Add Conditional Branch - See “Adding 
Conditional Branches to Message Flows” on 
page 18-7.

• Add Operational Branch - See “Adding 
Operational Branches to Message Flows” on 
page 18-8.

• Add Service Error Handler - See “Adding 
Proxy Service Error Handlers” on page 21-1. 

Pipeline Pair 
Node

A pipeline pair node consists of a 
request pipeline and a response 
pipeline.

• Edit Name and Annotation
• Add Pipeline Pair - See “Adding Pipeline 

Pair Nodes to Message Flows” on page 18-6.
• Add Conditional Branch - See “Adding 

Conditional Branches to Message Flows” on 
page 18-7.

• Add Operational Branch - See “Adding 
Operational Branches to Message Flows” on 
page 18-8.

• Paste Route - This option is available only if 
you have cut or copied a route node and it is on 
the Clipboard.

Response 
Pipeline

See pipeline pair node above. • Add Stage - See “Adding Stages to Pipelines” 
on page 18-10.

• Add Pipeline Error Handler - See “Adding 
Pipeline Error Handlers” on page 21-2.

Request 
Pipeline

See pipeline pair node above. • Add Stage - See “Adding Stages to Pipelines” 
on page 18-10.

• Add Pipeline Error Handler - See “Adding 
Pipeline Error Handlers” on page 21-2. 
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Pipeline with 
Error Handler

A pipeline with an error handler 
defined for it.

• Edit Pipeline Error Handler - See “Adding 
Pipeline Error Handlers” on page 21-2.

• Delete Pipeline Error Handler

Route Node

Route node actions define the 
handling of messages as they 
flow through the route node.

• Edit Route - See “Adding Route Nodes to 
Message Flows” on page 18-11.

• Edit Name and Annotation
• Add Route Error Handler - See “Adding 

Route Node Error Handlers” on page 21-4.

Route Node 
with Error 
Handler

A route node with an error 
handler defined for it.

• Edit Route Error Handler - See “Adding 
Route Node Error Handlers” on page 21-4.

• Delete Route Error Handler 

 

Stage Node

A stage node is a container of 
actions.

• Edit Stage - See “Adding Stages to Pipelines” 
on page 18-10.

• Edit Name and Annotation
• Add Stage - See “Adding Stages to Pipelines” 

on page 18-10.
• Add Stage Error Handler - See “Adding 

Stage Error Handlers” on page 21-3.

 

Stage Node 
with Error 
Handler

A stage node with an error 
handler defined for it.

• Edit Stage Error Handler - See “Adding 
Stage Error Handlers” on page 21-3.

• Delete Stage Error Handler 

 

Conditional 
Branch Node

A conditional branch node allows 
processing to proceed down 
exactly one of several possible 
paths.

• Edit Branch - See “Adding Conditional 
Branches to Message Flows” on page 18-7.

• Edit Name and Annotation

Table 18-1  Edit Message Flow Page Icons and Options (Continued)

Icon Description Menu Options
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Edit Stage Configuration Page
Use the Edit Stage Configuration page to add actions to pipeline stages, error handler stages, 
and route nodes in a message flow.

When nothing has yet been defined on the Edit Stage Configuration page, the only object 

displayed is the  Add an Action icon. Click that icon to get started. 

When a stage or a route node has already been configured, the actions and objects defined 
for that stage or route node appear on the page. Edit the existing actions, as appropriate, or 
click any of the icons representing actions to add more actions to the stage.

See “Adding and Editing Actions in Message Flows” on page 19-1 for instructions on working 
with all the kinds of actions you can add to a stage.

 

Operational 
Branch Node

An operational branch node 
determines what branch to follow 
based on specified operations.

• Edit Branch - See “Adding Operational 
Branches to Message Flows” on page 18-8.

• Edit Name and Annotation

Branch Node

A branch node is one of the 
alternative nodes defined by a 
conditional branch node or an 
operational branch node.

• Add Pipeline Pair - See “Adding Pipeline 
Pair Nodes to Message Flows” on page 18-6.

• Add Route - See “Adding Route Nodes to 
Message Flows” on page 18-11.

• Add Conditional Branch - See “Adding 
Conditional Branches to Message Flows” on 
page 18-7.

• Add Operational Branch - See “Adding 
Operational Branches to Message Flows” on 
page 18-8.

• Paste Route - This option is available only if 
you have cut or copied a route node and it is on 
the Clipboard.

 

Error Handler

An error handler provides the 
logic for resending errors in the 
message flow.

• Add Service Error Handler - See “Adding 
Proxy Service Error Handlers” on page 21-1.

Table 18-1  Edit Message Flow Page Icons and Options (Continued)

Icon Description Menu Options
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Adding Pipeline Pair Nodes to Message Flows
Message flows can include zero or more pipeline pair nodes: request and response pipelines for 
the proxy service (or for the operations on the service), and error handler pipelines that can be 
defined for stages, pipelines, and proxy services. pipelines can include one or more stages, which 
in turn include actions.

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add a Pipeline Pair node to a message flow

1. Click the  Proxy Service icon, then click Add Pipeline Pair.

2. To change the default name and add a description for the pipeline pair node, do the following:

a. Click the  Pipeline Pair Node icon, then click Edit Name and Annotation.

b. Change the name and description, as desired.

c. Click Save.

Note: When you rename a pipeline or a route node, the number of messages displayed on 
the Dashboard page in the Monitoring module may not correlate with those of other 
components due to the pipeline counters being reset to zero. This is because Oracle 
Service Bus treats the rename as a delete and recreate action. The numbers should 
correlate again after a time period equal to the service's monitoring interval has 
elapsed.

3. To add stages to the pipeline, see “Adding Stages to Pipelines” on page 18-10

4. To add actions to stages in the pipeline. See “Adding and Editing Actions in Message Flows” 
on page 19-1

5. On the Edit Message Flow page, continue to construct the message flow, as described in 
“Creating, Editing, and Viewing Message Flows” on page 18-1.

6. Click Save to commit the updates in the current session. 

7. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 
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Adding Conditional Branches to Message Flows
A branch node allows processing to proceed along exactly one of several possible paths. 
Branching is driven by an XPath-based switch table. Each branch in the table specifies a 
condition (for example, <500) that is evaluated in order down the message flow against a single 
XPath expression (for example, ./ns: PurchaseOrder/ns:totalCost on $body). Whichever 
condition is satisfied first determines which branch is followed. If no branch condition is 
satisfied, then the default branch is followed. A branch node may have several descendants in the 
message flow: one for each branch, including the default branch.

If the proxy service is not based on a WSDL and receives multiple document types as input, 
consider using a conditional branch node.

Conditional branching is driven by a lookup table with each branch tagged with a simple, but 
unique, string value. A variable in the message context is designated as the lookup variable for 
that node, and at run time, its value is used to determine which branch to follow. If no branch 
matches the value of the lookup variable, the default branch is followed. You should design the 
proxy service in such a way that the value of the lookup variable is set before reaching the branch 
node.

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add a conditional branch to a message flow

1. Click a  Pipeline Pair Node icon or a  Branch Node icon, then click Create 
Conditional Branch. The conditional branch node is added, and any existing nodes after the 
inserted branch node are moved to the default branch of the new conditional branch node.

2. To change the default name and add a description for the branch node, do the following:

a. Click the  Conditional Branch icon, then click Edit Name and Annotation.

b. Change the name and description, as desired. 

c. Click Save.

3. To add branch definitions, click the  Conditional Branch icon, then click Edit Branch. 
The Edit Branch Node page is displayed. 
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4. Do the following:

a. In the Selected Path field, click Edit to add an XPath expression for specifying the path. 
See “Creating and Editing Inline XQuery and XPath Expressions” on page 20-1.

b. In the Variable field, enter a context variable.

c. From the Operator field, select a comparison operator.

d. In the Value field, enter a value for the branch.

e. In the Label field, enter a label for the branch.

5. Optionally, under Options: 

– Click Add a New Branch to add a new branch definition to this branch node.

– Click Delete this Branch to delete a branch definition.

– Click Move Branch Up or click Move Branch Down to change the positions of 
branch definitions. This option displays only when more than one branch definition 
exists.

6. Click Save to commit the updates in the current session. 

7. On the Edit Message Flow page, continue to construct the message flow, as described in 
“Creating, Editing, and Viewing Message Flows” on page 18-1.

8. Click Save to commit the updates in the current session. 

9. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Adding Operational Branches to Message Flows
When message flows define Web Services Description Language (WSDL)-based proxy services, 
operation-specific processing is required. Instead of configuring a branching node based on 
operations manually, Oracle Service Bus provides a minimal configuration branching node that 
automatically branches based on operations. In other words, when you create an operational 
branch node in a message flow, you can quickly build your branching logic based on the 
operations defined in the WSDL because the Oracle Service Bus Console presents those 
operations in the branch node configuration page.

A branch node allows processing to proceed along exactly one of several possible paths. 
Branching is driven by an XPath-based switch table. Each branch in the table specifies a 
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condition (for example, <500) that is evaluated in order down the message flow against a single 
XPath expression (for example, ./ns: PurchaseOrder/ns:totalCost on $body). Whichever 
condition is satisfied first determines which branch is followed. If no branch condition is 
satisfied, then the default branch is followed. A branch node may have several descendants in the 
message flow: one for each branch, including the default branch.

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add an operation branch to a message flow

1. Click a  Pipeline Pair Node icon or a  Branch Node icon, then click Create 
Operational Branch. The operational branch node is added, and any existing nodes after the 
inserted branch node are moved to the default branch of the new operational branch node.

2. To change the default name and add a description for the branch node, do the following:

a. Click the  Operational Branch icon, then click Edit Name and Annotation.

b. Change the name and description, as desired. 

c. Click Save.

3. To add branch definitions, click the  Operational Branch icon, then click Edit Branch. 
The Edit Branch Node page is displayed.

4. In the Operation Branch Definitions panel, select a service operation.

5. Optionally, under Options: 

– Click Add a New Branch to add a new branch definition to this branch node.

– Click Delete this Branch to delete a branch definition.

– Click Move Branch Up or click Move Branch Down to change the positions of 
branch definitions. This option displays only when more than one branch definition 
exists.

6. Click Save. 

7. On the Edit Message Flow page, continue to construct the message flow, as described in 
“Creating, Editing, and Viewing Message Flows” on page 18-1.
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8. Click Save to commit the updates in the current session. 

9. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Adding Stages to Pipelines
Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add a stage to a Pipeline

1. If necessary, click the plus sign to the left of the  Pipeline Pair Node icon to expand it. 

A pipeline pair contains a  Request Pipeline and a  Response Pipeline.

2. Click the pipeline to which you want to add the stage, then click Add Stage.

3. To change the default name and add a description for the stage, do the following:

a. Click the  Stage icon, then click Edit Name and Annotation.

b. Change the name and description, as desired. 

c. Click Save.

4. To add actions to the stage, click the  Stage icon, then click Edit Stage. See “Adding and 
Editing Actions in Message Flows” on page 19-1.

5. To add error handling to the stage, click the  Stage icon, then click Add Stage Error 
Handler. See “Adding Stage Error Handlers” on page 21-3. The Edit Message Flow page is 
displayed.

6. Continue to construct the message flow, as described in “Creating, Editing, and Viewing 
Message Flows” on page 18-1.

7. Click Save to commit the updates in the current session. 

8. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 
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Adding Route Nodes to Message Flows
Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add a Route Node to a Message Flow

1. Click the  Pipeline Pair Node icon of a pipeline pair, then click Add Route.

2. To change the default name and add a description for the route node, click the  Route 
Node icon, then click Edit Name and Annotation.Change the name and description, as 
desired, then click Save. 

Note: When you rename a pipeline or a route node, the number of messages displayed on 
the Dashboard page in the Monitoring module may not correlate with those of other 
components due to the pipeline counters being reset to zero. This is because Oracle 
Service Bus treats the rename as a delete and recreate action. The numbers should 
correlate again after a time period equal to the service's monitoring interval has 
elapsed.

3. To add actions to the route node, click the  Route Node icon, then click Edit Route. The 
Edit Message Flow page is displayed. See the following sections for information about the 
actions you can add to route nodes:

– “Adding If... Then... Actions” on page 19-21

– “Adding Dynamic Routing to Route Nodes” on page 19-16

– “Adding Routing Actions to Route Nodes” on page 19-17

– “Adding Routing Tables to Route Nodes” on page 19-19

– “Adding Route Node Error Handlers” on page 21-4

4. On the Edit Message Flow page, continue to construct the message flow, as described in 
“Creating, Editing, and Viewing Message Flows” on page 18-1.

5. Click Save to commit the updates in the current session. 

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 
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Cutting, Copying, and Pasting Stages and Route Nodes
You can cut, copy, and paste stages and route nodes.

To cut a stage or a route node, click its icon and select Cut or Copy.

To paste a stage that you cut or copied from a different pipeline pair within the message 
flow of this proxy service or from the message flow of a different proxy service, do one of 
the following:

– Click the  Request Pipeline or  Response Pipeline icon, then click Paste 
Stage.

– Click the  Stage icon in a pipeline, then click Paste.

To paste a route node that you cut or copied from the message flow of another proxy 

service, click the  Pipeline Pair Node icon for the pipeline pair, then click Paste 
Route.
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Proxy Services: Actions
Actions are the elements of pipeline stages, error handler stages, route nodes, and branch nodes 
that define how messages are to be defined as they flow through a proxy service. 

Adding and Editing Actions in Message Flows
Actions are the elements of pipeline stages, error handler stages, route nodes, and branch nodes 
that define how messages are to be defined as they flow through a proxy service.

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

They also assume you have already added a pipeline stage, a route node, and/or an error handler 
stage. See:

“Adding Pipeline Pair Nodes to Message Flows” on page 18-6 

“Adding Stages to Pipelines” on page 18-10

“Adding Proxy Service Error Handlers” on page 21-1 

To add an action to a message flow

1. Select the component to which you want to add an action. For example, click the  Stage 

icon, then click Edit Stage, or click the  Route Node icon, then click Edit Route. 
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2. Depending on whether actions have already been added to the stage or to the route node, do 
one of the following:

– If no actions have yet been added, the Edit Stage Configuration page displays only 

the  Add an Action icon. Click that icon, then select an action type.

– If one or more actions have already been added, the Edit Stage Configuration page 

displays one or more icons representing those actions, for example, a  Publish icon 

or a  Routing icon, etc. Click the appropriate icon, click Add an Action, then select 
an action type. 

– Some actions, such as request and response actions in publish actions, include an 

 Add an Action link where an action is appropriate. Click that icon, then select an 
action type.

There are no restrictions on what actions may be chained together in a message flow.

Table 19-1 lists the actions you can configure for message flows. 

Table 19-1  Message Flow Actions 

Action Description More Information

Communication

 Dynamic Publish
Publish a message to a service identified by 
an Xquery expression

Adding Dynamic Publish 
Actions

 Publish
Publish a message to a statically specified 
service.

Adding Publish Actions

 Publish Table

Publish a message to zero or more statically 
specified services. Switch-style condition 
logic is used to determine at run time which 
services will be used for the publish.

Adding Publish Table 
Actions

 Routing Options
Modify any or all of the following properties 
in the outbound request: URI, Quality of 
Service, Mode, Retry parameters, Message 
Priority.

Adding Routing Options 
Actions
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 Service Callout
Configure a synchronous (blocking) 
callout to an Oracle Service 
Bus-registered proxy or business 
service.

Adding Service Callout 
Actions

 Transport headers
Set the transport header values in messages Adding Transport Header 

Actions

 Dynamic Routing
Assign a route for a message based on 
routing information available in an 
XQuery resource.

Adding Dynamic Routing 
to Route Nodes

 Routing
Identify a target service for the message 
and configure how the message is 
routed to that service:

Adding Routing Actions to 
Route Nodes

 Routing Table
Assign a set of routes wrapped in a 
switch-style condition table.Different 
routes are selected based upon the 
results of a single XQuery expression.

Adding Routing Tables to 
Route Nodes

Flow Control

 For each
Iterate over a sequence of values and 
execute a block of actions

Adding For Each Actions

 If...then...
Perform an action or set of actions 
conditionally, based on the Boolean result of 
an XQuery expression.

Adding If... Then... Actions

 Raise error
Raise an exception with a specified error 
code (a string) and description.

Adding Raise Error 
Actions

 Reply
Specify that an immediate reply be sent to 
the invoker.

Adding Reply Actions

 Resume
Resume message flow after an error is 
handled by an error handler.

Adding Resume Actions

 Skip
Specify that at run time, the execution of the 
current stage is skipped and the processing 
proceeds to the next stage in the message 
flow.

Adding Skip Actions

Table 19-1  Message Flow Actions (Continued)
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3. When you have finished adding actions, you can further configure the actions in stage or route 
node, as described in Table 19-2.

Message Processing

 Assign
Assign the result of an XQuery expression to 
a context variable.

Adding Assign Actions

 Delete
Delete a context variable or a set of nodes 
specified by an XPath expression.

Adding Delete Actions

 Insert
Insert the result of an XQuery expression at 
an identified place relative to nodes selected 
by an XPath expression.

Adding Insert Actions

 Java callout
Invoke a Java method from the pipeline. Adding Java Callout 

Actions

 MFL transform
Convert non-XML to XML or XML to 
non-XML in the pipeline.

Adding MFL Transform 
Actions

 Rename
Rename elements selected by an XPath 
expression without modifying the contents 
of the element.

Adding Rename Actions

 Replace
Replace a node or the contents of a node 
specified by an XPath expression.

Adding Replace Actions

 Validate
Validate elements selected by an XPath 
expression against an XML schema element 
or a WSDL resource.

Adding Validate Actions

Reporting Reporting

 Alert
Send an alert notification based on pipeline 
message context.

Adding Alert Actions

 Log
Construct a message to be logged. Adding Log Actions

 Report
Enable message reporting for a proxy 
service.

Adding Report Actions

Table 19-1  Message Flow Actions (Continued)
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4. Click Save to commit the updates in the current session. 

Table 19-2  Edit Stage Configuration Tasks 

To... Complete This Step...

Delete an action Click the appropriate icon, then click Delete this Action. 

Move an action down (demote) Click the appropriate icon, then click Move Action Down. 
The action is moved below the next action contained in this 
stage.

This option is displayed only when a stage contains two or 
more actions.

Move an action up (promote) Click the appropriate icon, then click Move Action Up. The 
action is moved above the previous action contained in this 
stage.

This option is displayed only when the stage contains 
two or more actions.

Cut an action Click the appropriate icon, then click Cut.

Copy an action Click the appropriate icon, then click Copy.

Paste an action that you have cut or 
copied

Click the appropriate icon, then click Paste Action.

You can copy and paste actions across stages. However, in the 
case of Assign, Replace or Insert actions, note the following:
• All variable-related and user-defined namespaces from 

the source (copied) stage are added as user-defined 
namespaces in the target (pasted) stage.

• Duplicate namespaces (identical namespaces in both 
source and target stage) are not copied.

• Conflicting namespaces (namespace declarations that use 
the same prefix but different URIs) are copied. Users will 
be able to save the configuration, but will not be able 
activate it until the conflicting namespace declarations in 
stage B are removed.

Validate a stage In the Edit Stage Configuration page, click Validate to 
validate all the actions configured in that stage. 
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5. On the Edit Message Flow page, continue to construct the message flow, as described in 
“Creating, Editing, and Viewing Message Flows” on page 18-1.

6. Click Save to commit the updates in the current session. 

7. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Adding Publish Actions
Use a publish action to identify a statically specified target service for a message and to configure 
how the message is packaged and sent to that service.

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Select Add an Action > Communication > Publish.

3. Click <Service>. The Select Service page is displayed.

4. Select a service from the list, then click Submit. This is the target service for the message.

5. If the service has operations defined, you can specify an operation to be invoked by selecting 
it from the Operation list.

6. To make the outbound operation the same as the inbound operation, select the Use inbound 
operation for outbound check box. 

7. To configure how the message is packaged and sent to the service, in the Request Actions 
field, click Add an Action. Then select an action to associate with the service. You can add 
more than one action. See “Adding and Editing Actions in Message Flows” on page 19-1. 

After you finish

When you complete the configuration of this action, continue by configuring other actions or by 
saving your configuration, as described in “Adding and Editing Actions in Message Flows” on 
page 19-1.

Adding Publish Table Actions
Use a publish table action to publish a message to zero or more statically specified services. Switch-style 
condition logic is used to determine at run time which services will be used for the publish.
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1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Select Add an Action > Communication > Publish Table.

3. Click <Expression>. The XQuery Expression Editor page is displayed. Create an XQuery 
expression, which at run time returns the value upon which the routing decision will be made. 
See “Creating and Editing Inline XQuery and XPath Expressions” on page 20-1.

4. From the Operator list, select a comparison operator. Then, in the adjacent field, enter a value 
against which the value returned from the XQuery expression will be evaluated.

5. Click <Service> to select a service to which messages are to be published if the expression 
evaluates true for the value you specified. The Select Service page is displayed.

6. Select a service from the list, then click Submit. This is the target service for the message.

7. If the service has operations defined, you can specify the operation to be invoked by selecting 
it from the invoking list.

8. If you want the outbound operation to be the same as the inbound operation, select the Use 
inbound operation for outbound check box. 

9. In the Request Actions field, to configure how the message is packaged and sent to the 
service, click Add an Action, then select one or more actions that you want to associate with 
the service. To learn more about the type of action you want to add, see “Adding and Editing 
Actions in Message Flows” on page 19-1.

Note: There is a nesting limit of four cumulative levels in the stage editor. If you attempt to 
add a fifth level, nesting action is not displayed. Cumulative levels include all 
branching actions: if... then... conditions, publish tables, and route tables. For 
example, you can have 2 levels of conditionals, then a publish table with a route table 
inside of it, bringing the total to 4 levels. If you attempt to add another conditional (to 
the last publish table), the conditional is not displayed.

10. To insert a new case, click the  Case icon, then select Insert New Case. 

11. Repeat steps 4-8 for the new case.

12. Add additional cases as dictated by your business logic. 

13. Click the  Case icon of the last case you define in the sequence, then select Insert Default 
Case to add a default case at the end. 
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14. Configure the default case—the configuration of this case specifies the routing behavior in 
the event that none of the preceding cases is satisfied.

After you finish

When you complete the configuration of this action, continue by configuring other actions or by 
saving your configuration, as described in “Adding and Editing Actions in Message Flows” on 
page 19-1.

Adding Dynamic Publish Actions
Use a dynamic publish action to publish a message to a service specified by an XQuery 
expression.

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Click the appropriate icon, then select Add an Action > Communication > Dynamic 
Publish.

3. Click <Expression>. 

4. In the XQuery Expression Editor, enter an Xquery expression or select an XQuery resource 
that provides a result similar to: 

<ctx:route>

<ctx:service 
isProxy="false">project/folder/businessservicename</ctx:service>

<ctx:operation>foo</ctx:operation>

</ctx:route>

Note: The element operation is optional. 

5. Click Save.

6. In the Request Actions field, click Add an Action to add an action, then select an action that 
you want to associate with the service. You can add more than one action. To learn more about 
the type of actions you can add, see the table of actions in “Adding and Editing Actions in 
Message Flows” on page 19-1.

After you finish 
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When you complete the configuration of this action, continue by configuring other actions or by 
saving your configuration, as described in “Adding and Editing Actions in Message Flows” on 
page 19-1.

Adding Routing Options Actions
Use the Routing Options action to modify any or all of the following properties for the outbound 
request in $outbound: URI, Quality of Service, Mode, Retry parameters. Although these 
properties can be modified using Assign, Insert, Replace, or Delete actions on $outbound, using 
Routing options provides a simpler way to perform this task, without requiring knowledge of 
XPath, XQuery, or the structure of the $outbound context variable.

The Routing Options action can only be used where the context variable $outbound is valid. It 
can be added to the following actions: 

Publish

Dynamic Publish

Publish Table

Service Callout

Route

Dynamic Route

Route Table

To configure a routing options action:

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Click the appropriate icon, then select Add an Action > Communication > Routing 
Options.

3. Complete any or all of the following steps:

– To set the URI for the outbound message: Select URI, and click the XQuery 
Expression Editor. Enter an expression that returns a URI. This overrides the URI for 
the invoked service.
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– To set the Quality of Service element: Select Quality of Service, and select the Quality 
of Service option from the drop-down list. This overrides the default that is auto 
computed. 

– To set the Mode: Select Mode, and select either request, or request-response from the 
drop-down list.

Note: This is normally already automatically set, based on the interface of the service 
invoked. However, in some cases like Any Soap or Any XML services, this is not 
so. 

– To set the Retry Interval: Select Retry Interval, and specify the number of seconds 
between retries. This overrides the default configured with the invoked service.

– To set the Retry Count: Select Retry Count, and specify the number of retries the 
system must attempt before discontinuing the action. This overrides the default 
configured with the invoked service.

– To set the Message Priority: Select Priority, and click the XQuery Expression Editor. 
Enter an expression that returns a positive integer. 

After you finish 

When you complete the configuration of this action, continue by configuring other actions or by 
saving your configuration, as described in “Adding and Editing Actions in Message Flows” on 
page 19-1.

Adding Service Callout Actions
Use a service callout action to configure a synchronous (blocking) callout to an Oracle Service 
Bus-registered proxy or business service.

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Click the appropriate icon, then select Add an Action > Communication > Service Callout.

3. Click <Service>. The Service Browser is displayed.

4. Select a service from the list of registered proxy or business services, then click Submit. 

5. If the service you chose in step 3, above, is WSDL-based and has operations that can be 
invoked on the service, those operations are listed in the invoking <Operation> drop-down 
list. Select an operation to be invoked on the service.
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6. Specify how you want to configure the request and response messages by selecting one of the 
following options:

– Select Configure SOAP Body to configure the SOAP Body. Selecting this option 
allows you to use $body directly.

Note: This option supports SOAP-RPC encoded, which is not supported when 
configuring payload parameters or document.

– Select Configure Payload Parameters or Configure Payload Document to configure 
the payload. 

7. Subsequent configuration options depend on the kind of service you selected in step 3 and on 
the kind of configuration options you chose for that service in step 5. Table 19-3 shows the 
options available for each service type. 

Table 19-4, below, provides instructions for each of the options listed in Table 19-3, above.

Table 19-3  Service Callout Configuration Options for Each Service Type 

Selected Service Type “Configure SOAP Body” 
Options

“Configure Payload Parameters” 
Options or 
“Configure Payload Document” Options

• SOAP RPC • SOAP Request Body and 
SOAP Response Body

• SOAP Request Header and 
SOAP Response Header 
(optional)

• Request Parameters and Response 
Parameters

• SOAP Request Header and SOAP 
Response Header (optional)

• SOAP Document
• Any SOAP

• SOAP Request Body and 
SOAP Response Body

• SOAP Request Header and 
SOAP Response Header 
(optional)

• Request Document and Response 
Document

• SOAP Request Header and SOAP 
Response Header (optional)

• XML
• Any XML
• Messaging

• SOAP Request Body and 
SOAP Response Body

• Request Document and Response 
Document
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Table 19-4  Service Callout Configuration Options 

For These Options... Follow These Steps...

SOAP Request Body and  
SOAP Response Body

To configure these options,
• In the SOAP Request Body field, enter the name of a variable 

to hold the XML of the SOAP Body element for the callout 
request.

• In the SOAP Response Body field, enter the name of a variable 
to which the XML of the SOAP Body element on the response 
will be bound.

SOAP Request Header and  
SOAP Response Header

To configure these options,
• In the SOAP Request Header field, enter the name of a variable 

to hold the XML of the SOAP Header element for the callout 
request 
You must wrap the input document for the SOAP Request 
Header with 
<soap-env:Header>...</soap-env:Header>.

• In the SOAP Response Header field, enter the name of a 
variable to which the XML of the SOAP Headers on the 
response, if any, will be bound.

Request Parameters and  
Response Parameters

To configure options,
• In the Request Parameters fields, enter names for the variables 

that will be evaluated at run time to provide values for the 
request parameters.
You must provide only the core payload documents in the input 
variable—the SOAP package is created for you by Oracle 
Service Bus. In other words, do not wrap the input document 
with <soap-env:Body>...</soap-env:Body>. 
For example, when creating a body input variable that is used for 
this request parameter, you would define that variable’s contents 
using the XPath statement body/* (to remove the wrapper 
soap-env:Body), not $body (which results in keeping the 
soap-env:Body wrapper).

• In the Response Parameters fields, enter the names of the 
variables to which the responses will be assigned at run time.
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8. Optionally, add one or more transport headers. For more information, see “Adding Transport 
Header Actions” on page 19-14.

Request Document and  
Response Document

To configure these options,
• In the Request Document Variable field, enter the name of a 

variable to assign a request document to. 
For SOAP Document-type services, the variable is evaluated at 
runtime to form the body of the SOAP message sent to the 
service. For Any XML services, the variable is evaluated at 
runtime to form the body of the XML message sent to the 
service.
For SOAP Document-type services and for Any XML services, 
you provide only the core payload documents in the input 
variable—the SOAP package is created for you by Oracle 
Service Bus. In other words, do not wrap the input document 
with <soap-env:Body>...</soap-env:Body>. 
For example, when creating a body input variable that is used for 
this request parameter, you would define that variable’s contents 
using the XPath statement body/*  (to remove the wrapper 
soap-env:Body), not $body (which results in keeping the 
soap-env:Body wrapper).
For Messaging services, the variable is evaluated to form the 
body of the message, based on the type of data expected by the 
service. The following restrictions apply to variables used with 
Messaging services: 
– For services that expect binary data, the variables 

must have a ctx:binary-content element. 
– For services that expect MFL data, the variable must 

have the XML equivalent. 
– For services that expect text data, the variable is a 

string.
• In the Response Document Variable field, enter the name of 

the variable to which a response document will be assigned at 
run time.

Table 19-4  Service Callout Configuration Options (Continued)

For These Options... Follow These Steps...
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Note: In addition to the transport headers you specify, headers are added by the Oracle 
Service Bus binding layer. For more information, see Configuring Transport Headers 
in Message Flows in Oracle Service Bus User Guide.

After you finish 

When you complete the configuration of this action, continue by configuring other actions or by 
saving your configuration, as described in “Adding and Editing Actions in Message Flows” on 
page 19-1.

Adding Transport Header Actions
Use a transport header action to set the header values in messages. 

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Click the appropriate icon, then select Add an Action > Communication > Transport 
Headers.

3. From the Set Transport Headers for list, select one of the following, to specify to the run 
time which of the message context locations are to be modified:

– Outbound Request - Select this option to set header values for outbound requests (the 
messages sent out by a proxy service in route, publish, or service callout actions). This 
header element is located in the message context as follows:

$outbound/ctx:transport/ctx:request/tp:headers

– Inbound Response - Select this option to set header values for inbound responses (the 
response messages a proxy service sends back to clients). This header element is 
located in the message context as follows:

$inbound/ctx:transport/ctx:response/tp:headers 

4. Optionally, select Pass all Headers through Pipeline to pass all headers through from the 
inbound message to the outbound message or vice versa. Every header in the source set of 
headers will be copied to the target header set, overwriting any existing values in the target 
header set.

For information about using this option in conjunction with the header-specific pass 
through option, see Configuring Transport Headers in Message Flows in Oracle Service 
Bus User Guide.

5. Complete the following steps for each Header you want to add:
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a. In the Transport Headers table, click Add Header to display fields for configuring the 
header.

b. Specify a header by doing either of the following:

• From the drop-down list in the Name column, select a header name. The list 
contains all of the predefined header names for the target transport (for example, 
Content-Type for HTTP transports, JMSCorrelationID for JMS transports, etc.). 

• Enter a header name in the Other field. If that header name is not one of the 
predefined headers for this service’s transport, it becomes a user-header, as defined 
by the transport specification.

c. Select one of the options in the Action column to specify how to set the headers value:

Set Header to Expression

Selecting this option allows you to use an XQuery or XSLT expression to set the value 
of the header. The expression can be simple (for example, “text/xml”) or a complex 
XQuery or XSLT expression.

Because the Oracle Service Bus transport layer defines the XML representation of all 
headers as string values, the result of any expression is converted to a string before the 
header value is set. Expressions that return nothing result in the header value being set 
to the empty string. You cannot delete a header using an expression.

Warning: Not all of the header settings you can specify in this action are honored 
at run time.For information about which of the headers for a given transport you 
can set and which of those set are honored at run time, see Configuring Transport 
Headers in Message Flows in Oracle Service Bus User Guide. 

Delete Header

Specifies that the header is removed from the request or response metadata.

Copy Header from Inbound Request (if you are setting transport headers for the 
Outbound Request) 
      or 
Copy Header from Outbound Response (if you are setting transport headers for the 
Inbound Response)

Specifies that this header is copied directly from the corresponding header of the same 
name from the inbound message to the outbound message and vice versa. For example, 
if you want to set the SOAPAction header for an outbound request, selecting Copy 
Header from Inbound Request causes the run time to copy the value from the 
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SOAPAction request header of $inbound. In the case of inbound response headers, the 
source of the header to copy is the response headers of $outbound. 

If the Copy Header... option is selected for a header that does not exist in the source, 
this option is ignored and no action is performed on the target for this header. 

For information about using this option in conjunction with the global Pass all 
Headers through Pipeline option, see Configuring Transport Headers in Message 
Flows in Oracle Service Bus User Guide.

6. To add additional Headers to the table, click the  Header icon, then click Add Header. 

The table is expanded to include an additional row, which includes a new set of options 
that you can use to configure another transport header. You can add as many headers as 
necessary to this table. You do not have to order the headers in the table, because the run 
time declares namespaces and places header elements in their proper order when 
generating the corresponding XML.

After you finish 

When you complete the configuration of this action, continue by configuring other actions or by 
saving your configuration, as described in “Adding and Editing Actions in Message Flows” on 
page 19-1.

Adding Dynamic Routing to Route Nodes
Assign a route for a message based on routing information available in an XQuery resource.

This is a terminal action, which means you cannot add another action after this one. However, 
this action can contain request and response actions.

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add Dynamic Routing to a Route Node

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Click the  Route Node icon, then click Edit Route. The Edit Stage Configuration page 
is displayed.
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3. Click the  Add an Action icon, then select Communication > Dynamic Routing.

4. Click <Expression>. The XQuery Expression Editor is displayed. 

5. In the XQuery Expression Editor, enter an Xquery expression, the result of which is similar 
to: 

<ctx:route>

    <ctx:service isProxy='true'>{$service}</ctx:service>

    <ctx:operation>{$operation}</ctx:operation>

</ctx:route>

Note: If a proxy service is being invoked, isProxy attribute should be set to true.

– The service name is the fully qualified service name. 

– The operation element is optional

6. Click Save.

7. In the Request Actions field, click Add an Action to add an action, then select an action that 
you want to associate with the service. You can add more than one action. To learn more about 
the type of actions you want to add, see the table of actions in “Adding and Editing Actions 
in Message Flows” on page 19-1.

8. In the Response Actions field, click Add an Action to add an action, then select an action 
that you want to associate with the service. You can add more than one action. To learn more 
about the type of actions you want to add, see the table of actions in “Adding and Editing 
Actions in Message Flows” on page 19-1.

9. Click Save.

10. On the Edit Message Flow page, continue to construct the message flow, as described in 
“Creating, Editing, and Viewing Message Flows” on page 18-1.

11. Click Save to commit the updates in the current session. 

12. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Adding Routing Actions to Route Nodes
Identify a target service for the message and configure how the message is routed to that service.
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This is a terminal action, which means you cannot add another action after this one. However, 
this action can contain request and response actions.

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add a Routing Action to a Route Node

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Click the  Route Node icon, then click Edit Route. The Edit Stage Configuration page 
is displayed.

3. Click the  Add an Action icon, then select Communication > Routing.

4. Click Service. The Service Browser is displayed.

5. Select a service from the list, then click Submit. The service is displayed instead of the default 
link.

6. If you want the outbound operation to be the same as the inbound operation, select the Use 
inbound operation for outbound check box. 

7. In the Request Actions field, click Add an Action to add an action, then select an action that 
you want to associate with the service. You can add more than one action. To learn more about 
the type of actions you can add, see the table of actions in “Adding and Editing Actions in 
Message Flows” on page 19-1.

8. In the Response Actions field, click Add an Action to add an action, then select an action 
that you want to associate with the service. You can add more than one action. To learn more 
about the type of actions you can add, see the table of actions in “Adding and Editing Actions 
in Message Flows” on page 19-1.

9. Click Save.

10. On the Edit Message Flow page, continue to construct the message flow, as described in 
“Creating, Editing, and Viewing Message Flows” on page 18-1.

11. Click Save to commit the updates in the current session. 
19-18 Using the Oracle Service Bus Console



Adding  Rout ing  Tab les  to  Route  Nodes
12. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Adding Routing Tables to Route Nodes
A routing table is a set of routes wrapped in a switch-style condition table. It is a short-hand 
construct that allows different routes to be selected based upon the results of a single XQuery 
expression.

There is a nesting limit of four cumulative levels in the stage editor. If you attempt to add a fifth 
level, this nesting action is not displayed. Cumulative levels include all branching actions: If... 
Then... conditions, publish tables, and route tables. For example, you can have 2 levels of 
conditionals, then a publish table with a route table inside of it, bringing the total to 4 levels. If 
you attempt to add another conditional (to the last publish table), the conditional is not displayed.

Identify target services for messages and configure how the messages are routed to these services:

This is a terminal action, which means you cannot add another action after this one. However, 
this action can contain request and response actions.

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add a Routing Table to a Route Node

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Click the  Route Node icon, then click Edit Route. The Edit Stage Configuration page 
is displayed.

3. Click the  Add an Action icon, then select Communication > Routing Table. The 
routing table action is displayed.

4. From the Operator list, select a comparison operator, then enter a value expression in the 
adjacent field.

5. Click <Service>. The Select Service page is displayed.

6. Select a service from the list, then click Submit. 

7. If you want to invoke an operation on the service, select an operation from the Operation list
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8. If you want the outbound operation to be the same as the inbound operation, select the Use 
inbound operation for outbound check box. 

9. In the Request Actions field, click Add an Action to add an action, then select an action that 
you want to associate with the service. You can add more than one action.

10. In the Response Actions field, click Add an Action to add an action, then select an action 
that you want to associate with the service. You can add more than one action.

To learn more about the types of request and response actions you can add, see “Adding 
and Editing Actions in Message Flows” on page 19-1.

11. To insert a new case, click the  Case icon, then select Insert New Case.

12. Repeat steps 2-7 for the new case. You can click the  Case icon, then select Insert Default 
Case to add a default case at the end whose routes are selected if none of the preceding cases 
is satisfied.

13. Click Save.

14. On the Edit Message Flow page, continue to construct the message flow, as described in 
“Creating, Editing, and Viewing Message Flows” on page 18-1.

15. Click Save to commit the updates in the current session. 

16. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Adding For Each Actions
Use the for each action to iterate over a sequence of values and execute a block of actions. 

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add a For Each action

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Click the appropriate icon, then select Add an Action > Flow Control > For Each.
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3. Enter variable names in the ...variable fields, click <XPath> to open the XPath editor to 
create an XPath expression, and configure the actions in the Do () loop. 

After you finish 

When you complete the configuration of this action, continue by configuring other actions or by 
saving your configuration, as described in “Adding and Editing Actions in Message Flows” on 
page 19-1.

Adding If... Then... Actions
Use an if...then... action to perform an action or set of actions conditionally, based on the Boolean 
result of an XQuery expression. 

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add an If...Then action

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Click the appropriate icon, then select Add an Action > Flow Control > If...Then.

3. Click <Condition> to display the XQuery Condition Editor page. 

The condition you create is used as the test that is executed before the then() clause is 
entered, per standard if...then logic. See “Creating and Editing Inline XQuery and XPath 
Expressions” on page 20-1.

4. When you finish editing the XQuery condition, click Add an Action, then select an action 
that you want to associate with the condition. To learn more about the type of action you want 
to add, see “Adding and Editing Actions in Message Flows” on page 19-1.

In the route node, you can select only the routing, dynamic routing, or routing table 
actions. However, these actions can contain request and response actions inside of them. 

5. As your logic requires, click the  If...Then... icon, then click Add else-if Condition or 
Add else Condition to add else-if conditions or else conditions. Click Add an Action to 
associate actions with these conditions.

Condition actions can be nested. However, there is a nesting limit of four cumulative levels 
in the stage editor. If you attempt to add a fifth level, this nesting action is not displayed. 
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Cumulative levels include all branching actions:if...then... conditions, publish tables, and 
route tables. For example, you can have two levels of conditionals, then a publish table 
with a route table inside of it, bringing the total to four levels. If you attempt to add 
another conditional action (to the last publish table), it is not displayed.

After you finish

When you complete the configuration of this action, continue by configuring other actions or by 
saving your configuration, as described in “Adding and Editing Actions in Message Flows” on 
page 19-1.

Adding Raise Error Actions
Use the raise error action to raise an exception with a specified error code (a string) and 
description. 

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add a Raise Error action

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Click the appropriate icon, then select Add an Action > Flow Control > Raise Error.

3. In the error code field, enter the error code you want to raise.

4. In the error message field, enter a description of the error code.

After you finish

When you complete the configuration of this action, continue by configuring other actions or by 
saving your configuration, as described in “Adding and Editing Actions in Message Flows” on 
page 19-1.

Transactions
If a service is transactional, a triggered Raise Error action aborts the transaction in the request 
(asynchronous) or in either the request or response (synchronous). For example, you may 
introspect messages and determine conditions under which a Raise Error action should occur 
even if no SOAP fault occurs, and Raise Error causes the transaction to be aborted.
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Adding Reply Actions
Use the reply action to specify that an immediate reply be sent to the invoker.

The reply action can be used in the request, response or error pipeline. You can configure it to 
result in a reply with success or failure. In the case of reply with failure where the inbound 
transport is HTTP, the reply action specifies that an immediate reply is sent to the invoker.

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add a Reply action

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Click the appropriate icon, then select Add an Action > Flow Control > Reply.

3. Select With Success to reply that the message was successful, or select With Failure to reply 
that the message has a fault.

After you finish

When you complete the configuration of this action, continue by configuring other actions or by 
saving your configuration, as described in “Adding and Editing Actions in Message Flows” on 
page 19-1.

Adding Resume Actions
Use the resume action to resume message flow after an error is handled by an error handler. This action 
has no parameters and can only be used in error pipelines. 

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add a Resume action

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Click the appropriate icon, then select Add an Action > Flow Control > Resume.

After you finish
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When you complete the configuration of this action, continue by configuring other actions or by 
saving your configuration, as described in “Adding and Editing Actions in Message Flows” on 
page 19-1.

Adding Skip Actions
Use the skip action to specify that at run time, the execution of this stage is skipped and the 
processing proceeds to the next stage in the message flow. This action has no parameters and can 
be used in the request, response or error pipelines. 

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add a Skip action

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Click the appropriate icon, then select Add an Action > Flow Control > Skip.

After you finish 

When you complete the configuration of this action, continue by configuring other actions or by 
saving your configuration, as described in “Adding and Editing Actions in Message Flows” on 
page 19-1.

Adding Assign Actions
Use the assign action to assign the result of an XQuery expression to a context variable. 

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add an Assign action

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Click the appropriate icon, then select Add an Action > Message Processing > Assign.
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3. Click <Expression>. The XQuery Expression Editor page is displayed. The XQuery 
expression is used to create the data that will be assigned to the named variable. See “Creating 
and Editing Inline XQuery and XPath Expressions” on page 20-1.

4. When you finish editing the expression, enter a context variable in the variable field. To learn 
more about context variables, see Inbound and Outbound Variables and Constructing 
Messages to Dispatch in the Oracle Service Bus User Guide.

After you finish

When you complete the configuration of this action, continue by configuring other actions or by 
saving your configuration, as described in “Adding and Editing Actions in Message Flows” on 
page 19-1.

Adding Delete Actions
Use the delete action to delete a context variable or a set of nodes specified by an XPath 
expression.The delete action is one of a set of update actions. 

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add a Delete action

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. To delete a context variable, select the Variable radio button, then enter the name of a context 
variable in the Variable field. To learn more about context variables, see Appendix A, 
“Message Context.”

Alternatively, to delete all nodes selected by an XPath expression, select the XPath radio 
button, then click <XPath>. The XPath Expression Editor page is displayed. See 
“Creating and Editing Inline XQuery and XPath Expressions” on page 20-1. After you save 
the expression, enter a context variable in the variable field. To learn more about context 
variables, see Appendix A, “Message Context.”

After you finish

When you complete the configuration of this action, continue by configuring other actions or by 
saving your configuration, as described in “Adding and Editing Actions in Message Flows” on 
page 19-1.
Using the Oracle Service Bus Console 19-25

http://download.oracle.com/docs/cd/E13159_01/osb/docs10gr3/userguide/context.html
http://download.oracle.com/docs/cd/E13159_01/osb/docs10gr3/userguide/context.html#construct_messages_dispatch
http://download.oracle.com/docs/cd/E13159_01/osb/docs10gr3/userguide/context.html#construct_messages_dispatch


Proxy  Se rv ices :  Ac t i ons
Adding Insert Actions
Use the insert action to insert the result of an XQuery expression at an identified place relative to 
nodes selected by an XPath expression. The insert action is one of a set of update actions.

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add an Insert action

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Click the appropriate icon, then select Add an Action > Message Processing > Insert.

3. Click <Expression> to edit an XQuery expression. The XQuery expression is used to create 
the data that will be inserted at a specified location in a named variable. The XQuery 
Expression Editor page is displayed. See “Creating and Editing Inline XQuery and XPath 
Expressions” on page 20-1.

4. When you finish editing the expression, select the relative location from the drop-down list. 
The relative location is used to control where the insert is performed relative to the result of 
the XPath expression:

– Before—as sibling before each element or attribute selected by the XPath expression

– After—as sibling after each element or attribute selected by the XPath expression

– As first child of—as first child of each element identified by the XPath expression. An 
error occurs if the result of the XPath returns attributes.

– As last child of—as last child of each element identified by the XPath expression. An 
error occurs if the XPath returns attributes.

5. Click XPath. The XPath Expression Editor page is displayed. See “Creating and Editing 
Inline XQuery and XPath Expressions” on page 20-1.

Valid configurations include those in which: 

– XQuery and XPath expressions both return elements. 

– The XQuery and XPath expressions both return attributes—in which case, the XQuery 
expression must return attributes.
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6. When you finish editing the XPath expression, enter a context variable in the in variable field. 
The XPath evaluates the contents of this variable. To learn more about context variables, see 
Appendix A, “Message Context.”

After you finish

When you complete the configuration of this action, continue by configuring other actions or by 
saving your configuration, as described in “Adding and Editing Actions in Message Flows” on 
page 19-1.

Adding Java Callout Actions
Use the Java callout action to invoke a Java method, or EJB business service, from within the 
message flow. 

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add a Java Callout action

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Click the appropriate icon, then select Add an Action > Message Processing > Java Callout.

3. Click <Method>. The Select a JAR page is displayed. Select a JAR resource from the list. 
The Select a Class and Method page is displayed.

4. From the list of Java classes listed, click the + beside the appropriate class, to display a list of 
methods. Select a method and click Submit. The Java callout action is displayed on the Edit 
Stage page, as follows:

– <Method> is replaced by the name of the Java method you selected in steps 2 and 3. 
This name is a link to the Select a Class and Method page. You can click this link to 
change your selection of Java method.

The method must be a static method.

– Parameters: An <Expression> link to the XQuery Expression Editor page is 
provided for each argument the Java method requires. A label for each link indicates 
the data type for the argument, which will be one of the following: 

• Java.lang.String 
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• Primitive types, and their corresponding class types (e.g., int vs. 
java.lang.Integer)

• java.lang.BigDecimal, and java.lang.BigInteger (these types are used in 
financial calculations where round-off errors or overflows are not tolerable)

• only org.apache.xbeans.XmlObject and no typed xml beans.

• byte[] 

• java.lang.String[]   (INPUT ONLY)

• XmlObject [ ] (INPUT ONLY)

– Result: A Result field in which you enter the variable to which the result is to be 
assigned. The label for the field indicates the data type of the result. 

Note: If the result is a byte array (the only possible array returned), the binary-content 
XML element is returned. 

– Attach a Service Account: A Service Account link allows you to specify an optional 
Service Account if there is a security context for this Java method. To learn more about 
security contexts and service accounts, see “Service Accounts” on page 14-1.

In the case of fixed and mapped service accounts, the userid/password from the service 
account is authenticated in the local system and the security context propagated to the 
Java callout. In the case of passthru, the security context is propagated to the Java 
callout. This context is the message level context if defined (with WS-Security). Else it 
is the transport level context. 

5. Under Parameters, click <Expression>. The XQuery Expression Editor page is displayed. 
Use the XQuery Expression Editor to provide the arguments required by the Java method. See 
“Creating and Editing Inline XQuery and XPath Expressions” on page 20-1

If the type of the input value you enter does not match the declared input argument type, 
Oracle Service Bus tries to automatically typecast input values to the declared type of the 
input argument. For example a string value of "123" will be converted to integer 123 if the 
declared type of the input argument is java primitive int. 

6. In the Result field, assign a variable for the result returned by the Java method.

7. If there is a security context for the Java method, select the check box and click <Service 
Account>. The Select Service Account page is displayed. Select the required service account 
from the list, and click Submit.

After you finish
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When you complete the configuration of this action, continue by configuring other actions or by 
saving your configuration, as described in “Adding and Editing Actions in Message Flows” on 
page 19-1.

Adding MFL Transform Actions
Use the MFL (Message Format Language) transform action to convert message content from 
XML to non-XML, or vice versa, in the message pipeline. An MFL is a specialized XML 
document used to describe the layout of binary data. It is an Oracle proprietary language used to 
define rules to transform formatted binary data into XML data, or vice versa. See “MFLs” on 
page 13-1.

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add an MFL Transform action

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Click the appropriate icon, then select Add an Action > Message Processing > MFL 
Transform.

3. From the Apply MFL Transformation drop-down list, select XML to Non-XML or 
Non-XML to XML, according to your requirement.

4. Click <Expression>. Using the XQuery Expression Editor, specify the variable on which the 
MFL transformation action is to be performed. This input must be text or binary when 
transforming to XML, and must be XML when transforming to non-XML. Binary content in 
the message context is represented by the binary-content XML element. This XML should be 
the result of the Xquery expression when the input needs to be binary. See “Creating and 
Editing Inline XQuery and XPath Expressions” on page 20-1.

5. Select one of the following options:

– MFL Resource: click the <resource> link. The Select MFL page is displayed. Select 
the static MFL resource that will perform the MFL transform action.

– MFL Resource from: click the Expression link. The XQuery Expression Editor 
page is displayed. Using the XQuery Expression Editor, create or edit an XQuery 
expression to dynamically specify an MFL resource that will perform the transform 
Using the Oracle Service Bus Console 19-29



Proxy  Se rv ices :  Ac t i ons
action, in the format project/folder/MFLresourcename. See “Creating and Editing 
Inline XQuery and XPath Expressions” on page 20-1. 

6. In the Assign to Variable field, enter the name of the variable to which the result of this 
transform action is to be assigned. The result will be a binary-content XML element.

After you finish

When you complete the configuration of this action, continue by configuring other actions or by 
saving your configuration, as described in “Adding and Editing Actions in Message Flows” on 
page 19-1.

Adding Rename Actions
Use the rename action to rename elements selected by an XPath expression without modifying 
the contents of the element. The rename action is one of a set of update actions. 

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add a Rename action

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Click the appropriate icon, then select Add an Action > Message Processing > Rename.

3. Click <XPath>. The XPath Expression Editor page is displayed. The XPath expression is 
used to specify the data (in the named variable) that will be renamed. See “Creating and 
Editing Inline XQuery and XPath Expressions” on page 20-1.

4. In variable field, enter the context variable that holds the element you want to rename. To 
learn more about context variables, see Appendix A, “Message Context.”.

5. Do one of the following:

– To rename selected elements using a localname, select the first localname radio button, 
then enter a local name in the localname field.

– To rename selected elements using a namespace, select the first namespace radio 
button, then enter a namespace in the namespace field.
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– To rename selected elements using a local name and namespace, select the localname 
and namespace radio button, then enter a local name and namespace in the localname 
and namespace fields.

After you finish

When you complete the configuration of this action, continue by configuring other actions or by 
saving your configuration, as described in “Adding and Editing Actions in Message Flows” on 
page 19-1.

Adding Replace Actions
Use a replace action to replace a node or the contents of a node specified by an XPath expression. 
The node or its contents are replaced with the value returned by an XQuery expression. 

A replace action can be used to replace simple values, elements and even attributes. An XQuery 
expression that returns nothing is equivalent to deleting the identified nodes or making them 
empty, depending upon whether the action is replacing entire nodes or just node contents.

The replace action is one of a set of update actions. 

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add a Replace action

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Click the appropriate icon, then select Add an Action > Message Processing > Replace.

3. Click <XPath>. The XPath Expression Editor page is displayed. The XPath expression is 
used to specify the data (in the named variable) that will be replaced.See “Creating and 
Editing Inline XQuery and XPath Expressions” on page 20-1.

4. When you finish editing the XPath expression, enter a context variable in the in variable 
field. See Appendix A, “Message Context.”

5. Click <Expression>. The XQuery Expression Editor page is displayed. The XQuery 
expression is used to create the data that replaces the data specified by the XPath in the named 
variable.See “Creating and Editing Inline XQuery and XPath Expressions” on page 20-1.

6. When you finish editing the XQuery expression, select one of the options:
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– Replace entire node—to specify that the nodes selected by the XPath expression you 
defined are replaced along with all of its contents

– Replace node contents—to specify that the node is not replaced; only the contents are 
replaced.

Note: Selecting the Replace node contents option and leaving the XPath field blank is 
more efficient than selecting the Replace entire node option and setting the 
XPath to ./*

After you finish

When you complete the configuration of this action, continue by configuring other actions or by 
saving your configuration, as described in “Adding and Editing Actions in Message Flows” on 
page 19-1.

Adding Validate Actions
Use a validate action to validate elements selected by an XPath expression against an XML 
schema element or a WSDL resource. You can validate global elements only; Oracle Service Bus 
does not support validation against local elements.

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add a Validate action

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Click the appropriate icon, then select Add an Action > Message Processing > Validate.

3. Click XPath. to construct an XPath expression that specifies the elements to be validated. See 
“Creating and Editing Inline XQuery and XPath Expressions” on page 20-1. When you are 
finished constructing the expression in the XPath Expression Editor, click Save. to insert the 
expression on the Edit Stage Configuration page.

4. In the in variable field, enter the name of the variable to hold the element to be validated.

5. Click resource, then select WSDL or Schema. 

6. From the WSDL Browser or XML Schema Browser, do the following:

a. Select the WSDL or XML schema
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b. Select the WSDL or XML schema type or element

c. Click Submit.

7. To save the result of this validation (a boolean result), select Save result of validation in 
variable and enter the name of the variable in which you want to save the result.

Alternatively, to raise an error if the element fails validation against the WSDL or XML 
schema element, select Raise Error on validation failure.

After you are finished

When you complete the configuration of this action, continue by configuring other actions or by 
saving your configuration, as described in “Adding and Editing Actions in Message Flows” on 
page 19-1.

Adding Alert Actions
Use the alert action to generate alerts based on message context in a pipeline, to send to an alert 
destination. Unlike SLA alerts, notifications generated by the alert action are primarily intended 
for business purposes, or to report errors, and not for monitoring system health. Alert destinations 
should be configured and chosen with this in mind. To learn more about alert destinations, see 
“Alert Destinations” on page 5-1.

If pipeline alerting is not enabled for the service or at the domain level, the configured alert action 
is bypassed during message processing. 

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add an Alert action

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Click the appropriate icon, then select Add an Action > Reporting > Alert.

3. Click <Destination>. The Select Alert Destination page is displayed. Select the required 
alert destination from the list and click Submit.

By default, the alert will always go to the console.
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4. Click <Expression>. The XQuery Expression Editor page is displayed. You specify the 
message context to be added to the alert message through XQuery expressions on context 
variables. See “Creating and Editing Inline XQuery and XPath Expressions” on page 20-1.

5. In the alert summary field, enter a short description of the alert. This will be the subject line 
in the case of an E-mail notification, and can contain no more than 80 characters. If no 
description is provided, a predefined subject line that reads, “Oracle Service Bus Alert”, will 
be used instead. 

6. In the severity level drop-down list, select a severity level for this alert from among: Normal, 
Warning, Minor, Major, Critical, and Fatal.

After you finish

When you complete the configuration of this action, continue by configuring other actions or by 
saving your configuration, as described in “Adding and Editing Actions in Message Flows” on 
page 19-1.

Tip: In order to prevent exceptions from aborting the message being processed, when 
generating a pipeline alert, it is recommended that an error handler for the alert action be 
defined to handle and contain such exceptions locally, rather than having them bubble up 
to a global error handler.

Adding Log Actions
Use the log action to construct a message to be logged and to define a set of attributes with which 
the message is logged. 

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add a Log action

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Click the appropriate icon, then select Add an Action > Reporting > Log.

3. Click <Expression>. The XQuery Expression Editor page is displayed. You specify the 
message context to be logged through XQuery expressions on context variables. See 
“Creating and Editing Inline XQuery and XPath Expressions” on page 20-1.
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4. In the Annotation field, enter notes for this log action. These notes are logged along with the 
result of the previously defined expression.

5. In the severity level drop-down list, select one of the options.

After you finish

When you complete the configuration of this action, continue by configuring other actions or by 
saving your configuration, as described in “Adding and Editing Actions in Message Flows” on 
page 19-1.

Adding Report Actions
Use the report action to enable message reporting for a proxy service. 

Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow 
page, as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add a report action

1. Navigate to where you want to add the action, as described in “Adding and Editing Actions 
in Message Flows” on page 19-1.

2. Click the appropriate icon, then select Add an Action > Reporting > Report.

Table 19-5  Log Action Severity Levels 

Severity Level Typical Usage

Info Used for reporting normal operations; a low-level informational message.

Warning A suspicious operation or configuration has occurred but it might not affect 
normal operation.

Error A user error has occurred. The system or application can handle the error 
with no interruption and limited degradation of service.

Debug While your application is under development, you might find it useful to 
create and use messages that provide verbose descriptions of low-level 
activity within the application.
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3. Click <Expression>. The XQuery Expression Editor page is displayed. See “Creating and 
Editing Inline XQuery and XPath Expressions” on page 20-1. The XQuery expression is used 
to create the data that will be reported to the Oracle Service Bus dashboard.

4. When you finish editing the XQuery expression, click Add a Key. Two fields are displayed: 
a Key Name field and a Key Value field, which includes an XPath link that you can click to 
edit an XPath expression and an in variable field in which you can enter a context variable.

You use key value pairs to extract key identifiers from any message context variable or 
message payload, and ignore the rest of the message. The keys are a convenient way to 
identify a message. They are displayed as report indexes in the Reporting module. See 
“Viewing Reporting Messages” on page 25-1 and “Viewing Message Details” on 
page 25-3.

a. Enter a key name in the Key Name field.

b. Click <XPath>. The Edit an XPath Expression page is displayed. See “Creating and 
Editing Inline XQuery and XPath Expressions” on page 20-1.

c. Enter a context variable in the in variable field. To learn about context variables, see 
Appendix A, “Message Context.”

d. To add more key values, click the  Key icon, then select Add a Key. To delete a key, 
click the  Key icon, then select Delete this Key.

For example, consider a report action configured on an error handler in a stage. The action reports 
the contents of the fault context variable in the event of an error. The report action is configured 
as follows:

Key name = errorCode

Key value = ./ctx:errorCode in variable fault

Each time this action is executed at run time, a message is reported via the Reporting Data Stream. 
The following table shows the results after the report action is executed twice.

After you finish

Report Index DB TimeStamp Inbound Service Error Code

errorCode=BEA-382505 04/26/07 9:45 AM MortgageBroker/ProxySvcs/loanGateway3 BEA-382505

errorCode=BEA-382505 04/26/07 9:45 AM BEA-382505
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When you complete the configuration of this action, continue by configuring other actions or by 
saving your configuration, as described in “Adding and Editing Actions in Message Flows” on 
page 19-1.
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Proxy Services: XQuery and XPath 
Editors
In the message flow of a proxy service, you can assign XQuery expressions to message context 
variables, assign If...Then... actions based on the Boolean result of an XQuery expression, insert 
the result of an XQuery expression at an identified place relative to an XPath expression, specify 
the message context that you want to log through XQuery expressions on context variables, and 
so on.

The XQuery Expression Editor, the XQuery Condition Editor, and the XPath Expression Editor 
are available in the appropriate context in message flows to construct the kind of expression 
called for in the context.

Creating and Editing Inline XQuery and XPath 
Expressions

When you add actions to stages or route nodes on the Edit Stage Configuration Page, a skeleton 
structure is displayed on the page that prompts for configuration details. Figure 20-1shows an 
example.

Figure 20-1  Example of Action Configuration Skeleton

Whenever it is appropriate for the context, the skeleton provides links for accessing the XQuery 
editors, where you can construct expressions that will be executed inline, as required by the 
context in the action. 
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Before you begin

These instructions assume you are creating or editing an action in the Edit Stage Configuration 
Page of a pipeline stage, an error handler stage, or a route node. See “Creating, Editing, and 
Viewing Message Flows” on page 18-1 and “Adding and Editing Actions in Message Flows” on 
page 19-1.

To create or modify an inline expression

1. On the Edit Stage Configuration page, locate the place in the action where you want to add 
or edit the expression.

2. Click the expression link to open the editor that is appropriate for the context. When an 
expression has not yet been defined, the link tells what kind of expression you can use in that 
position:

– Click <Expression> to create an XQuery expression.You can also import an XQuery or 
XSLT resource created outside Oracle Service Bus, then bind it to the inline XQuery. 

– Click <Condition> to create an XQuery conditional expression for an if..then... action.

– Click <XPath> to create an XPath expression for a message context variable.

When an expression has already been defined in a position, the <Expression>, 
<Condition>, or <XPath> link is replaced by a link that shows expression itself, for 

example true() , or a fragment of the expression it is too long to fit, for example 

$body/urn:POSta... .. Click the expression (or expression fragment) to open the 
expression in the appropriate editor.

3. Build the expression, as described in the following topics:

– “Building Expressions in the Editor Workspace Text Fields” on page 20-4

– “Creating Namespaces to Use in Inline Expressions” on page 20-8

– “Creating Variable Structures in the XQuery Editors” on page 20-9

– “Binding External XQuery Resources to Inline XQueries” on page 20-14

– “Binding External XSLT Resources to Inline XQueries” on page 20-15

– “Binding Dynamic XQuery Expressions to Inline XQueries” on page 20-16

– “Entering XQuery Comparison Expressions Using the Builder Option” on page 20-17

– “Entering Unary Expressions Using the Builder Option” on page 20-19

4. Optionally, do either or both of the following:
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– Click Validate to validate the expression.

– Click Test to test the expression. See “Performing XQuery Testing” on page 30-22.

5. Click Save to close the editor and insert the expression in the action.

After you finish

Continue configuring the action, as described in “Adding and Editing Actions in Message Flows” 
on page 19-1.

Understanding XQuery Editor Layouts and Tasks
The XQuery Expression Editor, the XQuery Condition Editor, and the XPath Expression Editor 
are each composed of the following components:

Palettes

Workspace

Property Inspector

Palettes
The left panel of the each editor contains the palettes listed below. In any of the editors, click the 
name of a palette to display it. Each palette contains entities that you can insert into expressions 
in the editors. 

The Namespace Definitions palette lists default Oracle Service Bus namespaces, variable 
namespaces, and user-defined namespaces. You can define new namespaces, which are 
then added to the list of user-defined namespaces. 

For more information, see:

– “Building Expressions in the Editor Workspace Text Fields” on page 20-4

– “Creating Namespaces to Use in Inline Expressions” on page 20-8

The XQuery Functions palette lists a set of standard XQuery functions.When you insert a 
function into an expression, placeholders are used for parameter values you must supply. 

For more information, see:

– “Building Expressions in the Editor Workspace Text Fields” on page 20-4

– “Binding External XQuery Resources to Inline XQueries” on page 20-14
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The Variable Structures palette provides a set of tools for inserting variables and paths to 
the variables, using XPath expressions.

Variable structures are graphical representations of variables or variable paths that are 
displayed in the editor. They can help you visualize the variable structure, and you can use 
them to construct inline XQuery expressions that reference the content of the variable.

Note: Variable structures do not create variables. Variables are created at runtime as the 
target of the Assign action in the stage. 

Oracle Service Bus provides several predefined message context variables (attachments, 
body, header, outbound, and inbound), whose contents you can display as variable 
structures. You can also define your own variable structures.

For more information, see

– “Building Expressions in the Editor Workspace Text Fields” on page 20-4

– “Creating Variable Structures in the XQuery Editors” on page 20-9

Workspace
The right side of the page provides a workspace for constructing the XQuery expression, XQuery 
condition, or XPath. The workspace is different in the three editors.

Property Inspector
In all three editors, the Property Inspector is displayed on the bottom right of the page. When 
you select an item from one of the palettes to add to the expression, that item appears in the 
Property Inspector. You can then paste the item into the workspace. See “Building Expressions 
in the Editor Workspace Text Fields” on page 20-4.

Building Expressions in the Editor Workspace Text Fields
The XQuery Expression Editor, the XQuery Condition Editor, and the XPath Expression 
Editor all provide text fields in which you can build expressions by typing directly or by pasting 
items from the palettes. 

Before you begin

These instructions assume you are creating or editing an expression in the XQuery Expression 
Editor, XQuery Condition Editor, or XPath Expression Editor, as described in “Creating and 
Editing Inline XQuery and XPath Expressions” on page 20-1. 
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To build an expression in a text field:

1. Display the panel containing the text field. Depending on the editor, do one of the following:

– In the XQuery Expression Editor, select XQuery Text (located under the workspace 
button bar), if it is not already selected.

– In the XQuery Condition Editor, select Text (located under the workspace button 
bar), if it is not already selected.

– In the XPath Expression Editor, you do not have to select anything, because there are 
no options for selecting other tools.

Note: Selecting any of the above links displays a text field where you can create a complete 
expression appropriate for the context. However, the tools and techniques described 
in this topic can be used wherever text fields are provided in the editors, for example 
when binding variables from imported resources to the inline expression, as described 
in “Binding External XQuery Resources to Inline XQueries” on page 20-14 and 
“Binding External XSLT Resources to Inline XQueries” on page 20-15.

2. If desired, type or paste an expression or expression fragment into the field. If you create the 
complete expression this way, skip to step 7, below. Otherwise, proceed to the next step.

3. Select the palette containing the item(s) you want to add to the expression, and locate the item 
you want to add, as described in Table 20-1, below.

Table 20-1  Palettes 

Palette Description and Use

Namespace Definitions Lists default Oracle Service Bus namespaces, variable namespaces, 
and user-defined namespaces. Namespace abbreviations are listed 
when defined.

Scroll through the lists to find the desired namespace. 

You can also define a namespace. See “Creating Namespaces to 
Use in Inline Expressions” on page 20-8.
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XQuery Functions Contains a set of standard XQuery functions, organized 
alphabetically and by type:
• Service Bus Functions
• Accessors
• Error Functions
• XML Functions
• Constructors
• Numerics 
• Strings
• URIs
• Booleans
• Durations, Dates, and Times
• QNames
• Nodes
• Sequences
• Context Functions
• Alphabetical

Expand or collapse nodes in the tree by clicking the plus sign (+) or 
minus sign (-).

See also:
• “XQuery Transformations” on page 10-1
• XQuery Implementation in the Oracle Service Bus User Guide.

Table 20-1  Palettes (Continued)
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4. Paste the desired item into the text field using any of the methods shown below in Table 20-2:

Variable Structures Displays variables and their contents as trees, which can help you to 
visualize. 

To display a variable structure and its contents
• Select the name of the structure from the drop-down list at the 

top of the palette. The list displays Built-in message context 
variables (attachments, body, header, outbound, and 
inbound), as well as any user-defined structures, organized by 
type (XML Type, Service Interface, and Simple Type).

• Expand or collapse nodes in the tree by clicking the plus sign 
(+) or minus sign (-).

You can also define your own variable structures. See “Creating 
Variable Structures in the XQuery Editors” on page 20-9.

Variable structures do not create variables. Variables are created at 
runtime as the target of the Assign action in the stage. 

When you insert an item from the a variable structure tree into the 
text field, it is inserted as an XPath expression that describes the 
path. 

See also “XQuery Transformations” on page 10-1.

Table 20-2  Ways to Paste Items Into the Editor Text Fields 

From this palette... Do this...

Namespace Definitions palette Use standard mouse or keyboard select, copy, and paste a 
namespace, for example:
1. Select the entire namespace string (or its abbreviation, if one 

exists) by dragging the mouse pointer over the string.
2. Press Ctrl-C to copy the string. 
3. Click the location in the text field where you want to insert the 

namespace.
4. Press Ctrl-V to paste the string. 

XQuery Functions palette or 
Variable Structures palette

Drag an item from the palette to the text field. 

Note: Dragging from the palette to the workspace is supported 
only in Internet Explorer.

Table 20-1  Palettes (Continued)
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5. Continue to drag and drop functions to build the desired expression.

6. Edit the expression in the text field, as needed.

7. Optionally, do either or both of the following:

– Click Validate. A message is displayed if the expression is validated successfully.

– Click Test to test the expression. See “Performing XQuery Testing” on page 30-22.

8. Click Save to close the editor and insert the expression in the action.

After you finish

Continue configuring the action, as described in “Adding and Editing Actions in Message Flows” 
on page 19-1.

Creating Namespaces to Use in Inline Expressions 
The Namespace Definitions palette includes a list of default namespaces, but you can also define 
new ones.

Before you begin

XQuery Functions palette or 
Variable Structures palette

1. Click an item in the palette. The item is displayed in the 
Property Inspector pane:
– Functions are displayed with placeholders for any values 

you have to supply. 
– Variables and their attributes are displayed as XPath 

expressions.
2. Click in the text field where you want to insert the item
3. Click Copy Property to paste the item into the location selected 

in the text field.

XQuery Functions palette or 
Variable Structures palette

1. Click an item in the palette. The item is displayed in the 
Property Inspector pane.

2. Select and copy the item in the Property Inspector, using 
standard keyboard or mouse actions.

3. Select a location in the text field, and paste the item into the text 
field, using standard keyboard or mouse actions.

Table 20-2  Ways to Paste Items Into the Editor Text Fields (Continued)
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These instructions assume you are creating or editing an expression in the XQuery Expression 
Editor, XQuery Condition Editor, or XPath Expression Editor, as described in “Creating and 
Editing Inline XQuery and XPath Expressions” on page 20-1. 

To create and use a namespace in an inline expression

1. Select Namespace Definitions. The Namespace Definitions palette includes a list of default 
namespaces, plus lists of variable namespaces and user defined namespaces, if any exist.

2. To define and add a user namespace, 

a. Click Add Namespace. 

b. In the Prefix field, enter a unique identifier for the namespace. You cannot use the same 
prefix more than once.

c. In the URI field, enter a URL for this namespace in the format http://url/.../ or enter 
a URN in the format uddi:server:.

d. Click Add to add the namespace to the User Defined Namespaces list.

e. Copy and paste the user-defined namespace into the XQuery expression, XQuery 
condition, or XPath, as described in “Creating and Editing Inline XQuery and XPath 
Expressions” on page 20-1.

After you finish

Continue as described in “Creating and Editing Inline XQuery and XPath Expressions” on 
page 20-1. 

Creating Variable Structures in the XQuery Editors
The Variable Structures palette in the XQuery and XPath editors displays graphical 
representations of the contents of variables. It includes by default the built-in message context 
variables attachments, body, header, outbound, and inbound. 

Each variable structure mapping entry has a label and maps a variable or variable path to one or 
more structures. The scope of these mappings is a stage or a route node.

You can also declare your own variable structures, based on:

XML types, including

– Schema elements

– WSDL elements
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– Schema types

– WSDL types

– MFLs

Service interfaces

Simple types (string or any XML)

You can use this feature directly for all user-defined variables, as well as $inbound, $outbound, 
and $fault. However, you cannot use it directly to access XML attachments in $attachments, 
headers in $header, or documents and RPC parameters in $body, with one exception— you can 
use it directly to access documents and parameters in $body for request messages received by a 
WSDL proxy service.

Before you begin

These instructions assume you are creating or editing an expression in the XQuery Expression 
Editor, XQuery Condition Editor, or XPath Expression Editor, as described in “Creating and 
Editing Inline XQuery and XPath Expressions” on page 20-1. 

To create a variable structure:

1. Select Variable Structures. 

2. In the Variable Structures palette, click Add New Structure. 

3. Continue with any of the tasks listed in Table 20-3, below.
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Table 20-3  Create a New Variable Structure 

To... Complete these steps...

Create a variable structure 
that maps a variable to an 
XML Schema type

1. Select XML Type at the top of the Variable Structures palette, if it 
is not already selected.

2. In the Structure Label field, enter a display name for the variable you 
want to create. This display name enables you to give a meaningful 
name to the structure so you can recognize it at design time but it has 
no impact at run time.

3. In the Structure Path field, enter the path of the variable structure at 
run time. The path must begin with $.

4. Under the Type field, select the appropriate radio button, then select 
Schema Type.

5. Click Browse. The XML Schema Browser is displayed. Select an 
XML Schema from the list, select an XML Schema type from the 
Definitions pane, then click Submit.

6. Click Add to create the variable structure.

Create a variable structure 
that maps a variable to a 
WSDL type

1. Select XML Type at the top of the Variable Structures palette, if it 
is not already selected.

2. In the Structure Label field, enter a display name for the variable you 
want to create. This display name enables you to give a meaningful 
name to the structure so you can recognize it at design time but it has 
no impact at run time.

3. In the Structure Path field, enter the path of the variable structure at 
run time. 

4. Under the Type field, select the appropriate radio button, then select 
WSDL Type.

5. Click Browse. The WSDL Browser is displayed. Select a WSDL 
from the list of WSDLs, select a WSDL type from the Definitions 
pane, then click Submit.

6. Click Add to create the variable structure.
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Create a variable structure 
that maps a variable to an 
XML Schema element

1. At the top of the Variable Structures palette, select XML Type, if it 
is not already selected.

2. In the Structure Label field, enter a display name for the variable you 
want to create. This display name enables you to give a meaningful 
name to the structure so you can recognize it at design time but it has 
no impact at run time.

3. In the Structure Path field, enter the path of the variable structure at 
run time. 

4. Under the Type field, select the appropriate radio button, then select 
Schema Element.

5. Click Browse. The XML Schema Browser is displayed. Select an 
XML Schema from the list, select an XML Schema type from the 
Definitions pane, then click Submit.

6. Click Add to create the variable structure.

Create a variable structure 
that maps a variable to a 
WSDL element

1. At the top of the Variable Structures palette, select XML Type, if it 
is not already selected.

2. In the Structure Label field, enter a display name for the variable you 
want to create. This display name enables you to give a meaningful 
name to the structure so you can recognize it at design time but it has 
no impact at run time.

3. In the Structure Path field, enter the path of the variable structure at 
run time.

4. Under the Type field, select the appropriate radio button, then select 
WSDL Element.

5. Click Browse. The WSDL Browser is displayed. Select a WSDL 
from the list of WSDLs, select a WSDL element from the Definitions 
pane, then click Submit.

6. Click Add to create the variable structure.

Table 20-3  Create a New Variable Structure (Continued)

To... Complete these steps...
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Create a variable structure 
that maps a variable to a 
child element

1. At the top of the Variable Structures palette, select XML Type, if it 
is not already selected.

2. In the Structure Label field, enter a display name for the variable you 
want to create. This display name enables you to give a meaningful 
name to the structure so you can recognize it at design time but it has 
no impact at run time.

3. In the Structure Path field, enter the path of the variable structure at 
run time. 

4. Under the Type field, select the type of variable you want to create:
To create an XML Schema Element or WSDL Element variable, select 
the radio button associated with this option, then select Schema 
Element or WSDL Element.
To create an MFL variable, select the radio button associated with this 
option, then select MFL.

5. For the XML Schema, WSDL, or MFL, click Browse to select an 
object from the list that the browser displays, then click Submit. For 
example, select an MFL from a list of MFLs, then click Submit.

6. Select the Set as child check box to set the element as a child of the 
structure being created.

7. Click Add to create the variable structure.

Create a variable structure 
that uses an MFL resource

1. At the top of the Variable Structures palette, select XML Type, if it 
is not already selected.

2. In the Structure Label field, enter a display name for the variable you 
want to create. This display name enables you to give a meaningful 
name to the structure so you can recognize it at design time but it has 
no impact at run time.

3. In the Structure Path field, enter the path of the variable structure at 
run time. 

4. Under the Type field, select the appropriate radio button, then click 
Browse. The MFL Browser is displayed. 

5. Select an MFL from the list of MFLs, then click Submit.
6. Click Add to create the variable structure.

Table 20-3  Create a New Variable Structure (Continued)

To... Complete these steps...
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After you finish

Continue as described in “Creating and Editing Inline XQuery and XPath Expressions” on 
page 20-1.

Binding External XQuery Resources to Inline XQueries
You can bind XQuery resources to inline XQuery expressions, so they will be executed inline as 
part of an action.

Before you begin

Create a Service Interface 
variable structure

1. At the top of the Variable Structures palette, select Service 
Interface.

2. In the Structure Label field, enter a display name for the variable you 
want to create. This display name enables you to give a meaningful 
name to the structure so you can recognize it at design time but it has 
no impact at run time.

3. In the Structure Path field, the default is already set as $body. You 
cannot change this field.

4. In the WSDL Based Service field, select the Service Browser icon, 
select a service from the list of services the Service Browser displays, 
then click Submit.
The service you selected is displayed in the WSDL Based Service 
field.

5. In the Operation field, select an operation or select None to not 
include an operation.

6. Click Add to create the variable.

Create a Simple variable 
structure

1. At the top of the Variable Structures palette, select Simple Type.
2. In the Structure Label field, enter a display name for the variable you 

want to create. This display name enables you to give a meaningful 
name to the structure so you can recognize it at design time but it has 
no impact at run time.

3. In the Structure Name field, enter a name for the variable structure 
you want to create.

4. Under the Type field, select String or Any XML.
5. Click Add to create the variable.

Table 20-3  Create a New Variable Structure (Continued)

To... Complete these steps...
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These instructions assume you are creating or editing an expression in the XQuery Expression 
Editor, XQuery Condition Editor, or XPath Expression Editor, as described in “Creating and 
Editing Inline XQuery and XPath Expressions” on page 20-1. 

To bind an XQuery Resource to an inline expression:

1. Click Variable Structures.

2. In the workspace (under the button bar), select XQuery Resources.

3. In the 1. Select an XQuery resource to execute box, click Browse.

4. In the XQuery Browser, select the radio button associated with the XQuery you want to use, 
then click Submit.

5. In the 2. Bind Variables box, define the input parameters for the transformation. For each 
variable listed under Variable Name enter an XQuery expression to be mapped to it. You 
must define a mapping for each parameter. For example, if an XQuery transformation has two 
input parameters named one and two, the Variable Name field has two labels—one and two. 
A text box, into which the XQuery expression is entered, is associated with each label.

The following XQuery expressions are examples of valid input to this field:
$body/*[1]

$body/po:PurchaseOrder

Note: The following variable name is not a valid entry for this field and results in an 
exception:  
body

6. After you finish, continue with any of the following tasks.

– Click Validate. A message is displayed if the expression is validated successfully.

– Click Test. See “Performing XQuery Testing” on page 30-22.

– Save or discard your changes.

Binding External XSLT Resources to Inline XQueries
The XQuery Expression Editor page allows you to select an XSLT resource for execution. To 
learn more about this editor, see “Creating and Editing Inline XQuery and XPath Expressions” 
on page 20-1.

To Select an XSLT Resource for Execution
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1. Select the XSLT Resources option.

2. Under the Select the XSLT resource to execute field, select the XSLT Browser icon.

3. In the XSLT Browser, select the radio button associated with the XSLT you want to execute, 
then click Submit.

4. Under the Bind Variables field, a label and a corresponding text box is displayed for each 
input parameter of the transformation. Each label corresponds to the name of a parameter, and 
each text box is for defining an XQuery expression to be mapped to the parameter. You must 
define a mapping for each parameter. For example, if an XSL transformation has two input 
parameters named one and two, the Variable Mapping field has two labels—one and two—
with a text box associated with each into which the XQuery expression is entered. In addition 
to the mapping for any input variables, you must also specify an XQuery expression for the 
Input Document to the transformation. The mapping is specified in the text box with the label 
Input Document.

The following XQuery expressions are examples of valid input to this field:
$body/*[1]

$body/po:PurchaseOrder

Note: The following variable name is not a valid entry for this field and results in an 
exception:  
body

5. Continue with any of the following tasks:

– “Creating Namespaces to Use in Inline Expressions” on page 20-8.

– “Creating Variable Structures in the XQuery Editors” on page 20-9.

– “Building Expressions in the Editor Workspace Text Fields” on page 20-4.

– “Binding External XQuery Resources to Inline XQueries” on page 20-14.

– Click Validate. A message is displayed if the expression is validated successfully.

– Click Test. See “Performing XQuery Testing” on page 30-22.

Binding Dynamic XQuery Expressions to Inline XQueries
The XQuery Expression Editor page allows you to specify a dynamic XQuery expression that 
evaluates at runtime to the name of a pre-registered XQuery resource. To learn more about this 
editor, see “Creating and Editing Inline XQuery and XPath Expressions” on page 20-1.

To define a dynamic XQuery expression
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1. Select the Dynamic XQuery option.

2. In the Enter Expression for XQuery Resource area, enter the XQuery expression that will 
evaluate at runtime to the name of a pre-registered XQuery resource.

The following shows the syntax for the XQuery resource (representing the full name of the 
resource):
Project/folder1/folder2/XQueryResourceName

3. In the Bind Variables using XQuery Template of Custom Variables area, define the input 
parameters for the transformation.

– Click Browse in the Select XQuery Template field to select an existing registered 
resource to serve as a template for the shape of the query (the number and names of the 
variables). After selecting a template, the variables appear in the Bind Variables area. 
Note that the template is not persisted with the configuration. Instead, the template 
serves as a quick start to help you specify the variables for the query.

– Type a variable name in the Add Custom Variable field, and click Add. For each 
variable listed under Variable Name, enter an XQuery expression to be mapped to it. 
You must define a mapping for each parameter. For example, if an XQuery 
transformation has two input parameters named one and two, the Variable Name field 
has two labels—one and two. A text box, into which the XQuery expression is entered, 
is associated with each label.

The following XQuery expressions are examples of valid input to the variable fields:
$body/*[1]

$body/po:PurchaseOrder

4. After you finish, continue with any of the following tasks.

– Click Validate. A message is displayed if the expression is validated successfully.

– Click Test. See “Performing XQuery Testing” on page 30-22.

– Save or discard your changes.

Entering XQuery Comparison Expressions Using the 
Builder Option

Before you begin
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These instructions assume you are creating or editing an XQuery conditional expression in the 
XQuery Condition Editor, as described in “Creating and Editing Inline XQuery and XPath 
Expressions” on page 20-1. 

To enter an XQuery comparison expression:

1. In the XQuery Condition Editor, select Builder (located under the workspace button bar), 
if it is not already selected. option.

2. In the Expression Builder box, select Comparison Expression if it is not already selected.

3. In the Operand field, enter a context variable, namespace definition, or XQuery function. 

To build the operand, you can paste XQuery functions from the XQuery Functions palette 
and namespaces from the Namespace Definitions palette. See step 3 and step 4 in 
“Building Expressions in the Editor Workspace Text Fields” on page 20-4.

4. From the Operator list, select a comparison operator.

5. In the Value field, enter text or enter a context variable.

You must enter text in quotations—for example, "true" is valid; true is not.

6. Click Add. The text you entered is displayed in the Expressions pane.

7. Repeat steps 3-6 to build additional conditions. Each condition is added to the end of the list 
of conditions.

Consider the following when using multiple conditions:

– When you build additional expressions, make sure to select the And or the Or options 
in the Conjunction field.

– You can select a condition and click the  Up arrow to move it up in the list of 

conditions or click the  Down arrow to move it down the list of conditions. You can 

also click the  Edit icon to update a condition, or click the  Delete icon to delete 
it.

– Unary expressions may be intermixed with Comparison expressions in the overall 
definition of a condition.

8. Optionally, do either or both of the following:

– Click Validate. A message is displayed if the expression is validated successfully.

– Click Test to test the expression. See “Performing XQuery Testing” on page 30-22.
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9. Click Save to close the editor and insert the expression in the action.

After you finish

Continue configuring the action, as described in “Adding and Editing Actions in Message Flows” 
on page 19-1.

Entering Unary Expressions Using the Builder Option
Before you begin

These instructions assume you are creating or editing an XQuery conditional expression in the 
XQuery Condition Editor, as described in “Creating and Editing Inline XQuery and XPath 
Expressions” on page 20-1. 

To enter an XQuery comparison expression:

1. In the XQuery Condition Editor, select Builder (located under the workspace button bar), 
if it is not already selected. option.

2. In the Expression Builder box, select Unary Expression if it is not already selected.

3. Select the Not check box to make this a negative expression, or leave it blank.

4. Enter a context variable, namespace definition or XQuery function in the Expression field.

To build the expression, you can paste XQuery functions from the XQuery Functions 
palette and namespaces from the Namespace Definitions palette. See step 3 and step 4 in 
“Building Expressions in the Editor Workspace Text Fields” on page 20-4.

5. Click Add to add the text to the Expressions pane.

6. Repeat steps 3-5 to build additional conditions. Each condition is added to the end of the list 
of conditions.

Consider the following when building unary expressions.

– When you build additional expressions, make sure to select the And or the Or options 
in the Conjunction field.

– You can select a condition and click the  Up arrow to move it up in the list of 

conditions, click the  Down arrow to move it down the list of conditions, click the 

 Edit icon to update it, or click the  Delete icon to delete it.
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– Unary expressions may be intermixed with Comparison expressions in the overall 
definition of a condition.

7. Optionally, do either or both of the following:

– Click Validate. A message is displayed if the expression is validated successfully.

– Click Test to test the expression. See “Performing XQuery Testing” on page 30-22.

8. Click Save to close the editor and insert the expression in the action.

After you finish

Continue configuring the action, as described in “Adding and Editing Actions in Message Flows” 
on page 19-1.
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Proxy Services: Error Handlers
You can configure error handling at the message flow, pipeline, route node, and stage level. 

Edit Error Handler page
You can configure error handling at the message flow, pipeline, route node, and stage level. 

Configure error handlers on the Edit Error Handler page. You must always add at least one 
stage to the page to specify how the error handler will work. See the following topics:

Adding Proxy Service Error Handlers

Adding Pipeline Error Handlers

Adding Stage Error Handlers

Adding Route Node Error Handlers

Editing Error Handlers

Handling Errors in Message Flows in the Oracle Service Bus User Guide

Adding Proxy Service Error Handlers
Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow page, 
as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To add a proxy service Error Handler
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1. Click the  Proxy Service icon, then click Add Service Error Handler. The Edit Error 
Handler page is displayed.

2. Click the  Error Handler icon, then click Add Stage. 

3. Click the  Stage icon, then click Edit Stage. The Edit Stage Configuration page is 
displayed.

4. Click Add an Action, then select the action you want to add.

An error handler is a pipeline and is therefore configured like any other pipeline. For 
example, you can use the Publish action to send error notifications to other services, use 
the Assign action to modify the context variables, and so on. See “Adding and Editing 
Actions in Message Flows” on page 19-1. There is no restriction on what actions may be 
chained together.

Three commonly-used error actions are Raise Error, Reply, and Resume. 

5. Add other actions and make other edits on the Edit Stage Configuration page, as desired.

6. On the Edit Stage Configuration page, click Save to commit the updates in the current 
session. 

7. On the Edit Error Handler page, click Save to commit the updates in the current session. 

After you finish

On the Edit Message Flow page, continue to construct the message flow, as described in 
“Creating, Editing, and Viewing Message Flows” on page 18-1.

Adding Pipeline Error Handlers
Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow page, 
as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

The instructions also assume you have created a pipeline pair node, as explained in “Adding 
Pipeline Pair Nodes to Message Flows” on page 18-6.

To add a Pipeline Error Handler
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1. Navigate to the pipeline pair node containing the pipeline to which you want to add an error 

handler. If the pipeline pair is not already expanded, click the plus sign next to the icon  
to display the pipelines.

2. Click the  Request Pipeline icon or the  Response Pipeline icon, then click Add 
Pipeline Error Handler. The Edit Error Handler page is displayed.

3. Click the  Error Handler icon, then click Add Stage. 

4. Click the  Stage icon, click Edit Stage. The Edit Stage Configuration page

5. Click Add an Action, then select the action you want to add.

An error handler is a pipeline and is therefore configured like any other pipeline. For 
example, you can use the Publish action to send error notifications to other services, use 
the Assign action to modify the context variables, and so on. To learn more about the type 
of action you want to add, see the appropriate procedure in “Adding and Editing Actions in 
Message Flows” on page 19-1. There is no restriction on what actions may be chained 
together.

Three commonly-used error actions are Raise Error, Reply, and Resume. 

6. Add other actions and make other edits on the Edit Stage Configuration page, as desired.

7. On the Edit Stage Configuration page, click Save to commit the updates in the current 
session. 

8. On the Edit Error Handler page, click Save to commit the updates in the current session. 

After you finish

On the Edit Message Flow page, continue to construct the message flow, as described in 
“Creating, Editing, and Viewing Message Flows” on page 18-1.

Adding Stage Error Handlers
Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow page, 
as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.
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The instructions also assume you have added a stage to a pipeline, as explained in “Adding Stages 
to Pipelines” on page 18-10.

To add a Stage Error Handler

1. Navigate to the stage to which you want to add error handling.

2. Click the  Stage icon, then click Add Stage Error Handler. The Edit Error Handler 
page is displayed.

3. Click the Error Handler icon, then click Add Stage. 

4. Click the  Stage icon, then click Edit Stage. The Edit Stage Configuration page is 
displayed.

5. Click Add an Action, then select the action you want to add.

An error handler is a pipeline and is therefore configured like any other pipeline. For 
example, you can use the Publish action to send error notifications to other services, use 
the Assign action to modify the context variables, and so on. To learn more about the type 
of action you want to add, see the appropriate procedure in “Adding and Editing Actions in 
Message Flows” on page 19-1. There is no restriction on what actions may be chained 
together.

Three commonly-used error actions are Raise Error, Reply, and Resume. 

6. Add other actions and make other edits on the Edit Stage Configuration page, as desired.

7. Click Save to commit the updates in the current session. 

After you finish

On the Edit Message Flow page, continue to construct the message flow, as described in 
“Creating, Editing, and Viewing Message Flows” on page 18-1.

Adding Route Node Error Handlers
Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow page, 
as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

The instructions also assume you have created a route node, as explained in “Adding Route 
Nodes to Message Flows” on page 18-11.
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To add a Route Node Handler

1. Click the  Route Node icon, then click Add Error Handler. The Edit Error Handler 
page is displayed.

2. Click the Error Handler icon, then click Add Stage. 

3. Click the  Stage icon, then click Edit Stage. The Edit Stage Configuration page is 
displayed.

4. Click Add an Action, then select the action you want to add.

Since an error handler is another pipeline, it is configured like any other pipeline. For 
example, the Publish action may be used to send error notifications to other services, the 
Assign action may be used to modify the context variables, and so on. To learn more about 
the type of action you want to add, see the appropriate procedure in “Adding and Editing 
Actions in Message Flows” on page 19-1. There is no restriction on what actions may be 
chained together.

Three commonly-used error actions are Raise Error, Reply, and Resume. 

5. Add other actions and make other edits on the Edit Stage Configuration page, as desired.

6. On the Edit Stage Configuration page, click Save to commit the updates in the current 
session. 

7. On the Edit Error Handler page, click Save to commit the updates in the current session. 

After you finish

On the Edit Message Flow page, continue to construct the message flow, as described in 
“Creating, Editing, and Viewing Message Flows” on page 18-1.

Editing Error Handlers
Before you begin

These instructions assume you are already editing a message flow in the Edit Message Flow page, 
as explained in “Creating, Editing, and Viewing Message Flows” on page 18-1.

To view and change an Error Handler

1. Do one of the following.
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After you finish

On the Edit Message Flow page, continue to construct the message flow, as described in 
“Creating, Editing, and Viewing Message Flows” on page 18-1.

Table 21-1  Viewing and Changing the Error Handler 

To... Complete This Step...

View and change the proxy service 
message flow error handler Click the  Proxy Service icon, then click Edit Service 

Error Handler. The Edit Error Handler page is displayed. See 
“Adding Proxy Service Error Handlers” on page 21-1.

View and change the pipeline error 
handler Click the appropriate  Request Pipeline icon or the 

 Response Pipeline icon, then click Edit Pipeline Error 
Handler. The Edit Error Handler page is displayed. See 
“Adding Pipeline Error Handlers” on page 21-2.

View and change the route node error 
handler Click the appropriate  Route Node icon, then click Edit 

Route Error Handler. The Edit Error Handler page is 
displayed. See “Adding Route Node Error Handlers” on 
page 21-4.

View and change the stage error 
handler Click the appropriate  Stage icon, then click Edit Stage 

Error Handler. The Edit Error Handler page is displayed. See 
“Adding Stage Error Handlers” on page 21-3.
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Security Configuration
You use the Security Configuration module to create and modify security data that is used in 
Oracle Service Bus inbound security and administrative security. 

Inbound transport-level security and message-level security use the user, group, and role data to 
authenticate inbound client requests. It applies access control policies to determine which 
authenticated users are authorized to use proxy services and business services. 

Administrative security uses the user, group, and role data to determine which authenticated users 
are authorized to create or modify Oracle Service Bus configuration data or to monitor Oracle 
Service Bus performance. For more information, see “Understanding Users, Groups, Security 
Roles and Policies” on page 22-1. See also Configuring Administrative Security in the Oracle 
Service Bus Security Guide.

Note: You cannot export users, groups, or roles when you export a configuration because these 
objects are located in security provider stores. You must create these objects again when 
you import the exported configuration or use WebLogic Server tools (if available) to 
export and import them.

Understanding Users, Groups, Security Roles and 
Policies

This section includes the following topics:

“Users” on page 22-2

“Groups” on page 22-2
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“Roles” on page 22-3

“Access Control Policies” on page 22-3

“Security Configuration Data and Sessions” on page 22-4

Users
Users are entities that can be authenticated. A user can be a person or a software entity, such as a 
Web Services client. You must give each user a unique identity (name) within a security realm. 

Typically, the users that you create fall into two categories:

Client users who can access your proxy services or business services.

If you create a large number of client users, consider organizing them into security groups.

Administrative users who can use the Oracle Service Bus Console to create or modify 
proxy services, business services, and other Oracle Service Bus resources. 

Oracle Service Bus uses role-based security for its administrative functions. Instead of 
giving access privileges directly to users, Oracle Service Bus gives administrative 
privileges only to security roles. To give administrative privileges to a user, you place the 
user in one of the default security groups, which is in one of the pre-defined security roles.

Groups
To facilitate administering a large number of users, you can organize users into named groups. 
Then, instead of giving access privileges or role identities to individual users, you give privileges 
or identities to groups.

Administrative Security Groups
Oracle Service Bus provides default security groups to facilitate giving users access to 
administrative functions such as creating proxy services. Each group is in one of the pre-defined 
Oracle Service Bus security roles that have been granted administrative privileges.

For more information, see Configuring Administrative Security in the Oracle Service Bus 
Security Guide.
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Roles
A security role is an identity that can be granted to a user or group based on conditions in the 
runtime environment. When you create access control policies, you can grant access to a role, 
group, or user.

For example, you can create two of your groups, MyCustomersEast and MyCustomersWest. You 
create a security role named PrivilegedCustomer and create conditions so that the 
MyCustomersWest group is in the role from 8am to 8pm EST, while the MyCustomersEast group 
is in the role from 8pm to 8am EST. Then you create an access control policy for a proxy service 
that gives the PrivilegedCustomer role access to the service. Different users will have access at 
different times depending on whether they are in the MyCustomersEast and MyCustomersWest 
group.

Administrative Security Roles
Oracle Service Bus provides four, pre-defined security roles (plus four pre-defined roles from 
WebLogic Server) that give administrative privileges. You cannot change the access privileges 
for the Oracle Service Bus administrative security roles, but you can change the conditions under 
which a user or group is in one of the roles.

For more information about these roles and the privileges available for each role, see Configuring 
Administrative Security in the Oracle Service Bus Security Guide.

Access Control Policies
An access control policy specifies conditions under which users, groups, or roles can access a 
proxy service. For example, you can create a policy that always allows users in the GoldCustomer 
role to access a proxy service and that allows users in the SilverCustomer role to access the proxy 
service only after 12pm on weeknights.

For all proxy services, you can create a transport-level policy, which applies a security check 
when a client attempts to establish a connection with the proxy service. Only requests from users 
who are listed in the transport-level policy are allowed to proceed.

A message-level access control policy applies a security check when a client attempts to invoke 
a proxy service with message-level security. You can create a message-level access control policy 
in the following cases: 

For proxy services that are active Web Service security intermediaries 

For proxy services that have message level custom authentication
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Only users who are listed in the message-level policy are allowed to invoke the operation.

Security Configuration Data and Sessions
Users, groups, and roles are persisted in security providers, which are not governed by Oracle 
Service Bus sessions. Therefore, you can create or modify this data when you are in or out of a 
session. Any additions or modifications to this data take effect immediately and are available to 
all sessions. If you discard a session in which you added or modified the data, the security data is 
not discarded.

Access control policies are persisted in authorization providers. And there is now a reference to 
them in the Oracle Service Bus repository. 

Access control policies are managed within an Oracle Service Bus design session and not outside 
the session. Because the changes are made within a session, you can commit or discard the 
changes as with other resources. 

Although ACLs can be managed from the Oracle Service Bus console, you can change policies 
outside Oracle Service Bus. However, changing policies outside of Oracle Service Bus can make 
the reference in Oracle Service Bus out-of-date and invalid. 

Therefore, for consistent management, either completely manage ACLs outside of Oracle Service 
Bus sessions (using the authorization provider MBeans or third-party authorization provider 
tools) or completely manage them from within Oracle Service Bus sessions. Any combination of 
the two approaches can result in an inconsistent view of policies. 

Locating Users
1. Select Security Configuration > Users. The Summary of Users page displays the 

information shown in Table 22-1. For a more detailed description of the properties, see 
“Editing Users” on page 22-6.

2. To restrict the number of items in the list or locate a specific user, you can filter by user name. 
Enter part or all of the user name in the Name field and click Search. 

You can use the asterisk (*) wildcard character. (Other wildcard characters are not 
supported.) 

Click View All to remove the search filters and display all users.
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Adding Users
1. Log in to the Oracle Service Bus Console as a user with WebLogic Server Admin privileges. 

Only users in the Admin role can modify security configuration data. See Configuring 
Administrative Security in the Oracle Service Bus Security Guide.

2. Select Security Configuration to display the Summary of Users page.

3. Click Add New to display the Create a New User - General Configuration page.

You can add a user from inside or outside a session. 

4. In the User Name field, enter a unique name. This is a required field.

5. In the Password field, enter a password. This is a required field. 

Note: Authentication providers can impose a minimum password length. For a user defined 
in the WebLogic Authentication provider, the default minimum password length is 8 
characters. You can customize this setting using the WebLogic Server 
Administration Console. (The WebLogic Authentication provider is configured in the 
default security realm with the name DefaultAuthenticator.)

6. In the Confirm Password field, enter the same password you entered for the Password field. 
This is a required field.

7. In the Authentication Provider field, select the authentication provider for this user.

Table 22-1  Users Information 

Property Description

User Name The name assigned to the user. The name is a link to the View User Details page. 
See “Editing Users” on page 22-6.

Group Membership The name of the group to which this user belongs. The name is a link to the View 
Group Details page. See “Editing Groups” on page 22-9.

Authentication Provider The authentication provider for this user.

Options Click the  Delete icon to delete a specific user. See “Deleting Users” on 
page 22-7.
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If multiple authentication providers are configured in the security realm, they will appear 
in the list. Select the authentication provider database that should store information for the 
new user. See Supported Standards and Security Providers in Oracle Service Bus Security 
Guide. 

8. In the Group Membership field, select a group for this user.

a. Select a group from the Available Groups field.

b. Click the arrow to move the group into the Current Groups field.

9. Click Save to create the user.

Oracle Service Bus Console saves the user and the user becomes available immediately to 
all sessions. If you are in a session when you add the user and then you discard the session, 
Oracle Service Bus Console does not delete the new user.

Editing Users
Use the View User Details page to view and change details of a specific user. 

1. Log in to the Oracle Service Bus Console as a user with WebLogic Server Admin privileges. 
Only users in the Admin role can modify security configuration data. See Configuring 
Administrative Security in the Oracle Service Bus Security Guide.

2. Locate the user. See “Locating Users” on page 22-4.

3. Click the user name. The View User Details page displays the information shown in 
Table 22-2.

4. To edit the user details, click Reconfigure to display the Edit User Details page.

You can edit user details from inside or outside a session.

Table 22-2  User Details 

Property Description

User Name The name of this user

Authentication Provider The authentication provider that contains this user definition.

Group Membership The name of the group to which this user belongs.
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5. Make the appropriate changes to the New Password, Confirm Password, and Group 
Membership fields. See “Adding Users” on page 22-5 for descriptions of the fields.

You cannot change the User Name field.

6. Click Save Changes to update the user.

Oracle Service Bus Console updates the user details and the update becomes available 
immediately to all sessions. If you are in a session when you update the user and then you 
discard the session, Oracle Service Bus Console does not delete the updates.

Deleting Users
Use the Summary of Users page to delete a selected user or multiple users. 

1. Log in to the Oracle Service Bus Console as a user with WebLogic Server Admin privileges. 
Only users in the Admin role can modify security configuration data. See Configuring 
Administrative Security in the Oracle Service Bus Security Guide.

2. Select Security Configuration to display the Summary of Users page.

3. Select the user you want to delete. You can select multiple users if necessary.

You can delete a user from inside or outside a session. 

4. Click Delete. A message prompting you to confirm that you want to delete the user is 
displayed.

5. To delete the user, click OK.

Oracle Service Bus Console deletes the user. If you are in a session when you delete the 
user and then you discard the session, Oracle Service Bus Console does not delete the 
updates.

6. Alternatively, you can click the  Delete icon in the Options column of the user you want 
to delete.

Locating Groups
1. Select Security Configuration > Groups. The Summary of Groups page displays the 

information shown in Table 22-3. For a more detailed description of the properties, see 
“Editing Groups” on page 22-9.
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2. To restrict the number of items in the list or locate a specific group, you can filter by group 
name. Enter part or all of the group name in the Name field and click Search.

You can use the asterisk (*) wildcard character. (Other wildcard characters are not 
supported.) 

Click View All to remove the search filters and display all groups.

Adding Groups
1. Log in to the Oracle Service Bus Console as a user with WebLogic Server Admin privileges. 

Only users in the Admin role can modify security configuration data. See Configuring 
Administrative Security in the Oracle Service Bus Security Guide.

2. Select Security Configuration > Groups to display the Summary of Groups page.

3. Click Add New.

You can add a group from inside or outside a session. 

4. In the Group Name field, enter a unique name. Note that you cannot enter spaces or special 
characters. This is a required field.

5. In the Authentication Provider field, select the authentication provider.

6. In the Group Membership field, select a group to which this group belongs.

a. Select a group from the Available Groups field.

b. Click the arrow to move the group into the Current Groups field.

Table 22-3  Group Information 

Property Description

Group Name The name of the group. The name is a link to the View Group Details page. See 
“Editing Groups” on page 22-9.

Group Membership The group to which this group belongs. The name is a link to the View Group 
Details page. See “Editing Groups” on page 22-9.

Authentication Provider The authentication provider that contains this group definition.

Delete Click the  Delete icon to delete a specific group. See “Deleting Groups” on 
page 22-10.
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7. Click Save to create the group.

Oracle Service Bus Console saves the group and the group becomes available immediately 
to all sessions. If you are in a session when you add the group and then you discard the 
session, Oracle Service Bus Console does not delete the new group.

Editing Groups
Use the View Group Details page to view and change details of a specific group. 

1. Log in to the Oracle Service Bus Console as a user with WebLogic Server Admin privileges. 
Only users in the Admin role can modify security configuration data. See Configuring 
Administrative Security in the Oracle Service Bus Security Guide.

2. Locate the group. See “Locating Groups” on page 22-7.

3. Click the group name. The View Group Details page displays the information shown in 
Table 22-4.

4. To edit the group details, click Reconfigure to display the Edit Group Details page.

You can edit group details from inside or outside a session.

5. Make the appropriate changes to the Group Membership field. See “Adding Groups” on 
page 22-8 for descriptions of the field.

You cannot change the Group Name field.

6. Click Save Changes to update the group.

Oracle Service Bus Console updates the group details and the update becomes available 
immediately to all sessions. If you are in a session when you update the group and then 
you discard the session, Oracle Service Bus Console does not delete the updates.

Table 22-4  Group Details 

Property Description

Group Name The name of this group.

Authentication Provider The authentication provider that contains this group definition.

Groups The group to which this group belongs.
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Deleting Groups
Use the Summary of Groups page to delete a selected group or multiple groups. 

1. Log in to the Oracle Service Bus Console as a user with WebLogic Server Admin privileges. 
Only users in the Admin role can modify security configuration data. See Configuring 
Administrative Security in the Oracle Service Bus Security Guide.

2. Select Security Configuration to display the Summary of Groups page.

3. Select the group you want to delete. You can select multiple groups if necessary.

You can delete groups from inside or outside a session. 

4. Click Delete. A message prompting you to confirm that you want to delete the group is 
displayed.

5. To delete the group, click OK.

Oracle Service Bus Console deletes the group. If you are in a session when you delete the 
group and then you discard the session, Oracle Service Bus Console does not un-delete the 
group.

6. Alternatively, you can click the  Delete icon in the Options column of the group you want 
to delete.

Locating Roles
1. Select Security Configuration > Roles. The Global Roles page displays the information 

shown in Table 22-5. For a more detailed description of the properties, see “Editing Roles” 
on page 22-14.

2. To restrict the number of items in the list or locate a specific role, scroll through the pages. 
Use the page controls above or below the table.

Table 22-5  Role Information 

Property Description

Role Name The name of the role. The name is a link to the View Role Details page. 
See “Editing Roles” on page 22-14.

Provider Name The authentication provider for this group.
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Adding Roles
1. Log in to the Oracle Service Bus Console as a user with WebLogic Server Admin privileges. 

Only users in the Admin role can modify security configuration data. See Configuring 
Administrative Security in the Oracle Service Bus Security Guide.

2. Select Security Configuration > Roles to display the Global Roles page.

3. Click New.

You can add a role from inside or outside a session. 

4. In the Role Name field, enter a unique name. This is a required field.

Be sure that there are no spaces or < > characters in the security role name. Security role 
names are case sensitive. The Oracle convention is that all security role names are singular.

5. To create the role, click OK.

Oracle Service Bus Console saves the role and the role becomes available immediately to 
all sessions. If you are in a session when you add the role and then you discard the session, 
Oracle Service Bus Console does not delete the new role.

When you click OK to create the role, the next step is to define the conditions under which 
the role applies. 

6. Continue in “Defining Role Conditions” on page 22-11.

Defining Role Conditions
1. On the Global Roles page, click the name of the new global role to display the Global Role 

Conditions page.

2. Under Role Conditions, click Add Condition. 

The following prompt is displayed:

Choose the predicate you wish to use as your new condition

3. Choose a predicate from the list box. Typically, you choose Group. When a group is used to 
create a security role, the security role can be granted to all members of the group (that is, 
multiple users). 

4. Click Next. Depending on what you chose for your condition predicate, do one of the 
following steps, described in Table 22-6.
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Table 22-6  Condition Predicate Options 

Condition Predicate... Complete These Steps...

If you selected Group, 
enter one or more 
arguments that define the 
group or groups that should 
hold this role

1. In the Group Argument Name field, enter an argument that defines the group.
2. Click Add.
3. If necessary, repeat steps 1 and 2 until you have finished adding arguments. 

You can click Remove to remove the arguments from the list.
4. Click Finish.

If you selected User, enter 
one or more arguments that 
define the user or users that 
should hold this role

1. In the User Argument Name field, enter an argument that defines the user.
2. Click Add.
3. If necessary, repeat steps 1 and 2 until you have finished adding arguments. 

You can click Remove to remove the arguments from the list.
4. Click Finish.

If you selected Server is in 
development mode, Allow 
access to everyone or 
Deny access to everyone

Click Finish.

If you selected a 
time-constrained predicate 
such as Access occurs 
between specified hours, 
select start and end times 
and a GMT offset

1. In the Starting Time field, enter the earliest permissible time in the format 
hh:mm:ss AM|PM. For example, enter 12:45:00 AM.

2. In the Ending Time field, enter the latest permissible time in the format 
hh:mm:ss AM|PM. For example, enter 12:45:00 AM.

3. In the GMT offset field, enter the time ahead of GMT in the format 
GMT+hh:mm, or behind GMT in the format GMT-hh:mm. For example, 
Eastern Standard Time in the USA is GMT-5:00. 

4. Click Finish.

If you selected Context 
element defined, enter a 
context element name

1. In the Context element name field, enter the name of the context element.
2. Click Finish.
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If you selected Context 
element’s value equals a 
numeric constant, 
Context element’s value is 
greater than a numeric 
constant, or Context 
element’s value is less 
than a numeric constant, 
enter a context element 
name and a numeric value 
to compare it against

1. In the Context element name field, enter the name of the context element the 
value of which is to be evaluated.

2. In the Numeric Value field, enter a numeric value.
3. Click Finish.

If you selected Context 
element’s value equals a 
string value, enter a 
context element name and a 
string value to compare it 
against

1. In the Context element name field, enter the name of the context element the 
value of which is to be evaluated.

2. In the String Value field, enter the string value that you want to compare.
3. Click Finish.

If you selected a 
time-constrained predicate 
such as Access occurs 
before or Access occurs 
after

1. In the Date field, enter a date in the format mm/dd/yy. For example, enter 
1/1/04. You can add an optional time in the format hh:mm:ss AM|PM. For 
example, you can enter 1/1/04 12:45:00 AM.

2. Click Finish.

If you selected the 
time-constrained predicate 
Access occurs on specified 
days of the week, select the 
day of the week and a GMT 
offset

1. In the Day of week field, enter the day of the week.
2. In the GMT offset field, enter the time ahead of GMT in the format 

GMT+hh:mm, or behind GMT in the format GMT-hh:mm. For example, 
Eastern Standard Time in the USA is GMT-5:00.

3. Click Finish.

If you selected a 
time-constrained predicate 
such as Access occurs on a 
specified day of the 
month, Access occurs 
before a specified day of 
the month, or Access 
occurs after a specified 
day of the month

1. In the Day of the Month field, enter the ordinal number of the day within the 
current month with values in the range from -31 to 31. Negative values count 
back from the end of the month, so the last day of the month is specified as -1. 
0 indicates the day before the first day of the month. 

2. In the GMT offset field, enter the time ahead of GMT in the format 
GMT+hh:mm, or behind GMT in the format GMT-hh:mm. For example, 
Eastern Standard Time in the USA is GMT-5:00. 

3. Click Finish.

Table 22-6  Condition Predicate Options (Continued)

Condition Predicate... Complete These Steps...
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5. If necessary, repeat the steps to add expressions based on different role conditions. In the Role 
Conditions section, you can do the following steps, described in Table 22-7, to modify the 
expressions.

6. When all the expressions in the Role Conditions section are correct, click Save. 

7. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Editing Roles
Use the View Role Details page to view and change details of a specific role. 

1. Log in to the Oracle Service Bus Console as a user with WebLogic Server Admin privileges. 
Only users in the Admin role can modify security configuration data. See Configuring 
Administrative Security in the Oracle Service Bus Security Guide.

2. Locate the role. See “Locating Roles” on page 22-10.

3. Click the role name. The View Role Details page displays the information shown in 
Table 22-8.

Table 22-7  Role Conditions Options 

To... Complete These Steps...

Change the ordering of the 
selected expression.

Click Move Up and Move Down.

Merge or unmerge role 
conditions and switch the 
highlighted and or 
statements between 
expressions. 

Click Combine and Uncombine.

Make a condition negative; 
for example, NOT Group 
Operators excludes the 
Operators group from the 
role.

Click Negate.

Delete a selected 
expression.

Click Remove.
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You can change role details from inside or outside a session. 

4. Do one of the following steps, described in Table 22-9.

5. Click Save. 

Oracle Service Bus Console updates the role and the update becomes available 
immediately to all sessions. If you are in a session when you update the role and then you 
discard the session, Oracle Service Bus Console does not delete the updates.

Table 22-8  Role Details 

Property Description

Name The name of the role. 

Role Conditions The conditions which determine membership in this role.

Table 22-9  Role Options 

To... Complete This Step...

Change the ordering of the 
selected expression.

Click Move Up and Move Down.

Merge or unmerge role 
conditions and switch the 
highlighted and or 
statements between 
expressions. 

Click Combine and Uncombine.

Make a condition negative; 
for example, NOT Group 
Operators excludes the 
Operators group from the 
role.

Click Negate.

Delete a selected 
expression.

Click Remove.
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Deleting Roles
1. Log in to the Oracle Service Bus Console as a user with WebLogic Server Admin privileges. 

Only users in the Admin role can modify security configuration data. See Configuring 
Administrative Security in the Oracle Service Bus Security Guide.

2. Select Security Configuration > Roles to display the Global Roles page.

3. Select the role you want to delete. You can select multiple roles if necessary.

You can delete roles from inside or outside a session. 

4. Click Delete. A message prompting you to confirm that you want to delete the role is 
displayed.

5. To delete the role, click OK.

Oracle Service Bus Console deletes the role. If you are in a session when you delete the 
role and then you discard the session, Oracle Service Bus Console does not un-delete the 
role.

Locating Access Control Policies
The Security page provides a link to the access control policies for a proxy service in the current 
Oracle Service Bus domain. 

This page lists does not list proxy services that you have created in session but have not not yet 
activated. If you want to edit access control policies for a new proxy service, first activate the 
session in which you created the proxy service.

1. If you want to locate the access control policies for a new proxy service, activate the session 
in which you created the proxy service. 

2. In the Access Control column select the name of the proxy service from Transport Access 
Control, or the name of the proxy service or a particular operation from Message Access 
Control. 

Editing Transport-Level Access Policies
Use the View Policy Details page to edit the transport-level access control policy of a proxy 
service. The page displays the information shown in Table 22-10.
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1. Log in to the Oracle Service Bus Console as a user with WebLogic Server Admin privileges. 
Only users in the Admin role can modify security configuration data. See Configuring 
Administrative Security in the Oracle Service Bus Security Guide.

2. Locate the access policy. See “Locating Access Control Policies” on page 22-16.

3. On the Security page, in the Transport Access Control column, click the name of the proxy 
service. The policy editor is displayed.

You can edit an access control policy from inside a session.

4. In the Authorization Providers field, select an authorization provider. Oracle recommends 
that you select the XACMLAuthorizer.

Note: Oracle Service Bus has deprecated support for the WebLogic Default Authorization 
provider. Instead, Oracle recommends that you use the WebLogic XACML 
Authorization provider. See Supported Standards and Security Providers in Oracle 
Service Bus Security Guide.

5. Add policy conditions. See “Adding Policy Conditions” on page 22-18.

6. When you have finished entering conditions in the Policy Conditions section, click Save. 

Editing Message-Level Access Policies
Use the View Policy Details page to edit the message-level access control policy of a proxy 
service that is a Web Service and is configured to require message-level security. The page 
displays the information shown in Table 22-11.

Table 22-10  Policy Details 

Property Description

Proxy Service Name Displays the name of the proxy service name for which you selected 
Transport Access Control on the Security page.

Providers Displays the authorization providers that are configured for the security 
realm. 

Policy Conditions Displays the conditions that determine for which users the proxy service 
will process requests.
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1. Log in to the Oracle Service Bus Console as a user with WebLogic Server Admin privileges. 
Only users in the Admin role can modify security configuration data. See Configuring 
Administrative Security in the Oracle Service Bus Security Guide.

2. Locate the access policy. See “Locating Access Control Policies” on page 22-16.

3. On the Security page, in the Message Access Control column, click the name of the proxy 
service or the particular operation in that proxy service. The policy editor is displayed.

You can edit an access control policy from inside a session. 

4. In the Authorization Providers field, select an authorization provider. Oracle recommends 
that you select the XACMLAuthorizer.

Note: Oracle Service Bus has deprecated support for the WebLogic Default Authorization 
provider. Instead, Oracle recommends that you use the WebLogic XACML 
Authorization provider. See Supported Standards and Security Providers in Oracle 
Service Bus Security Guide.

5. Add policy conditions. See Adding Policy Conditions.

6. When you have finished entering conditions in the Policy Conditions section, click Save.

Adding Policy Conditions
1. Access the policy editor for an access control policy. See “Editing Transport-Level Access 

Policies” on page 22-16 or “Editing Message-Level Access Policies” on page 22-17.

2. In the policy editor, under Policy Conditions, click Add Condition.

Table 22-11  Policy Details 

Property Description

Proxy Service Name Displays the name of the proxy service name for which you selected View Policies 
on the Access Control for Proxy Services page.

Providers Displays the authorization providers that are configured for the realm.

Operation Lists the operation in the proxy service that can be secured.

Policy Conditions Displays the conditions that determine which users can invoke the operations that 
are selected under Service Operations.
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The following prompt is displayed:

Choose the predicate you wish to use as your new condition

3. Select a predicate from the list. 

4. Click Next. Depending on what you chose for your condition predicate, do one of the 
following steps, shown in Table 22-12.
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Table 22-12  Condition Predicate Options 

If You Selected... Complete These Steps...

Role

(For transport-level 
security, this condition 
applies only if the proxy 
service uses a protocol that 
enables a client to supply 
credentials.)

1. In the Role Argument Name field, enter the role to which you want to 
grant access.
If you have not already created the role that you entered in this field, 
you can do so after you finish creating access control policies. See 
Adding Roles. If you do not create this role, then no one will be granted 
access.

2. Click Add.
3. If necessary, repeat steps 1 and 2 until you have finished adding 

arguments. You can click Remove to remove the arguments from the 
list.

4. Do one of the following:
To save the arguments and return to the predicate list, click Finish.
To discard the changes and return to the predicate list, click Back.
To discard the changes and return to the View Policy Details page, 
click Cancel.

Group

(For transport-level 
security, this condition 
applies only if the proxy 
service uses a protocol that 
enables a client to supply 
credentials.)

1. In the Group Argument Name field, enter the group to which you 
want to grant access.
If you have not already created the group that you entered in this field, 
you can do so after you finish creating access control policies. See 
Adding Groups. If you do not create this group, then no one will be 
granted access.

2. Click Add.
3. If necessary, repeat steps 1 and 2 until you have finished adding 

arguments. You can click Remove to remove the arguments from the 
list.

4. Do one of the following:
To save the arguments and return to the predicate list, click Finish.
To discard the changes and return to the predicate list, click Back.
To discard the changes and return to the View Policy Details page, 
click Cancel.
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User

(For transport-level 
security, this condition 
applies only if the proxy 
service uses a protocol that 
enables a client to supply 
credentials.)

1. In the User Argument Name field, enter the user to which you want 
to grant access.
If you have not already created the user that you entered in this field, 
you can do so after you finish creating access control policies. See 
Adding Users. If you do not create this user, then no one will be granted 
access.

2. Click Add.
3. If necessary, repeat steps 1 and 2 until you have finished adding 

arguments. You can click Remove to remove the arguments from the 
list.

4. Do one of the following:
To save the arguments and return to the predicate list, click Finish.
To discard the changes and return to the predicate list, click Back.
To discard the changes and return to the View Policy Details page, 
click Cancel.

Access occurs on specified 
days of the week

1. In the Day of week field, enter the day of the week.
2. In the GMT offset field, enter the time ahead of GMT in the format 

GMT+hh:mm, or behind GMT in the format GMT-hh:mm. For example, 
Eastern Standard Time in the USA is GMT-5:00.

3. Do one of the following:
To save the arguments and return to the predicate list, click Finish.
To discard the changes and return to the predicate list, click Back.
To discard the changes and return to the View Policy Details page, 
click Cancel.

Table 22-12  Condition Predicate Options (Continued)

If You Selected... Complete These Steps...
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Access occurs between 
specified hours

1. In the Starting Time field, enter the earliest permissible time in the 
format hh:mm:ss AM|PM. For example, enter 12:45:00 AM.

2. In the Ending Time field, enter the latest permissible time in the 
format hh:mm:ss AM|PM. For example, enter 12:45:00 AM.

3. In the GMT offset field, enter the time ahead of GMT in the format 
GMT+hh:mm, or behind GMT in the format GMT-hh:mm. For example, 
Eastern Standard Time in the USA is GMT-5:00. 

4. Do one of the following:
To save the arguments and return to the predicate list, click Finish.
To discard the changes and return to the predicate list, click Back.
To discard the changes and return to the View Policy Details page, 
click Cancel.

Access occurs before or 
Access occurs after

1. In the Date field, enter a date in the format mm/dd/yy. For example, 
enter 1/1/04. You can add an optional time in the format hh:mm:ss 
AM|PM. For example, you can enter 1/1/04 12:45:00 AM.

2. In the GMT offset field, enter the time ahead of GMT in the format 
GMT+hh:mm, or behind GMT in the format GMT-hh:mm. For example, 
Eastern Standard Time in the USA is GMT-5:00. 

3. Do one of the following:
To save the arguments and return to the predicate list, click Finish.
To discard the changes and return to the predicate list, click Back.
To discard the changes and return to the View Policy Details page, 
click Cancel.

Table 22-12  Condition Predicate Options (Continued)

If You Selected... Complete These Steps...
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Access occurs on a 
specified day of the 
month, Access occurs 
before a specified day of 
the month, or Access 
occurs after a specified 
day of the month

1. In the The day of the month field, enter the ordinal number of the day 
within the current month with values in the range from -31 to 31. 
Negative values count back from the end of the month, so the last day 
of the month is specified as -1. 0 indicates the day before the first day 
of the month. 

2. In the GMT offset field, enter the time ahead of GMT in the format 
GMT+hh:mm, or behind GMT in the format GMT-hh:mm. For example, 
Eastern Standard Time in the USA is GMT-5:00. 

3. Do one of the following:
To save the arguments and return to the predicate list, click Finish.
To discard the changes and return to the predicate list, click Back.
To discard the changes and return to the View Policy Details page, 
click Cancel.

Context element’s value 
equals a string constant

(Applies only to 
transport-level security. A 
context element is a 
parameter/value pair that a 
container such as a Web 
container can optionally 
provide to a security 
provider. Context elements 
are not available for 
message-level access 
control policies.)

1. In the Context element name field, enter the name of the context 
element for which to evaluate the value. See Context Properties Are 
Passed to Security Providers for possible values.

2. In the String Value field, enter the string value that you want to 
compare.

3. Do one of the following:
To save the arguments and return to the predicate list, click Finish.
To discard the changes and return to the predicate list, click Back.
To discard the changes and return to the View Policy Details page, 
click Cancel.

Table 22-12  Condition Predicate Options (Continued)

If You Selected... Complete These Steps...
Using the Oracle Service Bus Console 22-23

http://download.oracle.com/docs/cd/E13159_01/osb/docs10gr3/security/model.html#wp1096324
http://download.oracle.com/docs/cd/E13159_01/osb/docs10gr3/security/model.html#wp1096324


Secur i t y  Conf igura t i on
Context element’s value is 
greater than a numeric 
constant, Context 
element’s value equals a 
numeric constant, or 
Context element’s value is 
less than a numeric 
constant

(Applies only to 
transport-level security. A 
context element is a 
parameter/value pair that a 
container such as a Web 
container can optionally 
provide to a security 
provider. Context elements 
are not available for 
message-level access 
control policies.)

1. In the Context element name field, enter the name of the context 
element for which to evaluate the value. See Context Properties Are 
Passed to Security Providers for possible values.

2. In the Numeric Value field, enter a numeric value.
3. Do one of the following:

To save the arguments and return to the predicate list, click Finish.
To discard the changes and return to the predicate list, click Back.
To discard the changes and return to the View Policy Details page, 
click Cancel.

Context element defined

(Applies only to 
transport-level security. A 
context element is a 
parameter/value pair that a 
container such as a Web 
container can optionally 
provide to a security 
provider. Context elements 
are not available for 
message-level access 
control policies.)

1. In the Context element name field, enter the name of the context 
element. See Context Properties Are Passed to Security Providers for 
possible values.

2. Do one of the following:
To save the arguments and return to the predicate list, click Finish.
To discard the changes and return to the predicate list, click Back.
To discard the changes and return to the View Policy Details page, 
click Cancel.

Deny access to everyone, 
Allow access to everyone 
or Server is in 
development mode

Click Finish. 

Alternatively, you can click Cancel to discard the changes and return to the 
View Policy Details page.

Table 22-12  Condition Predicate Options (Continued)

If You Selected... Complete These Steps...
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5. If necessary, repeat steps 3-5 to add expressions based on different policy conditions. In the 
Policy Conditions section, you can do the following steps, shown in Table 22-13, to modify 
the expressions.

Related Topics
See Security Policy Conditions in Securing WebLogic Resources.

Table 22-13  Policy Conditions Options 

To... Complete These Steps...

Change the ordering of the 
selected expression.

Select the check box associated with the condition, then click Move Up and 
Move Down.

Merge or unmerge policy 
conditions and switch the 
highlighted and or 
statements between 
expressions. 

Select the check box associated with the appropriate conditions, then click 
Combine and Uncombine.

Make a condition negative; 
for example, NOT Group 
Operators excludes the 
Operators group from the 
policy.

Select the check box associated with the condition, then click Negate.

Delete a selected 
expression.

Select the check box associated with the condition, then click Remove.
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Monitoring
When you create a business or proxy service, monitoring is disabled by default for that service. 
To learn how to enable monitoring for proxy services, see “Configuring Operational Settings for 
Proxy Services” on page 23-14; for business services, see “Configuring Operational Settings for 
Business Services” on page 23-19.

To enable or disable monitoring of all services that have individually been enabled or disabled 
for monitoring, use the Enable Monitoring option on the Operations > Global Settings page. 
See “Enabling Global Settings” on page 24-14.

To learn more about monitoring at run time, see Monitoring in the Oracle Service Bus Operations 
Guide.

Viewing SLA Alerts
Use the SLA Alerts page to view a summary of SLA alerts and access detailed alert history 
information, shown in Table 23-1. 

The SLA Alerts page includes the following:

Tabs for displaying Pipeline Alerts, Service Health, and Server Health information.

On the SLA Alerts tab header, a numeric indicator shows the number of new alerts that 
have occurred since you last viewed them or during the last Dashboard refresh period, 
whichever is more recent. By default, the Dashboard refresh rate is No Refresh. To change 
the Dashboard refresh rate interval, see “Setting User Preferences” on page 24-20.
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WARNING: By selecting a dashboard refresh rate interval other than the default (No Refresh), 
the browser refreshes the Dashboard at regular intervals. This prevents your 
session from timing out, even without you interacting with the console. 

Oracle recommends that you use the Dashboard refresh rate feature with caution. 
You should never leave a console session unattended. While your console session 
is active others can gain access to it from your machine, without re-authentication.

A pie chart of the services with SLA alerts over the past 30 minutes, which is the default 
alert history duration interval. To change the time interval for displaying historical alert 
data, see “Setting User Preferences” on page 24-20.

The number of SLA alerts on the page match the pie chart which displays the breakdown 
of alerts by severity level, over the same time interval. You can click the area in the chart 
corresponding to the alert severity to display more details.

The top 10 services with SLA alerts are listed in descending order of the number of alerts 
issued by those services. Each service name is a link to the service monitoring details. See 
“Viewing Service Metrics” on page 23-25.

Fields that display alert information depending on your customized settings for the alert 
table. For example, timestamp, alert name, alert severity, action, and the names of the 
service and service type associated with the alert. To learn more about these fields, see 
Table 23-1.

An  Annotation icon next to an alert name indicates annotations. Positioning the mouse 
pointer over the icon previews the annotation text. Clicking on the icon lets you view the 
entire annotation text.

A  Table Customizer icon. See “Customizing Table Views” on page 1-2.

A link to the Extended Alert History page. See “Locating Alerts” on page 23-5.
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Viewing Pipeline Alerts
Use the Pipeline Alerts page to view a summary of pipeline alerts and access detailed alert history 
information, shown in Table 23-2.

The Pipeline Alerts page includes the following:

Tabs for displaying SLA Alerts, Service Health, and Server Health information.

On the Pipeline Alerts tab header, a numeric indicator shows the number of new alerts that 
have occurred since you last viewed them or during the last Dashboard refresh period, 

Table 23-1  SLA Alert History Information 

Property Description

Timestamp The date and time that the alert rule last evaluated to true. 

By default, all the alerts are sorted according to the timestamp.

Alert Name The name assigned to the alert. The name is a link to the Alert Details 
page. See “Viewing Alert Details” on page 23-8.

An  Annotation icon next to an alert name indicates annotations. 
Positioning the mouse pointer over the icon previews the annotation text.

Alert Severity The user-defined severity of the alert. 
• Fatal
• Critical
• Major
• Minor
• Warning
• Normal

Service The name of the service associated with the alert. The name is a link to the 
Service Monitoring Details page (only when the service is being actively 
monitored). See “Viewing Service Metrics” on page 23-25.

Service Type The parent service type: proxy service or business service. 

Action
The  View Alert Rule Details icon is a link to the Alert Rule General 
Configuration page. See “Viewing Alert Rule Configurations” on 
page 23-49.
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whichever is more recent. By default, the Dashboard refresh rate is No Refresh. To change 
the Dashboard refresh rate interval, see “Setting User Preferences” on page 24-20.

WARNING: By selecting a dashboard refresh rate interval other than the default (No Refresh), 
the browser refreshes the Dashboard at regular intervals. This prevents your 
session from timing out, even without you interacting with the console. 

Oracle recommends that you use the Dashboard refresh rate feature with caution. 
You should never leave a console session unattended. While your console session 
is active others can gain access to it from your machine, without re-authentication.

A pie chart of the services with pipeline alerts over the past 30 minutes, which is the 
default alert history duration interval. To change the time interval for displaying historical 
alert data, see “Setting User Preferences” on page 24-20.

The number of pipeline alerts on the page match the pie chart which displays the 
breakdown of alerts by severity level, over the same time interval. You can click the area in 
the chart corresponding to the alert severity to display more details.

The top 10 services with pipeline alerts are listed in descending order of the number of 
alerts issued by those services. Each service name is a link to the service monitoring 
details. See “Viewing Service Metrics” on page 23-25.

Fields that display alert information depending on your customized settings for the alert 
table. For example, timestamp, alert summary, alert severity, action, and the names of the 
service and service type associated with the alert. To learn more about these fields, see 
Table 23-2.

An  Annotation icon next to an alert summary indicates annotations. Positioning the 
mouse pointer over the icon previews the annotation text. Clicking on the icon lets you 
view the entire annotation text.

A  Table Customizer icon. See “Customizing Table Views” on page 1-2.

A link to the Extended Alert History page.
23-4 Using the Oracle Service Bus Console



Locat ing  A le r ts
Locating Alerts
1. Select Operations > Dashboard.

2. Select the SLA Alerts or Pipeline Alerts tab to display SLA or pipeline alerts.

3. Click the Extended Alert History link. The Extended SLA Alert History and Extended 
Pipeline Alert History pages display detailed alert history information.

Table 23-2  Pipeline Alert History Information 

Property Description

Timestamp The date and time that the alert occurred.

By default, all the alerts are sorted according to the timestamp.

Alert Summary A short description of the pipeline alert action or Oracle Service Bus Alert 
(the default value provided to pipeline alert actions that were designed 
without alert summary text). The alert summary is a link to the Alert 
Details page. See “Viewing Alert Details” on page 23-8.

An  Annotation icon next to an alert summary indicates annotations. 
Positioning the mouse pointer over the icon previews the annotation text.

Alert Severity The user-defined severity of the alert. 
• Fatal
• Critical
• Major
• Minor
• Warning
• Normal

Service The name of the service associated with the alert. The name is a link to the 
Service Monitoring Details page (only when the service is being actively 
monitored). See “Viewing Service Metrics” on page 23-25.

Service Type Only proxy services can define pipeline alerts, therefore, for pipeline 
alerts, all parent services are proxy services.

Action
The  Edit Message Flow icon is a link to the Edit Message Flow page 
of that proxy service.
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4. To restrict the number of items in the list or locate specific alerts:

– Click the  Open icon to display additional search filters. If you specify multiple 
search criteria, only results that match all the criteria will be returned.

– Filter by date range. Do one of the following:

• Select All to ignore the date range and time interval filter criteria and display all 
alerts.

• In the From and To fields, enter a date and time in the format MM/DD/YY HH:MM 
AM|PM, then click Search. The alerts that occurred over the specified date and time 
range are displayed. 

• In the For the Last field, enter the number of days, then specify hours and minutes, 
then click Search. The alerts that occurred over the specified time range are 
displayed. 

– Filter by alert severity. From the Alert Severity drop-down list, select to restrict alerts 
to the specified severity level, then click Search. 

Select the or above check box to restrict your search to the specified severity level or 
above (listed from the most inclusive to the most restrictive level): Normal, Warning, 
Minor, Major, Critical, and Fatal.

– Filter by parent Service. Click Browse to display the Select Service page. Select the 
parent service from the list and click Submit. Click Clear to remove the parent service 
filter criteria, or click Search. 

– For SLA alerts only, filter by Alert Name (Any String). Enter any string, including 
wildcard characters, then click Search. For more details, see “WebLogic Diagnostics 
Framework Query Language” on page 23-7.

– For pipeline alerts only, filter by Alert Summary (Any String). Enter any string, 
including wildcard characters, then click Search. For more details, see “WebLogic 
Diagnostics Framework Query Language” on page 23-7. To find pipeline alert actions 
that were designed without alert summary text, enter Oracle Service Bus Alert.

– Click View All to remove the search filters and display all alerts.

Use the Extended SLA Alert History and Extended Pipeline Alert History pages also to do 
the following: 

To display the alert data in a pie chart, select Pie Chart View. 

To display the same data in a bar chart, select Bar Chart View. 
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To display the data in tabular format, select Table View. 

To display an updated version of the data, click Refresh. 

To delete individual alerts, select the corresponding check boxes and click Delete at the 
bottom of the page.

To delete all alerts or those that were issued within a specified date and time range, click 
the Purge Alert History link at the top of the page. See “Purging Alerts” on page 23-7.

WebLogic Diagnostics Framework Query Language
Alerts are stored using the WebLogic Diagnostics Framework, which provides its own query 
language, including wildcards. For filtering alerts in extended alert history, use the syntax 
described in WLDF Query Language.

Purging Alerts
Use this page to permanently delete the specified SLA or pipeline alerts. 

Note: This action cannot be undone.

1. Select Operations > Dashboard.

2. Select the SLA Alerts or Pipeline Alerts tab, then click the Extended Alert History link.

3. On the upper right-hand side of the Extended Alert History page, click Purge SLA Alert 
History or Purge Pipeline Alert History.

4. Do one of the following steps, shown in Table 23-3.

Table 23-3  Alert Purging Options 

To... Complete These Steps...

• Purge all SLA alerts 
• Purge all pipeline alerts

1. Select Purge All Alerts.
2. Click Purge.

• Purge SLA alerts within a 
specified time frame

• Purge pipeline alerts 
within a specified time 
frame

1. Select Purge Alerts From... To...
2. In the Purge From field, enter a month, day, year, and time.
3. In the Purge To field, enter a month, day, year, and time.
4. Click Purge.
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Viewing Alert Details
This page displays details of specific alerts including the information shown in Table 23-4.

Table 23-4  Alert Details 

Property Description

Alert Name For SLA alerts only:

The name assigned to the alert. The name is a link to the Alert Rule 
Configuration page. See “Viewing Alert Rule Configurations” on 
page 23-49.

Alert Summary For pipeline alerts only:

A short description of the pipeline alert action or Oracle Service Bus Alert 
(the default value provided to pipeline alert actions that were designed 
without alert summary text).

Description A description for the alert rule.

Timestamp • For pipeline alerts: The date and time that the alert occurred.
• For SLA alerts: The date and time that the alert rule last evaluated to 

true.

Severity The user-defined severity of the alert.
• Fatal
• Critical
• Major
• Minor
• Warning
• Normal

Service The name and path of the service associated with this alert. The field is a 
link to the Service Monitoring Details page (only when the service is 
being actively monitored). See “Viewing Service Metrics” on page 23-25.

Service Type The parent service type: proxy service or business service. 

Only proxy services can define pipeline alerts, therefore, for pipeline 
alerts, all parent services are proxy services.
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Viewing Service Monitoring Information
The Service Health page displays metrics for services that have monitoring enabled. To learn 
how to enable monitoring for services, see “Configuring Operational Settings for Proxy Services” 
on page 23-14 and “Configuring Operational Settings for Business Services” on page 23-19.

By default, the Dashboard refresh rate is No Refresh. To change the Dashboard refresh rate 
interval, see “Setting User Preferences” on page 24-20.

WARNING: By selecting a dashboard refresh rate interval other than the default (No Refresh), 
the browser refreshes the Dashboard at regular intervals. This prevents your 
session from timing out, even without you interacting with the console. 

Oracle recommends that you use the Dashboard refresh rate feature with caution. 
You should never leave a console session unattended. While your console session 
is active others can gain access to it from your machine, without re-authentication.

On the Service Health tab header, these icons may be present:

A  Warning icon and numeric indicator. 

– Clicking on the icon filters the services displayed using Has Errors criteria. 

– The number indicates the number of services with errors since the page was last 
refreshed.

An  Endpoints Offline icon and numeric indicator. 

– Clicking on the icon filters the services displayed using Has Offline Endpoint URIs 
criteria. 

– The number indicates the number of services with endpoints that have become offline 
since the page was last refreshed.

Server The name of the server in which this alert was generated.

For SLA alerts only: N/A is displayed.

Annotation A text box in which you can enter notes for this alert. An  Annotation 
icon is displayed in the Alert History for alerts with annotations.

Table 23-4  Alert Details (Continued)

Property Description
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The Service Health page displays service metrics and monitoring information, shown in 
Table 23-5. 

1. In the Display Statistics field, do one of the following:

– To display monitoring statistics for each service for the period of the current 
aggregration interval, select Current Aggregation Interval. The Current Aggregation 
Interval view displays a moving statistic view of the service metrics.

– To display monitoring statistics for the period since you last reset statistics for a 
service, select Since Last Reset. The Since Last Reset view displays a running count of 
the metrics.

2. Select a Server from the drop-down list to display metrics for that server.

If a cluster exists, cluster-wide metrics are displayed by default. Select an individual 
Managed Server to display metrics for that server.

3. To restrict the number of items in the list or locate specific services:

– Click the  Open icon to display additional search filters. If you specify multiple 
search criteria, only results that match all the criteria will be returned.

– Filter by service name. In the Name field, enter the name of the search target or enter 
wildcard characters (use * and ? as wildcard characters to perform a more general 
search), then click Search. 

This search method is preferable if the name of the service is unique across all projects 
and paths.

– Filter by service path. In the Path field, enter the path of the search target, which is the 
project name and the name of the folder in which services reside. You can use * and ? 
as wildcard characters to perform a more general search. All the services that reside in 
that path are displayed.

The format for the Path field is as follows:  
project-name/root-folder/ . . ./parent-folder

If a service is directly under the project, the format is as follows: project-name

– Filter by service name and path. This search method is preferable if there is more than 
one service with the same name that reside in different paths.

– Filter by parent service. From the Service drop-down list, select the parent service type: 
Proxy Services or Business Services, then click Search. Select All Services to ignore 
the parent service filter criteria.
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– Filter by services with messages. Select the Has Messages option, then click Search. 

– Filter by services with alerts. Select the Has Alerts option, then click Search. 

– Filter by services with errors. Select the Has Errors option, then click Search. 

– Filter by services with offline URIs. Select the Has Offline Endpoint URIs option, 
then click Search. 

– Filter by services invoked by a particular proxy service. Enter the name and path of a 
proxy service in the field provided or click Browse to display the Select Proxy Service 
page. Select the proxy service from the list and click Submit. Click Search. The 
business services invoked by the proxy service you specified are displayed.

Wildcard characters are not supported in the Invoked by Proxy field.

– Click View All to remove the search filters and display all services.

Table 23-5  Service Monitoring Information

Property Description

Name The name assigned to the service. The name is a link to the Service Monitoring 
Details page. See “Viewing Service Metrics” on page 23-25.

Path The project associated with the service. If the service resides in a project folder, 
this folder is also listed. The path is displayed in the format:
project-name/root-folder/ . . ./parent-folder

The path is a link to the corresponding path in the Project Explorer.

Service Type The parent service type: proxy service or business service. 

Aggregation Interval This field is displayed only when you have selected Current Aggregation 
Interval in the Display Statistics field.

The current aggregation interval set for monitoring this service, in terms of hours 
and minutes. You set this interval on the Operational Settings page. See “Setting 
the Aggregation Interval for a Service” on page 23-25.

Avg. Response Time The average response time (in msec) that this service has taken to execute 
messages within the period of the current aggregation interval or for the period 
since the last reset.

Messages The number of messages associated with this service for the period of the current 
aggregation interval or for the period since the last reset.
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Errors The number of error messages associated with this service for the period of the 
current aggregation interval or for the period since the last reset.

Alerts This field is hidden by default.

The number of alerts (SLA and pipeline) associated with this service for the period 
of the current aggregation interval or for the period since the last reset.

For an individual Managed Server in a cluster, for proxy services, it shows the 
number of pipeline alerts only associated with this service for the period of the 
current aggregation interval or for the period since the last reset.

For business services, for individual Managed Servers, displays N/A.

SLA Alerts The number of SLA alerts associated with this service for the period of the current 
aggregation interval or for the period since the last reset.

For an individual Managed Server in a cluster, SLA Alerts will be N/A (only 
cluster-wide SLA alerts are displayed).

Pipeline Alerts For proxy services only:

The number of pipeline alerts associated with this service for the period of the 
current aggregation interval or for the period since the last reset.

Table 23-5  Service Monitoring Information

Property Description
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Endpoint URI Status For business services only, the status of endpoint URIs. The status is a link to the 
Endpoint URIs page. See “Viewing Business Services Endpoint URIs Metrics” 
on page 23-34.

For a single node domain (individual server instances):
• Online—All the endpoint URIs for the business service are online.
• Offline—All the endpoint URIs for the business service are offline.
• Partial—At least one of the endpoint URIs for the business service is 

offline.

For a clustered domain:
• When the Server field is set to Cluster or to one of the Managed Servers, 

Online status denotes that all of the endpoint URIs are online across the 
cluster or on the selected Managed Server, respectively.

• When the Server field is set to Cluster or to one of the Managed Servers, 
Offline status denotes that all of the endpoint URIs are offline across the 
cluster or on the selected Managed Server, respectively.

• When the Server field is set to Cluster, Partial status denotes that at least 
one of the endpoint URIs for the business service is offline on at least one of 
the servers, or that one of the endpoint URIs is offline on all the servers, but 
the other endpoint URIs for the same business service are still available on one 
or all the servers.

• When the Server field is set to one of the Managed Servers, Partial status 
denotes that at least one of the endpoint URIs for the business service is offline 
on the selected Managed Server.

Action This field is displayed only when you have selected Since Last Reset in the 
Display Statistics field.

In this column, you can click the  Reset icon for a specific service to reset the 
statistics for that service. When you confirm you want to do this, the system deletes 
all monitoring statistics that were collected for the service since you last reset 
statistics. However, the system does not delete the statistics being collected during 
the Current Aggregation Interval for the service. Additionally, after you click the 

 Reset icon, the system immediately starts collecting monitoring statistics for 
the service again.

Table 23-5  Service Monitoring Information

Property Description
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Resetting Statistics for Services
You can use the Service Health page to reset monitoring statistics for all services in your 
configuration. You can reset statistics whether or not you are in a session.

1. Select Operations > Dashboard > Service Health. 

2. In the Display Statistics field, select Since Last Reset. The Since Last Reset view displays a 
running count view of the metrics.

3. To reset the monitoring statistics for a specific service, click the  Reset icon in the Action 
column for that service.

When you confirm that you want to do this, the system deletes all monitoring statistics that 
were collected for the service since you last reset statistics. However, the system does not 
delete the statistics being collected during the Current Aggregation Interval for the 

service. Additionally, after you click the  Reset icon, the system immediately starts 
collecting monitoring statistics for the service again.

4. To reset monitoring statistics for all services, click the Reset All Statistics link at the top of 
the page. 

Note: Clicking Reset All Statistics resets the statistics for all monitored services regardless 
of whether they are displayed on the page or not.

When you confirm that you want to reset statistics, the system deletes all monitoring 
statistics that were collected for all services in your configuration since you last reset 
statistics. The system does not delete the statistics being collected during the Current 
Aggregation Interval for any of the services. Additionally, after you click Reset All 
Statistics, the system immediately starts collecting monitoring statistics for the services 
again.

Configuring Operational Settings for Proxy Services
Use the Operational Settings page to enable and disable a proxy service and monitoring for 
specific proxy services. Similarly, you can specify these same service-specific operational 
settings on the Operations > Smart Search page, with the following exceptions: you cannot set 
an aggregation interval or specify an alerting or logging severity level. For more information, see 
“Finding and Updating Operational Settings” on page 24-1.

The run-time effects of the service-level settings depend on their corresponding global settings. 
You must enable both the global and service-level settings for a service to be completely enabled 
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at run time. Additionally, the Service State must also be enabled. See “Enabling Global Settings” 
on page 24-14.

You can change and save monitoring configuration settings even if the service will be not be 
enabled at run time. For example, you can change and save the Aggregation Interval even if 
Service Monitoring is disabled. In this manner, you can edit settings and later enable them.

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select Resource Browser > Proxy Services. 

3. Click the proxy service name. 

The View a Proxy Service page displays the information shown in Table 23-6.

4. Select the Operational Settings tab.

You must be in an active session to configure proxy service operational settings shown in 
Table 23-7. 

Table 23-6  Proxy Service Information 

Property Description

Last Modified By The user who created or edited this service, or imported it into the 
configuration.

Last Modified On The date and time that the user created or edited this service, or imported 
it into the configuration. Click the date and time link to view the change 
history of this resource. See “View Change History page” on page 3-21.

References The number of objects that this service references. If such references exist, 
click the numeric link to view a list of the objects. See “Viewing 
References to Resources” on page 3-20.

Referenced By The number of objects that reference this service. If such references exist, 
click the numeric link to view a list of the objects. See “Viewing 
References to Resources” on page 3-20.

Description A description of the service, if one exists.
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Table 23-7  Configuring Proxy Service Operational Settings

To... Do This...

Disable State Clear the Enabled check box. When you activate the session, the service stops 
processing messages.

Disabling a service no longer causes the system to delete all monitoring 
statistics previously collected for the service.

Enable State Select the Enabled check box. When you activate the session, the service 
resumes processing messages.

Disable Monitoring Clear the Enabled check box. When you activate the session, the system stops 
collecting monitoring statistics for the service, and deletes any statistics 
collected previously.

Enable Monitoring Select the Enabled check box next to Monitoring. From the Enable Pipeline 
Monitoring at drop-down list, select to restrict monitoring to the specified 
level or above (listed from the most inclusive to the most restrictive level): 
Action, Pipeline, and Service.

When you activate the session, the system starts collecting monitoring 
statistics for the service.

Set an Aggregation Interval 
for a service

Select the interval in terms of hours or minutes, then click Update. If your 
selection for hours exceeds 1, then the default selection for minutes is always 
zero. However, if your selection for hours is 0 or 1, then you can configure 
intervals in terms of minutes. See “Setting the Aggregation Interval for a 
Service” on page 23-25.

You can change and save the Aggregation Interval setting whether or not you 
have enabled monitoring. 

To enable monitoring at run time, make sure the Enable Monitoring check 
box is selected.

Disable SLA Alerts Clear the Enabled check box. The system stops evaluating any alert rules 
configured for the service; therefore, you no longer receive SLA alerts 
associated with the service.
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Enable SLA Alerts Select the Enabled check box. From the Enable Alerting at drop-down list, 
select to restrict SLA alerts to the specified level or above (listed from the 
most inclusive to the most restrictive level): Normal (default), Warning, 
Minor, Major, Critical, and Fatal.

Service SLA alerting depends on both the global and service-level 
monitoring states—both must be enabled for SLA alerting to be 
enabled at run time. See “Enabling SLA Alerts Globally” on 
page 24-16.

Disable Pipeline Alerts Clear the Enabled check box. When you activate the session, the system stops 
executing pipeline alert actions; therefore, you no longer receive pipeline 
alerts associated with the service.

Enable Pipeline Alerts Select the Enabled check box. From the Enable Alerting at drop-down list, 
select to restrict pipeline alerts to the specified severity level or above (listed 
from the most inclusive to the most restrictive level): Normal (default), 
Warning, Minor, Major, Critical, and Fatal.

Disable the report action of a 
proxy service

Clear the Enabled check box next to Message Reporting. When you activate 
the session, the system stops executing report actions; therefore, you no 
longer receive message reporting associated with the service.

Enable the report action of a 
proxy service

Select the Enabled check box next to Message Reporting.

Disable logging output for a 
pipeline log action

Clear the Enabled check box next to Logging. When you activate the session, 
the system stops executing log actions; therefore, you no longer receive 
logging output associated with the service.

Enable logging output for a 
pipeline log action

Select the Enabled check box next to Logging. From the Enable Logging at 
drop-down list, choose to restrict logging output to the specified level or 
above (listed from the most inclusive to the most restrictive level): Debug 
(default), Info, Warning, and Error.

Enable run-time tracing for 
a proxy service

Select the Enabled check box next to Execution Tracing. After you enable 
execution tracing, the system logs various details culled from the 
Message Flow Context and the Message Context. These details 
include: stage name; pipeline or route node name; and the current 
Message Context.

Table 23-7  Configuring Proxy Service Operational Settings

To... Do This...
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Disable run-time tracing for 
a proxy service

Clear the Enabled check box next to Execution Tracing.

Enable message tracing for 
a proxy service

Select the Enabled check box next to Message Tracing. After you enable 
message tracing, the system logs messages exchanged between the Oracle 
Service Bus pipeline and the proxy service (inbound request and response, as 
well as outbound request and response messages).

Note that, when applicable, logged outbound messages can also include the 
retry number, error code, and error message.

From the Detail Level drop-down list, choose to specify the level of detail 
from among the following:
• Terse—Display the date, time, service type, service name, and URI
• Headers—Display terse information along with the XML representation 

of the message metadata
• Full—Display the headers information along with the raw payload, 

including attachments if any

If you choose Full from the Detail Level drop-down list, specify the 
maximum size (in kilobytes) for the message payload using the Payload 
Tracing Limit field. Also, specify the default encoding for logging the 
payload using the Default Encoding field. This can be useful when logging 
binary payloads or SOAP messages with binary attachments.

The default encoding value can be Base64 or any Java-supported encoding as 
defined in: 
http://java.sun.com/javase/6/docs/technotes/guides/intl/encoding.doc.html.

Leaving the Default Encoding field empty causes Oracle Service Bus to use 
the host’s default encoding for the payload. The default encoding depends on 
a combination of the JVM, the underlying operating system (OS), and 
OS-level locale settings.

If the setting specified in the Default Encoding field cannot be used (for 
example, it is not a valid option for the configuration), then Oracle Service 
Bus uses Base64 encoding for the payload.

Disable message tracing for 
a proxy service

Clear the Enabled check box next to Message Tracing.

Table 23-7  Configuring Proxy Service Operational Settings

To... Do This...
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Configuring Operational Settings for Business Services
Use the Operational Settings page to enable and disable a business service and monitoring for 
specific business services. Similarly, you can specify these same service-specific operational 
settings on the Operations > Smart Search page, with the following exceptions: you cannot set 
an aggregation interval or specify an alerting severity level. For more information, see “Finding 
and Updating Operational Settings” on page 24-1.

The run-time effects of the service-level settings depend on their corresponding global settings. 
You must enable both the global and service-level settings for a service to be completely enabled 
at run time. Additionally, the Service State must also be enabled. See “Enabling Global Settings” 
on page 24-14.

You can change and save monitoring configuration settings even if the service will be not be 
enabled at run time. For example, you can change and save the Aggregation Interval even if 
Service Monitoring is disabled. In this manner, you can edit settings and later enable them.

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select Resource Browser > Business Services. 

3. Click the business service name. 

The View a Business Service page displays the information shown in Table 23-8.

Table 23-8  Business Service Information 

Property Description

Last Modified By The user who created or edited this service, or imported it into the 
configuration.

Last Modified On The date and time that the user created or edited this service, or imported 
it into the configuration. Click the date and time link to view the change 
history of this resource. See “View Change History page” on page 3-21.

References The number of objects that this service references. If such references exist, 
click the numeric link to view a list of the objects. See “Viewing 
References to Resources” on page 3-20.
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4. Select the Operational Settings tab.

You must be in an active session to configure business service operational settings shown 
in Table 23-9. 

Referenced By The number of objects that reference this service. If such references exist, 
click the numeric link to view a list of the objects. See “Viewing 
References to Resources” on page 3-20.

Description A description of the service, if one exists.

Table 23-8  Business Service Information (Continued)

Property Description

Table 23-9  Configuring Business Service Operational Settings 

To... Do This...

Disable State Clear the Enabled check box. When you activate the session, the service 
stops processing messages.

Disabling a service no longer causes the system to delete all monitoring 
statistics previously collected for the service.

Enable State Select the Enabled check box. When you activate the session, the service 
resumes processing messages.
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Enable business service 
endpoint URIs to be taken 
offline

Set a retry interval for offline 
URIs

Select the Enable with Retry Interval check box.

When you select this option, the business service removes non-responsive 
endpoint URIs (takes them offline), at run time, so that only the responsive 
URIs are used for retry attempts and for processing subsequent requests. 

If you want to keep non-responsive URIs offline until you take corrective 
action and then re-enable the URIs, do not provide a retry interval. For 
example, a zero retry interval indicates that the endpoint remains offline 
indefinitely. To bring it back online, use the Mark Endpoint Online action 
on the Endpoint URIs page. See “Viewing Business Services Endpoint URIs 
Metrics” on page 23-34.

If you want to configure the business service to take non-responsive URIs 
offline and then re-attempt accessing the same URI endpoint for subsequent 
message processing after a specified time interval, you do so by specifying a 
retry interval value. Use the hours, minutes, and seconds fields to specify 
how long to keep the non-responsive URIs out of the active URIs processing 
loop.

The URI is kept offline for the specified time interval and then retried. If the 
endpoint responds, the URI becomes online again, or else it remains offline 
and the process repeats itself.

You can specify a retry interval only if you have selected the Enable with 
Retry Interval option. 

Disable Monitoring Clear the Enabled check box. When you activate the session, the system stops 
collecting monitoring statistics for the service, and deletes any statistics 
collected previously.

Enable Monitoring Select the Enabled check box. When you activate the session, the system 
starts collecting monitoring statistics for the service. 

Set an Aggregation Interval 
for a service

Select the interval in terms of hours or minutes, then click Update. If your 
selection for hours exceeds 1, then the default selection for minutes is always 
zero. However, if your selection for hours is 0 or 1, then you can configure 
intervals in terms of minutes. See “Setting the Aggregation Interval for a 
Service” on page 23-25.

You can change and save the Aggregation Interval setting whether or not you 
have enabled monitoring. 

To enable monitoring at run time, make sure the Enable Monitoring check 
box is selected.

Table 23-9  Configuring Business Service Operational Settings (Continued)

To... Do This...
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Disable SLA Alerts Clear the Enabled check box. The system stops evaluating any alert rules 
configured for the service; therefore, you no longer receive SLA alerts 
associated with the service.

Enable SLA Alerts Select the Enabled check box. From the Enable Alerting at drop-down list, 
select to restrict SLA alerts to the specified level or above (listed from the 
most inclusive to the most restrictive level): Normal (default), Warning, 
Minor, Major, Critical, and Fatal.

Service SLA alerting depends on both the global and service-level 
monitoring states—both must be enabled for SLA alerting to be 
enabled at run time. See “Enabling SLA Alerts Globally” on 
page 24-16.

Restrict the flow of messages 
sent to the set of endpoints 
configured in the business 
service

Select the Enabled check box next to Throttling State. When enabled, 
messages are processed by priority. You can optionally assign messages a 
priority using routing options; otherwise, messages are de-queued on a 
first-in, first-out basis.

For more information, see Throttling in Oracle Service Bus in the Oracle 
Service Bus Operations Guide.

Restrict the number of 
messages being dispatched to a 
set of endpoints configured in 
the business service

If Throttling State is enabled, this field is required. 

Specify a Maximum Concurrency value; it must be a positive integer value, 
it cannot be zero.

If exceeded, incoming messages are put into a wait (throttling) queue, if one 
exists. If not, the messages are discarded.

If the queue is full, messages in the queue with a lower priority are removed 
and a run-time error is raised. If an error handler is configured, it will be 
triggered. The new incoming messages will be enqueued.

Table 23-9  Configuring Business Service Operational Settings (Continued)

To... Do This...
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Specify whether messages sent 
to business services that have 
exceeded their message 
concurrency limit should be 
held in a wait queue

Set the maximum number of 
messages that are held in the 
wait queue

If Throttling State is enabled, this field is required. 

Specify a Throttling Queue value; it must be a positive integer value or keep 
the default value, zero, meaning there is no throttling queue. When the 
throttling queue value is zero (no throttling queue) and the number of 
messages exceed the Maximum Concurrency value, the messages are 
discarded and an error is raised. If an error handler is configured, it will be 
triggered.

If you disable throttling at run time, all the messages in the throttling queue 
will be processed. 

When you delete or rename a business service, all the messages in the 
throttling queue are discarded.

Specify the maximum length of 
time that messages will be held 
in a wait queue

If Throttling State is enabled, this field is optional. 

Specify a Message Expiration value in milliseconds; it must be a positive 
integer value. A value of zero means the message will never be expired.

This value is set at the queue level; all messages put in the queue have the 
same Message Expiration value. When exceeded, messages are removed 
from the queue without being processed. 

Table 23-9  Configuring Business Service Operational Settings (Continued)

To... Do This...
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Enable message tracing for a 
business service

Select the Enabled check box next to Message Tracing. After you enable 
message tracing, the system logs messages exchanged between the 
Oracle Service Bus pipeline and the business service (outbound request 
and response messages).
Note that, when applicable, logged outbound messages can also include the 
retry number, error code, and error message.

From the Detail Level drop-down list, choose to specify the level of detail 
from among the following:
• Terse—Display the date, time, service type, service name, and URI
• Headers—Display terse information along with the XML representation 

of the message metadata
• Full—Display the headers information along with the raw payload, 

including attachments if any

If you choose Full from the Detail Level drop-down list, specify the 
maximum size (in kilobytes) for the message payload using the Payload 
Tracing Limit field. Also, specify the default encoding for logging the 
payload using the Default Encoding field. This can be useful when logging 
binary payloads or SOAP messages with binary attachments.

The default encoding value can be Base64 or any Java-supported encoding as 
defined in: 
http://java.sun.com/javase/6/docs/technotes/guides/intl/encoding.doc.html.

Leaving the Default Encoding field empty causes Oracle Service Bus to use 
the host’s default encoding for the payload. The default encoding depends on 
a combination of the JVM, the underlying operating system (OS), and 
OS-level locale settings.

If the setting specified in the Default Encoding field cannot be used (for 
example, it is not a valid option for the configuration), then Oracle Service 
Bus uses Base64 encoding for the payload.

Disable message tracing for 
a business service

Clear the Enabled check box next to Message Tracing.

Table 23-9  Configuring Business Service Operational Settings (Continued)

To... Do This...
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Setting the Aggregation Interval for a Service
Use the Operational Settings page to set the aggregation interval for a specific service. The 
aggregation interval is the period over which aggregated statistics are computed for display in the 
console. The default aggregation interval setting is 10 minutes.

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select Resource Browser > Business Services or Proxy Services. 

3. Click the service name. 

4. Select the Operational Settings tab.

5. In the Aggregation Interval field, select the length of the aggregation interval in hours and 
minutes, then click Update. 

If your selection for hours exceeds 1, then the default selection for minutes is always zero. 
However, if your selection for hours is 0 or 1, then you can configure intervals in terms of 
minutes.

6. Click Update to commit the updates in the current session. 

7. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Viewing Service Metrics
Use this page to view the monitoring details of specific services, shown in Table 23-10, and the 
Service Metrics shown in Table 23-11.

Table 23-10  Service Monitoring Information 

Property Description

Service Name The name and path of the service. 

Service Type The parent service type: proxy service or business service.
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Display Statistics To display monitoring statistics for the service for the period of the current 
aggregration interval, select Current Aggregation Interval. The Current 
Aggregation Interval view displays a moving statistic view of the service 
metrics.

To display monitoring statistics for this service for the period since you 
last reset statistics, select Since Last Reset. The Since Last Reset view 
displays a running count view of the metrics.

Server Select a server from the drop-down list to display metrics for that server.

If a cluster exists, cluster-wide metrics are displayed by default. Select an 
individual Managed Server to display metrics for that server. 

If you display metrics for an individual Managed Server in a cluster, the 
SLA Alert Count will be N/A (only cluster-wide SLA Alert Counts are 
displayed).

Aggregation Interval If you have selected Current Aggregation Interval in the Display 
Statistics field, the current aggregation interval set for monitoring this 
service, in terms of hours and minutes. You set this interval on the 
Operational Settings page. See “Setting the Aggregation Interval for a 
Service” on page 23-25.

Reset Statistics If you have selected Since Last Reset in the Display Statistics field, you 
can reset the monitoring statistics for this service. Click Reset Statistics 
at the bottom of the page.

Table 23-10  Service Monitoring Information (Continued)

Property Description
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Table 23-11  Service Metrics 

Property Description

SLA Alert Count • The alert count is based on the Display Statistics view, either for 
the Current Aggregation Interval or for the period Since Last 
Reset.

• The alert severity and timestamp are displayed only in the 
Current Aggregation Interval view. For the Since Last Reset 
view, only the count value is displayed.

• The alert severity for the most severe alert within the current 
aggregation interval. If there are multiple alerts, the highest alert 
severity in the current aggregation interval is shown. If there are 
no alerts in the current aggregation interval, NORMAL is displayed.

• The timestamp displays the time the server was last polled for 
alert information and displays the alert status at the time the server 
was last polled. If there were no alerts when the server was last 
polled, NORMAL is displayed and the polling time is shown.

Pipeline Alert Count For proxy services only: 
• The pipeline alert count is based on the Display Statistics view, 

either for the Current Aggregation Interval or for the period 
Since Last Reset.

• The alert severity and timestamp are displayed only in the 
Current Aggregation Interval view. For the Since Last Reset 
view, only the count value is displayed.

• The alert severity for the most severe alert within the current 
aggregation interval. If there are multiple alerts, the highest alert 
severity in the current aggregation interval is shown. If there are 
no pipeline alerts in the current aggregation interval, NORMAL is 
displayed.

• The timestamp displays the time the server was last polled for 
pipeline alert information and displays the alert status at the time 
the server was last polled. If there were no alerts when the server 
was last polled, NORMAL is displayed and the polling time is 
shown.
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Min Response Time If you have selected Current Aggregation Interval in the Display 
Statistics field, the minimum response time this service has taken to 
execute messages within the period of the current aggregation 
interval.

If you have selected Since Last Reset in the Display Statistics field, 
the minimum response time this service has taken to execute 
messages within the period since you last reset statistics.

Max Response Time If you have selected Current Aggregation Interval in the Display 
Statistics field, the maximum response time this service has taken to 
execute messages within the period of the current aggregation 
interval.

If you have selected Since Last Reset in the Display Statistics field, 
the maximum response time this service has taken to execute 
messages within the period since you last reset statistics.

Overall Avg. Response Time If you have selected Current Aggregation Interval in the Display 
Statistics field, the overall average time (in milliseconds) this service 
has taken to execute messages within the period of the current 
aggregation interval.

If you have selected Since Last Reset in the Display Statistics field, 
the overall average time this service has taken to execute messages 
within the period since you last reset statistics.

Message Count If you have selected Current Aggregation Interval in the Display 
Statistics field, the total number of messages that this service has 
executed within the period of the current aggregation interval.

If you have selected Since Last Reset in the Display Statistics field, 
the total number of messages that this service has executed within the 
period since you last reset statistics.

Error Count If you have selected Current Aggregation Interval in the Display 
Statistics field, the number of error messages that this service has 
executed within the period of the current aggregation interval.

If you have selected Since Last Reset in the Display Statistics field, 
the number of messages with errors that this service has executed 
within the period since you last reset statistics.

Table 23-11  Service Metrics (Continued)

Property Description
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Failover Count For business services only:

If you have selected Current Aggregation Interval in the Display 
Statistics field, the number of failovers that this service has attempted 
within the period of the current aggregation interval.

If you have selected Since Last Reset in the Display Statistics field, 
the number of failovers that this service has attempted within the 
period since you last reset statistics.

Success Ratio If you have selected Current Aggregation Interval in the Display 
Statistics field, the success ratio of this service within the period of 
the current aggregation interval.

If you have selected Since Last Reset in the Display Statistics field, 
the success ratio of this service within the period since you last reset 
statistics.

For example, if the service has executed 9 out of 10 messages 
successfully, then the success ratio is 90%.

Failure Ratio If you have selected Current Aggregation Interval in the Display 
Statistics field, the failure ratio of this service within the period of the 
current aggregation interval.

If you have selected Since Last Reset in the Display Statistics field, 
the failure ratio of this service within the period since you last reset 
statistics.

For example, if the service has failed to execute 1 out of 10 messages, 
then the failure ratio is 10%.

WS Security Errors If you have selected Current Aggregation Interval in the Display 
Statistics field, the number of messages with WS security errors that 
this service has executed within the period of the current aggregation 
interval.

If you have selected Since Last Reset in the Display Statistics field, 
the number of messages with WS security errors that this service has 
executed within the period since you last reset statistics.

Table 23-11  Service Metrics (Continued)

Property Description
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Validation Errors For business services: N/A is displayed.

For proxy services:

If you have selected Current Aggregation Interval in the Display 
Statistics field, the number of messages with validation errors that 
this service has executed within the period of the current aggregation 
interval.

If you have selected Since Last Reset in the Display Statistics field, 
the number of messages with validation errors that this service has 
executed within the period since you last reset statistics.

Min Throttling Time For business services only:

If you have selected Current Aggregation Interval in the Display 
Statistics field, the least amount of time that messages have spent in 
a throttling queue within the period of the current aggregation 
interval.

If you have selected Since Last Reset in the Display Statistics field, 
the least amount of time that messages have spent in a throttling queue 
within the period since you last reset statistics.

Max Throttling Time For business services only:

If you have selected Current Aggregation Interval in the Display 
Statistics field, the maximum amount of time that messages have 
spent in a throttling queue within the period of the current aggregation 
interval.

If you have selected Since Last Reset in the Display Statistics field, 
the maximum amount of time that messages have spent in a throttling 
queue within the period since you last reset statistics. 

Average Throttling Time For business services only:

If you have selected Current Aggregation Interval in the Display 
Statistics field, the average amount of time that messages have spent 
in a throttling queue within the period of the current aggregation 
interval.

If you have selected Since Last Reset in the Display Statistics field, 
the average amount of time that messages have spent in a throttling 
queue within the period since you last reset statistics.

Table 23-11  Service Metrics (Continued)

Property Description
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Viewing Operations Metrics for WSDL-Based Services
Use this page to view the service monitoring information, shown in Table 23-10, and the 
Operations metrics for WSDL-based services, shown in Table 23-12.

Table 23-12  Operations Metrics 

Property Description

Operation Name The name of the operation associated with this service.

Message Count If you have selected Current Aggregation Interval in the Display 
Statistics field, the total number of messages that this operation has 
executed within the period of the current aggregation interval.

If you have selected Since Last Reset in the Display Statistics field, 
the total number of messages that this operation has executed within 
the period since you last reset statistics.

Error Count If you have selected Current Aggregation Interval in the Display 
Statistics field, the number of messages with errors that this operation 
has executed within the period of the current aggregation interval.

If you have selected Since Last Reset in the Display Statistics field, 
the number of messages with errors that this operation has executed 
within the period since you last reset statistics.

Min Response Time If you have selected Current Aggregation Interval in the Display 
Statistics field, the minimum response time this operation has taken 
to execute messages within the period of the current aggregation 
interval.

If you have selected Since Last Reset in the Display Statistics field, 
the minimum response time this operation has taken to execute 
messages within the period since you last reset statistics.
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Viewing Pipeline Metrics
Use this page to view the service monitoring information, shown in Table 23-10, and the Pipeline 
metrics for proxy services that have pipelines, shown in Table 23-13.

Max Response Time If you have selected Current Aggregation Interval in the Display 
Statistics field, the maximum response time this operation has taken 
to execute messages within the period of the current aggregation 
interval.

If you have selected Since Last Reset in the Display Statistics field, 
the maximum response time this operation has taken to execute 
messages within the period since you last reset statistics.

Avg. Response Time If you have selected Current Aggregation Interval in the Display 
Statistics field, the overall average time this operation has taken to 
execute messages within the period of the current aggregation interval.

If you have selected Since Last Reset in the Display Statistics field, 
the overall average time this operation has taken to execute messages 
within the period since you last reset statistics.

Table 23-12  Operations Metrics (Continued)

Property Description

Table 23-13  Pipeline Metrics 

Property Description

Component Name The name of the component.

Message Count If you have selected Current Aggregation Interval in the Display 
Statistics field, the total number of messages that this component has 
executed within the period of the current aggregation interval.

If you have selected Since Last Reset in the Display Statistics field, 
the total number of messages that this component has executed within 
the period since you last reset statistics.
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Viewing Action Metrics
Use this page to view the service monitoring information, shown in Table 23-10, and the Action 
metrics for proxy services that have pipelines, shown in Table 23-14.

Error Count If you have selected Current Aggregation Interval in the Display 
Statistics field, the number of messages with errors that this 
component has executed within the period of the current aggregation 
interval.

If you have selected Since Last Reset in the Display Statistics field, 
the number of messages with errors that this component has executed 
within the period since you last reset statistics.

Min Response Time If you have selected Current Aggregation Interval in the Display 
Statistics field, the minimum response time this component has taken 
to execute messages within the period of the current aggregation 
interval.

If you have selected Since Last Reset in the Display Statistics field, 
the minimum response time this component has taken to execute 
messages within the period since you last reset statistics.

Max Response Time If you have selected Current Aggregation Interval in the Display 
Statistics field, the maximum response time this component has taken 
to execute messages within the period of the current aggregation 
interval.

If you have selected Since Last Reset in the Display Statistics field, 
the maximum response time this component has taken to execute 
messages within the period since you last reset statistics.

Avg. Response Time (msecs) If you have selected Current Aggregation Interval in the Display 
Statistics field, the overall average time this component has taken to 
execute messages within the period of the current aggregation interval.

If you have selected Since Last Reset in the Display Statistics field, 
the overall average time this component has taken to execute messages 
within the period since you last reset statistics.

Table 23-13  Pipeline Metrics (Continued)

Property Description
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Viewing Business Services Endpoint URIs Metrics
Use this page to view the service monitoring information, shown in Table 23-10, and the 
Endpoint URIs metrics for business services, shown in Table 23-15. For more information, see 
Managing Endpoint URI for Business Services in Oracle Service Bus Operations Guide.

Table 23-14  Action Metrics 

Property Description

Node A hierarchical display of the nested actions.

Count If you have selected Current Aggregation Interval in the Display 
Statistics field, the number of invocations within the period of the 
current aggregation interval.

If you have selected Since Last Reset in the Display Statistics field, 
the number of invocations within the period since you last reset 
statistics.

Note that this is different than the number of messages since an action 
can be invoked many times per message.

Avg. Time If you have selected Current Aggregation Interval in the Display 
Statistics field, the average execution time per invocation within the 
period of the current aggregation interval.

If you have selected Since Last Reset in the Display Statistics field, 
the average execution time per invocation within the period since you 
last reset statistics.

Total Time If you have selected Current Aggregation Interval in the Display 
Statistics field, the total execution time within the period of the 
current aggregation interval.

If you have selected Since Last Reset in the Display Statistics field, 
the total execution time within the period since you last reset statistics.
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Table 23-15  Endpoint URIs Metrics 

Property Description

Endpoint URI The endpoint URL associated with this business service.

Message Count If you have selected Current Aggregation Interval in the Display 
Statistics field, the total number of messages executed by this 
endpoint URI within the period of the current aggregation interval.

If you have selected Since Last Reset in the Display Statistics field, 
the total number of messages executed by this endpoint URI within the 
period since you last reset statistics.

Error Count If you have selected Current Aggregation Interval in the Display 
Statistics field, the number of messages with errors executed by this 
endpoint URI within the period of the current aggregation interval.

If you have selected Since Last Reset in the Display Statistics field, 
the number of messages with errors executed by this endpoint URI 
within the period since you last reset statistics.

Min Response Time If you have selected Current Aggregation Interval in the Display 
Statistics field, the minimum response time this endpoint URI has 
taken to execute messages within the period of the current aggregation 
interval.

If you have selected Since Last Reset in the Display Statistics field, 
the minimum response time this endpoint URI has taken to execute 
messages within the period since you last reset statistics.

Max Response Time If you have selected Current Aggregation Interval in the Display 
Statistics field, the maximum response time this endpoint URI has 
taken to execute messages within the period of the current aggregation 
interval.

If you have selected Since Last Reset in the Display Statistics field, 
the maximum response time this endpoint URI has taken to execute 
messages within the period since you last reset statistics.
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Viewing Server Information
The Server Health page includes the following:

On the Server Health tab header, a  Shutdown icon and numeric indicator which shows 
the number of servers that are shutdown, may be present:

– Clicking on the icon filters the servers displayed using the Shutdown Health criteria 
and SHUTDOWN State criteria.

– The number indicates the number of shutdown servers.

Avg. Response Time If you have selected Current Aggregation Interval in the Display 
Statistics field, the overall average time this endpoint URI has taken 
to execute messages within the period of the current aggregation 
interval.

If you have selected Since Last Reset in the Display Statistics field, 
the overall average time this endpoint URI has taken to execute 
messages within the period since you last reset statistics.

Status The status of the business service endpoint URI.

For single server domains or for an individual Managed Server in a 
cluster: Online or Offline. 

For cluster-level statistics: Online, Offline, or Partial, when that 
particular URI is offline on at least one of the Managed Servers in the 
cluster.

Action Click the  Mark Endpoint Online icon to mark an offline URI, 
Online. This action is enabled only if the URI has an Offline or Partial 
status.

To enable this action, a business service must be enabled for taking 
URIs offline and its service and global-level monitoring operational 
settings must be enabled. See “Configuring Operational Settings for 
Business Services” on page 23-19.

Note: If successful, the action is immediate. However, reflecting 
that its endpoint URI status is now online takes one 
monitoring aggregation cycle, which might take as long as 1 
minute and a half.

Table 23-15  Endpoint URIs Metrics (Continued)

Property Description
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A pie chart that depicts the health of the servers in the domain. You can click the area in 
the chart that corresponds to the server to display more details.

The Log Summary. To display the log, click the numeric link that displays the number of 
messages for a given severity. For example, Alert:1, click on the number 1. See “Viewing 
Details of Domain Log Files” on page 23-41.

Fields that display server information, depending on your customized settings for the 
Server Summary table. For example, server name, health, cluster name, machine name, 
the state of the server, and the length of time the server has been running. To learn more 
about these fields, see Table 23-16.

By default, the Dashboard refresh rate is No Refresh. To change the Dashboard refresh 
rate interval, see “Setting User Preferences” on page 24-20.

WARNING: By selecting a dashboard refresh rate interval other than the default (No Refresh), 
the browser refreshes the Dashboard at regular intervals. This prevents your 
session from timing out, even without you interacting with the console. 

Oracle recommends that you use the Dashboard refresh rate feature with caution. 
You should never leave a console session unattended. While your console session 
is active others can gain access to it from your machine, without re-authentication.

A  Table Customizer icon. See “Customizing Table Views” on page 1-2.

To restrict the number of items in the list or locate specific servers:

– Click the  Open icon to display additional search filters. If you specify multiple 
search criteria, only results that match all the criteria will be returned.

– Filter by health status. From the Health drop-down list, select to restrict servers to the 
specified health status level, then click Search. 

Select the or above check box to restrict your search to the specified server health 
status level or above (listed from the most inclusive to the most restrictive level): OK, 
Warning, Overloaded, Critical, and Fatal.

– Filter by server. From the Server drop-down list, select All or the name of the server, 
then click Search. 

– Filter by cluster name. From the Cluster Name drop-down list, select All or the name 
of the cluster associated with the server, then click Search. 

– Filter by machine name. From the Machine Name drop-down list, select All or the 
name of the machine associated with the server, then click Search. 
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– Filter by state. From the State drop-down list, select All or the state of the server: 
RUNNING, FAILED, or SHUTDOWN, then click Search. 

– Click View All to remove the search filters and display all servers.

The Server Health page displays the following information for each server, shown in 
Table 23-16, depending on the filter settings you have specified.

Table 23-16  Server Summary Details 

Property Description

Server The name of the server. The name is a link to the View Server Details 
page. See “Viewing Server Details” on page 23-39.

Health The health status of the server:
• OK—the server is functioning without any problems.
• OK/Not Processing—the server is in the ADMIN state, available 

only for administration operations. All run-time Oracle Service 
Bus messages will fail.

• Warning—the server might have problems in the future. Check the 
server logs and the corresponding RuntimeMBean for more 
details.

• Overloaded—the server has more work assigned to it than the 
configured threshold; it might refuse more work.

• Critical—server failure pending; something must be done 
immediately to prevent failure. Check the server logs and the 
corresponding RuntimeMBean for more details.

• Shutdown—the server has failed and must be restarted.
• Critical—server failure pending; something must be done 

immediately to prevent failure. Check the server logs and the 
corresponding RuntimeMBean for more details. 

Cluster Name The name of the cluster associated with this server.

Machine Name The name of the machine associated with this server.
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Viewing Server Details
The objects displayed on this page are WebLogic Server entities. To learn more about these 
entities, see the WebLogic Server Administration Console Online Help in one of the following 
ways:

The WebLogic Server Administration Console Online Help is available at the following 
URL: 
http://download.oracle.com/docs/cd/E12840_01/wls/docs103/ConsoleHelp/co
re/index.html

Access the online help system from the Oracle Service Bus Console when the server is 
running. Click WLS Console in the top banner, then click Help in the top banner of the 
WebLogic Server Administration Console.

Viewing Domain Log Files
This page displays a summary of domain log file entries, including the information shown in 
Table 23-17.

To customize the display of domain log file information, see “Customizing Your View of 
Domain Log File Entries” on page 23-40.

To display details of a specific log file, select the radio button for the appropriate entry, 
then click View. See “Viewing Details of Domain Log Files” on page 23-41.

State The state of the server:
• RUNNING
• ADMIN
• FAILED
• SHUTDOWN

Uptime The length of time this server has been running.

Table 23-16  Server Summary Details (Continued)

Property Description
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Customizing Your View of Domain Log File Entries
1. Click Customize this table. Additional fields are displayed.

You can click the Customize this table link at any time to close this table and retain the 
original settings.

2. In the Filter fields, do the following:

a. In the Time field, select the time interval for which you want to view log entries. 

b. In the Start Time field, enter a start time in the format MM/DD/YYYY HH:MM:SS. For 
example, enter 10/25/06 08:39:48. You use the Start Time and End Time fields to specify 
a window of time for which you want to view log entries.

c. In the End Time field, enter a end time in the format MM/DD/YYYY HH:MM:SS. For 
example, enter 10/25/06 13:20:51. You use the Start Time and End Time fields to specify 
a window of time for which you want to view log entries.

d. In the Criteria text box, specify a filtering criteria (a text string). The filtering criteria is 
specified as a string in the WLDF Query Language. The query language supports Boolean 
operators: AND, OR, and NOT, and relational operators. For more information on query 
syntax, see WLDF Query Language in Configuring and Using the WebLogic Diagnostics 
Framework at 
http://download.oracle.com/docs/cd/E12840_01/wls/docs103/wldf_config
uring/appendix_query.html.

3. In the Columns field, select the columns you want to display:

a. Select a column name from the Available field.

Table 23-17  Domain Log Summary Information 

Property Description

Date The date the entry was logged.

Subsystem The subsystem associated with the entry.

Severity The severity of the message.

Message ID The unique identification for the message.

Message The message description.
23-40 Using the Oracle Service Bus Console

http://download.oracle.com/docs/cd/E12840_01/wls/docs103/wldf_configuring/appendix_query.html
http://download.oracle.com/docs/cd/E12840_01/wls/docs103/wldf_configuring/appendix_query.html
http://download.oracle.com/docs/cd/E12840_01/wls/docs103/wldf_configuring/appendix_query.html


Viewing  Deta i l s  o f  Domain  Log  F i l es
b. Click the arrow to move this column name to the Chosen field.

c. Repeat until you have listed all the column names you want to display in the Chosen field.

In the Chosen field, you can use the Up and Down arrows to reorder the column names 
as required.

4. In the Number of rows displayed per page field, select the number of log entries you want 
to display on a single page.

5. In the Maximum Results Returned field, select the maximum number of log entries you 
want to display in total or select Show All to display all of them.

6. Do one of the following:

– To save the new settings, click Apply.

– To discard your changes and retain the original settings, click Reset.

Viewing Details of Domain Log Files
Use this page to view details of domain log file entries, shown in Table 23-18.

Table 23-18  Domain Log Details 

Property Description

Message A description of the event or condition.

Date Displays the time and date when the message originated, in a format that 
is specific to the locale. The Java Virtual Machine (JVM) that runs each 
WebLogic Server instance refers to the host computer operating system 
for information about the local time zone and format.

Subsystem Indicates the subsystem of WebLogic Server that was the source of the 
message; for example, Enterprise Java Bean (EJB) container or Java 
Messaging Service (JMS).

Message ID A unique six-digit identifier.

All message IDs that WebLogic Server system messages generate start 
with BEA- and fall within a numerical range of 0-499999.
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Severity Indicates the degree of impact or seriousness of the event reported by the 
message:
• Alert—A particular service is in an unusable state while other parts of 

the system continue to function. Automatic recovery is not possible; 
the immediate attention of the administrator is needed to resolve the 
problem.

• Critical—A system or service error has occurred. The system can 
recover but there might be a momentary loss or permanent 
degradation of service.

• Emergency—The server is in an unusable state. This severity 
indicates a severe system failure or panic.

• Error—A user error has occurred. The system or application can 
handle the error with no interruption and limited degradation of 
service.

• Info—Used for reporting normal operations; a low-level 
informational message.

• Notice—An informational message with a higher level of importance. 
• Warning—A suspicious operation or configuration has occurred but 

it might not affect normal operation.

Machine The DNS name of the computer that hosts the server instance.

Server The name of the WebLogic Server instance on which the message was 
generated.

Thread The ID that the JVM assigns to the thread in which the message 
originated.

User ID The user ID under which the associated event was executed.

Transaction ID Present only for messages logged within the context of a transaction.

Context ID Context information to correlate messages coming from a specific request 
or application.

Detail A description of the event or condition.

Cause The cause of the message.

Action The action that should be taken.

Table 23-18  Domain Log Details (Continued)

Property Description
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Viewing Alert Rules
Use this page to view the alert rules information shown in Table 23-19. 

Locating Alert Rules
1. Select Resource Browser > Business Services or Proxy Services. 

Table 23-19  Alert Rules Information 

Property Description

Name The name assigned to this alert rule. The name is a link to the Alert Rule 
General Configuration page. See “Viewing Alert Rule Configurations” on 
page 23-49.

SLA State The status of the alert rule: Enabled or Disabled.

Description This field is hidden by default.

A description of the alert rule.

Severity The severity of the alert that will be triggered by this rule: Normal, Warning, 
Minor, Major, Critical, or Fatal.

Aggr. Interval The length of the aggregation interval in terms of hours and minutes.

Expiration Date The date when this alert rule is no longer in effect.

Stop Processing Displays Yes or No.

Frequency The frequency of this alert:
• Every Time
• Notify Once

Options This column includes the following functionality:
• Click the arrows to reorder the alert rules. You can move individual alert 

rules up or down the list. You can do this only when this more than one 
alert rule configured for this service.

• Click the  Rename icon to rename an alert rule.

• Click the  Delete icon to delete a specific alert rule. See “Deleting 
Alert Rules” on page 23-51.
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2. Click the service name. 

3. Select the SLA Alert Rules tab.

4. To locate a specific alert rule for this service, scroll through the pages. Use the page controls 
above or below the table. Go to a page by selecting the page number or by using the arrow 
buttons to go to the next, previous, first, or last page. 

You can use this page also to do the following:

To configure monitoring for this service, select the Operational Settings tab. See 
“Configuring Operational Settings for Proxy Services” on page 23-14 and “Configuring 
Operational Settings for Business Services” on page 23-19.

To add a new alert rule, click Add New. See “Creating and Editing Alert Rules” on 
page 23-44.

Creating and Editing Alert Rules
The tasks in creating and editing alert rules include:

“Configuring General Information for Alert Rules” on page 23-44

“Defining Alert Rule Conditions” on page 23-47

“Reviewing the Alert Rule Configuration” on page 23-49

Note: When a service is created from another service, alert rules are maintained in the following 
way:

When a proxy service is created from a business service or a business service is 
created from a proxy service, the alert rules, if any, are removed.

When a proxy service is created from another proxy service or a business service is 
created from another business service, the alert rules, if any, are retained.

Configuring General Information for Alert Rules
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Resource Browser > Proxy Services or Business Services. 

3. Click the service name. 

4. Select the SLA Alert Rules tab and click Add New. 
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5. In the Rule Name field, enter a name for the alert rule. This is a required field.

6. In the Alert Summary field, enter a short description of the alert rule. This text is also used 
as the subject line for an e-mail message if this alert rule is configured with an e-mail alert 
notification, and can contain no more than 80 characters. If you do not provide an alert 
summary, the default text, Oracle Service Bus Alert, will be used instead.

7. In the Rule Description field, enter a description for the alert rule.

8. In the Alert Destination field, enter the name of the alert destination resource or click 
Browse to display the Select Alert Destination page. Select an alert destination from the list 
and click Submit. 

By default, the alert will always go to the console. To configure and select other alert 
destination resources, see “Adding Alert Destinations” on page 5-2 and “Locating Alert 
Destinations” on page 5-1.

9. In the Start Time field, enter a start time in the format HH:MM. For example, enter 09:00 AM. 
You use the Start Time and End Time fields to specify a window of time during which the 
rule is active on each day prior to the expiration date. For example, between 9am and 5pm 
every day.

10. In the End Time field, enter an end time in the format HH:MM. For example, enter 05:00 PM. 
You use the Start Time and End Time fields to specify a window of time during which the 
rule is active on each day prior to the expiration date. For example, between 9am and 5pm 
every day.

The alert rule is active daily during the start time you specified until the end time you 
specified, until the rule expires.

11. In the Rule Expiration Date field, enter an expiration date in the format MM/DD/YYYY. For 
example, enter 12/31/2010. The rule expires at 11:59 pm on the specified date. If you do not 
specify a date, the rule never expires.

12. In the Rule Enabled field, keep Yes as the default to ensure that this rule is enabled, or select 
No to disable this rule.

13. In the Alert Severity field, select one of the following:

– Normal

– Warning

– Minor

– Major
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– Critical

– Fatal

14. In the Alert Frequency field, select one of the following settings, shown in Table 23-20.

15. Select Yes for the Stop Processing More Rules option if you want to abort executing further 
rules after one of the rules associated with a service evaluates to true. Use this option to stop 
evaluating subsequent rules when there are multiple rules associated with a particular service. 
Keep No as the default to continue processing rules.

This option behaves like the Stop Processing More Rules option in the Rules Wizard in 
Microsoft Outlook. 

After you finish 

Click Next to display the New Alert Rule - Conditions Configuration page. Continue in 
“Defining Alert Rule Conditions” on page 23-47.

Table 23-20  Alert Frequency Setting 

Property Description

Every Time If you select this option, the actions included in the alert rule are executed 
every time the alert rule evaluates to true. For example, if you set the 
condition that the average response time is greater than 300 milliseconds, 
you receive an alert every time this condition evaluates to true.

The number of times an alert rule is evaluated depends on the 
aggregation interval and the sample interval associated with that rule. If 
the aggregation interval is set to 5 minutes, the sample interval is 1 
minute. Rules are evaluated each time 5 samples of data are available. 
Therefore, the rule is evaluated for the first time approximately 5 minutes 
after it is created and every minute thereafter. 

Notify Once If you select this option, the actions included in the rule are executed the 
first time the rule evaluates to true, and no more alerts are generated 
until the condition resets itself and evaluates to true again. For 
example, if you set the condition that the average response time is less 
than 300 milliseconds, you receive an alert the first time this condition 
evaluates to true, but you do not receive any more alerts until the 
condition evaluates to false and then to true again. The alert 
timestamp gets updated and is displayed on the Dashboard.
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Defining Alert Rule Conditions
Use this page to define conditions for the alert rule. You must specify at least one condition. If 
you specify multiple conditions, you must use the And/Or operators to combine them.

1. In the Select Aggregation Interval for the Condition field, select the number of hours and 
minutes to set the aggregation interval for this condition. The aggregation interval determines 
the frequency at which the condition is tested. The condition is tested each time the 
monitoring subsystem aggregates enough samples of data to constitute 1 aggregation interval.

For example, if you select an aggregation interval of 1 hour, the condition is tested each 
time an hour's worth of data is available. The first time the condition is tested is at the end 
of the first hour. After that, the condition is tested every 10 minutes because the sampling 
interval for an aggregation interval of 1 hour is set to 10 minutes.

2. You start by defining a simple expression. Two or more simple expressions can be combined 
to form a complex expression. To define a complex simple expression, do the following:

a. In the first drop-down field, select Count, Minimum, Maximum, Average, or Status.

b. In the next drop-down field, select an operand. 

Depending on whether you select Count, Minimum, Maximum, Average, or Status in 
the first drop-down field, the list of the operands varies. For example, if you select 
Minimum, Maximum, or Average, the Response Time operand is available. Use this 
operand to set the response time in milliseconds (msec). The operands available also 
depends on the configuration of the service itself. The number of operands varies 
according to whether a service has pipelines, route nodes, operations, and so on.

For information on how to generate alerts based on endpoint URI status, see Managing 
Endpoint URI for Business Services in Oracle Service Bus Operations Guide.

When you select Count, this field displays the operands shown in Table 23-21.

Table 23-21  Count Operand Details 

Property Description

Error Count The error count gets incremented when message processing returns a 
failure.

Failure Ratio (%) The ratio of errors encountered to the total number of messages 
successfully processed over the specified aggregation interval.

Message Count The total number of messages processed.
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c. In the next field, select the desired comparison operator: =, !=, > or <. 

d. In the next field, enter the value to compare against.

e. Click Add.

3. To define a complex expression:

a. Repeat steps a - e in step 2 to define a simple expression.

b. Repeat steps a - e again to define another simple expression.

c. Select the check box for each of the two expressions.

d. Click And or Or to combine the expressions into a complex expression.

The Split option is available after you combine multiple expressions. This option is 
used to split complex expressions back into separate simple expressions.

After you finish 

Click Prev to return to the General Configuration page. Or, click Last to display the New Alert 
Rule - [service name] page. Continue in “Reviewing the Alert Rule Configuration” on 
page 23-49.

Success Ratio (%) The ratio of messages successfully processed to the total number of 
messages encountered over the specified aggregation interval.

Failover count For business services only: The failover count.

<Request Pipeline>. 
Error Count

For proxy services only: The number of erroneous messages processed 
by the request pipeline.

<Request Pipeline>. 
Message Count

For proxy services only: The number of messages processed by the 
request pipeline.

Validation Error Count For proxy services only that have a validate action in the pipeline: The 
number of validation errors.

WSS Error Count Available depending on the transport for the service (such as with 
HTTP): The number of Web Service Security (WSS) erroneous 
messages processed. This counter is only available for WSDL-based 
services and is updated when a WSS error is encountered.

Table 23-21  Count Operand Details (Continued)

Property Description
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Reviewing the Alert Rule Configuration
Use this page to review the configuration data that you have entered for this alert rule. If 
necessary, you can click Edit to make changes to the configuration before you save the alert rule.

Do any of the following:

To make a change to one of the configuration pages, click the  Edit icon for the 
appropriate page.

To return to the previous page, click Prev.

To create the alert, click Save. The alert rule is created and saved in the current session.

To disregard changes, click Cancel.

To end the session and deploy the configuration to the run time, click Activate under 
Change Center.

Viewing Alert Rule Configurations
Use this page to view alert rule configuration details, shown in Table 23-22.

Table 23-22  Alert Rule - General Configuration 

Property Description

Rule Name The name of the alert rule.

Rule Description A description of the alert rule.

Alert Summary A short description of the alert rule. This text is also used as the subject 
line for an e-mail message if this alert rule is configured with an 
e-mail alert notification.

Alert Destination The path and name of the alert destination resource that contains the 
destination address for alert notifications. This field is a link to the View 
Alert Destination - General Configuration page. See “Editing Alert 
Destinations” on page 5-5.

Start Time (HH:MM) The start time for this alert rule.

End Time (HH:MM) The end time for this alert rule.
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The page displays the Conditions information shown in Table 23-23.

Editing Alert Rules
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Locate the alert rule. See “Locating Alert Rules” on page 23-43.

Rule Expiration Date 
(MM/DD/YYYY)

The date when this alert rule no longer applies.

Rule Enabled Whether or not this alert rule is enabled.

Alert Severity The severity of the alert raised as a result of this alert rule:
• Normal
• Warning
• Minor
• Major
• Critical
• Fatal

Alert Frequency The frequency of the alert:
• Every Time
• Notify Once

Stop Processing More 
Rules

Whether or not the alert stops processing more rules.

Table 23-23  Alert Rule Conditions 

Property Description

Condition Expression The aggregation interval for this condition, in terms of hours and minutes.

A list of one or more conditions that govern this alert rule.

Table 23-22  Alert Rule - General Configuration (Continued)

Property Description
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3. Click the alert rule name. 

4. To make a change to the fields on the configuration pages, click the  Edit icon for the 
appropriate page or the Edit button at the bottom of the page. See “Creating and Editing Alert 
Rules” on page 23-44 for descriptions of the pages and fields.

5. Do any of the following:

– To go to the next page, click Next.

– To return to the previous page, click Prev.

– To go to the summary page, click Last.

– To commit the updates in the current session, click Save.

– To disregard changes and return to the SLA Alert Rules page, click Cancel.

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Deleting Alert Rules
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Locate the alert rule. See “Locating Alert Rules” on page 23-43.

3. Click the  Delete icon in the Options field of the alert rule you want to delete. The alert 
rule is deleted in the current session. 

4. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 
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Configuration
You use the Configuration module to locate and manage proxy services, business services, alert 
destinations, SLA alert rules, and the run-time tracing for proxy services. 

You can specify operational settings for all services, at the service and global level, and use the 
global settings to turn on and off monitoring, SLA alerts, and, for proxy services only, pipeline 
message reporting and pipeline message logging.

Finding and Updating Operational Settings
Use the Smart Search page to easily locate proxy services, business services, alert destinations, 
and SLA alert rules. Additionally, you can use the Smart Search page to specify service-specific 
operational settings, with the following exceptions: you cannot set an aggregation interval or 
specify an alerting or logging severity level. For more information, see “Configuring Operational 
Settings for Proxy Services” on page 23-14 and “Configuring Operational Settings for Business 
Services” on page 23-19.

The run-time effects of the service-level settings depend on their corresponding global settings. 
You must enable both the global and the service-level settings for a service to be completely 
enabled at run time. Additionally, the service State must also be enabled. See “Enabling Global 
Settings” on page 24-14.

You can enable or disable operational settings only from within a session.

Finding All Services (Proxy and Business Services)
1. Select Operations > Smart Search. 
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2. From the Type drop-down list, select All Services, then click Search. The Summary of All 
Services page displays the information shown in Table 24-1.

3. To restrict the number of items in the list or locate specific services:

– Click the  Open icon to display additional search filters. If you specify multiple 
search criteria, only results that match all the criteria will be returned.

– Filter by service name. In the Name field, enter the name of the search target or enter 
wildcard characters (use * and ? as wildcard characters to perform a more general 
search), then click Search. 

This search method is preferable if the name of the service is unique across all projects 
and paths.

– Filter by service path. In the Path field, enter the path of the search target, which is the 
project name and the name of the folder in which services reside. You can use * and ? 
as wildcard characters to perform a more general search. All the services that reside in 
that path are displayed.

The format for the Path field is as follows:  
project-name/root-folder/ . . ./parent-folder

If a service is directly under the project, the format is as follows: project-name

– Filter by service name and path. This search method is preferable if there is more than 
one service with the same name that reside in different paths.

– Filter by service state. From the State drop-down list, select the state of the service: 
Enabled or Disabled, then click Search. Select All to ignore the service state filter 
criteria.

– Filter by service monitoring. From the Monitoring drop-down list, select the 
monitoring status of the service: Enabled or Disabled, then click Search. Select All to 
ignore the service monitoring filter criteria.

– Filter by service’s SLA Alerts setting. From the SLA Alerts drop-down list, select the 
SLA alerts setting of the service: Enabled or Disabled, then click Search. Select All to 
ignore the service SLA alerts filter criteria.
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You can use this page also to do the following:

Table 24-1  Services Summary Information 

Property Description

Name The name assigned to the service. The name is a link to the Operational Settings 
page. See “Configuring Operational Settings for Proxy Services” on page 23-14 
or “Configuring Operational Settings for Business Services” on page 23-19. 

Path The project associated with the service. If the service resides in a project folder, 
this folder is also listed. The path is displayed in the format:
project-name/root-folder/ . . ./parent-folder

The path is a link to the corresponding path in the Project Explorer.

Type The parent service type: proxy service or business service. 

State The state of the service: Enabled or Disabled.

Monitoring The monitoring status of the service: Enabled or Disabled.

SLA Alerts The SLA alerts status: Enabled or Disabled, and the level enabled at and above: 
Normal (N), Warning (W), Minor (Mn), Major (Mj), Critical (C), or Fatal (F).

Pipeline Alerts For proxy services only:

The pipeline alerts status: Enabled or Disabled, and the level enabled at and 
above: Normal (N), Warning (W), Minor (Mn), Major (Mj), Critical (C), or Fatal 
(F).

Reports For proxy services only: 

The message reporting status of the service: Enabled or Disabled.

Logs For proxy services and Split-Joins only:

The logging status: Enabled or Disabled, and the level enabled at and above: 
Debug (D), Info (I), Warning (W), or Error (E).

Tracing For proxy services and Split-Joins only:

The run-time tracing status of the proxy service: Enabled or Disabled.

Actions
For proxy services: The  Edit Message Flow icon is a link to the pipeline for 
that proxy service.
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To remove the search filter and display all services, click View All.

To discard your changes and refresh the page with the currently stored settings using the 
same search criteria, click Reset.

From within a session, to enable or disable any service-level settings, select or clear the 
check box next to it and click Update. 

Note: The run time effects of the service-level settings depend on their corresponding 
global settings. You must enable both the global and the service-level settings for a 
service to be completely enabled at run time. Additionally, SLA Alerts depends on 
both the global and service-level Monitoring states—both must be enabled for SLA 
alerts to be enabled at run time. See “Enabling Global Settings” on page 24-14. 

In addition, the service State must also be enabled.

To customize your view of the operational settings information, click the  Table 
Customizer icon. See “Customizing Table Views” on page 1-2.

Finding Proxy Services
1. Select Operations > Smart Search.

2. From the Type drop-down list, select Proxy Services, then click Search. The Summary of 
Proxy Services page displays the information shown in Table 24-2.

3. To restrict the number of items in the list or locate specific proxy services:

– Click the  Open icon to display additional search filters. If you specify multiple 
search criteria, only results that match all the criteria will be returned.

– Filter by proxy service name and path. In the Name and Path fields, enter the name 
and path of the search target, then click Search. The path is the project name and the 
name of the folder in which the proxy service resides. You can use * and ? as wildcard 
characters to perform a more general search. 

– Filter by service state. From the State drop-down list, select the proxy service state: 
Enabled or Disabled, then click Search. Select All to ignore the service state filter 
criteria.

– Filter by service monitoring. From the Monitoring drop-down list, select the 
monitoring status of the proxy service: Enabled or Disabled, then click Search. Select 
All to ignore the service monitoring filter criteria.
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– Filter by service’s SLA Alerts setting. From the SLA Alerts drop-down list, select the 
SLA alerts setting of the proxy service: Enabled or Disabled, then click Search. Select 
All to ignore the service SLA alerts filter criteria.

– Filter by service’s pipeline alerts setting. From the Pipeline Alerts drop-down list, 
select the pipeline alerts setting of the proxy service: Enabled or Disabled, then click 
Search. Select All to ignore the service pipeline alerts filter criteria.

– Filter by services with message reports. From the Message Reports drop-down list, 
select the message reports status of the proxy service: Enabled or Disabled, then click 
Search. Select All to ignore the service message reports filter criteria.

– Filter by services with logging. From the Logs drop-down list, select the logging status 
of the proxy service: Enabled or Disabled, then click Search. Select All to ignore the 
service logging filter criteria.

– Filter by services with run-time tracing. From the Tracing drop-down list, select the 
run-time tracing status of the proxy service: Enabled or Disabled, then click Search. 
Select All to ignore the service tracing filter criteria.

Table 24-2  Proxy Services Summary Information 

Property Description

Name The name assigned to the proxy service. The name is a link to the 
Operational Settings page. See “Configuring Operational Settings for 
Proxy Services” on page 23-14.

Path The project associated with the proxy service. If the service resides in a 
project folder, this folder is also listed. The path is displayed in the format:
project-name/root-folder/ . . ./parent-folder

The path is a link to the corresponding path in the Project Explorer.

Type The parent service type: proxy service. 

State The state of the proxy service: Enabled or Disabled.

Monitoring The monitoring status of the proxy service: Enabled or Disabled.

SLA Alerts The SLA alerts status: Enabled or Disabled, and the level enabled at and 
above: Normal (N), Warning (W), Minor (Mn), Major (Mj), Critical (C), 
or Fatal (F).
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You can use this page also to do the following:

To remove the search filters and display all proxy services, click View All.

To discard your changes and refresh the page with the currently stored settings using the 
same search criteria, click Reset.

From within a session, to enable or disable any service-level settings, select or clear the 
check box next to it and click Update. 

Note: The run time effects of the service-level settings depend on their corresponding 
global settings. You must enable both the global and the service-level settings for a 
service to be completely enabled at run time. Additionally, SLA Alerts depends on 
both the global and service-level Monitoring states—both must be enabled for SLA 
alerts to be enabled at run time. See “Enabling Global Settings” on page 24-14. 

In addition, the service State must also be enabled.

To customize your view of the operational settings information, click the  Table 
Customizer icon. See “Customizing Table Views” on page 1-2.

Finding Business Services
1. Select Operations > Smart Search.

Pipeline Alerts The pipeline alerts status: Enabled or Disabled, and the level enabled at and 
above: Normal (N), Warning (W), Minor (Mn), Major (Mj), Critical (C), 
or Fatal (F).

Reports The message reports status of the service: Enabled or Disabled.

Logs The logging status: Enabled or Disabled, and the level enabled at and 
above: Debug (D), Info (I), Warning (W), or Error (E).

Tracing The run-time tracing status of the proxy service: Enabled or Disabled.

Actions
The  Edit Message Flow icon is a link to the pipeline for that proxy 
service.

Table 24-2  Proxy Services Summary Information (Continued)

Property Description
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2. From the Type drop-down list, select Business Services, then click Search. The Summary 
of Business Services page displays the information shown in Table 24-3.

3. To restrict the number of items in the list or locate specific business services:

– Click the  Open icon to display additional search filters. If you specify multiple 
search criteria, only results that match all the criteria will be returned.

– Filter by business service name and path. In the Name and Path fields, enter the name 
and path of the search target, then click Search. The path is the project name and the 
name of the folder in which the business service resides. You can use * and ? as 
wildcard characters to perform a more general search.

– Filter by service state. From the State drop-down list, select the business service state: 
Enabled or Disabled, then click Search. Select All to ignore the service state filter 
criteria.

– Filter by service monitoring. From the Monitoring drop-down list, select the 
monitoring status of the business service: Enabled or Disabled, then click Search. 
Select All to ignore the service monitoring filter criteria.

– Filter by business service’s SLA alerts setting. From the SLA Alerts drop-down list, 
select the SLA alerts setting of the business service: Enabled or Disabled, then click 
Search. Select All to ignore the service SLA alerts filter criteria.

Table 24-3  Business Services Summary Information 

Property Description

Name The name assigned to the business service. The name is a link to the 
Operational Settings page. See “Configuring Operational Settings for 
Business Services” on page 23-19.

Path The project associated with the business service. If the service resides in a 
project folder, this folder is also listed. The path is displayed in the format:
project-name/root-folder/ . . ./parent-folder

The path is a link to the corresponding path in the Project Explorer.

Type The parent service type: business service. 

State The state of the business service: Enabled or Disabled.
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You can use this page also to do the following:

To remove the search filter and display all business services, click View All.

To discard your changes and refresh the page with the currently stored settings using the 
same search criteria, click Reset.

From within a session, to enable or disable any service-level settings, select or clear the 
check box next to it and click Update. 

Note: The run time effects of the service-level settings depend on their corresponding 
global settings. You must enable both the global and the service-level settings for a 
service to be completely enabled at run time. Additionally, SLA Alerts depends on 
both the global and service-level Monitoring states—both must be enabled for SLA 
alerts to be enabled at run time. See “Enabling Global Settings” on page 24-14.

In addition, the service State must also be enabled.

To customize your view of the operational settings information, click the  Table 
Customizer icon. See “Customizing Table Views” on page 1-2.

Finding Split-Joins
1. Select Operations > Smart Search.

2. From the Type drop-down list, select Split-Joins, then click Search. The Summary of 
Split-Joins page displays the information shown in Table 24-4.

3. To restrict the number of items in the list or locate specific business services:

– Click the  Open icon to display additional search filters. If you specify multiple 
search criteria, only results that match all the criteria will be returned.

Monitoring The monitoring status of the business service: Enabled or Disabled.

SLA Alerts The SLA alerts status: Enabled or Disabled, and the level enabled at and 
above: Normal (N), Warning (W), Minor (Mn), Major (Mj), Critical (C), 
or Fatal (F).

Table 24-3  Business Services Summary Information (Continued)

Property Description
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– Filter by Split-Join name and path. In the Name and Path fields, enter the name and 
path of the search target, then click Search. The path is the project name and the name 
of the folder in which the Split-Join resides. You can use * and ? as wildcard characters 
to perform a more general search.

– Filter by Split-Joins with logging. From the Logs drop-down list, select the logging 
status of the Split-Join: Enabled or Disabled, then click Search. Select All to ignore the 
logging filter criteria.

– Filter by execution tracing. From the Execution Tracing drop-down list, select the 
execution tracing status of the Split-Join: Enabled or Disabled, then click Search. 
Select All to ignore the service logging filter criteria.

You can use this page also to do the following:

To remove the search filter and display all Split-Joins, click View All.

To discard your changes and refresh the page with the currently stored settings using the 
same search criteria, click Reset.

From within a session, to enable or disable any service-level settings, select or clear the 
check box next to it and click Update. 

Table 24-4  Split-Join Summary Information 

Property Description

Name The name assigned to the Split-Join. The name is a link to the Operational 
Settings page. See “Editing Split-Joins” on page 9-3.

Path The project associated with the Split-Join. If the Split-Join resides in a 
project folder, this folder is also listed. The path is displayed in the format:
project-name/root-folder/ . . ./parent-folder

The path is a link to the corresponding path in the Project Explorer.

Type The parent service type: Split-Join. 

Logs The logging status: Enabled or Disabled, and the level enabled at and 
above: Debug (D), Info (I), Warning (W), or Error (E).

Execution Tracing The run-time tracing status of the Split-Join: Enabled or Disabled.
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Note: The run-time effects of the Split-Join-level settings depend on their corresponding 
global settings. You must enable both the global and the service-level settings for a 
service to be completely enabled at run time.

To customize your view of the operational settings information, click the  Table 
Customizer icon. See “Customizing Table Views” on page 1-2.

Finding Alert Destinations
1. Select Operations > Smart Search.

2. From the Type drop-down list, select Alert Destinations, then click Search. The Summary 
of Alert Destinations page displays the information shown in Table 24-5.

3. To restrict the number of items in the list or locate specific alert destinations:

– Click the  Open icon to display additional search filters. If you specify multiple 
search criteria, only results that match all the criteria will be returned.

– Filter by alert destination name and path. In the Name and Path fields, enter the name 
and path of the search target, then click Search. The path is the project name and the 
name of the folder in which the alert destination resides. You can use * and ? as 
wildcard characters to perform a more general search. 

– Filter by alert destination target. In the Target multi-select box, select one or more alert 
destination targets: SNMP Trap, Reports, e-mail, or JMS, then click Search. Only alert 
destinations with at least one of the selected targets will be displayed. Select no alert 
destination targets to ignore the alert destination filter criteria.

– Filter by search pattern. In the Search Pattern (Any String) text box, specify any 
string, then click Search. The system uses the string to search all the Description fields 
of the alert destinations, as well as the specific detailed fields of the e-mail and JMS 
destinations. If the string appears in any of the alert destination fields, the alert 
destinations matching the search criteria are displayed.
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You can use this page also to do the following:

To remove the search filter and display all alert destinations, click View All.

To delete a specific alert destination if not referenced by other resources, select the check 
box next to it and click Delete.

To customize your view of the operational settings information, click the  Table 
Customizer icon. See “Customizing Table Views” on page 1-2.

Finding SLA Alert Rules
1. Select Operations > Smart Search.

2. From the Type drop-down list, select SLA Alerts, then click Search. The Summary of SLA 
Alert Rules page displays the information shown in Table 24-6.

3. To restrict the number of items in the list or locate specific SLA alert rules:

– Click the  Open icon to display additional search filters. If you specify multiple 
search criteria, only results that match all the criteria will be returned.

Table 24-5  Alert Destinations Summary Information 

Property Description

Name The name of the alert destination resource. This field is a link to the View 
Alert Destination - Configuration page. See “Locating Alert 
Destinations” on page 5-1.

Path The project associated with the alert destination. If the alert destination 
resides in a project folder, this folder is also listed. The path is displayed in 
the format:
project-name/root-folder/ . . ./parent-folder

The path is a link to the corresponding path in the Project Explorer.

Options Click the  Delete icon to delete a specific alert destination. A  
Deletion Warning icon is displayed when other resources reference this 
resource. You can delete the resource with a warning confirmation. This 
might result in conflicts due to unresolved references to the deleted 
resource. See “Deleting Alert Destinations” on page 5-6.
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– Filter by alert rule name. In the Name field, enter the name of the search target or enter 
wildcard characters (use * and ? as wildcard characters to perform a more general 
search), then click Search. 

This search method is preferable if the name of the alert rule is unique across all 
projects and paths.

– Filter by parent service path. In the Path field, enter the path of the parent service, 
which is the project name and the name of the folder in which parent service resides. 
You can use * and ? as wildcard characters to perform a more general search. All alert 
rules whose parent services reside in that path are displayed.

The format for the Path field is as follows:  
project-name/root-folder/ . . ./parent-folder

If a service is directly under the project, the format is as follows: project-name

– Filter by parent service. In the Parent Service field, click Browse to display the Select 
Service page. Select the parent service from the list and click Submit. Click Clear to 
remove the parent service filter criteria, or click Search. 

Note: Your selection in the Parent Service field restricts your choices in the Service 
Type field.

– Filter by parent service type. From the Service Type drop-down list, select Proxy 
Services or Business Services, then click Search. Select All Services to ignore filtering 
by parent service type criteria.

Note: Your selection in the Service Type field restricts your choices in the Parent 
Service field.

– Filter by rule state. From the Rule State drop-down list, select the state of the alert 
rule: Enabled or Disabled, then click Search. Select All to ignore the rule state filter 
criteria.

– Filter by severity. From the Severity drop-down list, select to restrict SLA alerts rules 
to the specified level, then click Search. 

Select the or above check box to restrict your search to the specified severity level or 
above (listed from the most inclusive to the most restrictive level): Normal, Warning, 
Minor, Critical, and Fatal.
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You can use this page also to do the following:

To remove the search filter and display all SLA Alert Rules, click View All.

To discard your changes and refresh the page with the currently stored settings using the 
same search criteria, click Reset.

Table 24-6  SLA Alert Rules Summary Information 

Property Description

Name The name assigned to this alert rule. The name is a link to the Alert Rule 
Configuration page. See “Viewing Alert Rule Configurations” on page 23-49.

SLA State The status of the alert rule: Enabled or Disabled.

Description Note: This field is hidden by default.

A description of the alert rule.

Service Name The name of the parent service. The name is a link to the SLA Alert Rules page. 
See “Viewing Alert Rules” on page 23-43.

Path The project associated with the parent service of the alert rule. If the parent 
service of the alert rule resides in a project folder, this folder is also listed. The 
path is displayed in the format:
project-name/root-folder/ . . ./parent-folder

The path is a link to the corresponding path in the Project Explorer.

Severity The severity of the alert that is triggered by this rule: Normal, Warning, Minor, 
Major, Critical, or Fatal.

Aggr. Interval The length of the aggregation interval in terms of hours and minutes.

Expiration Date The date when this alert rule is no longer in effect.

Stop Processing Note: This field is hidden by default.

Displays Yes or No.

Frequency The frequency of this alert:
• Every Time
• Notify Once
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From within a session, to enable or disable an SLA Alert Rule, select or clear the check 
box next to it and click Update. 

To customize your view of the operational settings information, click the  Table 
Customizer icon. See “Customizing Table Views” on page 1-2.

Enabling Global Settings
You can enable or disable all global settings only from within a session. Table 24-7 lists global 
settings tasks and help topics.

Enabling Global Monitoring of Services
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Operations > Global Settings.

Table 24-7  Global Settings Tasks and Help Topics 

To... See...

Turn monitoring for all services on and off at the 
domain level

• “Enabling Global Monitoring of Services” on 
page 24-14

• “Disabling Global Monitoring of Services” on 
page 24-15

Turn SLA alerts for all services on and off at the 
domain level

• “Enabling SLA Alerts Globally” on page 24-16
• “Disabling SLA Alerts Globally” on page 24-16

For proxy services only: Turn pipeline alerts for 
all proxy services on and off at the domain level

• “Enabling Pipeline Alerts Globally” on page 24-17
• “Disabling Pipeline Alerts Globally” on page 24-17

For proxy services only: Turn message reporting 
for all proxy services on and off at the domain 
level

• “Enabling Message Reporting Globally” on page 24-18
• “Disabling Message Reporting Globally” on page 24-18

For proxy services only: Turn logging output for 
all proxy services on and off at the domain level

• “Enabling Logging Globally” on page 24-19
• “Disabling Logging Globally” on page 24-19
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3. Select the Enable Monitoring check box for the system to start collecting monitoring 
statistics for all services whose monitoring is enabled at the service level.

4. Click Update to save all of the settings on this page. 

5. Alternatively, click Reset at any time during the session to discard your changes and refresh 
the page with the currently stored settings.

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Disabling Global Monitoring of Services
Note: If you disable monitoring for all services, all statistics collected so far for those services 

are deleted as well. These statistics cannot be restored using the session Undo function. 
You can use Undo to enable monitoring again for the services, but the deletion of the 
statistics is irreversible.

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select Operations > Global Settings.

3. Clear the Enable Monitoring check box for the system to stop collecting monitoring 
statistics for all services in your configuration.

Note: This option overrides the Enable Service Monitoring option that you can select for 
specific business and proxy services. See “Configuring Operational Settings for 
Business Services” on page 23-19 and “Configuring Operational Settings for Proxy 
Services” on page 23-14.

Note: This option also overrides the Enable SLA Alerts option. If you disable monitoring 
at the global level, SLA alerts will also be disabled at run time as well, even though 
the corresponding Enable SLA Alerts check box may be selected. See “Enabling 
SLA Alerts Globally” on page 24-16.

4. Click Update. The monitoring configuration is saved in the current session.

5. Alternatively, click Reset at any time during the session to discard your changes and refresh 
the page with the currently stored settings.

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 
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Enabling SLA Alerts Globally
Although you can configure SLA Alerts independently from Monitoring, there is an interaction 
between the two settings at run time. If global monitoring is enabled, SLA alerts can be enabled 
or disabled. However, if global monitoring is disabled then SLA alerts will be effectively disabled 
because SLA alert rule conditions depend on monitoring statistics being evaluated.

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select Operations > Global Settings.

3. Select the Enable SLA Alerts check box for the system to start evaluating alert rules for all 
services in your configuration.

4. Click Update to save all of the settings on this page. 

5. Alternatively, click Reset at any time during the session to discard your changes and refresh 
the page with the currently stored settings.

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Disabling SLA Alerts Globally
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Operations > Global Settings.

3. Clear the Enable SLA Alerts check box for the system to stop evaluating alert rules for all 
services in your configuration.

Note: This option overrides any SLA Alerts settings that you can select for specific 
business and proxy services. See “Configuring Operational Settings for Business 
Services” on page 23-19 and “Configuring Operational Settings for Proxy Services” 
on page 23-14.

4. Click Update. The SLA alerts configuration is saved in the current session.

5. Alternatively, click Reset at any time during the session to discard your changes and refresh 
the page with the currently stored settings.
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6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Enabling Pipeline Alerts Globally
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Operations > Global Settings.

3. Select the Enable Pipeline Alerts check box for the system to start executing any pipeline 
alert actions for proxy services.

Pipeline Alerts has no dependency on global Monitoring. 

4. Click Update to save all of the settings on this page. 

5. Alternatively, click Reset at any time during the session to discard your changes and refresh 
the page with the currently stored settings.

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Disabling Pipeline Alerts Globally
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Operations > Global Settings.

3. Clear the Enable Pipeline Alerts check box for the system to stop executing any pipeline 
alert actions for proxy services.

Note: This option overrides any Pipeline Alerts settings that you can select for specific 
proxy services. See “Configuring Operational Settings for Proxy Services” on 
page 23-14.

4. Click Update. The pipeline alerts configuration is saved in the current session.

5. Alternatively, click Reset at any time during the session to discard your changes and refresh 
the page with the currently stored settings.

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.
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Enabling Message Reporting Globally
This option controls pipeline Report actions on the message context only. It does not effect SLA 
alerts or pipeline alerts targeted to the reporting framework.

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select Operations > Global Settings.

3. Select the Enable Reporting check box to start any pipeline Report actions for all proxy 
services.

4. Click Update to save all of the settings on this page. 

5. Alternatively, click Reset at any time during the session to discard your changes and refresh 
the page with the currently stored settings.

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Disabling Message Reporting Globally
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Operations > Global Settings.

3. Clear the Enable Reporting check box to stop any pipeline Report actions for all proxy 
services.

Note: This option overrides any Message Reporting settings that you can select for specific 
proxy services. See “Configuring Operational Settings for Proxy Services” on 
page 23-14.

4. Click Update. The message reporting configuration is saved in the current session.

5. Alternatively, click Reset at any time during the session to discard your changes and refresh 
the page with the currently stored settings.

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.
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Enabling Logging Globally
If you select Enable Logging, pipeline Log action messages are sent to the WebLogic Server 
logging service. To be able to view them, you must configure WebLogic Server to forward these 
messages to the domain log.

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select Operations > Global Settings.

3. Select the Enable Logging check box to start any pipeline Log actions for all proxy services. 

4. Click Update to save all of the settings on this page. 

5. Alternatively, click Reset at any time during the session to discard your changes and refresh 
the page with the currently stored settings.

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Disabling Logging Globally
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select Operations > Global Settings.

3. Clear the Enable Logging check box to stop any pipeline Log actions for all proxy services.

Note: This option overrides any Logging settings that you can select for specific proxy 
services. See “Configuring Operational Settings for Proxy Services” on page 23-14.

4. Click Update. The logging configuration is saved in the current session.

5. Alternatively, click Reset at any time during the session to discard your changes and refresh 
the page with the currently stored settings.

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.
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Setting User Preferences
Use this page to customize and persist your console display options and settings. You can update 
(change) your User Preferences without activating a change session.

Table 24-8 describes the options and controls on the page.

Table 24-8  User Preferences - Options and Controls 

To... Do This...

Change your Home Page, the page 
that opens when you launch the 
console

From the first drop-down list, select any main menu choice: Operations, 
Resource Browser, Project Explorer, Security Configuration, or 
System Administration.

From the second drop-down list, select any one of the sub-menu choices. 
(The contents of the sub-menus dynamically change based on your first 
menu selection.)

Display Search Filters Select Yes or No.

By default, search filters are not displayed (closed). By selecting Yes, 
search filters are always displayed (open).

Display Stage Annotations Select Yes or No.

By default, pipeline stage annotations are not displayed (closed). By 
selecting Yes, stage annotations are always displayed (open).

Display Resource Metadata Select Yes or No.

By default, resource metatdata sections are displayed (open). By selecting 
No, resource metatdata sections are not displayed (closed).
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Change how often the console 
updates the display of data on the 
Dashboard

From the Dashboard Refresh Rate drop-down list, select No Refresh, 1, 
2, 3, 5, 10, 20, 30 or 60 minutes as the refresh rate for the Dashboard.

The default rate is No Refresh, but you can select another predefined 
time. For example, if you select 5 minutes, the Dashboard is updated 
with data every 5 minutes.

WARNING: By selecting a dashboard refresh rate interval other 
than the default (No Refresh), the browser 
refreshes the Dashboard at regular intervals. This 
prevents your session from timing out, even 
without you interacting with the console. 

Oracle recommends that you use the Dashboard 
refresh rate feature with caution. You should never 
leave a console session unattended. While your 
console session is active others can gain access to 
it from your machine, without re-authentication.

Change the time interval for 
displaying historical data for alerts 
on the Dashboard

From the Alert History Duration drop-down list, select 30 minutes, 1, 
2, 3, or 6 hours as the time interval for displaying historical alert data. The 
default is 30 minutes (displays alerts received within the last 30 minutes) 
but you can select another predefined duration. For example, if you select 
1 hour, the Dashboard displays the alerts received within the last hour. 

Table 24-8  User Preferences - Options and Controls (Continued)

To... Do This...
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Reporting
Before you can use the Reporting module, you must first create a proxy service and then add a 
report action to the message flow of that proxy service. See “Adding and Editing Actions in 
Message Flows” on page 19-1 and “Adding Report Actions” on page 19-35. See also Reporting 
in the Oracle Service Bus Operations Guide.

Viewing Reporting Messages
Use the Message Report Summary page to view reporting messages information shown in 
Table 25-2. The page displays up to 100 messages. 

1. To restrict the number of items in the list or locate specific messages:

– Click the  Open icon to display additional search filters. If you specify multiple 
search criteria, only results that match all the criteria will be returned.

– To set the filter parameters, do one or more of the following steps shown in Table 25-1.
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– You can use wildcard characters in service name, error code, and report index field 
searches. 

• Entering only asterisk (*) returns all messages. For example, if you enter * in the 
error code field, messages with and without error codes are displayed. 

• In the Error Code field only, strict search limitations apply. For example, to find 
messages with the error code BEA12345, you can enter *, BE*, or BEA12345.

2. Click Search. The page displays the messages that fall within the filter parameters you set. 
The maximum number of messages that can be displayed when filtering messages is 1000.

3. Click View All to remove the search filters and display all messages.

4. To locate a message, you can also do the following: 

Table 25-1  Message Filter Parameters 

To... Complete These Steps...

Filter by time parameters Set a time period:
1. Select the Messages From... To... radio button.
2. In the Messages From field, enter a date and time in the format 

MM/DD/YY HH:MM:SS AM|PM. For example, you can enter 10/10/07 
12:45:00 AM.

3. In the Messages To field, enter a date and time in the format 
MM/DD/YY HH:MM:SS AM|PM. 

Alternatively, you can select parameters for the most recent messages:
1. Select the For the Last radio button.
2. In the For the Last field, enter the number of days, then specify hours and 

minutes.

Note: By default, message reports for the last 30 minutes are displayed.

Filter by service name In the Inbound Service Name field, enter the service name.

Filter by error code In the Error Code field, enter an error code.

Filter by report index In the Report Index field, enter the report indexes. These are the key value 
pairs you defined when you configured the report action for this proxy service. 
This is a string search.
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– Resort the list of messages. Click on an underlined column name. Ascending and 
descending arrows indicate the sort order. Click the column name to change the sort 
order.

– Scroll through the pages. Use the page controls above or below the table. Go to a page 
by selecting the page number or by using the arrow buttons to go to the next, previous, 
first, or last page.

Related Topics
See also How to Enable Reporting in the Oracle Service Bus Operations Guide.

Viewing Message Details
Use this page to view details of a specific message. 

1. Locate the message. See “Viewing Reporting Messages” on page 25-1.

2. Click the report index. The View Message Details page displays the General Configuration 
information shown in Table 25-3.

Table 25-2  Message (Reporting) Summary Details 

Property Description

Report Index A link to the View Message Details page. See “Viewing Message Details” on 
page 25-3.

Report indexes are key value pairs that you use to extract key identifiers from 
a message context variable. Keys are a convenient way to filter messages. You 
use the report action to add key value pairs. See “Adding and Editing Actions 
in Message Flows” on page 19-1.

DB TimeStamp The date and time that the message was added in the database.

Inbound Service The inbound service associated with the message. The service is a link to the 
View a Proxy Service - Configuration Details page. See “Editing Proxy 
Service Configurations” on page 17-47.

Error Code The error code associated with this message, if there is one.

You specify error codes when you configure the raise error action. See 
Handling Errors in the Oracle Service Bus User Guide and “Adding Proxy 
Service Error Handlers” on page 21-1.
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The page displays the Inbound Service information shown in Table 25-4.

The page displays the Outbound Service information shown in Table 25-5.

Table 25-3  Message Configuration Parameters 

Property Description

Message ID The unique identification for this message.

Database Timestamp The date and time that the message was registered in the database.

Time at point of Logging The date and time that the message was logged.

Server name The name of the server in which this message was generated.

State State of the pipeline in which this message was generated:

REQUEST—indicates that the reporting action is executed in a request 
pipeline.

RESPONSE—indicates that the reporting action is executed in a response 
pipeline.

ERROR—the action is running in the service-level error handler.

Node Name The node name of the pipeline in which this message was generated.

Pipeline Name The name of the pipeline in which this message was generated.

Stage Name The name of the stage in which this message was generated.

Table 25-4  Inbound Service Details 

Property Description

Name The inbound proxy service associated with this message. This is a link to the 
View a Proxy Service - Configuration Details page. See “Editing Proxy 
Service Configurations” on page 17-47.

URI The URI associated with the proxy service.

Operation The inbound operation associated with this message.
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The page displays the Report Index information shown in Table 25-6.

The page displays the Fault information shown in Table 25-7.

The page displays the Report Body information shown in Table 25-8.

Table 25-5  Outbound Service Details 

Property Description

Name The outbound business service associated with this message. This is a link to 
the View a Business Service - Configuration Details page. See “Editing 
Business Service Configurations” on page 16-46.

URI The URI to the outbound business service end point.

Operation Name of the operation invoked on the outbound service.

Table 25-6  Report Index Details 

Property Description

Report Index Text Report indexes are key value pairs that you use to extract key identifiers from 
a message context variable. Keys are a convenient way to filter messages. You 
use the report action to add key value pairs. See “Adding and Editing Actions 
in Message Flows” on page 19-1.

Table 25-7  Fault information Details 

Property Description

Error Code The error code associated with the message, if there is one. 

You specify error codes when you configure the raise error action. See 
“Handling Errors” in the Oracle Service Bus User Guide and “Adding Proxy 
Service Error Handlers” on page 21-1.

Reason The reason for the error code.

Detail The fault details associated with the error code. These details, if present, are 
typically a stack trace of where a particular fault occurred, and may be 
truncated due to a size limitation in the database. The limit is 2048 characters.
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3. Click OK when you have finished viewing the details of a specific message.

Purging Messages
Use this page to purge selected messages from the reporting datastore. 

Message purging occurs in the background so the Message Report Summary page is not locked 
up while the purge occurs. Therefore, you can do a purge that takes a while to finish; the length 
of time depends on how many messages need to be purged. However, if you filter reporting 
messages, the purging process is slowed down; the Message Report Summary page may display 
incorrect data as some of the data hasn’t been purged yet.

The Purge Messages feature may be useful during design and test phases of your project. 
However, in a production environment, Oracle recommends that the management of the data in 
your database (including purging) is handled by the Database Administrator using database 
management tools.

1. Select Operations > Purge Messages.

2. Do one of the following steps, shown in Table 25-9.

Table 25-8  Report Body Details 

Property Description

Report Body Text This link opens another browser that displays the details of the report body. You 
use an expression in the report action to capture the report body text. See the 
procedure for the report action in “Adding and Editing Actions in Message 
Flows” on page 19-1.
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Related Topics
To learn more about purging messages, see Reporting in the Oracle Service Bus Operations 
Guide.

Table 25-9  Message Purging Options 

To... Complete These Steps...

Purge all messages 1. Select the Purge All Messages radio button.
2. Click Purge.

Purge messages within a 
specified time frame

1. Select the Purge Messages From... To... radio button.
2. In the Purge Messages From field, enter a month, day, year, and time in 

the format MM/DD/YY HH:MM:SS. For example, you can enter 10/10/07 
12:45:00 AM.

3. In the Purge Messages To field, enter a month, day, year, and time in the 
format MM/DD/YY HH:MM:SS.

4. Click Purge.
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Import/Export
This section includes the following topics:

“Importing Resources” on page 26-1

“Exporting Resources” on page 26-7

Importing Resources
Use the Import Resources page to import a full project JAR file or a resource JAR file that has 
been previously exported from another Oracle Service Bus domain. You can choose to import 
only a subset of the exported data. If the resource already exists in the importing system, it will 
be updated. Otherwise, it will be created. Resources are only scheduled for deletion when the JAR 
being imported is a full project JAR and there are resources located in the same project in the 
importing system that are not present in the imported JAR file. It will not delete resources which 
are located in other projects.

You can import resources at the resource level even though they were exported at the project 
level. For example, even if system resources were exported in a full project JAR file, you can 
deselect them when importing.

You cannot export users, groups, roles, or certificates when you export a configuration. 
Therefore, you must create these objects again when you import an exported configuration.

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select System Administration > Import Resources.
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3. Select an exported project or resource JAR file.

a. In the File Name field, click Browse to locate the directory where the JAR file is stored.

b. Select the JAR file, then click Open.

4. Click Next. Continue in “Selecting Projects and Resources to Import” on page 26-2.

Selecting Projects and Resources to Import
1. If you are importing a resource JAR file and want to ensure that all its associated resources 

are imported, select Include Dependencies.

Note: Include Dependencies cannot be selected if you are importing a full project JAR file 
or a pre-version 2.6 configuration file. 

2. Click the  Open icon to display Advanced Settings for preserving values in the importing 
system.

3. When you are re-importing a resource but desire to protect any customization made to the 
existing resource, select Preserve Environment Variables.

Note: Customizing any references within an existing resource cannot be preserved. See 
“Creating Customization Files” on page 29-6.

4. When you are importing the Global Operational Settings resource or other resources like 
business or proxy services that contain associated service-level operational settings, and 
desire to preserve the operational values in the importing system, select Preserve 
Operational Values. 

5. To prevent overwriting of existing security-related configuration in resources which are being 
updated, select among the following options:

a. Preserve Security and Policy Configuration—preserves the security configuration 
(excluding access control policies) and the references to the WS-Policies bound directly 
to the service (instead of bound to the WSDL). 

For more information, see Oracle Service Bus Security Guide.

b. Preserve Credentials—preserves PKI credentials in service key providers, user name 
and passwords in service accounts, and user name and password credentials in SMTP 
Servers, Proxy Servers, JNDI Providers, and UDDI Registries.

c. Preserve Access Control Policies—preserves access control policies.
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The resource summary information is shown in Table 26-1.

6. Select the objects on which you want to operate (create, update, or delete).

a. To display each object contained in the JAR file, expand the folder for the file. The check 
box associated with each object is selected. 

The following resource file details, displayed for each object, are shown in Table 26-2.

Table 26-1  Resource Information 

Property Description

Name The name of the project.

Global resources, such as UDDI Registry information, SMTP Servers, Proxy 
Servers, JNDI Providers, and Global Operational Settings appear under the 
System project in their respective folders.

Type The resource type, which is Project. 

Expand the Project folder to display and deselect resources.

Operations Displays --- or !Deletions! 

Expand the Project folder to display the operations (create, update, delete) that 
will be performed on the resources.

To prevent resources from being deleted, deselect them. Resources are only 
scheduled for deletion when the JAR being imported is a full project JAR and 
there are project resources in the importing system that are not present in the 
imported JAR file.

References Expand the Project folder to display the number of objects that each resource 
references.
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Table 26-2  Resource File Details 

Property Description

Name The name and path of the resource. The path is the project name and the name 
of the folder in which the resource resides.

Type Any of the following resource types:
• Business service
• MFL File
• Proxy service
• Service Key Provider
• XML schema
• Service Account
• WS-Policy
• WSDL
• XQuery Transformation
• XSL Transformation
• JAR
• Alert Destination
• JNDI Provider
• SMTP Server
• Proxy Server
• Operational Settings
• Registry
• MQ Connection (if available)
• Split-Join

Note: If a resource has sensitive security data, an  Encryption icon is 
displayed.

Caution: If you select a service account or service key provider, you 
might overwrite existing security data unless you specify 
to preserve security settings during import. See “Importing 
Service Accounts or Service Key Providers” on page 26-6.
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b. Clear the check boxes next to the resources that you do not want to import.

7. Click Import. 

After you finish 

If applicable, continue in “Specifying the Importing Security Settings” on page 26-5. Or, 
continue in “Reviewing the Import Summary” on page 26-6.

Specifying the Importing Security Settings
If the JAR file contains resources with user name and password data that were encrypted when it 
was exported, the Import Resources - Security Settings page is displayed. 

1. Enter the password that was used to encrypt the data (see “Exporting Resources” on 
page 26-7). 

If you do not know the password that was used to encrypt the resource data, click the Prev 
button and clear the check box that is next to the resource. You can import all other 
non-encrypted resources without knowing the password.

2. Click Finish Import.

The Processing Configuration Data pop-up window is displayed. You should wait until 
this window closes before you do anything else on the console. The window closes 
automatically when the system finishes importing the objects. The Import Resources page 
is displayed, which includes a message that you have successfully deployed the data. 

After you finish 

Continue in “Reviewing the Import Summary” on page 26-6.

Operations Create, update, or delete.

Resources are only scheduled for deletion when the JAR being imported is a 
full project JAR and there are project resources in the importing system that 
are not present in the imported JAR file.

References The number of objects that this resource references.

Table 26-2  Resource File Details (Continued)

Property Description
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Importing Service Accounts or Service Key Providers
Note: In earlier Oracle Service Bus versions, service key providers were called proxy service 

providers.

If the JAR file was created by AquaLogic Service Bus 3.0 or later and contains service accounts 
or service key providers, you can import these resources along with the user names, passwords, 
local-user to remote-user mappings, and alias to key-pair bindings that they contain.

For each service key provider, Oracle Service Bus imports the alias to key-pair binding into the 
PKI credential mapping provider. If this data was encrypted during export, you must supply the 
password that was used to encrypt the data. If you do not know the password, you can import all 
other non-encrypted resources.

If you import a service account or service key provider and a corresponding resource of the same 
name already exists in your domain, the imported resource will overwrite the one already in your 
domain, even if the one already in your domain has been modified during the current session, 
unless you specify to preserve security settings during import. See step 5 in “Selecting Projects 
and Resources to Import” on page 26-2.

Reviewing the Import Summary
The import summary information is shown in Table 26-3.

Table 26-3  Import Summary Information 

Property Description

Status Whether or not the resource was imported successfully.

A WSDL may be temporarily marked as invalid until all of its dependencies 
are imported. When the import action is completed, however, the 
configuration service re-validates the files marked invalid. 

Name The name of the resource. 

Path The path of the resource. The path is the project name and the name of the 
folder in which the resource resides.
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1. Click Import Another.

You can import another JAR file, or you can click View Changes under Change 
Center to view the import details. See “Viewing Configuration Changes” on page 2-4.

2. When you have finished, click Activate under Change Center.

Exporting Resources
Use the Export Resources page to Export Projects or Export Resources. If you choose to 
export a full project, one or more projects can be selected for export. You can still expand the 

Type Any of the following resource types:
• Business service
• MFL File
• Proxy service
• Service Key Provider
• XML schema
• Service Account
• WS-Policy
• WSDL
• XQuery Transformation
• XSL Transformation
• JAR
• Alert Destination
• JNDI Provider
• SMTP Server
• Proxy Server
• Operational Settings
• Registry
• MQ Connection (if available)
• Split-Join

Diagnostic Message Displays error or informational messages if they exist for this resource.

Table 26-3  Import Summary Information (Continued)

Property Description
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projects to see folders and resources but selection is only at the project level. Also, Include 
Dependencies cannot be selected.

You can export projects and resources whether you are working within a session or outside of a 
session. If you export within a session, the resources are session resources and the configuration 
may be incomplete or have conflicts. If you export outside of a session, the resources are activated 
core resources.

Oracle Service Bus cannot export the users, groups, or roles that you create in the Security 
Configuration module of the Oracle Service Bus Console. Neither can it export credential maps 
or other security-provider data that you create in the WebLogic Server Administration Console. 
Instead, use the WebLogic Server Administration Console to export this data. See Migrating 
Security Data in Securing WebLogic Server.

1. Select System Administration > Export Resources.

The Export Resources page displays the list of objects in your configuration. The name, 
type, last modified time, and references for each object are displayed.

For services, the last modified timestamp reflects the modifications made to the service 
definition, as well as to the service transport or pipeline configuration. It does not, 
however, reflect the changes made to the alerts defined for that service.

2. Select whether to Export Projects or Export Resources.

Note: Exporting projects might cause resource deletion when you import the full project 
JAR file. For more information, see “Importing Resources” on page 26-1.

3. Select the projects or resources you want to export. If you selected Export Projects, you 
cannot deselect the check boxes for individual resources.

a. Expand the project folders. The name, type, last modified time, and references for each 
resource contained in the project are displayed. 

b. Select the check boxes associated with the projects or resources you want to export.

c. Clear the check boxes associated with the projects or resources that you do not want to 
export.

4. If you selected Export Resources, select or clear the Include Dependencies check box. Use 
this option to export any other resources that this resource references.

5. Click Export to create a JAR file and export it. 

After you finish
26-8 Using the Oracle Service Bus Console

http://download.oracle.com/docs/cd/E12840_01/wls/docs103/secmanage/security_data_migration.html
http://download.oracle.com/docs/cd/E12840_01/wls/docs103/secmanage/security_data_migration.html


Expo r t ing  Resources
If applicable, continue in “Specifying the Exporting Security Settings” on page 26-9.

Specifying the Exporting Security Settings
If your export includes a service account or a service key provider, the Export Resources - 
Security Settings page is displayed. 

For each service account, Oracle Service Bus exports the user name and password or the 
local-user to remote-user map (depending on which data was stored in the service account). For 
each service key provider, Oracle Service Bus exports the alias to key-pair binding from the PKI 
credential mapping provider; it does not export private keys, certificates, or other data from the 
key stores. Key store data must be exported using tools that the key store vendor provides.

If you want Oracle Service Bus to encrypt the user name and password data that is in the service 
account, service key provider, UDDI Registry, JNDI Provider, or SMTP provider resources 
before exporting it the to JAR file, do the following:

1. Select the Protect Sensitive Data check box. 

2. Enter and confirm a password. 

When you or someone else attempts to import this JAR, Oracle Service Bus will not 
import the resources with encrypted user name and password data unless you specify this 
password. You can import all of the other non-encrypted resources in the JAR without 
specifying the password.

3. Click Finish Export button.

4. When you click Export or Finish Export, the Processing Configuration Data pop-up 
window is displayed. Wait until this window closes before you do anything else on the 
console. The window is closed automatically when the File Download dialog box is 
displayed.

5. In the File Download dialog box, click Open to open the exported JAR file or click Save to 
save the JAR file to your desktop.
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UDDI
Universal Description, Discovery and Integration (UDDI) registries are used in an enterprise to 
share Web Services. UDDI provides a framework in which to classify your business, its services, 
and the technical details about the services you want to expose.

Publishing a service to a registry requires knowledge of the service type and the data structure 
representing that service in the registry. A registry entry has certain properties associated with it 
and these property types are defined when the registry is created. You can publish your service 
to a registry and make it available for other organizations to discover and use. Proxy services 
developed in Oracle Service Bus can be published to a UDDI registry. Oracle Service Bus can 
interact with any UDDI version 3.0-compliant registry.

See also UDDI in the Oracle Service Bus User Guide.

Viewing Configured UDDI Registries
Use this page to designate a default UDDI registry (see “Setting Up a Default UDDI 
Configuration” on page 27-5) and to view UDDI registries. Additionally, you can search for 
registries that you have previously configured. 

1. In the UDDI Registries panel, enter the name of the registry you want to find in the Name 
field, or enter wildcard characters; use * for multiple characters and ? for single characters. 
The search returns all the records that satisfy the name criteria.

2. Click Search. 

3. Click View All to remove the search filters and view all the registries that are configured to 
work with Oracle Service Bus. 
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Table 27-1 displays UDDI registry configuration settings.

Configuring UDDI Registries
This section includes the following tasks:

“Adding UDDI Registries” on page 27-2

“Editing UDDI Registries” on page 27-4

Adding UDDI Registries
Use this page to add and configure UDDI registries. After registries are configured, you can then 
publish Oracle Service Bus proxy services to them or import business services from them to be 
used in an Oracle Service Bus proxy service. 

Table 27-1  UDDI Registry Configuration Settings 

Property Description

Registry Name The name of the registry. The name assigned to a registry when it is first 
created. You cannot edit the name of a registry after the entry is saved.

Inquiry URL The URL of the Inquiry API endpoint used for locating and importing 
services.

Publish URL The URL of the Publish API endpoint used for publishing services.

Security URL The URL of the Security API endpoint used for getting an authentication 
token so that you can publish to the registry.

Subscription URL The URL of the Subscription API endpoint used for subscribing to registry 
changes, creating a registry subscription, and listening for changes to 
imported services.

User Name The user name which is required for user authentication.

Password (Confirm 
Password)

The password which is required for user authentication.

Load tModels into registry Loads the tModels into the selected registry. This option only has to be 
selected once per registry.

Enable Auto-Import Auto-synchronizes services with the UDDI registry. 
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You must be in an active session to add a registry. 

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select System Administration > UDDI Registries.

3. In the UDDI Registries panel, click Add Registry.

4. To configure the registry, complete the following steps. Asterisks denote required fields. See 
Table 27-1 for descriptions of the properties that must be set when adding a registry.

a. In the Name field, enter a name for the registry. 

b. In the Inquiry URL field, enter an inquiry URL in the format: 
http://host:port/APPLICATION_SERVER_CONTEXT/uddi/inquiry

c. In the Publish URL field, enter a publish URL in the format 
http://host:port/APPLICATION_SERVER_CONTEXT/uddi/publishing

d. In the Security URL field, enter a security URL in the format 
http://host:port/APPLICATION_SERVER_CONTEXT/uddi/security

e. In the Subscription URL field, enter a subscription URL in the format 
http://host:port/APPLICATION_SERVER_CONTEXT/uddi/subscription

By default, the value for APPLICATION_SERVER_CONTEXT in the installer is 
registry.

f. In the Username field, enter the user name to log into the registry console.

g. In the Password /(Confirm Password) field enter the password to log into the registry 
console.

h. Select the Load tModel into registry check box to publish the Oracle Service Bus 
tModels to this registry.

This field is only required when publishing proxy services to this registry.

i. Select the Enable Auto Import check box to auto-synchronize imported services with the 
UDDI registry. Any service that is imported with this option selected will be kept in 
synchrony with the UDDI registry.

Note: Auto-synchronization is a background process; you cannot reverse it using the 
session Undo function. Undoing an auto-synchronization change is not 
permanent as the service will be re-synchronized in the next synchronization 
cycle. If you want an imported service to stay out of synchrony with the UDDI 
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registry, you have to detach the service to avoid further updates from the registry. 
See “Detaching Services” on page 27-8.

5. Click Validate to validate the URLs you have provided.

6. Click Save to configure the registry with the settings provided and save it in the current 
session.

7. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Editing UDDI Registries
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2.

2. Select System Administration > UDDI Registries.

3. In the UDDI Registries panel, from the list of available registries, click the name of the 
registry you want to edit. 

You can also search for a specific registry using the Search option. See “Viewing 
Configured UDDI Registries” on page 27-1.

The UDDI Registry Configuration page displays the configuration properties that define 
the registry and the following registry-specific information, shown in Table 27-2.

Table 27-2  UDDI Registry Information 

Property Description

Last Modified By The user who made the last configuration change to this UDDI registry 
resource.

Last Modified On The date and time that the last configuration change was made. Click the 
date and time link to view the change history of this resource. See “View 
Change History page” on page 3-21.

References The number of objects that this UDDI registry references. If such 
references exist, click the numeric link to view a list of the references. See 
“Viewing References to Resources” on page 3-20.
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4. At the bottom of the page, click Edit.

5. On the UDDI Configuration-Edit Registry page, edit the registry configuration parameters. 

These properties are described in Table 27-1. You cannot edit the name of the registry. 

6. Click Save to commit the updates in the current session.

7. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Setting Up a Default UDDI Configuration
You can designate one of the configured registries as the default UDDI registry for the domain. 
See “Configuring UDDI Registries” on page 27-2. 

To use the auto-publish functionality, you must first set a default registry. See “Using 
Auto-Publish” on page 27-10.

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select System Administration > UDDI Registries.

3. In the UDDI Default Configuration panel, click Select Default. 

4. From the Default Registry Name list, select the name of the registry you want to set as the 
default registry.

5. To set a default business entity, choose an entity from the Business Entity list.

6. Click Make Default.

7. To change the default registry, click Clear Selection and repeat the above steps.

Referenced By The number of objects that reference this UDDI registry. If such references 
exist, click the numeric link to view a list of the objects. See “Viewing 
References to Resources” on page 3-20.

Description A description of the registry.

Table 27-2  UDDI Registry Information (Continued)

Property Description
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Importing Business Services From a UDDI Registry
You can import the following business service types from a UDDI registry into Oracle Service 
Bus:

WSDL services over HTTP transport.

Oracle Service Bus proxy services that are published to a UDDI registry. This feature is 
primarily used in multi-domain Oracle Service Bus deployments where proxy services 
from one domain need to discover and route to proxy services in another domain.

If you only have one registry configured, Oracle Service Bus automatically connects to that 
registry and retrieves all the business entities and populates the search form. If you have more 
than one registry configured, the import wizard prompts you to first select the registry from which 
you want to import services.

On import, the inquiry URL is used to locate a specific service as a registry has several different 
types of services.

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select System Administration > Import From UDDI.

3. From the Import Registry Name drop-down list, select the name of the registry from which 
you want to import the service, then click Next.

When a single registry is configured in Oracle Service Bus, the initial registry selection 
page is not displayed as this is the default registry. The registry selection page is only 
displayed when two or more registries are defined.

Use the Import From UDDI page to search for specific business services and import 
them. You can search for a service by business entity, by pattern, or by using a 
combination of both.

4. Select the business entity name (for example, document Services) from the Entity Name 
drop-down list to search by business entity.

5. In the Service Name field, enter the pattern (for example, a%) for which you want to search. 
A list of business services matching the entered search criteria is displayed.

6. Select the service(s) that you want to import, then click Next.

If you are unable to find a desired service, it may be because you do not belong to the 
security group with permissions to view its records.
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7. Select the binding templates from which you want to create business services, then click Next.

If a selected service has multiple binding templates, then each of these binding templates 
results in a business service. In this case you will be prompted to further narrow your 
selection among the binding templates you want to import.

8. On the Import UDDI: Select Import Location page select a project from the Project 
drop-down list, select a folder where you want to import your services and associated 
resources, then click Next.

9. The Import UDDI: Review and Import Services page displays a list of all of the resources 
(business services, MFLs, schemas, WSDLs, and so on) that will be created in the system. A 
warning message is displayed for any resource that cannot be imported. 
By default, all the items in the list are marked for import. 

a. Clear the check box next to a specific resource if you already have the resource in your 
system and want to manually resolve the dependencies.

b. You can resolve dependencies from the View Conflicts page in the Change Center after 
the import process is complete. For more information on viewing and resolving conflicts, 
see“Viewing and Resolving Conflicts” on page 2-11. 

10. Click Import to start the import process.

A pop-up window is displayed indicating the progress of the import. When the import is 
complete, the Import Summary page displays the result of the import. A success message 
is displayed at the top of the page if the import was successful. If one or more resources 
could not be imported, an error message is displayed. 

– Go to the Status column for the resource to view the cause of the error. 

– To view and resolve additional conflicts, click View Conflicts.

11. To import more services, click Import Another.

12. To make changes to your selections, click Back.

Using Auto-Import Status
You can use the Auto-Import Status page to synchronize changes to a service with those present 
in the registry. Upon any changes to a service in the registry, Oracle Service Bus provides 
notification of the change on the Auto-Import Status page which lists all out-of-sync services. 
You can then synchronize the service in the Oracle Service Bus Console with the corresponding 
service in the UDDI registry. 
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When configuring a registry, you can select the Enable Auto-Import option which 
auto-synchronizes imported services with the UDDI registry. Any service that is imported with 
this option selected will be kept in synchrony with the UDDI registry automatically. See 
“Configuring UDDI Registries” on page 27-2.

If there is any failure during auto-synchronization, it will be reported on the Auto-Import Status 
page where you can update it manually. 

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select System Administration > Auto-Import Status.

3. On the Auto-Import Status page, select the type of service you want to display from the 
View drop-down list. 

4. Select the check boxes next to the proxy services you want to synchronize with the 
corresponding services in the registry.

5. Click Synchronize.

6. On the next page, click Finish. 

Detaching Services
When you do not want the service in the Oracle Service Bus Console synchronized with the 
corresponding service in the registry, you can avoid synchronization by detaching it from the 
registry in one of the following ways:

“Detaching a Service by Editing its Configuration” on page 27-8

“Detaching a Service From the Auto-Import Status Page” on page 27-9

Detaching a Service by Editing its Configuration

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select the Project Explorer. 

3. Expand the project folder and select the business service you want to detach from the 
corresponding service in the registry. 

4. At the bottom of the View a Business Service page, click Edit.
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5. Enable the Detach from Registry option. The business service will be detached from the 
corresponding service in the UDDI registry.

Detaching a Service From the Auto-Import Status Page
You can use this Detach option only when you get notification about the change on the 
Auto-Import Status page.

1. On the System Administration > Auto-Import Status page, select the check boxes next to 
the business services you want to detach from the corresponding services in the UDDI 
registry.

Services are shown on this page only when there is a change in the original service present 
in the registry. Not every service is available on this page.

2. Click Detach.

Publishing Proxy Services to a UDDI Registry
You can publish your service to a registry and make it available for other organizations to 
discover and use. All proxy services developed in Oracle Service Bus can be published to a UDDI 
registry. You can select the business entity under which you want to publish your service and you 
can publish a number of services at a time. 

Before you can publish to a registry, you must have an account with that registry. Oracle Service 
Bus supports interoperability with version 3.0-compliant UDDI registries. The configuration 
described in this section assumes you are using Oracle Service Registry.

For information about setting up a user account in Oracle Service Registry, see the Oracle Service 
Registry User’s Guide on the Oracle Service Registry product documentation site.

Unpublishing a service from a registry is done from the Oracle Service Registry installation.

1. Select System Administration > Publish to UDDI.

You can only publish when you are not in a session. Exit your session to access the 
registries list. All the registries to which you have access are displayed in the drop-down 
list of selected registries.

2. From Publish Registry Name, select the name of the registry to which you want to publish, 
then click Next.

When a single registry is configured in Oracle Service Bus, the initial registry selection 
page is not displayed as this is the default registry. The registry selection page is only 
displayed when two or more registries are defined.
Using the Oracle Service Bus Console 27-9

http://download.oracle.com/docs/cd/E13173_01/alsr/docs30/index.html


UDDI
The Publish to UDDI: Select individual Services and Publish page is displayed, 
showing a list of Oracle Service Bus proxy services and their locations in the project 
folder. Starting with the topmost project level folder, the details for name, type, and 
description are shown for all services. 

3. Select the service(s) that you want to publish. 

a. Expand the Project folder to see the proxy services defined. By default the folder and its 
contents are marked for publishing. 

b. You can select individual items to publish.

4. From the Publish Services to Business Entity drop-down list, select the business entity to 
which you want to add the service in the registry. This is the business entity under which the 
service will be classified in the registry.

5. Click Publish to publish the services. 

A confirmation message is displayed indicating that the service was published successfully.

6. Click Publish Another to return to the Publish to UDDI: select registry page.

Using Auto-Publish
You can use auto-publish to automatically publish proxy services to a registry. To do so, you must 
enable the Publish to Registry option on the Create/Edit a Proxy Service-General 
Configuration page. See “General Configuration page” on page 17-3. Note that the Publish to 
Registry option only displays when a default registry exists. See “Setting Up a Default UDDI 
Configuration” on page 27-5. 

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select the Project Explorer. 

3. Expand the project folder and select the proxy service you want to edit. 

4. At the bottom of the View a Proxy Service page, click Edit.

5. Select Publish to Registry, and click Save to commit the updates in the current session. 

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

The service is configured to be published to the default registry.
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Notes:

When you have successfully published a service to a registry, the option to select 
the service for auto-publishing to a registry is no longer available.

If the service is not successfully published it can be re-published. To re-publish a 
service, select the service on the Auto-Publish Status page and click Publish.

If the Publish to Registry option is enabled, the proxy services are published as 
soon as they are created or edited, and the session is activated. You can use the 
Publish to Registry option with all proxy services, except those using Local 
Transport.
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Global Resources
You use the Global Resources module to add and configure JNDI Providers, SMTP Servers, and 
Proxy Servers, and make them available in Oracle Service Bus as system resources.

Viewing JNDI Providers
Use this page to view a list of JNDI Providers and the information shown in Table 28-1.

Additionally, you can search for JNDI Providers that you have previously configured. 

1. To restrict the number of items in the list or locate specific JNDI Providers:

– Click the  Open icon to display additional search filters. If you specify multiple 
search criteria, only results that match all the criteria will be returned.

– Enter the name of the JNDI Provider you want to find in the Name field, and click 
Search to search for a specific entry. 

You can enter wildcard characters (? for a single character; * for multiple characters) to 
perform a more general search. 

– Enter the Provider URL of the JNDI Provider you want to find, and click Search. 

2. Click View All to remove the search filters and display all the JNDI Provider resources that 
are configured to work with Oracle Service Bus. 

Table 28-1 displays UDDI registry configuration settings.
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Adding JNDI Providers
You add and configure a JNDI Provider resource and make it available in Oracle Service Bus as 
a system resource. You must be in an active session.

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2. 

2. Select System Administration > JNDI Providers.

3. Click Add. 

4. In the Name field, enter a name for the JNDI Provider resource. This is a required field. 

5. In the Description field, enter a short description for the JNDI Provider.

6. Keep the JNDI Cache option Enabled (default) or select Disabled.

Table 28-1  JNDI Provider Information 

Property Description

Name The unique name assigned to this JNDI Provider. The name is a link to the View 
JNDI Provider - Configuration page. See “Editing JNDI Providers” on 
page 28-3.

Provider URL The URL of the JNDI Provider. See “Adding JNDI Providers” on page 28-2.

JNDI Cache Enabled or Disabled. When enabled, the JNDI context and JNDI objects are 
cached locally which improves performance when doing an object lookup. 
Oracle recommends that you keep the JNDI cache enabled.

Actions
• Click the  Reset icon to reset the JNDI context to discard the JNDI 

connection and locally cached objects.

• Click the  Launch Test Console icon to test whether the JNDI 
Provider can successfully establish a connection and obtain a JNDI context.

Options • Click the  Rename icon to rename the JNDI Provider.

• Click the  Delete icon to delete a specific JNDI Provider. See “Deleting 
JNDI Providers” on page 28-5
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When enabled, the JNDI context and JNDI objects are cached locally which improves 
performance when doing an object lookup. Oracle recommends that you keep the JNDI 
cache enabled.

7. In the Provider URL field, enter the URL for the JNDI Provider in the format: 
protocol://host:port 

You can use any protocol, for example, http, https, t3, t3s, iiop, iiops. 

This is a required field.

8. In the case of clusters, the JNDI Provider URL should be configured with a comma-separated 
list of Managed Servers, in the format:

protocol://<hostname>:<ms1port>, <hostname>:<ms2port>

9. If access to the target JNDI Provider requires a user name and password, enter a user name in 
the User Name field, and the associated password in the Password and Confirm Password 
fields.

These fields are optional, and required only if the JNDI tree is secured. 

10. Click Save to create and save the JNDI Provider resource in the current session. 

11. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Editing JNDI Providers
Use this page to view the details of a JNDI Provider and edit the configuration, if required. 
Additionally, you can reset the JNDI Provider cache and to test the connection to the JNDI 
Provider.

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Locate the JNDI Provider. See “Viewing JNDI Providers” on page 28-1.

3. Click the JNDI Provider name. 

The View JNDI Provider - Configuration page displays the JNDI Provider information 
shown in Table 28-2.
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4. Click Edit to display the Edit JNDI Provider - [provider-name] page. 

The Name field is not editable.

5. In the Description field, you can edit the short description of the JNDI Provider.

6. In the Provider URL field, you can edit the URL of the JNDI Provider.

7. You can edit the User Name and Password fields.

If the JNDI Provider was configured with a user name and password, then the User Name 
will not be editable. You can edit the New Password and Confirm Password fields. If the 
JNDI was not configured with a user name and password, then the User Name field will 
be editable, and you can enter a new user name.

8. Click Save to commit the updates in the current session. 

Table 28-2  JNDI Provider Information 

Property Description

Last Modified By The user who created or modified this JNDI Provider resource, or imported it into 
the configuration.

Last Modified On The date and time that the user created or modified this JNDI Provider resource, 
or imported it into the configuration. Click the date and time link to view the 
change history of this resource. See “View Change History page” on page 3-21.

References The number of objects that this JNDI Provider references. If such references exist, 
click the numeric link to view a list of the references. See “Viewing References 
to Resources” on page 3-20.

Referenced By The number of objects that reference this JNDI Provider. If such references exist, 
click the numeric link to view a list of the objects. See “Viewing References to 
Resources” on page 3-20.

Description A description of this JNDI Provider.

JNDI Cache Enabled or Disabled. When enabled, the JNDI context and JNDI objects are 
cached locally which improves performance when doing an object lookup. Oracle 
recommends that you keep the JNDI cache enabled.

Provider URL The URL for the JNDI Provider.

User Name The user name used to access a secure JNDI Provider.
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9. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Deleting JNDI Providers 
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2. 

2. Select System Administration > JNDI Providers.

3. In the Summary of JNDI Providers page, select a JNDI Provider. You can also search for a 
specific JNDI Provider using the Search option. See “Viewing JNDI Providers” on 
page 28-1.

4. Click the  Delete icon in the Options field of the JNDI Provider you want to delete. A  
Deletion Warning icon is displayed when other resources reference this resource. You can delete the 
resource with a warning confirmation. This might result in conflicts due to unresolved references to the 
deleted resource.

5. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Viewing SMTP Servers
Use this page to designate a default SMTP Server (see “Configuring a Default SMTP Server” on 
page 28-7) and to view a list of SMTP Servers. 

SMTP Server resources are used while configuring alert destination resources and E-mail 
transport-based business services. See “Adding Alert Destinations” on page 5-2 and “Create/Edit 
a Business Service - E-Mail Transport Configuration Page” on page 16-17.

Table 28-3 displays SMTP Server information.

Table 28-3  SMTP Server Information 

Property Description

Name The unique name assigned to this SMTP Server resource. The name is a link to 
the View SMTP Server - Configuration page. See “Editing SMTP Servers” on 
page 28-7.
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Locating SMTP Servers
1. Select System Administration > SMTP Servers. 

2. To locate specific SMTP Servers:

– Resort the list. Click on an underlined column name. Ascending and descending arrows 
indicate the sort order. Click the column name to change the sort order.

– Scroll through the pages. Use the page controls above or below the table. Go to a page 
by selecting the page number or by using the arrow buttons to go to the next, previous, 
first, or last page.

Adding SMTP Servers
Use the Summary of SMTP Servers page to add and configure SMTP Server resources and 
make them available in Oracle Service Bus as a system resource. You must be in an active session 
to configure or reconfigure SMTP Server resources.

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2. 

2. Select System Administration > SMTP Servers. 

3. Click Add. 

4. In the Name field, enter a name for the SMTP Server resource. This is a required field. 

5. In the Description field, enter a short description for the SMTP Server resource.

6. In the Server URL field, enter the URL that points to the SMTP Server. This is a required 
field. 

Server URL The URL that points to the SMTP Server. See “Adding SMTP Servers” on 
page 28-6.

Options • Click the  Rename icon to rename this SMTP Server resource.

• Click the  Delete icon to delete a specific SMTP Server. See “Deleting 
SMTP Servers” on page 28-9.

Table 28-3  SMTP Server Information (Continued)

Property Description
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7. In the Port Number field, enter a port number for the SMTP Server (the default port is 25). 
This is a required field.

8. If access to the target SMTP Server requires a user name and password, enter a user name in 
the User Name field, and the associated password in the Password and Confirm Password 
fields.

These fields are optional, and required only if the SMTP Server is secured. 

9. Click Save to create and save the SMTP Server resource in the current session. 

10. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Configuring a Default SMTP Server
You can designate one of the configured SMTP Servers as the default server for the domain. See 
“Adding SMTP Servers” on page 28-6.

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2. 

2. Select System Administration > SMTP Servers. 

3. In the Default SMTP Server panel, click Select Default. 

4. From the Default SMTP Server drop-down list, select an SMTP Server. 

5. Click Make Default. 

The Summary of SMTP Servers page is displayed with the selected SMTP Server shown 
as the default SMTP Server for the domain. 

6. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Editing SMTP Servers
Use this page to view the details of an SMTP Server and edit the configuration, if required. 

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Locate the SMTP Server. See “Locating SMTP Servers” on page 28-6.
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3. Click the SMTP Server name. 

The View SMNP Servers - Configuration page displays the information shown in 
Table 28-4.

4. Click Edit to display the Edit SMTP Server - [server-name] page. 

The Name field is not editable.

5. In the Description field, you can edit the short description of the SMTP Server.

6. In the Server URL field, you can edit the URL of the SMTP Server.

7. In the Port Number field, you can edit the port number. 

8. You can edit the User Name and Password fields.

9. Click Save to commit the updates in the current session. 

Table 28-4  SMTP Server Information 

Property Description

Last Modified By The user who created or modified this SMTP Server resource.

Last Modified On The date and time that the user created or modified this SMTP Server resource. 
Click the date and time link to view the change history of this resource. See “View 
Change History page” on page 3-21.

References The number of objects that this SMTP Server references.If such references exist, 
click the numeric link to view a list of the references. See “Viewing References 
to Resources” on page 3-20.

Referenced By The number of objects that reference this SMTP Server. If such references exist, 
click the numeric link to view a list of the objects. See “Viewing References to 
Resources” on page 3-20.

Description The description of this SMTP Server, if provided.

Server URL The URL that points to the location of the SMTP Server.

Port Number The port number for this SMTP Server. This is port 25 by default. 

User Name The user name used to access a secure SMTP Server.
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10. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Deleting SMTP Servers 
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2. 

2. Select System Administration > SMTP Servers.

3. On the Summary of SMTP Servers page, select an SMTP Server. See “Locating SMTP 
Servers” on page 28-6.

4. Click the  Delete icon in the Options field of the SMTP Server resource you want to delete. 

The SMTP Server resource is deleted in the current session. A  Deletion Warning icon is 
displayed when other resources reference this resource. You can delete the resource with a warning 
confirmation. This might result in conflicts due to unresolved references to the deleted resource.

5. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Viewing Proxy Servers
Use this page to view a list of Proxy Servers and the information shown in Table 28-5.

Proxy Server resources are used while configuring the HTTP transport for business services. For 
more information, see “HTTP Transport Configuration Page” on page 16-20.

Table 28-5 displays Proxy Server information.

Table 28-5  Proxy Server Information 

Property Description

Name The unique name assigned to this Proxy Server resource. The name is a link to the 
View Proxy Server - Configuration page. See “Editing Proxy Servers” on 
page 28-11.

Options • Click the  Rename icon to rename this Proxy Server resource.

• Click the  Delete icon to delete a specific Proxy Server. See “Deleting 
Proxy Servers” on page 28-13.
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Locating Proxy Servers
1. Select System Administration > Proxy Servers.

2. To locate specific Proxy Servers:

– Resort the list. Click on an underlined column name. Ascending and descending arrows 
indicate the sort order. Click the column name to change the sort order.

– Scroll through the pages. Use the page controls above or below the table. Go to a page 
by selecting the page number or by using the arrow buttons to go to the next, previous, 
first, or last page.

Adding Proxy Servers
Use the Summary of Proxy Servers page to add and configure Proxy Server resources and make 
them available in Oracle Service Bus as a system resource. You must be in an active session to 
configure or reconfigure Proxy Server resources.

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2. 

2. Select System Administration > Proxy Servers. 

3. Click Add.

4. In the Name field, enter a name for the Proxy Server resource. This is a required field. 

5. In the Description field, enter a short description for the Proxy Server resource.

6. In the Host-Port Parameters section, enter the following information:

a. In the Server Host field, enter the host name or IP address of the Proxy Server. This is a 
required field.

The Server Host name for the Oracle Service Bus proxy server must be identical to the 
server host name of the actual proxy server.

b. In the Clear Text Port field, enter the Proxy Server clear-text port number.

c. In the SSL Port field, enter the Proxy Server SSL port number. You must enter either a 
clear text or SSL port number.

d. Click Add.
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You can configure multiple Proxy Servers for each Proxy Server resource. This enables 
Oracle Service Bus to perform load balancing and offer fault tolerance features for the 
Proxy Server resource.

7. If the Proxy Server performs proxy authentication, enter a user name in the User Name field, 
and the associated password in the Password and Confirm Password fields.

These fields are optional, and required only if the Proxy Server is secured.

8. Click Save to create and save the Proxy Server resource in the current session. 

9. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Editing Proxy Servers
Use this page to view the details of a Proxy Server and edit the configuration, if required. 

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Locate the Proxy Server. See “Locating Proxy Servers” on page 28-10.

3. Click the Proxy Server name.

The View Proxy Servers - Configuration page displays the information shown in 
Table 28-6.

Table 28-6  Proxy Server Information 

Property Description

Last Modified By The user who created or modified this Proxy Server resource.

Last Modified On The date and time that the user created or modified this Proxy Server resource. 
Click the date and time link to view the change history of this resource. See “View 
Change History page” on page 3-21.

References The number of objects that this Proxy Server references.If such references exist, 
click the numeric link to view a list of the references. See “Viewing References 
to Resources” on page 3-20.

Referenced By The number of objects that reference this Proxy Server. If such references exist, 
click the numeric link to view a list of the objects. See “Viewing References to 
Resources” on page 3-20.
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4. Click Edit to display the Edit Proxy Server - [server-name] page. 

The Name field is not editable.

5. In the Description field, you can edit the short description of the Proxy Server.

6. In the Host-Port Parameters section, you can add a new Proxy Server by entering the 
following information:

a. In the Server Host field, enter the host name or IP address of the Proxy Server. This is a 
required field.

The Server Host name for the Oracle Service Bus proxy server must be identical to the 
server host name of the actual proxy server.

b. In the Clear Text Port field, enter the Proxy Server clear-text port number.

c. In the SSL Port field, enter the Proxy Server SSL port number. You must enter either a 
clear text or SSL port number.

d. Click Add.

You can configure multiple Proxy Servers for each Proxy Server resource. This enables 
Oracle Service Bus to perform load balancing and offer fault tolerance features for the 
Proxy Server resource.

You can also edit or delete an existing Proxy Server configuration by doing the following:

Description The description of this Proxy Server, if provided.

Host-Port Parameters Details about each Proxy Server in the Proxy Server resource, including the 
following information:
• Server Host: The host name or IP address of the Proxy Server.

The Server Host name for the Oracle Service Bus proxy server must 
be identical to the server host name of the actual proxy server.

• Clear Text Port: The Proxy Server clear-text port number.
• SSL Port: The Proxy Server SSL port number.

User Name The user name used for proxy authentication.

Table 28-6  Proxy Server Information (Continued)

Property Description
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– Click the  Edit icon in the Options field of the Proxy Server you want to edit. Edit 
the Server Host field, the Clear Text Port field, and the SSL Port field, and click 
Update.

– Click the  Delete icon in the Options field of the Proxy Server you want to delete.

7. You can edit the User Name and Password fields, used for proxy authentication.

8. Click Save to commit the updates in the current session. 

9. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Deleting Proxy Servers 
1. If you have not already done so, click Create to create a new session or click Edit to enter an 

existing session. See “Using the Change Center” on page 2-2. 

2. Select System Administration > Proxy Servers.

3. On the Summary of Proxy Servers page, select a Proxy Server. See “Locating SMTP 
Servers” on page 28-6.

4. Click the  Delete icon in the Options field of the Proxy Server resource you want to delete. 

The Proxy Server resource is deleted in the current session. A  Deletion Warning icon is 
displayed when other resources reference this resource. You can delete the resource with a warning 
confirmation. This might result in conflicts due to unresolved references to the deleted resource.

5. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 
Using the Oracle Service Bus Console 28-13



Globa l  Resources
28-14 Using the Oracle Service Bus Console



C H A P T E R 29
Customization
This section includes the following topics:

“Finding and Replacing Environment Values” on page 29-1

“Creating Customization Files” on page 29-6

“Executing Customization Files” on page 29-7

Finding and Replacing Environment Values
Use the Find and Replace page to search for environment values that differ between domains. 
Environment values are certain predefined fields in the configuration data whose values are very 
likely to change when you move your configuration from one domain to another (for example, 
from test to production). Environment values represent entities such as URLs, URIs, file and 
directory names, server names, e-mails, and such. Also, environment values can be found in alert 
destinations, proxy services, business services, SMTP Server and JNDI Provider resources, and 
UDDI Registry entries. 

This page behaves differently based on whether or not you are in a session. If you are in a session, 
you can find and replace environment values. However, if you are outside a session, you can find 
environment values only; Replace All is disabled.

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2. 

2. Select System Administration > Find & Replace.

3. In the Find Value field, enter the environment value that you want to locate.
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4. To display a list of environment values in your configuration that contain the value you 
entered, click Find. 

A list of relevant values is displayed, which includes the Owner, Type, and the 
Environment Value columns. 

5. To locate only items changed in your current session, select the Only Items Changed In 
Current Session check box.

6. Select the variable type for which to search, from the Find in Variable Type drop-down list, 
described in Table 29-1. 

Table 29-1  Variable Types 

Variable Type Found In Description

All Types

Alert SNMP Trap Alert Destination SNMP trap (enable or disable) for an alert destination.

Alert To Reporting Data Alert Destination Alert to reporting data (enable or disable) for an alert 
destination.

Email Archive Directory E-mail proxy Archive directory for an e-mail proxy service.

Email Destination URI Alert Destination URI in an e-mail alert destination.

Email Download Directory E-mail proxy Download directory for an e-mail proxy service.

Email Error Directory E-mail proxy Error directory for an e-mail proxy service.

FTP Archive Directory FTP proxy Archive directory for an FTP proxy service.

FTP Download Directory FTP proxy Download directory for an FTP proxy service.

FTP Error Directory FTP proxy Error directory for an FTP proxy service.

File Archive Directory File proxy Archive directory for a file proxy service.

File Error Directory File proxy Error directory for a file proxy service.

File Stage Directory File proxy Stage directory for a file proxy service.

IMAP Move Folder E-mail proxy IMAP Move directory for an e-mail proxy service.
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JCA Always Use WSDL 
Flag

JCA proxy and 
business service

Determines whether or not connection factory 
properties, activation spec properties (proxy services), 
and interaction spec properties (business services) are 
always used from the WSDL.

JCA Connection Mode JCA proxy and 
business service

Determines how a service connects to an associated 
JCA adapter: managed or non-managed mode.

JCA Overwrite Connection 
Authentication Flag

JCA proxy and 
business service

Determines whether or not the authentication 
credentials in the JCA adapter connection factory are 
overridden in a development/test environment 
(non-managed connection mode).

JMS Alert Destination URI Alert Destination URI in a JMS alert destination.

JMS Managed Server JMS business service Managed Server entry in the table of Managed Server 
vs destination of a JMS business service with a 
response correlation pattern as Message ID pattern. 

JMS Queue Connection 
Factory

JMS proxy and 
business service

A response queue connection factory of a JMS proxy 
or business service with the response correlation 
pattern as Message ID. 

JMS Response Destination JMS business service Destination entry in the table of Managed Server vs 
destination of a JMS business service with a response 
correlation pattern as Message ID pattern.

JMS Response URI JMS proxy and 
business service

The URI of the response queue for JMS proxy or 
business services using response correlation pattern of 
JMS Correlation ID. 

JNDI Provider URL JNDI Provider JNDI Provider URLs.

MQ Connection Pool Size MQ Connection 
Resource

The size of the MQ connection pool.

MQ Connection Timeout MQ Connection 
Resource

The time interval after which unused connections 
are destroyed.

MQ Dead Letter URI MQ proxy The URI of the dead letter queue to which request 
messages are redirected after a pipeline retries a 
message a specified number of times.

Table 29-1  Variable Types (Continued)

Variable Type Found In Description
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MQ Host Name MQ Connection 
Resource

The host name of the MQ queue manager.

MQ Port Number MQ Connection 
Resource

The port number of the MQ queue manager 
listener.

MQ Queue Manager 
Channel Name

MQ Connection 
Resource

The queue manager server connection channel name.

MQ Queue Manager Name MQ Connection 
Resource

The name of the MQ queue manager.

MQ Response URI MQ proxy and business 
service

Proxy or business service URI.

MQ Unrecognized 
Response URI

MQ business service The URI of the queue to which unrecognized response 
messages are sent.

MQ Version MQ Connection 
Resource

The version of WebSphere MQ being used.

Managed Server for Polling E-mail, File, FTP, or 
SFTP proxy service in a 
clustered domain

Managed Server for polling in a clustered domain.

Proxy Server Host Proxy Server Resource The host name of the proxy server.

Proxy Server Port Proxy Server Resource The port number of the proxy server.

Proxy Server SSL Port Proxy Server Resource The SSL port of the proxy server.

SFTP Archive Directory SFTP proxy Archive directory for a SFTP proxy service. If 
direct-streaming is on, the archive directory is present 
on the remote SFTP server; otherwise, it is present 
locally.

SFTP Download Directory SFTP proxy Download directory for a SFTP proxy service.

SFTP Error Directory SFTP proxy Error directory for a SFTP proxy service. If 
direct-streaming is on, the error directory is present on 
the remote SFTP server; otherwise, it is present 
locally.

Table 29-1  Variable Types (Continued)

Variable Type Found In Description
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SMTP Server URL SMTP Server SMTP Server URLs.

Secure Connections to JMS 
Server

JMS proxy or business 
service

If true, Oracle Service Bus connects to the JMS server 
and JNDI tree using SSL (t3s); otherwise, connections 
occur over a clear text (t3) channel.

Service Retry Count Business service The number of times endpoint URIs are retried; in 
other words, the number of failover attempts.

Service Retry Iteration 
Interval

Business service The length of time that a business service waits 
before iterating over the entire set of URIs again.

Service URI Proxy or business 
service

Proxy or business service URI.

Service URI Weight Business service The individual weights assigned to business service 
URIs.

Split-Join Work Manager Split-Join Work Manager name for a split-join resource.

Tuxedo Access Point Map Proxy or business 
service

Name and address of the local access point(s) per 
Managed Server; there is one location per URI. 

Tuxedo Access Point Name Business service Name of the remote WTC access point associated with 
the URI.

Tuxedo Network Address Business service Network address of the remote WTC access point 
associated with the URI.

UDDI Auto Import UDDI Registry Auto-synchronize property of an imported business 
service from a UDDI Registry. This property is per 
registry.

UDDI Auto Publish Proxy service Auto-publish property of a proxy service to a UDDI 
Registry.

UDDI Inquiry URL UDDI Registry Inquiry URL for a UDDI Registry.

UDDI Publish URL UDDI Registry Publish URL for a UDDI Registry.

UDDI Security URL UDDI Registry Security URL for a UDDI Registry.

UDDI Subscription URL UDDI Registry Subscription URL for a UDDI Registry.

Table 29-1  Variable Types (Continued)

Variable Type Found In Description
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7. To locate environment values located in a particular project, select the project name from the 
Located in Project drop-down list.

8. In the Replace with field, enter the new environment value.

9. To replace the original environment value with the new value, click Replace All. 

All occurrences of the environment value you entered in the Find Value field are replaced 
with the environment value you entered in the Replace with field in the current session.

Note: Certain environment values are complex XML objects that cannot be found and 
replaced using the console. However, you can still set these environment values 
directly by using the ALSBConfigurationMBean from a script. For detailed 
information about ALSBConfigurationMBean, see the Javadoc for Oracle Service 
Bus Classes. In addition to setting them through the API, you can set complex type 
environment values using customization files. See “Executing Customization Files” 
on page 29-7.

10. To end the session and deploy the configuration to the run time, click Activate under Change 
Center.

Related Topics
For detailed information about EnvValueTypes, see the Javadoc for Oracle Service Bus Classes. 
The Java types and location values of these environment values are specified in the javadoc.

Creating Customization Files
The Create Customization File page provides a convenient way to generate a customization file 
for a set of resources or projects that you select. You can then use this file as a starting point for 
making your desired modifications by specifying the actual values for an environment.

WS Error Queue URI WS business service The URI of the JMS queue for storing error messages.

Work Manager Proxy or business 
services using DSP, 
HTTP, JMS, MQ, JPD, 
SB, Tuxedo, or WS 
transports

Work Manager name in all proxy and business 
services.

Table 29-1  Variable Types (Continued)

Variable Type Found In Description
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You can use customization files to make changes to environment values as well as to change 
references within resources. Customization files can include customizations for all the 
environment values found in the resources you selected, including complex environment values 
types defined inside the EnvValueTypes class. In addition, it includes a reference customization 
type for changing resource references inside resources with dependencies.

The customization schema (Customization.xsd) which describes the customization types is 
available at the following location in your Oracle Service Bus installation: 

BEA_HOME\modules\com.bea.common.configfwk_[version].jar, where BEA_HOME 
represents the directory in which you installed Oracle Service Bus.

1. Select System Administration > Create Customization File. 

The Create Customization File page displays the list of objects in your configuration. The 
name and type of each object is displayed.

2. Select the projects or resources you want to include in the customization file.

a. Expand the project folders. The name and type for each resource contained in the project 
is displayed. 

b. Select the check boxes associated with the projects or resources you want to include in the 
customization file.

a. Clear the check boxes associated with the projects or resources that you do not want to 
include in the customization file.

3. Click Create File to create a customization XML file.

4. In the File Download dialog box, click Open to open the customization file or click Save to 
save the XML file to your desktop.

Executing Customization Files
Use this page to execute a customization XML file that has been previously saved on your 
system. Customization files provide a convenient way to modify your environment during 
deployment, from development to staging, from staging to production, or during design time.

You must be in a session to execute a customization file.

1. If you have not already done so, click Create to create a new session or click Edit to enter an 
existing session. See “Using the Change Center” on page 2-2.

2. Select System Administration > Execute Customization File.
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3. Select a customization file to execute.

a. In the File Name field, click Browse to locate the directory where the customization file 
is stored.

b. Select the XML file, then click Open.

4. Click Next. The following customization details are displayed, shown in Table 29-2.

5. To customize only resources, services, projects, or folders changed in the current session, 
select the Only Items Changed In Current Session check box.

If you limit customizations to only resources modified in the current session, the Apply To 
column gets updated with the resources modified in current session. If you limit 
customizations of a project or folder, then the resources modified in current session within 
that project or folder are displayed in Apply To column.

6. Click Execute to commit the updates in the current session.

To view customization details, within the session, select View Changes under Change 
Center, and click the Customization task. See “Viewing Configuration Changes” on 
page 2-4.

7. To end the session and deploy the configuration to the run time, click Activate under Change 
Center. 

Table 29-2  Customization Details 

Property Description

Operation • Find & Replace—modify environment values by doing string 
substitutions.

• Map References—maps existing references found in resources to other 
references.

• Set Environment Values—modify environment values for resources.

Apply To Name of the service, project, folder, or resource to be customized. 

The name is a link to the Configuration Details page of the service or 
resource, or to the project or folder in the Project Explorer.

Description A description of each customization.
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Test Console
The Oracle Service Bus Test Console is a browser-based test environment used to validate and 
test the design of your system. You can configure the object of your test (proxy service, business 
service, or resource), execute the test, and view the results in the test console. In some instances, 
you can trace through the code and examine the state of the message at specific trace points. To 
learn more about the test console, see Using the Test Console in Oracle Service Bus User Guide.

Only users in the IntegrationAdmin and IntegrationDeployer roles can use the test 
console. For more information about roles, see Roles in Oracle Service Bus in the Oracle Service 
Bus Operations Guide.

Testing Services
This section includes the following topics:

“Testing Proxy Services” on page 30-2

“Configuring Proxy Services Test Data” on page 30-3

“Viewing Proxy Services Test Results” on page 30-9

“Tracing Proxy Services” on page 30-9

“Testing Business Services” on page 30-10

“Configuring Business Services Test Data” on page 30-11
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Testing Proxy Services
You can test the following types of proxy services: any XML, any SOAP, Messaging, XML, and 
SOAP. You can test SOAP proxy services with Web Service Security (WSS) policies. See Web 
Service Security in “Configuring Proxy Services Test Data” on page 30-3.

Note: When the test console invokes a proxy with HTTP custom token authentication, the 
authentication check is not done.

WARNING: Testing proxy services with the direct call option enabled bypasses some 
important security steps, including access control. Oracle recommends that you 
not use the test service in production systems.

1. Click Activate under Change Center to enable the test feature in the console.

You can test proxy services from the Resource Browser or Project Explorer. 

2. Select Resource Browser > Proxy Services to display the Summary of Proxy Services 
page.

3. Under Actions, click the  Launch Test Console icon associated with the proxy service you 
want to test. 

The test console opens the Proxy Service Testing page. For example, using the examples 
provided with the product (see Oracle Service Bus Examples), click the icon associated 
with the LoanGateway1 proxy service.

Note: In a clustered domain, you cannot use the test console to test any configured business 
service or proxy service which routes to a business service. 

4. For SOAP and XML services, select the WSDL operation you want to test.

5. Configure the test data for the proxy service. This must be the data that the proxy service 
expects from the client. 

By default, both test configuration options, Direct Call and Include Tracing, are enabled. 
You can clear the Direct Call option, which also clears the Include Tracing option. By 
doing so, testing is performed using the indirect call method where the message is sent 
through the transport layer. 

You can use the Direct Call option (leave Direct Call selected) and disable tracing; simply 
clear the Include Tracing check box.

6. Click Execute. The Proxy Service Testing page displays the results. For information about 
interpreting the test results, see “Viewing Proxy Services Test Results” on page 30-9.
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7. To run the test again, click Back. Repeat steps 5–8.

Configuring Proxy Services Test Data
Table 30-1 lists the configuration options for testing proxy services. The fields for accepting 
input to the request document are based on the service type.

Table 30-1  Proxy Services Configuration Options 

Section Options/Fields Description

Name The name of the proxy service being tested.

Available 
Operations

Operations associated with the proxy service.

Test Console 
Actions

Execute Run the test.

Reset Reset the input values.

Close Close the test console and do not run the test.

Test 
Configuration

Set the testing configuration options.

Direct Call Send a message to the proxy service without using 
the Oracle Service Bus transport layer. The input 
data to the test console must be that which is sent 
from the client to the proxy service.

The opposite of the direct call is an indirect call. It 
can be invoked by clearing the Direct Call option. 
It is performed by default for business services. The 
indirect call sends messages through the transport 
layer. In this case, the input data to the test console 
must be that which is being sent from a proxy 
service to the invoked service.

Include Tracing Tracing shows the state of the message as it passes 
through the system.
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Request 
Document

The input fields generate the request message that is sent to the proxy service. Click Execute 
to run the test with the values you entered. The test console displays the request message and 
the service's response message and metadata.

Input in the Request Document section is service-type specific. The service types and a 
description of the input required by each are listed in the following sections.

any XML The service requests input in the form of a 
payload.The payload is the content of the message 
being sent. The content is expected to be an XML 
document. You can browse to a file or enter the 
message content in the text box.

Table 30-1  Proxy Services Configuration Options (Continued)

Section Options/Fields Description
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Request 
Document 
continued

any SOAP The service requests input in the form of a payload. 
The payload is the content of the message being 
sent. The content is expected to be the SOAP 
envelope. You can browse to a file or enter the 
message content in the text box.

Messaging Messaging services define four possible input 
types: none, XML, Binary or Text. The service 
requests a single input—either file-based or 
text-based, except for the type none that does not 
require any input.

Oracle recommends entering binary input from a 
file. Data entered in the text area is converted to 
binary input using the system encoding.

Data entered from files for text services must be 
converted to text. The encoding input field is used 
to specify the encoding to apply during the 
conversion. The system encoding is used if this 
field is not configured. By default, the encoding 
field is initialized with the encoding value 
configured on the proxy service endpoint.

XML The service requests input in the form of a 
payload.The payload is the content of the message 
being sent. The content is expected to be an XML 
document. You can browse to a file or enter the 
message content in the text box.

If your proxy service is a WSDL-based service with 
multiple operations defined, the test console 
generates and provides a sample document to use 
when testing the service. You can use this sample 
data directly, edit it and then run the test, or provide 
your own test data.

All operations are listed at the top of the page. 

Table 30-1  Proxy Services Configuration Options (Continued)

Section Options/Fields Description
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Request 
Document 
continued

SOAP Document For a SOAP document, the SOAP envelope is 
usually composed of zero or more headers and one 
body payload. The Form and XML tabs provide 
alternative ways to specify the content.

The Form tab contains a SOAP Header field and a 
SOAP Body field. The content of the SOAP Header 
field is expected to be a SOAP Header tag (this 
allows for the definition of more than one header). 
The SOAP Body field contains the data that is 
actually sent as part of the message. The content is 
expected to be an XML document. Both the header 
and the body are used to generate the SOAP 
envelope.

Request 
Document 
continued

SOAP RPC For SOAP RPC, the SOAP envelope is composed 
of zero or more headers, and zero or more 
arguments.

The Form and XML tabs provide alternative ways 
to specify the content.

The Form tab contains a single input for SOAP 
headers, and one input field for each argument (the 
name of the input field corresponds to the name of 
the argument). The content of the SOAP Header 
field is expected to be a SOAP Header tag (this 
allows for the definition of more than one header).

The WSDL is used to detect the type of each 
argument. A single-line input field is used for 
primitive types; a multi-line input field is used for 
XML types. A sample document is automatically 
generated to facilitate testing.

The headers and arguments are used by the test 
console to generate the SOAP envelope.

The XML tab contains a single input field. The 
content of this field is expected to be the SOAP 
envelope being sent. The payload (XML input) can 
be file-based or text-based. Referencing a file for 
input takes precedence over textual input. Browse 
and select the file you want to use in your test.

Table 30-1  Proxy Services Configuration Options (Continued)

Section Options/Fields Description
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Web Service 
Security

This section is available only for SOAP services when the selected operation has a Web 
Service Security (WSS) policy.

Service Provider The test service gets all client-side PKI (key-pair) 
credentials for Web Service security operations 
(digital signature and encryption) from this service 
provider. This field is optional. Certain scenarios 
require a service provider, depending on the 
request/response policy for the operation. For more 
information, see “Testing Services with Web 
Service Security” in Using the Test Console in the 
Oracle Service Bus User Guide.

Username The user name in Web Service security username 
tokens generated from the test service. This field is 
optional. This user name is only needed in some 
scenarios where the operation's request policy 
specifies an identity assertion. 

Do not confuse this field with the transport security 
context username field. 

This must be a valid user name and password in the 
local security realm. An invalid user name or 
invalid password causes a client-side error on the 
test service.

Password The password in Web Service security user name 
tokens generated from the test service.

Transport The Transport section is collapsed by default. The fields and values depend on the test 
configuration.

Table 30-1  Proxy Services Configuration Options (Continued)

Section Options/Fields Description
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Note: The secured SOAP message is displayed printed with extra white spaces. Because white 
spaces can affect the semantics of the document, this SOAP message cannot always be 
used as the literal data. For example, digital signatures are whitespace sensitive and can 
become invalid.

Authentication Username The user name for setting the security context used 
by the test service when invoking the proxy service. 

If the proxy service routes the message to a 
business service that expects a SAML token, this is 
the identity that will be represented by the token. 
For more information, see Using SAML for 
Authentication in the Oracle Service Bus Security 
Guide. 

Do not confuse this field with the Web Service 
Security (WSS) username field. This must be a 
valid user name and password in the local security 
realm. An invalid user name or invalid password 
will cause a client-side error on the test service.

Note: When the test console invokes a proxy with 
HTTP custom token authentication, the 
authentication check is not done.

Password The associated password. For more information, 
see Username.

Invocation 
Mode

Request/Response This option is only displayed when testing any 
SOAP or any XML proxy service. Clear the 
Request/Response check box for one-way service 
invocations.

Message 
Metadata

See Table 30-10

Transport 
Headers

See Table 30-10

Table 30-1  Proxy Services Configuration Options (Continued)

Section Options/Fields Description
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Viewing Proxy Services Test Results
Table 30-2 describes proxy service testing results. Tracing is only enabled if you have selected 
both the Direct Call and the Include Tracing options.

Tracing Proxy Services
Tracing is enabled when you test proxy services using a direct call. The Include Tracing check 
box is selected by default with the Direct Call option. If you do not want tracing, clear the 
Include Tracing check box. When you enable tracing, the test results include the details of the 
trace. Use tracing to track problems in the system and to isolate them for correction. The trace 
information shows the path taken through the request and response paths in the code.

1. Click Activate under Change Center to enable the test feature in the console.

Table 30-2  Testing Results for Proxy Services 

Section Description

Proxy Service Name The name of the proxy service that is being tested.

Test Console Actions Back displays the previous browser page.

Close closes the test console.

Request Document The request message sent to the proxy service by the test console.

This section is initially collapsed if the test console did not modify the request 
message. This section is initially expanded for SOAP services configured using 
the Form tab, or if WS-Security has been applied.

If WS-Security has been applied, this section will contain two SOAP messages—
the first message is the clear text message; the second is the secured SOAP 
message.

Response Document The message response.

For a SOAP service with a WS-Security response, this section contains two 
SOAP messages. The first SOAP message is the secured message as received by 
the client. The second SOAP message is the corresponding clear text message.

Response Metadata The metadata retuned with the message response.

Tracing Proxy Services Tracing shows the state of the message as it passes through the system. When the 
Direct Call option is not selected, tracing is not performed. For more information 
on tracing, see “Tracing Proxy Services” on page 30-9.
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2. Select Resource Browser > Proxy Services to display the Summary of Proxy Services 
page.

3. Under Actions, click the  Launch Test Console icon associated with the service you want 
to test. The test console opens the Proxy Service Testing page.

4. Configure the test data for the proxy service. You must have the Direct Call and Include 
Tracing options selected to enable tracing. See “Configuring Proxy Services Test Data” on 
page 30-3.

5. Click Execute. The Proxy Service Testing page displays the test results for the service and 
the tracing information.

6. Scroll down to the Invocation Trace section.

This section displays a graphical representation the message flow. You can trace the 
message through the service and view the state of the message at pre-selected points in the 
trace. The trace points are automatically set. 

7. Click the + plus sign to expand the message flow to view more detail. 

While viewing the trace you can also view the message flow in the Oracle Service Bus 
Console. This helps you relate the trace to the stages and actions in the message flow. You 
can modify the message flow and run the trace again to view the output.

Testing Business Services
You can test the following types of business services: any XML, any SOAP, Messaging, XML, 
and SOAP. You can test SOAP business services with Web Service Security policies. For more 
information, see “Testing Services with Web Service Security” in Using the Test Console in the 
Oracle Service Bus User Guide.

Note: In a clustered domain, you cannot use the test console to test any configured business 
service or proxy service which routes to a business service. 

1. Click Activate under Change Center to enable the test feature in the console.

2. Select Resource Browser > Business Services to display the Summary of Business 
Services page.

3. Under Actions, click the  Launch Test Console icon associated with the service you want 
to test. The test console opens the Business Service Testing page. For example, using the 
tutorials provided with the product, click the icon associated with loanSaleProcessor.
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4. For SOAP and XML services, select the WSDL operation you want to test.

5. Configure the test data for the business service (the input data should be the message being 
sent by the proxy service to the business service). The Direct Call and Include Tracing 
options that are available when testing proxy services are not available for business services. 
By default, business services are tested using the Direct Call option, meaning that the 
messages pass through the transport layer.

6. Click Execute. 

The Business Service Testing page displays the results. For more information, see 
“Viewing Business Services Test Results” on page 30-16.

Configuring Business Services Test Data
Table 30-3 lists the configuration options for testing business services. The fields for accepting 
input to the request document are based on the service type.

Table 30-3  Business Services Configuration Options 

Section Options/Fields Description

Name The name of the business service being tested.

Available Operations Operations associated with the business service. 

Test Console Actions Execute Run the test.

Reset Reset the input values.

Close Close the window and do not run the test.
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Request Document The input fields generate the request message that is sent to the business service. Click 
Execute to run the test with the values you entered. The test console displays the 
request message and the service's response message.

Input in the Request Document section is service-type specific. The service types and 
a description of the input required by each are listed in the following sections.

any XML The service requests input in the form of a 
payload. The payload is the content of the 
message being sent. The content is expected to 
be an XML document. You can browse to a file 
or enter the message content in the text box.

any SOAP The service requests input in the form of a 
payload. The payload is the content of the 
message being sent. The content is expected to 
be the SOAP envelope. You can browse to a file 
or enter the message content in the text box.

Request Document 
continued

Messaging Messaging services define 4 possible input 
types: none, XML, Binary or Text. The 
service requests a single input either file-based 
or text-based, except for the type none that does 
no require any input.

Oracle recommends entering binary input from a 
file. Data entered in the text area are converted to 
binary using the system encoding.

Data entered from files for text services must be 
converted to text. The encoding input field is 
used to specify the encoding to apply during the 
conversion. The system encoding is used if this 
field is not configured. By default, the encoding 
field is initialized with the encoding value 
configured on the proxy service endpoint.

Table 30-3  Business Services Configuration Options (Continued)

Section Options/Fields Description
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Request Document 
continued

XML The service requests input in the form of a 
payload. The payload is the content of the 
message being sent. The content is expected to 
be an XML document. You can browse to a file 
or enter the message content in the text box.

This is a WSDL-based service with multiple 
operations defined. Oracle provides a sample 
document to use in testing this service. All 
operations are listed at the top of the page with 
an arrow highlighting the selected operation. 

SOAP Document For a SOAP document, the SOAP envelope is 
usually composed of zero or more headers and 
one body payload.

The Form and XML tabs provide alternative 
ways to specify the content.

The Form tab contains a SOAP Header field and 
a SOAP Body field. The content of the SOAP 
Header field is expected to be a SOAP Header 
tag (this allows for the definition of more than 
one header). The SOAP Body field contains the 
data that is actually sent as part of the message. 
The content is expected to be an XML 
document. Both the header and the body are used 
to generate the SOAP envelope.

The XML tab contains a single input field. The 
content of this field is expected to be the SOAP 
envelope being sent.

Table 30-3  Business Services Configuration Options (Continued)

Section Options/Fields Description
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Request Document 
continued

SOAP RPC For SOAP RPC, the SOAP envelope is 
composed of zero or more headers, and zero or 
more arguments.

The Form and XML tabs provide alternative 
ways to specify the content.

The Form tab contains a single input for SOAP 
headers, and one input field for each argument 
(the name of the input field corresponds to the 
name of the argument). The content of the SOAP 
Header field is expected to be a SOAP Header 
tag (this allows for the definition of more than 
one header). 

The WSDL is used to detect the type of each 
argument. A single-line input field is used for 
primitive types; a multi-line input field is used 
for XML types. A sample document is 
automatically generated to facilitate testing.

The headers and arguments are used by the test 
console to generate the SOAP envelope.

The XML tab contains a single input field. The 
content of this field is expected to be the SOAP 
envelope being sent. The payload (XML input) 
can be file-based or text-based. Referencing a 
file for input takes precedence over textual input. 
Browse and select the file you want to use in 
your test.

Table 30-3  Business Services Configuration Options (Continued)

Section Options/Fields Description
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Web Service Security This section is available only for SOAP services when the selected operation has a 
Web Service Security policy.

Service Provider The test service gets all client-side PKI 
(key-pair) credentials for Web Service security 
operations (digital signature and encryption) 
from this service provider. This field is optional. 
Certain scenarios require a service provider, 
depending on the request/response policy for the 
operation. For more information, see “Testing 
Services with Web Service Security” in Using 
the Test Console in the Oracle Service Bus User 
Guide.

Web Service Security 
continued

Username The user name in Web Service security 
username tokens generated from the test service. 
This field is optional. This user name is only 
needed in some scenarios where the operation's 
request policy specifies an identity assertion. 

Do not confuse this field with the transport 
security context username field. This must be a 
valid user name and password in the local 
security realm. An invalid user name or invalid 
password will cause a client-side error on the test 
service.

In some scenarios, this user name and password 
may also be used when the test service generates 
a SAML assertion.

Password The password in Web Service security username 
tokens generated from the test service.

Transport The Transport section is collapsed by default. The fields and values depend on the test 
configuration.

Table 30-3  Business Services Configuration Options (Continued)

Section Options/Fields Description
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Viewing Business Services Test Results
Table 30-4 describes business service testing results.

Authentication Username The user name for setting the security context 
used by the test service when invoking the 
business service. If the business service expects 
a SAML token, this identity may be propagated 
in the SAML token. See Using SAML for 
Authentication in the Oracle Service Bus 
Security Guide. This must be a valid user name 
and password in the local security realm. An 
invalid user name or invalid password will cause 
a client-side error on the test service.

Password The associated password. For more information, 
see Username.

Service Provider This field is used when testing an HTTPS 
business service with CLIENT-CERT 
authentication. See HTTP(S) in Oracle Service 
Bus User Guide. The service provider must have 
an associated SSL client credential. The test 
service will use that credential during the SSL 
handshake

Invocation Mode Request\Response This option is only displayed when testing an 
any SOAP or any XML business service. Clear 
the Request/Response check box for one-way 
service invocations.

Message Metadata See Table 30-10.

Transport Headers See Table 30-10.

Table 30-3  Business Services Configuration Options (Continued)

Section Options/Fields Description
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Note: The secured SOAP message is displayed pretty printed, for example, with extra white 
spaces. This SOAP message cannot always be used as the literal data as white spaces can 
affect the semantics of the document. For example, digital signatures are whitespace 
sensitive and can become invalid.

Testing Transformations
You can test transformations after activating a session or during a session to ensure that the 
resources operate with the expected behavior. You must activate the session to test the run time, 
otherwise the testing is done at design time using your local changes.

You can test the following transformations: 

“Testing MFL Transformations” on page 30-18

“Testing XSLT Transformations” on page 30-19

Table 30-4  Testing Results for Business Services 

Section Description

Business Service Name The name of the business service.

Test Console Actions Click Back to display the previous browser page.

Click Close to close the test console window.

Request Document The request message sent to the business service by the test console.

This section is initially collapsed if the test console did not modify the 
request message. This section is initially expanded for SOAP services 
configured using the Form tab, or if WS-Security has been applied.

If WS-Security has been applied, this section will contain two SOAP 
messages. The first message is the clear text message. The second is the 
secured SOAP message.

Response Document The message response.

For a SOAP service with a WS-Security response, this section will contain 
two SOAP messages. The first SOAP message is the secured message as 
received by the client. The second SOAP message is the corresponding 
clear text message.

Response Metadata The metadata returned with the message response.
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“Testing XQuery Transformations” on page 30-20

Testing MFL Transformations
A Message Format Language (MFL) document is a specialized XML document used to describe 
the layout of binary data. MFL resources support two transformations. Each transformation only 
accepts one input and provides a single output: XML to binary, or binary to XML.

Table 30-5 describes MFL configuration options.

You can test the design time or the run time. 

1. Click Activate if you want to test the run time. Do not activate the session to test the design 
time.

Table 30-5  Configuring MFL Options 

Section Description

Name The name of the resource being tested.

Supported 
transformations

 To select a specific transformation, select the transformation name.

Test Console Actions Execute Apply the transformation.

Reset Reset the input field (for XML to binary, the sample XML 
document is reset).

Close Cancel the current operation.

MFL Transformation 
Configuration

XML Input Required for XML to binary transformations:

The XML schema for the MFL document can be inferred. A 
sample XML document is automatically entered in the text 
field.
The XML input can be file-based or text-based. Referencing a 
file for input takes precedence over textual input. Browse and 
select the file you want to use in your test.

Binary Input Required for binary to XML transformations:

The binary input can be file-based or text-based. Referencing a 
file for input takes precedence over textual input. Browse and 
select the file you want to use in your test.
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2. Select Resource Browser > MFLs to display the Summary of MFL Files page.

3. Under Actions, click the  Launch Test Console icon associated with the resource you 
want to test. The test console opens the Resource Testing page.

4. Select the transformation you want to test.

5. Configure the test data for the MFL resource. For more information, see Table 30-5.

6. Click Execute. The Resource Testing page displays the results.

7. To retest, click Back. You can close the test console, modify, and retest the resource.

Testing XSLT Transformations
eXtensible Stylesheet Language Transformations (XSLT) describe XML-to-XML mappings in 
Oracle Service Bus. To test an XSLT resource you must supply the input XML document and the 
test console returns the output XML document. XSLT transformations may have additional 
named parameters. All parameters required by the transformation are displayed on the 
configuration page. Default values are available but you can override them.

Table 30-6 describes XSLT configuration options.

Table 30-6  Configuring XSLT Options 

Section Description

Name The name of the resource being tested.

Test Console 
Actions

Execute Apply the transformation.

Reset Reset the input field(s).

Close Cancel the current operation.
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You can test the design time or the run time. 

1. Click Activate if you want to test the run time. Do not activate the session to test the design 
time.

2. Select Project Explorer > XSLTs to display the Summary of XSLTs page.

3. Under Actions, click the  Launch Test Console icon associated with the resource you 
want to test. The test console opens the Resource Testing page.

4. Configure the test data for the resource in the Input and Parameters section of the page. For 
more information, see Table 30-6.

5. Click Execute. The Resource Testing page displays the results. 

6. To retest, click Back. You can close the test console, modify, and retest the resource.

Testing XQuery Transformations
XQuery maps can describe XML-to-XML, XML to non-XML, and non-XML to XML mappings. 
An XQuery transformation can take multiple inputs and returns one output. Each input 
corresponds to an XQuery external variable declared in the XQuery resource. The value of an 
XQuery input variable can be a primitive value (String, integer, date, and so on), an XML 
document, or a sequence of these types. The output value can be a primitive value (String, integer, 
date, and so on), an XML document, or a sequence of these types. 

Input and 
Parameters

The input document and parameters for testing the XSLT resource.

XML Input The XML input can be file-based or text-based. 
Referencing a file for input takes precedence over 
textual input. Browse and select the file you want 
to use in your test. XML input is required.

<param_name> ([] as XML) param_name is a named XSLT parameter. 

There are two types of input: XML and primitive 
(String, integer, float, and so on). The default 
input type is String. Select the check box 
associated with the parameter name to identify a 
parameter of type XML.

Table 30-6  Configuring XSLT Options (Continued)

Section Description
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Note: The test console does not support sequences on input.

Table 30-7 describes XQuery configuration options.

You can test the design time or the run time. 

1. Click Activate if you want to test the run time. Do not activate the session to test the design 
time.

2. Select Project Explorer > XQueries to display the Summary of XQueries page.

Table 30-7  Configuring XQuery Options 

Section Description

Name The name of the resource being tested.

Test Console 
Actions

Execute Execute the transformation.

Reset Reset the input field(s).

Close Close the test console.

Variables This section contains one input field for each of the XQuery external variables.

<param_name> ([] as XML) param_name is a XQuery variable name in the 
XQuery resource. 

In the test console, a single-line edit box is 
displayed if the type is a simple type. A multi-line 
edit box is displayed if the data is XML.

A combination input (<param_name> ([] as 
XML)) is used when the variable is not typed. You 
must declare the variable type. Select the check 
box to identify a parameter of type XML.

An XML input can be file-based or text-based. 
Referencing a file for input takes precedence over 
textual input. Browse and select the file you want 
to use in your test.

Input in the test console is rendered based on the 
type to make it easier to understand the type of 
data you must enter. When untyped, the default 
type is XML.
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3. Under Actions, click the  Launch Test Console icon associated with the resource you 
want to test. The test console opens the Resource Testing page.

4. Configure the test data for the resource in the Variables section of the page. For more 
information, see Table 30-7.

5. Click Execute. The Resource Testing page displays the results. 

6. To retest, click Back. You can close the test console, modify, and retest the resource.

Performing XQuery Testing
You can edit and test an action in the message flow using the following Editors: XQuery 
Expression Editor, XQuery Condition Editor, and XPath Expression Editor. Testing takes the 
same form for both the XQuery Expression and Condition Editors. However, the scenario is 
different for the XPath Expression Editor because it takes only one input. 

Note: You must disable the pop-up blockers in your browser for XQuery testing to work. If you 
have toolbars in the IE browser, you may need to disable the pop-up blockers from under 
the Options menu as well as for all toolbars that are configured to block them.

This section includes the following topics:

“Using the XQuery Expression and XQuery Condition Editors” on page 30-22

“Using the XPath Expression Editor” on page 30-24

Using the XQuery Expression and XQuery Condition Editors
You use XQuery expressions to create the data content for the message context variables (or part 
of a message context variable) during the execution of the message flow. You can use the test 
console directly in the XQuery Expression Editor to test the definition of the expression.

Similarly, you use XQuery conditions to evaluate Boolean conditions in the message flow. You 
can use the test console directly in the XQuery Condition Editor to test the definition of the 
condition.

An XQuery can take multiple inputs and returns one output. Each input corresponds to an XQuery 
unbound variable defined in the XQuery. The value of an XQuery input can be a primitive value 
(String, integer, date, and so on), an XML document, or a sequence of these types. The output 
value can be a primitive value (String, integer, date, and so on), an XML document, or a sequence 
of these types. 
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Note: The test console does not support sequences on input.

Table 30-8 describes XQuery configuration options.

1. Access the test console when editing an action in the message flow of a pipeline. 

– To access the XQuery Expression Editor, see “Creating and Editing Inline XQuery and 
XPath Expressions” on page 20-1.

– To access the XQuery Condition Editor, see “Creating and Editing Inline XQuery and 
XPath Expressions” on page 20-1.

Table 30-8  Configuring XQuery Testing 

Section Description

Name The type of expression being tested.

Test Console 
Actions

Execute Apply the transformation.

Reset Reset the input field(s).

Close Cancel the current operation.

Variables This section contains one input field for each of the XQuery unbound variables.

<param_name> ([] as XML) param_name is the name of the corresponding 
XQuery unbound variable. 

In the test console, a single-line edit box is 
displayed if the type is a simple type. A multi-line 
edit box is displayed if the data is XML. A 
combination input (<param_name> ([] as XML)) 
is used when the variable is not typed.You must 
declare the variable type. Select the check box to 
identify a parameter of type XML.

An XML input can be file-based or text-based. 
Referencing a file for input takes precedence over 
textual input. Browse and select the file you want 
to use in your test.

Input in the test console is rendered based on the 
type to make it easier to understand the type of 
data you must enter. The default type is XML.
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The XQuery Testing Expression page is displayed. All input variables requested are 
displayed on the page.

2. Configure the test data for the XQuery in the Variables section of the page. For more 
information, see Table 30-8. 

3. Click Execute. The testing page displays the results. 

4. Once you have completed a test, you can click Back to execute a new test. To execute a new 
test after making changes to the XQuery, you must close and reopen the test console for the 
changes to take effect.

Using the XPath Expression Editor
You use XPath expressions to select a subset of an XML message context variable. You can use 
the test console in the XPath Expression Editor to test the definition of the XPath expression. An 
XPath expression takes a single XML document as input and generates a sequence of XML 
documents, primitives types, or both as output.

Table 30-9 describes XPath expression configuration options.

1. Access the test console when editing an action in the message flow of a pipeline. To access 
the XPath Expression Editor, see “Creating and Editing Inline XQuery and XPath 
Expressions” on page 20-1.

Table 30-9  Configuring XPath Options 

Section Description

Name The type of expression being tested.

Test Console 
Actions

Execute Apply the transformation.

Reset Reset the input field.

Close Cancel the current operation.

Variables This section contains a single input field corresponding to the XML document against which 
this XPath expression is being tested.

The XML input can be file-based or text-based. Referencing a file for input takes precedence 
over textual input. Browse and select the file you want to use in your test. 
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2. Configure the test data for the XPath expression in the Variables section of the page. For 
more information, see Table 30-9.

3. Click Execute. The testing page displays the results. 

4. Once you have completed a test, you can use the Back button to execute a new test. To execute 
a new test after making changes to the XPath expression, you must close and reopen the test 
console for the changes to take effect.

Understanding How the Run Time Uses the Transport 
Settings in the Test Console

“Configuring Proxy Services Test Data” on page 30-3 and “Configuring Business Services Test 
Data” on page 30-11 describe how you configure the values of the transport headers, transport 
metadata, and transport-related security data for outbound requests when you test proxy services 
or business services in the test console. However, some specifications you can make in the test 
console are not honored at run time. That is, the values of certain headers or metadata are 
overwritten, or ignored by the Oracle Service Bus at run time when the test is executed. The 
headers and metadata for which there are limitations are described in Table 30-10.

Table 30-10  Limitations to Transport Header and Metadata Values You Specify in the Test Console When Testing a 
Service 

Transport Service Type Description of Limitation Transport Headers 
Affected

HTTP(S)1 Proxy Services All transport headers and 
other fields you set are 
preserved at run time. This is 
true whether or not the 
Direct Call option is set.

All 

Business Services The Oracle Service Bus run 
time overrides any values 
you set for these parameters.

• Content-Length
• Content-Type
• relative-URI
• client-host
• client-address
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JMS Proxy Services When the Direct Call option 
is used, all transport headers 
and other fields you set are 
preserved at run time.

All 

When the Direct Call option 
is not used, the same 
limitations apply as those for 
a transport header action 
configuration.

See the limitations for JMS 
transport headers described 
in Table 3-7 Limitations to 
Transport Header Values 
You Specify in Transport 
Header Actions in Oracle 
Service Bus User Guide.

Business Services The same limitations apply 
as those for a transport 
header action configuration.

See the limitations for JMS 
transport headers described 
in Table 3-7 Limitations to 
Transport Header Values 
You Specify in Transport 
Header Actions in Oracle 
Service Bus User Guide.

E-Mail Proxy Services No limitations. Any 
transport headers and other 
fields you set are honored at 
run time. This is true whether 
or not Direct Call is 
specified. 

Business Services The Oracle Service Bus run 
time overrides any values 
you set for these parameters

Content-Type

File Proxy Services No limitations. Any 
transport headers and other 
fields you set are honored at 
run time.2

Business Services

Table 30-10  Limitations to Transport Header and Metadata Values You Specify in the Test Console When Testing a 
Service (Continued)

Transport Service Type Description of Limitation Transport Headers 
Affected
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FTP Proxy Services No limitations. Any 
transport headers and other 
fields you set are honored at 
run time. 

Business Services

1. When you test proxy services, the test console never sends a HTTP request over the network, therefore 
transport-level access control is not applied.
2. For example, FileName (Transport metadata)—the value you assign is appended to the output file 
name. For example, 1698922710078805308-b3fc544.1073968e0ab.-7e8e-{$FileName}.

Table 30-10  Limitations to Transport Header and Metadata Values You Specify in the Test Console When Testing a 
Service (Continued)

Transport Service Type Description of Limitation Transport Headers 
Affected
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Error Codes
This section describes the Oracle Service Bus errors that can occur when a proxy service is being 
executed. The error codes associated with these errors surface inside the element of the fault 
context variable. You can access the value using the following XQuery statement:
$fault/ctx:errorCode/text()

Errors are accompanied by details specific to the error inside the fault element.

Table A-1 lists Oracle Service Bus error codes. 

Table A-1  Oracle Service Bus Error Codes 

Subsystem Error Code Error Message

Transport Run Time 
Error  
(BEA-380000 to 
BEA-380099)

BEA-380000 General Transport error 
XML Details: An Error Response Was Received 
(when occurring in publish action)

Message Flow runtime 
error codes 
(382000...382499)

BEA-382000 General runtime error

BEA-382030 General parse failure from binding layer (e.g. message to 
XML service is not XML)

BEA-382031 WS-I compliance failure
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BEA-382032 Message must be a soap:Envelope 
XML Details: A Non-SOAP or Invalid Envelope Was 
Received

BEA-382033 A soap:Envelope must contain a soap:Body

BEA-382040 Failed to assign value to context variable "{0}". Value must be
an instance of {1}

BEA-382041 Failed to assign value to context variable "{0}". Variable is 
read-only.

BEA-382042 Failed to assign value to context variable "{0}". {1}

BEA-382043 Failed to update the value of context variable "{0}": {1}

BEA-382045 Failed to initialize the value of context variable "{0}": {1}

BEA-382046 Failed to marshall the value of context variable "{0}" to XML:
{1}

BEA-382100 General binding error while processing inbound request

BEA-382101 General binding error while preparing inbound response

BEA-382102 General binding error while preparing outbound request

BEA-382103 General binding error while processing outbound response

BEA-382104 Failed to prepare request metadata for service {0}

BEA-382105 Failed to prepare response metadata for service {0}

BEA-382150 Failed to dispatch request to service {0}

BEA-382151 Cannot dispatch to unknown service: {0}

Action error codes 
(382500...382999)

BEA-382500 ALSBConfigurationMBean service callout action 
received SOAP Fault response. 

XML details: A SOAP Fault Response was Received

Table A-1  Oracle Service Bus Error Codes (Continued)

Subsystem Error Code Error Message
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BEA-382501 Oracle Service Bus service callout action received an 
unrecognized response. XML details: An Unrecognized 
Response was Received

BEA-382502 Oracle Service Bus service callout has received an error 
response from the server XML details: An Unknown Error 
Response Was Received

BEA-382505 Oracle Service Bus Validate action validation failed. 

XML details: Validation Failed

BEA-382510 Oracle Service Bus Assign action failed updating variable 
"{0}": {1}

BEA-382511 Oracle Service Bus Delete action failed updating variable 
"{0}": {1}

BEA-382512 Oracle Service Bus Insert action failed updating variable 
"{0}": {1}

BEA-382513 Oracle Service Bus Replace action failed updating variable 
"{0}": {1}

BEA-382514 Oracle Service Bus Rename action failed updating variable 
"{0}": {1}

BEA-382515 Callout to java method "{0}" resulted in exception: {1}

BEA-382516 Failed to evaluate expression for callout to java method "{0}".
Argument index: {1}, exception: {2}

BEA-382517 Failed to assign the result of Java callout to variable. Method:
{0}, variable: {1}, exception: {2}

BEA-382518 Security exception while calling to java method "{0}". 
Service account: {1}. {2}

BEA-382600 Oracle Service Bus publish action received an error response:
{0}

Table A-1  Oracle Service Bus Error Codes (Continued)

Subsystem Error Code Error Message
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Security error codes 
(386000...386999)

BEA-386000 General security error. Possible reasons include the following:
• Custom token or custom user name/password 

authentication is configured but authentication already 
took place via WS-Security.

BEA-386100 Authentication failed. Possible reasons include the following
• The XPath is configured to act on the body or header but

there is no such message part (the binding layer returns 
null).

• The XPath engine throws an exception when evaluating 
the XPath expression.

• The result of the user name XPath or password XPath is a
node that is not of type TEXT or ATTR.

• The XPath returns more than one node.
• A user name/password was retrieved but authentication 

failed.
• A custom token was retrieved but identity assertion failed

(the CSS identity assertion service throws 
LoginException or any other exception).

BEA-386101 Missing authentication token. Possible reasons include the 
following: 
• The user name XPath or password XPath returns an empty

result or empty string.
• The custom token XPath returns an empty result, null 

attribute value, or null text-value.

BEA-386102 Message-level authorization denied. Possible reasons include
the following: 
• The message level access control policy denies access to 

the proxy service.

Table A-1  Oracle Service Bus Error Codes (Continued)

Subsystem Error Code Error Message
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BEA-386103 The proxy service operation selection algorithm cannot 
determine the operation name from the request or returns an 
invalid operation (one which is not in the WSDL or null). 
Possible reasons include the following: 
• An error occurs while computing the operation.
• The operation selection algorithm returns null.
• The operation selection algorithm returns an operation 

that is not of the of the operations declared by the WSDL

BEA-386200 General web service security error

BEA-386201 A web service security fault occurred[<error-code from WSS
fault>][<fault-string from WSS-fault>] XML details: A 
WS-Security Fault Occurred

BEA-386400 General outbound web service security error

BEA-386401 Failed to convert outbound message to SOAP

BEA-386402 Cannot determine the outbound operation

BEA-386420 A web service security error occurred while producing 
security header

BEA-386440 A web service security error occurred while processing the 
security header

BEA-386460 Web Service Security policy validation error

UDDI error codes 
(394500...394999)

BEA-394500 An error was encountered while importing a resource

BEA-394501 An error was encountered while querying the UDDI registry 
for business entities

BEA-394502 An error was encountered while initializing the UDDI service

BEA-394503 An error was encountered while initializing the inquiry port

BEA-394504 An error was encountered while publishing this service

BEA-394505 Failed to connect to the UDDI registry

Table A-1  Oracle Service Bus Error Codes (Continued)

Subsystem Error Code Error Message
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Error Details Schemas
Below are schema definitions for XML snippets that accompany the error codes listed in 
Table A-1. These XML snippets appear inside the fault context variable under the 
<ctx:details> element. These schemas do not all come from a single namespace. Also, while 
a given error code typically implies a particular XML snippet, some XML snippets are used by 
several error codes. 

BEA-394506 An error was encountered while querying the UDDI registry 
for business services

BEA-394507 The registry name contains characters that are not allowed

BEA-394508 The publish URL was missing the UDDI registry 
configuration

BEA-394509 The Service Account configured is not valid

BEA-394510 A resource could not imported while importing a service

BEA-394511 A validation exception occurred while creating a service 
definition while importing a service

BEA-394512 A generic error was encountered while importing a resource

BEA-394513 An internal error was encountered while importing a resource

BEA-394514 Failed to create an FTP endpoint configuration when 
importing a service

BEA-394515 Failed to create an E-mail endpoint configuration when 
importing a service

BEA-394516 A possible syntax error was encountered in the access point 
URL when importing a service

BEA-394517 An error was encountered when parsing the InstanceParms 
while importing a service

BEA-394518 Failed to create an file endpoint configuration when importing
a service

Table A-1  Oracle Service Bus Error Codes (Continued)

Subsystem Error Code Error Message
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<xs:schema 
targetNamespace="http://www.oracle.com/wli/sb/stages/transform/config"
           xmlns:tns="http://www.oracle.com/wli/sb/stages/transform/config"

   xmlns:xs="http://www.w3.org/2001/XMLSchema"
           xmlns:ref="http://www.oracle.com/wli/sb/reference"
           xmlns:sdk="http://www.oracle.com/wli/sb/stages/config"

   elementFormDefault="qualified"
   attributeFormDefault="unqualified">

A SOAP Fault Response was Received
    <xs:element name="ReceivedFaultDetail" type="tns:ReceivedFaultDetail"/>
    <xs:complexType name="ReceivedFaultDetail">
        <xs:sequence>
            <xs:element name="faultcode" type="xs:QName"/>
            <xs:element name="faultstring" type="xs:string"/>
            <xs:element name="detail" minOccurs="0" >
                <xs:complexType mixed="true" >
                    <xs:sequence>
                        <xs:any namespace="##any" minOccurs="0" maxOccurs="unbounded" 
processContents="lax" />
                    </xs:sequence>
                    <xs:anyAttribute namespace="##any" processContents="lax" />
                </xs:complexType>
            </xs:element>

            <!-- HTTP-specific status/response code -->
            <xs:element name="http-response-code" type="xs:int" minOccurs="0"/>
        </xs:sequence>
    </xs:complexType>

An Unrecognized Response was Received
    <xs:element name="UnrecognizedResponseDetail" 
type="tns:UnrecognizedResponseDetail"/>
    <xs:complexType name="UnrecognizedResponseDetail">
        <xs:sequence>
            <xs:element name="detail" minOccurs="0" type="xs:string" />

            <!-- HTTP-specific status/response code -->
            <xs:element name="http-response-code" type="xs:int" minOccurs="0"/>
        </xs:sequence>
    </xs:complexType>

An Unknown Error Response Was Received
    <xs:element name="ErrorResponseDetail" type="tns:ErrorResponseDetail"/>
    <xs:complexType name="ErrorResponseDetail">
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        <xs:sequence>
            <xs:element name="detail" minOccurs="0" type="xs:string" />

            <!-- HTTP-specific status/response code -->
            <xs:element name="http-response-code" type="xs:int" minOccurs="0"/>
        </xs:sequence>
    </xs:complexType>

Validation Failed
    <xs:complexType name="ValidationFailureDetail">
        <xs:sequence minOccurs = "0" maxOccurs="unbounded">
            <xs:element name="message" type="xs:string"/>
            <xs:element name="xmlLocation" type="xs:anyType"/>
        </xs:sequence>
    </xs:complexType>
</xs:schema>
<schema targetNamespace="http://www.oracle.com/wli/sb/errors"
        xmlns:err="http://www.oracle.com/wli/sb/errors"
        xmlns:tc="http://www.oracle.com/wli/sb/transports"
        xmlns="http://www.w3.org/2001/XMLSchema"
        elementFormDefault="qualified"
        attributeFormDefault="unqualified">

A Non-SOAP or Invalid Envelope Was Received
    <element name="InvalidEnvelope">
        <complexType>
            <sequence>
                <element name="localpart" type="NCName"/>
                <element name="namespace" type="anyURI" minOccurs="0"/>
            </sequence>
        </complexType>
    </element>

A WS-Security Fault Occurred
    <element name="WebServiceSecurityFault">
        <complexType>
            <sequence>
                <element name="faultcode" type="QName"/>
                <element name="faultstring" type="string"/>
                <element name="detail" minOccurs="0">
                    <complexType mixed="true">
                        <sequence>
                            <any namespace="##any" minOccurs="0" maxOccurs="unbounded" 
processContents="lax"/>
                        </sequence>
                        <anyAttribute namespace="##any" processContents="lax"/>
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                    </complexType>
                </element>
            </sequence>
        </complexType>
    </element>

An Error Response Was Received
    <element name="ErrorResponseDetail" type="err:ErrorResponseDetail"/>
    <complexType name="ErrorResponseDetail">
        <sequence>
            <!-- Response metadata -->
            <element name="response-metadata" type="tc:ResponseMetaDataXML" 
minOccurs="0" />
        </sequence>
    </complexType>
</schema>
Using the Oracle Service Bus Console A-9


	Oracle® Service Bus
	10g Release 3 Maintenance Pack 1 (10.3.1)

	Oracle Service Bus Using the Oracle Service Bus Console, 10g Release 3 Maintenance Pack 1 (10.3.1)
	Introduction to Oracle Service Bus
	Starting Oracle Service Bus Console
	Customizing Table Views

	Change Center
	Using the Change Center
	Activating Sessions
	Exiting Sessions
	Viewing Configuration Changes
	Purging Session Activation History
	Undoing Tasks
	Viewing Task Details
	Viewing All Sessions
	Viewing and Resolving Conflicts

	Working with Projects, Folders, and Resources
	Projects View page
	Project/Folder View page
	Adding Projects
	Renaming Projects
	Moving Projects (Converting to a Folder)
	Cloning Projects
	Deleting Projects
	Adding Folders
	Renaming Folders
	Moving or Upgrading Folders
	Cloning Folders
	Deleting Folders
	Creating Resources
	Loading Resources from a Zip File
	Load Resources - Select Zip File and Review Type Extensions page
	Loading Resources from a URL
	Load Resources - Load Resources from URL page
	Load Resources - Review Loaded Resources page
	Load Resources - Import Result page
	View References page
	Viewing References to Resources
	View Change History page
	Using the Resource Browser
	Renaming Resources
	Moving Resources
	Cloning Resources
	Exporting a WSDL
	Generating a WSDL
	Viewing Resources in a Web Browser
	Deleting Resources

	XML Schemas
	Locating XML Schemas
	Adding XML Schemas
	Editing XML Schemas
	Deleting XML Schemas
	Viewing Unresolved XML Schema References
	Resolving Unresolved XML Schema References

	Alert Destinations
	Locating Alert Destinations
	Adding Alert Destinations
	Editing Alert Destinations
	Deleting Alert Destinations

	WSDLs
	Locating WSDLs
	Adding WSDLs
	Editing WSDLs
	Deleting WSDLs
	Viewing Unresolved WSDL References
	Resolving Unresolved WSDL References

	JARs
	Locating JARs
	Adding JARs
	Editing JARs
	Editing JAR Dependencies
	Deleting JARs

	MQ Connections
	Locating MQ Connections
	Adding MQ Connections
	Editing MQ Connections
	Deleting MQ Connections

	Split-Joins
	Locating Split-Joins
	Adding Split-Joins
	Editing Split-Joins
	Deleting Split-Joins

	XQuery Transformations
	Locating XQuery Transformations
	Adding XQuery Transformations
	Editing XQuery Transformations
	Deleting an XQuery Transformation

	Custom WS-Policies
	Locating Custom WS-Policies
	Adding Custom WS-Policies
	Editing Custom WS-Policies
	Deleting Custom WS-Policies

	XSL Transformations
	Locating XSL Transformations
	Adding an XSL Transformation
	Editing XSL Transformations
	Deleting an XSL Transformation
	Resolving Unresolved XSL Transformation References

	MFLs
	Locating MFLs
	Adding MFLs
	Editing MFLs
	Deleting MFLs

	Service Accounts
	Specifying Service Accounts
	Locating Service Accounts
	Adding Service Accounts
	Editing Service Accounts
	Deleting Service Accounts

	Service Key Providers
	Locating Service Key Providers
	Adding Service Key Providers
	Editing Service Key Providers
	Deleting Service Key Providers

	Business Services: Creating and Managing
	Creating and Configuring Business Services
	Create/Edit a Business Service - Page Reference
	Exporting a WSDL Associated with a Business Service
	Locating Business Services
	Editing Business Service Configurations
	View a Business Service - Configuration Details page
	View a Business Service - Policies page
	View a Business Service - Security page
	Deleting Business Services

	Proxy Services: Creating and Managing
	Creating and Configuring Proxy Services
	Create/Edit a Proxy Service - Page Reference
	Exporting a WSDL Associated with a Proxy Service
	Locating Proxy Services
	Editing Proxy Service Configurations
	View a Proxy Service - Configuration Details page
	View a Proxy Service - Policies page
	View a Proxy Service - Security page
	Deleting Proxy Services

	Proxy Services: Message Flow
	Creating, Editing, and Viewing Message Flows
	Edit Message Flow page
	Edit Stage Configuration Page
	Adding Pipeline Pair Nodes to Message Flows
	Adding Conditional Branches to Message Flows
	Adding Operational Branches to Message Flows
	Adding Stages to Pipelines
	Adding Route Nodes to Message Flows
	Cutting, Copying, and Pasting Stages and Route Nodes

	Proxy Services: Actions
	Adding and Editing Actions in Message Flows
	Adding Publish Actions
	Adding Publish Table Actions
	Adding Dynamic Publish Actions
	Adding Routing Options Actions
	Adding Service Callout Actions
	Adding Transport Header Actions
	Adding Dynamic Routing to Route Nodes
	Adding Routing Actions to Route Nodes
	Adding Routing Tables to Route Nodes
	Adding For Each Actions
	Adding If... Then... Actions
	Adding Raise Error Actions
	Transactions

	Adding Reply Actions
	Adding Resume Actions
	Adding Skip Actions
	Adding Assign Actions
	Adding Delete Actions
	Adding Insert Actions
	Adding Java Callout Actions
	Adding MFL Transform Actions
	Adding Rename Actions
	Adding Replace Actions
	Adding Validate Actions
	Adding Alert Actions
	Adding Log Actions
	Adding Report Actions

	Proxy Services: XQuery and XPath Editors
	Creating and Editing Inline XQuery and XPath Expressions
	Understanding XQuery Editor Layouts and Tasks
	Building Expressions in the Editor Workspace Text Fields
	Creating Namespaces to Use in Inline Expressions
	Creating Variable Structures in the XQuery Editors
	Binding External XQuery Resources to Inline XQueries
	Binding External XSLT Resources to Inline XQueries
	Binding Dynamic XQuery Expressions to Inline XQueries
	Entering XQuery Comparison Expressions Using the Builder Option
	Entering Unary Expressions Using the Builder Option

	Proxy Services: Error Handlers
	Edit Error Handler page
	Adding Proxy Service Error Handlers
	Adding Pipeline Error Handlers
	Adding Stage Error Handlers
	Adding Route Node Error Handlers
	Editing Error Handlers

	Security Configuration
	Understanding Users, Groups, Security Roles and Policies
	Locating Users
	Adding Users
	Editing Users
	Deleting Users
	Locating Groups
	Adding Groups
	Editing Groups
	Deleting Groups
	Locating Roles
	Adding Roles
	Editing Roles
	Deleting Roles
	Locating Access Control Policies
	Editing Transport-Level Access Policies
	Editing Message-Level Access Policies
	Adding Policy Conditions

	Monitoring
	Viewing SLA Alerts
	Viewing Pipeline Alerts
	Locating Alerts
	WebLogic Diagnostics Framework Query Language

	Purging Alerts
	Viewing Alert Details
	Viewing Service Monitoring Information
	Resetting Statistics for Services
	Configuring Operational Settings for Proxy Services
	Configuring Operational Settings for Business Services
	Setting the Aggregation Interval for a Service
	Viewing Service Metrics
	Viewing Operations Metrics for WSDL-Based Services
	Viewing Pipeline Metrics
	Viewing Action Metrics
	Viewing Business Services Endpoint URIs Metrics
	Viewing Server Information
	Viewing Server Details
	Viewing Domain Log Files
	Customizing Your View of Domain Log File Entries
	Viewing Details of Domain Log Files
	Viewing Alert Rules
	Locating Alert Rules
	Creating and Editing Alert Rules
	Viewing Alert Rule Configurations
	Editing Alert Rules
	Deleting Alert Rules

	Configuration
	Finding and Updating Operational Settings
	Enabling Global Settings
	Setting User Preferences

	Reporting
	Viewing Reporting Messages
	Viewing Message Details
	Purging Messages

	Import/Export
	Importing Resources
	Exporting Resources

	UDDI
	Viewing Configured UDDI Registries
	Configuring UDDI Registries
	Setting Up a Default UDDI Configuration
	Importing Business Services From a UDDI Registry
	Using Auto-Import Status
	Detaching Services
	Publishing Proxy Services to a UDDI Registry
	Using Auto-Publish

	Global Resources
	Viewing JNDI Providers
	Adding JNDI Providers
	Editing JNDI Providers
	Deleting JNDI Providers
	Viewing SMTP Servers
	Locating SMTP Servers
	Adding SMTP Servers
	Configuring a Default SMTP Server
	Editing SMTP Servers
	Deleting SMTP Servers
	Viewing Proxy Servers
	Locating Proxy Servers
	Adding Proxy Servers
	Editing Proxy Servers
	Deleting Proxy Servers

	Customization
	Finding and Replacing Environment Values
	Creating Customization Files
	Executing Customization Files

	Test Console
	Testing Services
	Testing Transformations
	Performing XQuery Testing
	Understanding How the Run Time Uses the Transport Settings in the Test Console

	Error Codes

